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MAXON Computer License Agreement
for CINEMA 4D / BodyPaint 3D

NOTICE TO USER

WITH THE INSTALLATION OF CINEMA 4D / BODYPAINT 3D A CONTRACT IS CONCLUDED
BETWEEN YOU AND MAXON COMPUTER GMBH, IN THE FOLLOWING CALLED THE
“LICENSOR", A COMPANY UNDER GERMAN LAW WITH RESIDENCE IN FRIEDRICHSDORF,
GERMANY. “YOU" AND THE “USER" REFERS TO THE LICENSEE.

WHEREAS BY INDICATING YOUR ACCEPTANCE BELOW, YOU ACCEPT ALL THE TERMS AND
CONDITIONS OF THIS AGREEMENT. IN THE CASE OF NON-ACCEPTANCE OF THIS LICENSE YOU
ARE NOT PERMITTED TO INSTALL THE SOFTWARE.

IF YOU DO NOT ACCEPT THIS LICENSE PLEASE SEND THE SOFTWARE TOGETHER WITH THE
DOCUMENTATION TO MAXON COMPUTER OR TO THE SUPPLIER WHERE YOU BOUGHT THE
SOFTWARE.

1. General

Under this contract the licensor grants to you a non-exclusive license to use CINEMA 4D /
BodyPaint 3D, which is software and documentation, in the following called the "software". The
software itself as well as the copy of the software or any other copy you are authorized to make
under this contract remain the property of the licensor.

2. Use of the Software

(1) The user of this license is authorized to copy the software as far as the copy is necessary to use
the software. Necessary copies are the installation of the program from the original disk to the mass
storage medium of your hardware as well as the loading of the program into RAM.

(2) Furthermore the user is entitled to make a backup copy. However only one backup copy may be
made and kept in store. This backup copy must be identified as a backup copy of the licensed
software. (3) Further copies ARE NOT ALLOWED; this also covers the making of a hard copy of the
program code on a printer as well as copies, in any form, of the documentation.

3. Multiple use and network operation

(1) The user may use the software on any hardware available to him. However, should the user
change the hardware he is obliged to delete the software from the mass storage medium of the
hardware used up to then. A simultaneous installation or use on more than one hardware IS NOT
ALLOWED.

(2) The use of the licensed software for network operation or other client server systems is
prohibited if this opens the possibility of simultaneous multiple use of the software. In the case that
the user intends to use the software in network operation or other client server system he has to



take care that a multiple use is not possible by employing the necessary access security or otherwise
the user has to pay to the licensor a special network license fee, the amount of which is determined
by the number of users admitted to the network.

(3) The license fee for networks will be communicated to the licensee by the licensor immediately
after the user has indicated the number of admitted users in writing. The correct address of the
licensor is given in the manual and also at the end of this contract. The network use may start only
after the pertaining license fee is completely paid.

4, Transfer

(1) You may not rent, lease, sublicense or lend the software or documentation. You may, however,
transfer all your rights to use the software to another person or legal entity provided that you
transfer this agreement, the software, including all copies, updates or prior versions as well as all
copies of the font software converted to other formats and all documentation to such person or
entity and that you retain no copies, including copies stored on a computer and that the other
person agrees that the terms of this agreement remain valid and that his acceptance is
communicated to the licensor.

(2) The user is obliged to carefully store the terms of the agreement. Prior to the transfer of the
software the user has to inform the new user of these terms. In case the user does not have the
terms at hand at the time of the transfer of the software, he is obliged to request a second copy
from the licensor, the cost of which is born by the licensee.

(3) In case of transfer the license of the former user expires.

5. Recompilation and changes of the software

(1) The recompilation of the provided program code in other code forms as well as all other types of
reverse engineering of the different phases of software production including any alterations of the
software are not allowed.

(2) The removal of the security against copy or similar safety systems is only permitted if a faultless
performance of the software is impaired or hindered by such security. The burden of proof for the
fact that the performance of the program is impaired or hindered by the security device rests with
the user.

(3) Copyright notices, serial numbers or other identifications of the software may not be removed or
changed. The software is owned by the licensor and its structure, organization and code are the
valuable trade secrets of the licensor. It is also protected by United States Copyright and
International Treaty provisions. Except as stated above, this agreement does not grant you any
intellectual property rights on the software.



6. Limited warranty

(1) The parties hereto agree, that at present it is not possible to develop and produce software in
such a way that it is fit for any conditions of use without problems. The licensor warrants that the
software will perform substantially in accordance with the documentation. The licensor does not
warrant that the software and the documentation comply with certain requirements and purposes of
the user or works together with other software used by the licensee. The user is obliged to check the
software and the documentation carefully immediately upon receipt and has to inform the licensor in
writing of apparent defects 14 days after receipt. Latent defects have to be communicated in the
same manner immediately after their discovery. Otherwise the software and documentation are
considered to be faultless. The defects, in particular the symptoms that occurred, are to be described
in detail in as much as the user is able to do so. The warranty is granted for a period of 6 months
from delivery of the software (for the date of which the date of the purchase according to the
invoice is decisive, respectively in case of shipment by the licensor the date of the invoice). The
licensor is free to cure the defects by free repair or provision of a faultless update.

The licensor and its suppliers do not and cannot warrant the performance and the results you may
obtain by using the software or documentation. The foregoing states the sole and exclusive remedies
for the licensor’s or its suppliers’ breach of warranty, except for the foregoing limited warranty. The
licensor and its suppliers make no warranties, express or implied, as to noninfringement of third
party rights, merchantability, or fitness for any particular purpose. In no event will the licensor or its
suppliers be liable for any consequential, incidental or special damages, including any lost profits or
lost savings, even if a representative of licensor has been advised of the possibility of such damages
or for any claim by any third party.

If the licensor is unable to repair or replace the program in such way that it fulfils this agreement, the
user is entitled to withdraw from the agreement or is entitled to a reduction in the license fee. If the
creation of a program in the sense of this agreement is not possible with reasonable effort and within
a reasonable time, the licensor is entitled to withdraw from the agreement.

(2) In the case of enforcement of guarantee by the user, the user is obliged to return the program
and manuals together with proof of purchase. The cost of the return is to be borne by the licensor.

(3) The licensor accepts no liability should the software infringe third-party rights unless the
infringement was caused by gross negligence or is shown to be culpable. In this case only, the
licensor will excuse the user from any possible costs for the judicial defence of the enforcement of
copyrights and damages by the third party.

Some states or jurisdictions do not allow the exclusion or limitation of incidental, consequential or
special damages, or the exclusion of implied warranties or limitations on how long an implied
warranty may last, so the above limitations may not apply to you. In this case a special limited
warranty is attached as exhibit to this agreement, which becomes part of this agreement. To the
extent permissible, any implied warranties are limited to 6 months. This warranty gives you specific
legal rights. You may have other rights which vary from state to state or jurisdiction to jurisdiction. In
the case that no special warranty is attached to your contract please contact the licensor for further
warranty information.



7. Damage in transit

The user is obliged to immediately inform the transport agent in writing of any eventual damages in
transit and has to provide the licensor with a copy of said correspondence, since all transportation is
insured by the licensor if shipment was procured by him.

8. Secrecy

The user is obliged to take careful measures to protect the programs and their documentation, in
particular the serial number, from access by third parties. The user is not permitted to duplicate or
pass on the programs or documentation. These obligations apply equally to the user's employees or
other persons engaged by the user to operate the programs. The user will pass on these obligations
to such persons. The user is liable for damages in all instances where these obligations have not been
met.

9. Information

In case of transfer of the software the user is obliged to inform the licensor of the name and full
address of the transferee in writing. The address of the licensor is stated in the manual and at the
end of this contract.

10. Data Protection

For the purpose of customer registration and control of proper use of the programs licensor will store
personal data of the users in accordance with the German law on Data Protection
(Bundesdatenschutzgesetz). This data may only be used for the above-mentioned purposes and will
not be accessible to third parties. Upon request of the user the licensor will at any time inform the
user of the data stored with regard to him.

11. Other

(1) This contract includes all rights and obligations of the parties. There are no other agreements.
Any changes or alterations of this agreement have to be performed in writing with reference to this
agreement and have to be signed by both contracting parties. This also applies to the agreement on
abolition of the written form.

(2) This agreement is governed by German law. Place of jurisdiction is the competent court in
Frankfurt am Main. This agreement will not be governed by the United Nations Convention on
Contracts for the International Sale of Goods, the application of which is expressly excluded.

(3) If any part of this agreement is found void and unenforceable, it will not affect the validity of the
balance of the agreement which shall remain valid and enforceable according to its terms.



12. Termination

This agreement shall automatically terminate upon failure by you to comply with its terms despite
being given an additional period to do so. In case of termination due to the aforementioned reason,
user is obliged to return the program and all documentation to licensor. Furthermore, upon request
of licensor user has to submit written declaration that he is not in possession of any copy of the
program on data storage devices or on the computer itself.

13. Information and Notices

Should you have any questions concerning this agreement or if you desire to contact MAXON
COMPUTER for any reason and for all notifications to be performed under this agreement, please
write to:

MAXON Computer
GmbH Max-Planck-Str. 20
D-61381

Friedrichsdorf

Germany

or for North and South America to:

MAXON Computer Inc.

566 St. Charles Drive, Suite 2
Thousand Oaks, CA 91360
USA

We also shall be glad to provide you with the address of your nearest supplier.
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Preface

Traditionally, a preface in a computer program's
documentation is all about thanking the customer
for her or his wise choice of purchase. Certainly,
we are truly grateful for your purchase and we
offer you our warmest thanks. But let's be honest,
your fingers are already itching to turn the page to
see what wonderful features await you. You want
to know how BodyPaint 3D is going to
revolutionize the way you work, and to this we
now turn our attention.

Firstly, BodyPaint 3D is based on the highly-
optimized, multi-award-winning program code of
CINEMA 4D XL. This means that BodyPaint 3D
shares the legendary speed and proverbial stability
of its sister package. If you have used CINEMA 4D
XL, you will feel at home right away, because you
can integrate BodyPaint 3D with CINEMA 4D XL
seamlessly - the new tools simply appear as extra
managers in your usual layout.

Secondly, and just as importantly, BodyPaint 3D is
for users of almost all 3D applications. This is made
possible by BodyPaint 3D's numerous import and
export filters. Also, BodyPaint 3D has a fully
configurable GUI so that you can feel at home
whatever your main 3D application.

The problem that BodyPaint 3D aims to address is
easily defined. Imagine that you have spent many
hours creating the most detailed of 3D objects.
The modeling is done and all you need now is
good texturing. However, try as you might, most
of the textures show seams and distortions when
mapped to the model. Only rarely can you get a
texture to fit snugly onto its model. Or perhaps
you are fed up of guessing where you should paint
in your 2D paint package. All these difficulties and
more come about because you cannot paint
directly onto the 3D object.

PREFACE « 1

With BodyPaint 3D, you can paint directly onto
your 3D models in real-time, even if they number
millions of polygons. Just load a model, grab a
brush and a texture, then start painting. You can
even paint to several material channels at the same
time, using a MultiBrush.

One feature in particular makes BodyPaint 3D
unique; its RayBrush technology enables you to
paint to a rendered image in three dimensions
— a world first! Not only can you paint color to
the rendered image, you can also paint bump,
transparency, reflection and other properties
besides. For example, you might render a ship
then paint welding with reflection and bump in
a single brush stroke.

We have endeavoured to make BodyPaint 3D
practical to use. For example, you can work with
layers. In addition, BodyPaint 3D includes most
popular image-editing and selection tools.

The powerful UV Editor is a highlight, an absolute
star, of BodyPaint 3D. The UV Editor enables you
to edit a texture's geometry without changing the
object. You can move the UV coordinates freely so
that your textures fit the object optimally. Above
all, it is easy to place textures (or even parts of
textures) with absolute pixel-point accuracy.

Your fingers are probably itching even more now,
but before you go, please be aware that we will be
delighted to receive your comments and
improvement suggestions for BodyPaint 3D. To
this end, please use the suggestion form in the
Support area of our website (www.maxon.net).
Only your comments and suggestions will enable
BodyPaint 3D to remain your software.

We wish you every success in using BodyPaint 3D.
Team MAXON.
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1 Getting to Know BodyPaint 3D

Launching
There are several ways to start BodyPaint 3D:

- Double-click on the program icon.
- Double-click on a scene file.
- Use the Start menu (Windows).

Alternatively, you can drag-and-drop one or
more BodyPaint 3D files from Explorer
(Windows) or Finder (Macintosh) on to the
BodyPaint 3D application icon or directly into
the program.

Template.c4d

If the BodyPaint 3D root folder contains a scene
named ‘Template.c4d’, this is loaded during
startup and all the settings defined there
become effective.

Quitting

File > Quit quits the program. If any unsaved
changes are detected, a dialog asks you if you
wish to save these before quitting.

Clicking on Cancel in this dialog returns you to
the program.

Note

The layout can be saved automatically each time
you quit the program - activate Save Layout at
Program End on the General page of the
General Settings.

Mouse Techniques

BodyPaint 3D offers enhanced mouse
functionality. The features that go beyond
conventional mouse control are:

- You can simulate the right mouse button on
the Macintosh by clicking with the Ctrl key
held down. Alternatively, use a two-button
mouse with the appropriate driver.

- If you wish to drag an object on to a window
displayed as a tab but the window is
concealed, drag and hold the object over the
window's tab. After a short delay, the window
will be activated and you can drop the object
on the target.

- If you are using a wheel mouse, you can use
the wheel to scroll sliders (such as a material's
color and brightness sliders). You can also use
the wheel to increment/decrement numbers in
numerical text boxes.

- Vertical window slider. Use this, for example,
to scroll quickly in the Object manager.

- Increment arrows alongside some input boxes.

Graphics Tablet

BodyPaint 3D supports all graphics tablets that
conform to the WinTab standard, such as the
Wacom range. The pen pressure, pen tilt, pen
direction and pen finger wheel are all supported.
For details on how to link these input methods
to your brush settings, please see Chapter 7,
Brush Settings.
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Hotkeys 1 to 7

You can use the following hotkeys in the view
panel:

1 move camera
zoom camera
rotate camera
move object
scale object

rotate object

N O o0 A WN

scale model

Command palettes

The GUI

The BodyPaint 3D GUI offers features far in
advance of the standard Windows/Macintosh
GUI. For example, you may dock all windows
into the main window.

When a docked window is moved, the
surrounding windows adapt so that no
overlapping occurs. Each window has its own
menu bar. Windows can also be displayed as
tabs and grouped together to conserve display
space.

Window menu bars

e

Command
groups

Texture View

] -
. Tabs

Material manager Color presets

Brush presets

Layer manager



The GUI is freely configurable. You can create
your own icon palettes (including folded icons)
and you can even edit the menus.

You can define various layouts and switch
between them at will.
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A Quick Tour

In this section we take a look at the individual
program elements that appear on the screen the
first time you launch BodyPaint 3D. This is
merely a quick tour - the detailed descriptions
come later in the corresponding chapters.

Managers

Managers are the main program elements in
BodyPaint 3D. Each manager has its own
window and runs parallel to the other managers.
This means that each manager can operate
independently (so that it is multithreaded) -
something of a rarity for application software.
For example, if you paint an object in the
Perspective View, the bitmap in the Texture
View is changed at the same time.

Although the managers operate independently,
each manager reacts immediately to changes
made in other managers that affect it. For
example, if you move an object in the editor, the
corresponding values in the Coordinate manager
change.

Windows

Each manager has its own window. A window
can be placed freely or it can be docked into
BodyPaint 3D's main window.

In the default layout, almost all the managers
are docked. If you change the size of a docked
window, the surrounding windows are adjusted
automatically to avoid an overlap.

If you wish to undock a window from the
group, click on its pin icon and select Undock.
To re-dock the window, drag-and-drop its pin
icon onto the main window. A black line will
indicate the insertion position.
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To change a window's size, first move the
mouse pointer to its border. The pointer will
change into a double arrow to indicate the
direction (either vertical or horizontal) in which
you can drag the border. Drag the window as
required. The other windows in the group will
adapt to the change.

Menu Bars

Each manager has its own menu bar.
Menu bars have the following features:
- Submenus.

- Commands that cannot be selected are grayed
out.

- Activated options are indicated with a tick.

- All shortcuts, including those you have
allocated yourself, are displayed.

If there is insufficient space to display the entire
menu bar, a black triangle appears. If you click
on the triangle, the other menu entries appear
on a popup menu.
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Command Palettes

There are two command palettes (aka icon
palettes) in the default layout to house the most
frequently used commands.

Some of the icons have a small black triangle to
their lower right. This indicates a folded group.
If you click and hold down the left mouse
button on the icon, hidden icons appear. Folded
groups take up minimal space and are a
convenient way to group similar commands. The
visible icon is usually the last command that you
used. For more information on command
palettes see Command Palettes, page 32.

Tabs

You can display windows and command palettes
as tabs. For example, the Object manager and
Structure manager are displayed as tabs in the
default layout. This saves display space and
allows you to reach a manager or command
palette quickly.

strurtaee | Doerts Browsar | st 4]
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If there is insufficient display space for all the

tabs, one of the tabs will be torn. You can use

the small arrow icons to the top right of the

window to scroll through the tabs.

For more information on tabs see Tabs, page 31.
For details on the individual program managers,
please see the corresponding chapters.

Context Menus

BodyPaint 3D supports context menus. To
activate a context menu, press the right mouse
button (or Command-click for the Macintosh).

Input Boxes

Input boxes with two small arrows (one pointing
up, the other pointing down) offer the following
features:



- Click on an arrow to increment or decrement
the value by one.

- If you click on an arrow and move the mouse
up/down, the value increases or decreases
rapidly.

- The wheel mouse is supported - position the
mouse pointer in a box with a numerical value,
then move the wheel to increase/decrease the
value.

BodyPaint 3D has a built-in expression evaluator
which enables you to include mathematical
operators in numerical boxes. See Appendix 1.
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Perspective View

Here, you cab paint and render the object in
three dimensions.

Texture View

This window is used for viewing and editing
bitmaps in two dimensions. In addition, you can
view and edit UV mesh.

Material Manager

The Material manager contains all the materials
used in the scene. A double-click on a material
opens its dialog so that it can be edited. You can
apply a material by dropping it on to an object.

Color Manager

This manager contains ready-to-use color
presets. You can add your own presets if you
wish.

CHAPTER 1 « GETTING TO KNOW BODYPAINT 3D « 9

Brush Manager

Here, you can choose a predefined brush tool.
You can also add your own brushes to the
manager.

Layer Manager

This is where all two-dimensional bitmap layers
are created and managed.

Active Tool Manager

This manager shows the settings for the active
tool - the settings vary according to the tool. For
a detailed description of the options, see the
relevant tools chapter.

Object Manager

The Objects manager contains all the scene
elements (objects). Objects can be grouped
hierarchically. For example, a leaf will be the
child of a branch, which in turn is the child of
the trunk while the tree is the main (root)
object.

An object can be selected by clicking on its
name in the Objects manager. This activates the
object in the view panel, from where it can be
moved and so on. You can use tags to allocate
certain properties to objects in the Objects
manager. For example, you can use a texture
tag to apply a texture
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2 View Menu
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View Panels

You can open as many view panels as you like.
Each view panel has its own display settings.
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A view panel can show up to four views
simultaneously. Each of these views has its own
display settings.

View Icons

There are four icons at the top right of each
view. The right-most icon toggles the active
view (see Toggle Active View, page 24). The
remaining icons move, zoom and rotate the
camera (click-drag on the icon you require to
see the effect).

Edit
Undo View/Redo View

ale

Each view has its own Undo View/Redo View
functions (the Undo/Redo functions of the main
window do not affect editor cameras).

Note

The shortcut for Undo View is Ctrl+Shift+Z. For
Redo View, use Ctrl+Shift+Y.

Frame

Frame Selected Elements

The camera will move so that the selected
elements (e.g. objects, polygons) fill the view
and are centred.

Frame Active Object
The camera will move so that the active object
fills the view and is centred.

Frame Scene Without Camera/Light

The camera will move so that all objects (bar
lights and cameras) fill the active view and are
centred.

Frame Scene

The camera will move so that all objects,
including lights and cameras, fill the active view
and are centred.
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Frame Default

This function resets the view to its default
values.

Use as Render View

If this option is activated, the active camera of
the active view is used for the rendering in the
Picture Viewer.

Redraw

This function redraws the scene. This is useful
when BodyPaint 3D has been unable to
complete the Perspective View picture
automatically. This may happen, for example,
when you call functions in quick succession.

Configure

If you select Configure, the view's configuration
dialog will open.
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Active Object

Display

Display sets the display mode (e.g. Gouraud
shading, wireframe) for the active object,
although see Use Shading Property below.

Use Shading Property

If this option is activated, the active object will
use the display mode defined in its display tag
instead of the setting defined in this dialog.

Show Normals

If you enable this option, surface normals will be
shown when you select polygons. The normals
appear as small auxiliary lines which are
perpendicular to their surface. By convention,
the direction of a normal represents the
direction of its surface. For example, backface
culling checks the direction of each normal to
determine whether its surface should be drawn -
if the normal points away from the camera, the
surface is not drawn (the surface is assumed to
point away from the camera, just like its
normal).

X-Ray Effect

To activate the X-ray mode, select this function.
If the active object is a polygon object, it will
become semi-transparent so that you can see its
concealed points and edges.

Show Animation Path

If this option is selected, the active object’s
animation path will appear in the editor in the
form of a yellow curve. If you want to edit the
animation path, drag the curve's points to new
positions and edit the tangents.



Inactive Object

Display
Display sets the display mode (e.g. Gouraud

shading, wireframe) for the inactive objects in
the scene.

Use Shading Property

If this option is activated, the inactive objects
will use the display mode defined in their display
tags instead of the setting defined in this dialog.

View Settings

Projection

You can use this setting to change the projection
type (e.g. to Perspective, Bird, Dimetric).

Disable Textures

Select this option if you wish to switch off
realtime texture mapping.

Disable Backface Culling

You can select this option to switch off backface
culling.

Note

Backface culling merely hides an object’s
concealed points and edges. For example, if you
are using the wireframe display mode, you can
still see an object when it is behind another
object.

Show Safe Frames

This activates the safe frames (Render Safe,
Action Safe, Title Safe), although they must be
activated in the General Settings as well in order
for them to be displayed.
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Show Picture

If you wish to place a background picture in a
planar view (e.g. front, top, right), click on the
Path box and use the dialog that opens to locate
the picture. Next, activate the Show Picture
option. You can use the horizontal and vertical
offset and size boxes to move and scale the
background picture freely. This background
picture is a modeling aid - it is not intended for
rendering. You can place a different picture in
each planar view.

Cameras

Each view has its own camera. The editor
camera is used by default, but you may create
and use your own cameras via the Object
manager.

Scene Cameras

You may activate your own camera (see
page 314) by selecting it from this list.

Link Active Object

If you select this function, you will view the
scene from the origin of the active object. This
can be any type of object, even a light source.
However, if the object has surfaces, the view
may be obscured!

Editor Camera

This function activates the editor camera.
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Projection

You can choose from over a dozen projection
modes. A detailed technical explanation for each
projection type is beyond the scope of this
manual. However, the pictures highlight the key
differences visually.

Warning!

The camera position may alter when you change
the projection mode. You can avoid this by
selecting the view (e.g. View 3) from the View
menu.

Perspective

This is the default projection mode for the view
panel. It operates in a similar fashion to a real

camera.

Parallel

With parallel projection, the vanishing point is
infinitely distant. As a result, the picture appears
to have no vanishing point and all lines are
parallel.

Left

This function selects the YZ (left) view.
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Right Back

This function selects the ZY (right) view. This function selects the YX (back) view.

Front Top

This function selects the XY (front) view. This function selects the XZ (top) view.
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Bottom
This function selects the ZX (bottom) view.

LEE

The following projection types all use parallel
projection. They differ in the format and/or
viewing angle.

Military, Frog and Bird projection share the same
viewing angle but use different formats...

Military

XY:z=1:1:1

Frog

XY:Z=1:2:1
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Isometric

This is a popular choice for technical subjects
(e.g. machinery). The X:Y:Z format is 1:1:1.

X:Y:Z =1:0,5:1

Gentleman

This is a popular choice for architecture.

Dimetric

This is similar to Isometric, but with an X:Y:Z
format of 1:1:0.5.

XY:Z=1:1:.0,5
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Display

This sub-menu lists display options such as the
shading mode. You can, in addition, activate
realtime antialiasing from the Views tab of the
General Settings - provided that you are using
an OpenGL card which supports this feature.

Level Of Detail

Choose from Low, Medium or High. The setting
affects the display detail of parametric objects;
the lower the detail, the faster the display. This
setting has no effect on polygon objects.

Gouraud Shading

Gouraud shading offers the highest quality
display mode in the Perspective View. All objects
are shaded with smoothing and light sources are
evaluated for the shading.

The redraw rate is affected most by the
processor speed and graphics card speed. If the
display becomes too slow, try reducing the view
size.

Quick Shading

Quick shading is almost identical to Gouraud
shading (see above). The only difference is that
the auto light (see page 416) is used to calculate
the shading values - all lights in the scene itself
are ignored. This can lead to a faster redraw
rate, since only a single light source (the auto
light) is evaluated.

Wireframe

If this mode is selected, objects are displayed as
lines. This can be particularly effective for an
overview of complex scenes, especially when
used with backface culling (see page 22). This
mode is drawn very quickly.



Isoparms

This mode displays isoparm lines for those
objects which make use of them (e.g.
HyperNURBS objects). Other objects, such as
polygon objects, will be displayed in wireframe.

The isoparm display mode is very fast and is
particularly suited to complex scenes.

Shaded Box

This mode displays each object as a shaded box.
Each box has the same dimensions as the object
it represents. This mode is drawn very quickly,
even with complex scenes. It can be useful for
characters or for navigation in large scenes.
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Box

This mode displays each object as a wireframe
box. Each wireframe box has the same
dimensions as the object it represents. This
mode is exceptionally fast, making it suitable for
the most demanding scenes.

Skeleton

This is the fastest display mode of all, but it is
only suited to hierarchical structures. Each object
origin is shown as a small dot and these dots are
connected with lines according to the hierarchy.
This mode is particularly useful for characters,
not only for its speed, but also because it
removes all non-critical lines to expose the all-
important skeleton.
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Use Shading Property

If this option is activated, objects will use the
display mode defined in their display tags
instead of the general display setting. Objects
that do not have a display tag will continue to
use the general setting.

Backface Culling

If you activate backface culling, backfaces are
not drawn in the editor. This can speed up the
display as well as hide concealed surfaces.

A backface is a surface which points away from
the camera. BodyPaint 3D can tell in which
direction a surface points by examining its
surface normal.

If the surface normal points towards the camera,
the surface is a frontface. If the surface normal
points away from the camera, the surface is a
backface and is not drawn if this option is
activated. The following picture demonstrates
the backface principle:

By convention, the normals should point
outwards from their surfaces. If your object has
normals that point inwards on the object,
display errors may arise. In this case, reverse the
normals (see Structure Manager, page 389).

A

The following picture shows how backface
culling hides concealed surfaces (backfaces). The
object on the left does not use backface culling,
the object on the right does.




Textures

BodyPaint 3D's realtime texture mapping
(RTTM) enables you to see textures in the
Perspective View in realtime - even without an
OpenGL card! To activate RTTM mode for a
particular view, select the Textures option from
its Display menu. The textures will only be
visible with Gouraud shading or quick shading.

RTTM can display the following material
properties:

- Color textures
- Highlights

- Bump map

- Alpha channel
- Transparency

You can use a display tag in the Object manager
to activate or deactivate RTTM for each object
(File > New Tag > Display Tag).
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Activating and deactivating RTTM

RTTM is an approximation of the rendered
result. RTTM may, under circumstances, differ
substantially from the final result, especially for
large surfaces which extend towards the
horizon.
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X-Ray

To activate the X-ray mode, select this function.
If the active object is a polygon object, it will
become semi-transparent so that you can see its
concealed points and edges.

It enables you to see concealed surfaces in the
Gouraud shading and quick shading modes.

T oD
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View
Each view panel can have up to four views. Each
of these views may have its own:

- camera
- projection type
- display mode

View arrangement

You can choose a single-view mode or all-views
mode. The arrangements on offer are:

Single-View

2 Views Stacked

2 Views Side by Side
3 Views Top Split

3 Views Bottom Split
3 Views Left Split

3 Views Right Split
4 Views

4 Views Top Split

4 Views Bottom Split
4 Views Left Split

4 Views Right Split

4 Views Stacked

4 Views Side by Side

Each view may have its own camera, projection
type and display mode.

Note

These settings are saved automatically when you
save the document.

Toggle Active View

This option toggles between the single-view
mode and the all-views mode. When toggling
from all-views to single-view, select the option
from the target view (the view that you wish to
see next).

View 1 - View 4/All Views

Here you can switch between the single-views
and the all-view mode.

You can change each view's projection type via
its Cameras menu. The default projections are:

View 1 F1 perspective
View 2 F2 top

View 3 F3 right

View 4 F4 front

All Views  F5 all views
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3 Configuration

We have taken great care during the entire
development stage to ensure that BodyPaint 3D
is easy to use despite its wealth of features.

You may configure many aspects of

BodyPaint 3D. The downside of this flexibility is
that there are, consequently, many settings.
However, the settings are not bundled together
in a giant, unfathomable settings dialog.
Instead, we have placed the options where they
most make sense. Not only does this hide their
sheer number from you, they are also easier to
find as a result.

This chapter provides you with an overview of
the settings. There is also a detailed description
for each setting or a reference to another
chapter (some settings are best explained in
other chapters, e.g. the render settings are
documented in the Render Menu chapter).

Overview

The Configuration Dialogs

BodyPaint 3D's configuration dialogs are listed
below. In each case we tell you where you can
find the dialog and what, in general terms, the
dialog controls.

General Settings

These are global settings that apply to the
program as a whole. For example, you can use
these settings to change the colors used in the
Perspective View. The settings apply to all open
documents.
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The general settings can be accessed from the
Edit menu of the main window. They will be
saved when you quit BodyPaint 3D.

The general settings are described in detail later
in this chapter. See page 40.

Viewport Settings

These are local settings that configure the
viewport for the active scene. For example, you
can use these settings to determine the shading
mode for active objects and inactive objects.

The viewport settings can be accessed from the
Edit menu of each viewport (select Configure).
They are saved when you save the scene.

The viewport settings are described under
Configure.

Render Settings

These are local settings that affect the output of
the active scene. For example, you can use
these settings to switch shadows on or off.

The render settings can be accessed from the
Render menu of the main window. They are
saved when you save the scene.

These settings are described in detail in Render
Settings, page 404.

Import/Export Settings

These are global settings that affect the
importing and exporting of files. For example,
you can use these settings to scale objects that
are imported in 3DS format.

The import/export settings can be accessed
from the File menu of the main window. They
are saved when you quit BodyPaint 3D.
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The import/export settings are described in
detail on page 292.

Browser Settings

These are global settings that relate to the
display of thumbnails in the Browser. For
example, you can use these settings to
determine which file formats are shown.

The Browser settings can be accessed from the
Edit menu of the Browser. They are saved when
you save the scene. However, you can prevent
the Browser from loading the settings by
deactivating the Load Manager Settings option
in the general settings.

The browser settings are described in detail on
page 57.

The Configuration Managers

Command Manager

You can use this manager to edit the existing
palettes, create your own palettes or define new
short-cuts.

You can access the Command manager from the
Window menu of the main window. The
settings are saved when you quit BodyPaint 3D.

The Command manager is described in detail
later in this chapter. See page 36

Note

The short-cuts will be saved when you quit
BodyPaint 3D.

Menu Manager

You can use this manager to create your own
menu structure for each manager.

You can access the Menu manager from the
Window menu of the main window. The
settings are saved when you click on the Save
All Changes button in the Menu manager
dialog. They are also saved when you quit
BodyPaint 3D.

The Menu manager is described in detail later in
this chapter. See page 38.

Other Settings

There are many settings in addition to those
mentioned above. For example, you can change
the size of the preview in the Material manager.

These settings are always saved in the scene file.
However, you can prevent them from being
loaded into the managers by deselecting the
Load Manager Settings option in the general
settings.

Each setting is described in detail in the chapter
for the corresponding manager.

Graphical User Interface

The Main Window

The main window in where the managers and
command palettes meet each other. If the size
of the main window or a docked window is
changed, all the other windows in the group
adapt to the change. The main window is simply
a group of windows and palettes. You can
create your own group to suit your needs (see
Undocking below).

Changing The Size Of Windows

To change the width or height of a window, first
move the mouse to a window border. The
mouse pointer will change into a double arrow



to indicate the direction (either vertical or
horizontal) in which you can drag the border.
Drag the window as required. The other
windows in the group will adapt to the change.

Before moving the edge of the window

After moving the edge of the window

Changing The Window Order

To change the window order, drag the pin icon
using the mouse. A dark line will appear to
indicate the point at which insertion will take
place.

The following pictures illustrate just a few of the
layouts that are possible.
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This layout would be useful if you regularly need to find
brushes quickly.

With a layout like this you can view a wider selection of colors
at once.
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A typical layout for using reference material, a scan of a
photograph for example, to recreate it in BodyPaint 3D.
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Why not move icon palettes close to where they will be used.

Note

You can load a previously saved layout or revert
to the default layout at any time. See Working
With Layouts, page 55.

Undocking

You can undock a window to separate it from a
group. To do this, click on the pin icon and
select Undock from the menu. The window is
removed from the group and becomes a
separate window.
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Undocked window

Note

You can insert a window or a command palette
into an undocked window to create a new
group. This is particularly useful if you are using
more than one monitor.

Undocked windows are fully functional,
although you do lose the advantage of
automatic justification.

Docking

You can dock a new window (new windows are
undocked by default) into a group at any time.
To do this, click on the pin for the new window
and drag it to the required position in the
docking window. A dark line will indicate the
insertion position.

Try adding a second Perspective View for
practice: Select Window > New View Panel in
the main window. Drag the pin for the new
window and drop it wherever you like, e.g.



between the Object manager and the
Coordinate manager (check that you can see the
dark line before you release the mouse). You
can remove the window by undocking it and
then closing it (click on the pin to select the
Undock and Close commands).

New view, still undocked

Here the new view is docked

Rename

This function in the pin's menu allows you to
rename the window or command palette. The
name of a command palette is visible in the
interface only when it is defined as a tab.
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Tabs
Creating Tabs

You can display a window or command palette
as a tab. To create the tab, click on the pin icon
and select Make Tab.

Grouping Tabs

You can remove a tab from one group and insert
it into another group (the target group). To do
this, drag the tab’s pin and drop in on to a tab
or pin in the target group. The mouse pointer
will change into a hand to indicate when the
insertion is possible.
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ﬁh [dit WYiew [Hage

If you drop the tab on to a pin, it will be
inserted after the tab that the pin belongs to. If
you drop the tab on to a tab, it will be inserted
before it provided that the hand icon is released
on the left half of the tab; otherwise, it will be
inserted after the tab.

Do not forget about the command palettes —
they make great tabs too!
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If you drop a pin on to another pin (the target),
both will become tabs, even if the target was not
a tab.
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Converting Tabs into Windows

You can convert a window defined as a tab into
a freestanding window. To do this, drag the
tab's pin slightly to the left and release the
mouse button.
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Here the Object Manager gets undocked
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The undocked Object Manager

Command Palettes

A command, or icon, palette can contain any
command that can be selected from a menu.
The command palette can show the commands
as icons, text or as both icons and text.

Command palettes help you reach important
commands quickly. You can edit the default
palettes and create completely new palettes.
You can dock new palettes into the layout.

Note

An undocked palette is a window in its own
right. For example, it can contain several
command palettes and windows. This is
particularly useful if you are using more than
one monitor.

Creating a New Command Palette

To create a new (empty) command palette,
either:

- select Window > Layout > New Icon Palette
(main window)

- click on any pin icon and select New Icon
Palette from the pin's menu

- click the right mouse button within an existing
command palette (e.g. the default palette to
the left of the main window) and select New
Icon Palette from the context menu

=] 5]

New command palette, still empty

There are two ways to add commands to the
command palette. You can either drag-and-drop
commands from an existing palette (e.g. the
default palette to the left of the main window)
or you can drag-and-drop commands from the
Command manager (choose Window >
Command Manager).

You must activate the Edit Palettes option in the
Command manager before you can add
commands. Once the Edit Palettes option is
selected, drop the first command on to the



empty palette box of the new command palette.

When you drag-and-drop further commands on
to the palette, a dark line will appear to
demonstrate where the command will be
inserted. To open the context menu for the
command palette, position the mouse pointer
on an icon and click the right mouse button.

The Command manager is described in detail
later in this chapter.
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This is the way a command is added to the new palette

Changing the Sequence

To move a command to a different location in
the palette, drag-and-drop the command to the
new position (a dark line will indicate the
insertion position).

Icons / Text

You can reach these two settings via the
command palette’s context menu (position the
mouse pointer over a command and click the
right mouse button).

If the Icons option is selected, icons will be
shown for the commands. If the Text option is
selected, text will be shown for the commands.
If both options are selected, icons and text are
shown for the commands.
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Different combinations of command palettes

Vertical

You can reach this setting via the command
palette’s context menu (position the mouse
pointer over a command and click the right
mouse button).
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If this setting is activated, text will be displayed
below each icon instead of to the right
(provided that Icons and Text are also
activated).

Command Alignment (Horizontal vs Vertical)

You can reach this setting via the command
palette’s context menu (position the mouse
pointer over a command and click the right
mouse button).

Select Transpose to toggle the alignment of the
commands between vertical and horizontal
alignment.
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Rows / Columns

You can reach this setting via the command
palette’'s context menu (position the mouse
pointer over a command and click the right
mouse button).

The value you set here defines the number of
rows or columns for commands. Think of this as
the number of lines. For example, if you have
20 commands, setting this value to 2 will create
2 lines with 10 commands in each line. A value
of 3 would create three lines (this time with 7
commands in the first two lines and 6
commands in the final line).

If you are using vertical command alignment,
this setting refers to the number of columns. If
you are using horizontal command alignment,
this setting refers to the number of rows.
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Alignment in rows or columns

Icon Size

You can reach this setting via the command
palette’s context menu (position the mouse
pointer over a command and click the right
mouse button).

You can use this setting to change the size of
the command icons. The sizes you can choose
from are:

Large 32 by 32 pixels
Medium 24 by 24 pixels
Small 16 by 16 pixels
Original  original icon size (see below)

The original icon sizes are defined in the icon
resource file. The original sizes usually
correspond to Large icons.
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The different icon sizes

Note

If an icon is displayed at a different pixel size to
its original size, it must be resampled. This may
lead to a visible loss in picture quality.

Creating Folded Palettes

You can group commands to form a folded
palette. To do this, ensure that the Edit Palettes
option is active, then position the mouse pointer
over a command and click the right mouse
button to open the context menu. Choose Fold
Palette.

Now, only one command is visible. This is called
the visible command. The little arrow towards
the bottom right of the icon indicates that it
contains a folded menu.

Next, deactivate the Edit Palettes option. Click
and hold down the left mouse button on the
visible command. The folded palette appears.
You can either release the mouse button and
then click on the required hidden command, or
you can move the mouse pointer over the
required command before you release the
mouse button. Note that the visible command is
also a hidden command.

If the Lock Icon command of the context menu
is not selected, the visible icon will always be the
last command that you selected. Hence, you can



repeat the last command simply by clicking on
the visible icon. You do not have to unfold the
palette to reach it.

V74T

The order of the commands in the folded palette
corresponds to their order before they were
folded. You should arrange the commands

before you fold them.
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You can drag-and-drop a visible command on to
another palette. This enables you to use several
folded groups within the same palette. To create
a palette with several folded command groups:
Create two empty command palettes. Use the
first palette to create a folded command group,
then drag-and-drop the folded commands

(i.e. the visible command) on to the second
palette. Next, create the second folded group in
the first palette, then drag-and-drop it on to the
second palette, and so on. Once the process is
complete, close the redundant palette.

BN Ve P

You can also use text-only display with folded
palettes.
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Unfolding icons

You can unfold a folded group of commands
into a palette of individual commands. To do
this, select Unfold from the context menu (click
the right mouse button on the visible
command).

This command can be selected only when the
Edit Palettes option is active.

Lock Icon

If this command of the context menu is not
activated, the visible command for a folded
group of commands will always be the last
command that you selected.

If this command is activated, the current visible
icon will be locked, meaning that no matter
which tools you go on to use from the folded
palette the visible command remains the same.

This command can be selected only when the
Edit Palettes option is active.
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Delete Command

You can delete a command from the palette. To
do this, move the mouse pointer over the
command that you wish to delete, then hold
down the right mouse button and select Delete
Command from the context menu.

This command can be selected only when the
Edit Palettes option is active.

Edit Palettes

You must activate the Edit Palettes command
before you can make changes to palettes. You
can reach this setting via the context menu
(right mouse button over a command).

Note

The palettes will be saved automatically when

you save the layout. To save the layout, choose
Save Layout As or Save as Default Layout from
the Window > Layout menu (main window).

The Command Manager

The Command manager contains lists of all the
commands in BodyPaint 3D. You can use this
manager to drag-and-drop commands in order
to create your own command palettes or
submenus (see The Menu Manager, page 38).
You can also use the Command manager to
define short-cuts.

Inserting Commands in Palettes

First, select the Edit Palettes option. Next, drag-
and-drop commands on to the palette. A dark
line will indicate where a command will be
inserted.

You can also drag-and-drop separators on to
palettes to visually separate commands into
logical groups. Separator 1 is a line, Separator 2

is a space. Simply drag-and-drop these
separators on to the palette. Again, a dark line
will appear to indicate the insertion point.
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This is how you add separators to the new command palette

You can use the pop-up menu to the right of
the pin to select which command category is
displayed in the list. Each category refers to a
particular menu or manager.

You will notice that some commands do not
have icons. This is because these commands
were difficult to represent as icons and we did
not wish to cause undue stress to Joern, the icon
designer.

Allocating Short-cuts

You can allocate a short-cut to any command so
that you can press a simple key sequence to call
the command rather than select it via a menu or
palette.

For example, if you press Ctrl-B, the render
settings dialog will open. You use the Command
manager to allocate the short-cuts. You can also
use the Command manager to define a second
short-cut for the same command.



This can be useful when two keys are logical
alternatives for a particular command. For
example, the delete and backspace keys are
both short-cuts for the Delete command. The
second short-cut is also useful for standard
commands which have different short-cuts
under Windows and Mac OS.
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To create a short-cut:

Select the command from the list in the
Command manager by clicking on it with the
left mouse button.

Next, click on the first text box to the right of
Assign:. Press the key combination that you
wish to assign to the command.

Click on the green tick to the right of the text
box to activate it. The short-cut will appear in
the Current: box. To remove the short-cut, click
on the red cross icon.

Valid short-cuts are:

- asingle key

- akey + Ctrl

- a key + Shift

- a key + Ctrl and Shift
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Note

Some keys are reserved and cannot be allocated
as short-cuts (e.g. left arrow, right arrow).

BodyPaint 3D’s hotkeys are extremely useful.
For example, if you hold down the 1 key you
can move the camera, no matter which tool is
active. The hotkeys come at a price - you
cannot use them with short-cuts, even if you
combine them with Ctrl and/or Shift.

If a short-cut has already been allocated, the
command that uses the short-cut will be
displayed below the text boxes. You should
remove the short-cut before reallocating it (to
remove the short-cut, select the command that
it is currently allocated too, then click on the red
cross icon).

It is not possible to predict the effect of pressing
a short-cut that is applied to more than one
command.

Note
The short-cuts are saved in the layout.

Warning!

Do not attempt to allocate short-cuts that are
used by OS commands, e.g. Ctrl-Alt-Del
(Windows).
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The Menu Manager

You can use the Menu manager to edit
submenus and pop-up menus. You can also
create your own submenus.

The menus in the manager and how they look in the program

The Menu manager and the Command manager

allow you to configure your very own
BodyPaint 3D interface, fine-tuned to the way
you like to work.

The Menus

BodyPaint 3D has more than 25 menus and
pop-up menus. Use the pop-up menu at the top
of the manager to determine which menu is
shown in the list.

Submenus are prefixed with Submenu. To open
or close a submenu, double-click on it.

Inserting Commands

The Command manager contains lists of all the
BodyPaint 3D commands. You can drag-and-
drop commands from the Command manager
into the Menu manager.

The mouse pointer will change form to indicate
the insertion mode.

Copy, Delete/Cut, Paste

You can use these commands to copy, delete or
paste the selected command.

Move Up, Move Down

You can use these commands to move the
selected menu entry one position up or one
position down the list.

New Submenu

This will insert a new submenu above the
selected entry. You can add commands or even
further submenus to the submenu.

Rename

You can use this command to rename a
submenu that you created.



You cannot rename the standard menus and
commands.

Apply

The changes will be applied. You can test them
immediately.

Save All Changes

All menu changes will be saved.

Revert to Saved

Discards all settings and reverts to the last menu
definition that was saved.

Revert to Original

Reactivates the standard menu settings, which
are permanently stored in the program (factory
settings).

The Pin Menu

Each manager has a pin icon towards its top left
corner.

*

Earlier in this chapter we explained how the pin
is used to combine and arrange managers (see
Graphical User Interface, page 28). The pin also
has a menu, the functions of which are
described below.

Undock

This function removes the current manager from
the main window. The manager will be
displayed in its own window.

CHAPTER 3 * CONFIGURATION » 39

Undock a tab to open a manager in a floating window

Rename

You can use this function to rename a window
or a tab.
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Make Tab

This function creates a tab for the active
window/active manager.
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New Icon Palette

This function creates an empty command
palette. You can use the Command manager
(see above) to add commands to the palette.

Close

This function closes the manager. To open the
manager again, select it from the Window menu
of the main window.

General Settings

These settings enable you to change the editor's
appearance as well as influence the operation of
functions. You can access this dialog from the
Edit menu of the main window.
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High Thread Priority

If you enable this option the system assigns a
higher priority, i.e. more computing time, to
BodyPaint 3D than to other running
applications. If this option is enabled
applications other than BodyPaint 3D which are
running will execute more slowly than usual. So
if you want to work in other applications while
rendering in BodyPaint 3D, you may find it
useful to disable this option.

Graphics Tablet

If you experience problems when using a
graphics tablet with BodyPaint 3D, activate this
option.

Use HPB System

If you select this option, the HPB system will be
used for object rotation. Note that the heading,
pitch and bank values refer to the object's
parent system.

If the option is not selected, object rotation will
take place about its local axes or the world axes.

For further details, please see World System,
page 370.
Link Manager Selection

Only relevant if you are running BodyPaint 3D
with CINEMA 4D XL. Please consult your
CINEMA 4D reference manual for details.

Display Units

Values are displayed together with their unit of
measurement by default.

If this option if deactivated, the unit of
measurement will not be displayed.



Center New Objects in View

BodyPaint 3D creates all new objects at the
origin of the world coordinate system by
default. If the origin is not visible in the view, a
newly created object may be out of sight.

If this option is activated, new objects will
appear in the centre of the active view.

Use QuickTime

If you enable this option BodyPaint 3D uses
QuickTime, if it is installed on your computer. A
wider range of file formats is then available; you
will have access to more textures.

If this option is disabled the speed of the
Browser is increased slightly as it has to check
fewer file formats.

Note

QuickTime can crash if you used damaged image
files; this is not the fault of BodyPaint 3D, and it
is for this reason that you can disable QuickTime
through this option.

Save RTTM Textures

If you have activated realtime texture mapping
(RTTM), small editor textures will be created so
that you can see textures in the editor.

These editor textures take a while to create and
they must be created each time you load the
scene.

However, if Save RTTM Textures is activated,
the editor textures will be saved in the scene
file. This speeds up the loading process, but the
file size will increase as a result.

Save Particles

Only relevant if you are running BodyPaint 3D
with CINEMA 4D XL. Please consult your
CINEMA 4D reference manual for details.
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Load Manager Settings

We mentioned in the Other Settings section of
the overview that each manager also contains
settings that are not represented in the settings
dialog (e.g. the size of preview icons).

You have the option either to load these settings
when you load the scene or to use the current
settings. If the option is activated, the settings
that were last used in the saved scene will be
activated in the corresponding managers.

Note

These settings are always saved in the scene file.
Whether or not you use them is another matter.

Render Materials on Loading

When you save a scene, the material preview
pictures are saved as well. When a scene is
loaded, these pictures will be used and
displayed. However, if you load a foreign 3D
data format, only the base colors of the
materials will be shown.

If this option is activated, BodyPaint 3D will
create new preview pictures each time a scene is
loaded. By necessity, this will slightly slow down
the loading process.

Generate Backup Copies

When you save a scene with a filename that
already exists in the destination folder, the
original scene will be overwritten by default.

If this option is activated, BodyPaint 3D will
rename the original file before the new file is
created. The original file is appended with
‘.bak’. For example, ‘Design.c4d’ will become
‘Design.bak’. If ‘Design.bak’ already exists, it
will be overwritten.
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Save Layout at Program End

If this option is activated, the current layout will
be saved when you quit BodyPaint 3D. When
you next start the program, the layout will be in
the same state that you left it in.

This may possibly lead to unwelcome effects.

For example, perhaps your usual layout has the
Perspective View and the Texture View side by
side and of equal size. You decide to create a
new layout with a larger Perspective View. You
save the new layout under its own name and
quit the program. If this option is activated, the
new layout will overwrite your usual layout.

Note

Always save a new layout using a unique name,
even if you intend for it to be your normal
layout. To save the layout, choose Window >
Layout > Save Layout As.

Undo Depth

You can use this value to determine the
maximum number of editing steps that can be
undone consecutively. (See Undo/Redo,

page 303 for further details.)

Recent File List

You can use this value to determine the number
of recent files that are listed in the File menu
(see page 289).

Redraw Limit ... Milliseconds

Sometimes it is not possible to move an object
smoothly in the editor with full shading due to
hardware limitations such as processor speed.

BodyPaint 3D uses an ingenious system that
estimates the time required for a redraw. If the
estimated time exceeds the redraw limit
specified here, a faster display mode will be

used automatically. For example, Quick Shading
will be reduced to Wireframe. If the wireframe
mode is still to slow, Box will be used instead.

This process enables you to work smoothly in
the Perspective View. You can configure the
threshold value to suit your needs. The default
value of 600 milliseconds means that a
minimum of three pictures per second will be
drawn.

If you do not want a faster display mode to be
used, set the redraw limit to a very high value
(e.g. 10000 milliseconds).

Editor : Pixel

These values specify the ratio of a pixel's on-
screen width to its on-screen height. The pixel
ratio for most monitors is 1:1.

However, some display media use a pixel ratio
other than 1:1. This will lead to distortion unless
the pixel ratio is adjusted accordingly. For
example, circles will appear to be ellipses.

If you need to calculate the pixel ratio manually,
expand the Perspective View so that it fills the
entire screen. Select the side view and import a
cube. Measure the width and height of the cube
with a ruler and enter values in the
corresponding boxes.

Basic Units

Here you determine the basic unit of
measurement in BodyPaint 3D. You can choose
from pixels, kilometres, metres, centimetres,
millimetres, micrometres, nanometres, miles,
yards, feet and inches.

For example, if you select Centimetre as the
basic units, all position values will be stated in
cm. Note that if you change units the numerical
values will not be converted.



However, you can enter values in different units.

For example, if the basic units are cm and you
type ‘5 km' into a dialog, the value will be
converted to 500000 cm.

If you set the basic units to Pixel, the unit of
measurement will not be specified. It is then up
to you to decide how to interpret the values.

You can use the following abbreviations for
units when entering values:

Pixel no units specified
Kilometres km
Metres m
Centimetres cm
Millimetres mm
Micrometres um
Nanometres nm
Miles mi
Yards yd
Feet ft
Inches in

Animation Units

Only relevant if you are running BodyPaint 3D
with CINEMA 4D XL. Please consult your
CINEMA 4D reference manual for details.

Color System

You can choose between the RGB model and
the HSV model. You can also choose whether
the values should be specified as a percentage,
or in steps ranging from O to 255, or in steps
ranging from O to 65535.

A good choice of colors is essential for
consistent photorealistic results. Photorealism is
often a yardstick for programs such as
BodyPaint 3D.
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Sensitivity
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The human eye can see several hundred
thousand colors in the spectral range between
400 nm (blue) and 700 nm (red). This color
sensitivity is the result of many thousands of
receptors on the retina. Not all of these are
equally sensitive, and not all are sensitive to the
same range of wavelengths.

Some of the receptors are particularly sensitive
within the blue range, around 440 nm; others
are far more sensitive in other ranges, while yet
others are particularly receptive in the green
range, around 540 or 580 nm.

The eye therefore has three different types of
receptors for the primary colors red, green and
blue. The spectral sensitivity and overlapping of
the sensitive ranges make characterisation of
colors extremely difficult.

The color which the human eye perceives as
white does not contain equal parts of red, green
and blue light—this would be called
chromatic—but must, in accordance with the
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overlapping sensitivity ranges, be made up of
varying proportions of these colors. Only then
does the eye see white. This is what we call
achromatic light.

Typical output devices for color are printers,
imagesetters and computer screens. The first
two use the subtractive method of color mixing
(CMY) and will not be part of our discussion
here. Most important for BodyPaint 3D is the
additive method of color mixing, which is the
one used for representing colors on monitors.
BodyPaint 3D characterises all colors by using
three numerical values.

Two different color models are used, which you
can easily toggle between. Probably the best
known model is RGB, which is used by most
graphics applications because it is best suited to
the hardware components for image and color
output. The most commonly used output device
is the computer screen, which has a grid
consisting of fine dots, made up from a red, a
green and a blue point. These points can be
addressed by an electron beam. By aiming the
beam at not just one color dot, but for example
the red and the green, the added color value is
yellow.

The color pigments for the screen dots have
been selected in such a way that when equal
parts are added they result in a white which
comes closest to what the human eye perceives
as a pure white.

By beaming different intensities at the three dots
it is possible not only to generate the eight basic
colors (black, red, green, yellow, blue, magenta,
cyan and white) which are the result of mixing
the three primary colors, but many, many mixed
colors.
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The number of colors possible is determined by
the number of gradations in the intensity of the
electron beam.

Using four gradations per primary color results
in 4 x 4 x 4 = 64 colors. The standard is 256
gradations per primary color, which gives 256 x
256 x 256 = 16,777,216 colors.

These colors can be represented in a three-
dimensional coordinate system.
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The coordinate axes are formed by the three
primary colors. Black is at the origin. Mixed
colors between red and green form the base
plane. Moving upward, more and more blue
gets mixed in, until white is reached at the front
corner of the cube. All white shades lie on the
line connecting the origin with this corner.



Less technical, and therefore better suited for
painters and artists, is the HSV model. H is the
hue, S the saturation, V the color value. The
illustration below shows what these mean.
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The six basic colors (red, yellow, green, cyan,
blue, magenta) form a hexagon around the
color white, together with black. The hue is the
angle: starting with 0° for red, through 180° for
cyan, to 270° for magenta. The saturation (S) is
always measured radially towards the outside.
On the inside, along the black/white axes, it has
the value 0.0, outside, at the edge of the
hexagon, itis 1.0. The greater the saturation,
the more intensive the hue.

The value (V) is measured in the direction of the
black/white axis. At the height of white it has
the value 1.0; going downwards it decreases
until it reaches the value 0.0 for black. The color
value is used for darkening the hue.

Let's summarise this:

- Pure color pigments sit at the edge of the
hexagon:V=1.0and S=1.0.

- To add white, reduce the saturation.

- To add black, decrease the color value.
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Refresh Active View Only

BodyPaint 3D refreshes all views simultaneously
by default. If you are working with a complex
scene using a high level of shading (e.g.
Gouraud Shading with RTTM mode activated),
the Perspective View soon becomes sluggish.

If this option is activated, only the window in
which you carry out an action will be redrawn in
realtime. The other views will only be refreshed
once the action has been completed (e.g. when
you release the mouse button having dragged
an object to a new position).

Render Safe

If this option is activated, the boundaries of the
film format (see page 410) will be shown in the
editor window.



46 » CONFIGURATION ¢ CHAPTER 3

Note

You can set this option separately for each view
via the viewport settings (see Configure,
page 14), which apply to the active view only.

Action Safe

Only relevant if you are running BodyPaint 3D
with CINEMA 4D XL. Please consult your
CINEMA 4D reference manual for details.

Title Safe

Only relevant if you are running BodyPaint 3D
with CINEMA 4D XL. Please consult your
CINEMA 4D reference manual for details.

Scale Axes
If this option is activated, an object's axes will be
scaled whenever you scale the object itself.

You may find, however, that relatively large or
relatively small axes make it difficult to perform
quick actions (move, scale, rotate) by dragging
on a particular axis.

If this option is deactivated, the object axes
retain their size when the object is scaled.

Semi-Transparent Axes

If this option is activated, the object axes will be
semi-transparent. You can enter the strength of
the transparency in the box to the right.

If this option is deactivated, the object axes will
be displayed at full brightness.
OpenGL

Use OpenGL

If the Use OpenGL option is activated,
BodyPaint 3D will use its built-in OpenGL
routines. You will be able to select further

options provided that they are supported by
your OpenGL implementation (see the
documentation for your card/software).

If this option is deactivated, OpenGL support is
turned off and BodyPaint 3D will use its internal
shading routines instead.

Note

OpenGL can be installed on your computer as
hardware or software. As a general rule,
software-only implementations are much slower
than their hardware counterparts.

Warning!
The OpenGL support has no effect on rendering
speed. It affects editor shading only.

Antialiased Lines

If this option is activated, lines will be smoothed
(antialiased) by the OpenGL implementation
provided that it supports this mode.

MIP Maps

If this option is activated, the OpenGL
implementation will use MIP maps for texturing
in the Perspective View. You can only use this
option if it is supported by your OpenGL
implementation.

For more details on MIP mapping, see
page 217.

Smart Window Refresh

When activated, this option accelerates window
refresh under OpenGL if, for example, you
move an undocked manager onto the
Perspective View. If the option is inactive,
OpenGL must refresh the entire screen each
time.



Note

This function is not supported by all OpenGL
cards. If display errors appear with the option
active, your card does not support Smart
Window Refresh.

Smart Live Selection

When this option is activated, the live selection
under OpenGL is accelerated. Only the selected
polygons or points are redrawn (as opposed to

the entire screen).

Note

This function is not supported by all OpenGL
cards. If display errors appear with the option
active, your card does not support Smart Live
Selection.

A Few Words on Acceleration

Many of us know that 3D computer games can
be enhanced dramatically by using a 3D
accelerator card. With this knowledge in mind,
many users anticipate massive gains with
professional software too. The reality is
somewhat slower and the user is disappointed
more often than not.

Simple graphics cards soon fall by the wayside
because they do not have enough graphics
memory to display complex objects in a
reasonably large editor window. A screen that is
1000 by 1000 pixels in size with 24-bit color
requires about 4MB of memory. Double this
figure to allow for screen buffering. If you also
take the depth buffer into account, the memory
required is about 1T0MB. If insufficient graphics
memory is available, the screen size must be
reduced. (Our calculation doesn't even take
editor textures into account!)

Even if your card has sufficient memory, there
are other factors to consider:
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3D objects are drawn on the screen as filled
triangles. There are two main stages involved.
First, BodyPaint 3D must calculate the triangles.
Next, the triangles must be drawn. If no 3D
accelerator card is present, BodyPaint 3D will
draw the triangles itself using the CPU. The ratio
of the time required to calculate the triangles to
the time required to draw the triangles is about
1:1. Even if a 3D graphics card takes over the
second stage (drawing the triangles),

BodyPaint 3D must still use the CPU to first
calculate the triangles.

For example, if a graphics card can draw
triangles five times more quickly than
BodyPaint 3D, the overall increase in shading
speed is only 40%, not the 500% that you may
have hoped for.

The assumed ratio of 1:1 depends on other
factors:

1. Window size

If you increase the size of the editor window,
the time required by the 3D card barely
increases (provided that the card has sufficient
memory). The CPU, on the other hand, is
slowed down to a far greater degree. For
example, increasing the window size from 640
by 480 to 1280 by 960 will triple the time
required by the CPU. As a result, the total
shading time is doubled (3:1 instead of 1:1).

2. Number of polygons to be drawn

If a scene contains many polygons in a small
area, BodyPaint 3D can often draw them more
quickly than the 3D card.

The Role Of The CPU

If you are not using a 3D graphics card, the
display speed increases linearly with CPU speed.
If you double the CPU speed, the display speed
doubles as well.
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If you double the CPU speed when a 3D card is
already in use, the CPU accelerates the
calculation of the triangles, but not the drawing
of them. In this case, the display speed increases
by a factor of 1.5 — the faster the CPU, the less
difference (as a percentage) a 3D graphics card
makes.

BodyPaint 3D and Other Programs

Some other 3D programs experience a more
noticeable acceleration with 3D cards. The
reason for this is quite simple. Such programs
are naturally slow, whereas BodyPaint 3D is
already highly optimised for speed.

BodyPaint 3D is exceptionally fast, even before
you activate OpenGL.

Just because a 3D graphics card is used for
shading, this does not mean that shading will be
equally fast in all programs. The triangles must
still be calculated by the program itself, and this
is where BodyPaint 3D excels. The result is that,
even though the same 3D card is used,
BodyPaint 3D has faster shading than many
other 3D programs.

The concept that makes this possible is adaptive
shading (aka adaptive blitting). This means that
BodyPaint 3D will only redraw those parts of the
screen that have actually changed. OpenGL, on
the other hand, does a complete redraw every
time. The result is that BodyPaint 3D sometimes
out-performs 3D cards. We told you that
BodyPaint 3D is exceptionally fast!

Outlook

Until OpenGL is expanded to include adaptive
technology, a faster processor is probably more
effective than a 3D card.

A Word of Caution

Our testers have noticed that some 3D cards

switch off their OpenGL support beyond certain
resolutions and color depths. Some cards only
support OpenGL up to 1024 by 768 pixels and
24-bits. Some even give up on OpenGL beyond
800 by 600 and 65535 colors. Perhaps the most
alarming aspect is that in all cases the OpenGL
was deactivated silently, leaving the user in the
dark.

A Second Word of Caution

Acceleration is not always supported on multi-
monitor systems (particularly under

Windows 9x). Be sure to ask about any such
OpenGL limitations before purchasing a multi-
monitor system.

Textures

Perspective Correction

If this option is activated, the OpenGL
implementation will correct the perspective of
editor textures. This will enhance the quality of
the display, although it can also slow down
shading. You can only use this option if it is
supported by your OpenGL implementation.

Use Textures

This option defines whether textures are
displayed when the Gouraud Shading mode is
activated. This setting is applied globally, i.e. it
affects all views.

You can define this option separately for each
view via the viewport settings (see Configure,
page 14), which apply to the active view only.

Note

You can work more smoothly in the Perspective
View if you deactivate this option.



Color

Here you can define the colors used in the
editor. Select the element that you wish to
change from the pop-up box and change its

color using the sliders or the system color dialog.

You will see either three color sliders or a color
table depending on the Color System setting on
the General page. The default setting is the RGB
model with values specified as percentages.

The resultant color is shown to the left of the
sliders. If you click on this color box, the system
color dialog will open.

If you click on the little triangle just below the
color box, a hidden menu appears. You can use
this menu to change the color model or switch
over to the color table. This setting will be
retained for as long as the dialog is open. As
soon as you close the dialog, the setting on the
general page will be used.
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This tab allows you control over the look-and-
feel of BodyPaint 3D’s user interface.

Language

Here you can select a language for

BodyPaint 3D's interface from the installed
language sets. After quitting and re-launching
BodyPaint 3D, all messages, menus and dialogs
will change to use the new language.

Scheme

From this pop-up menu you can choose one of
the installed schemes.

Reset to Factory Settings

Owing to the many ways that you can configure
BodyPaint 3D to your needs, it can easily
happen that you lose the plot! So if you click
this button all your changes are reset to the
original factory settings.

Dialogs (OK/Cancel Group)

Using the Style pop-up you can set the order of
the OK and Cancel buttons within dialogs.
Windows uses OK on the left and Cancel on the
right, while the reverse is true under Mac OS.
Choose whichever you feel comfortable with on
your platform.

Using Alignment you choose how these OK and
Cancel buttons are to be aligned in the dialogs;
aligned left, centred or aligned right.

Help Text

If the Help Text in Statusbar option is enabled, a
short explanation of the menu entries or icons
will be displayed in the status bar (at the bottom
of the screen) whenever you go to choose a
menu item or hover over an icon.
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If the Bubble Help option is enabled, some help
information appears near the mouse pointer
when you hover the mouse pointer over an
icon.

Menus

Here you choose whether, in addition to the
normal function descriptions for menu items,
BodyPaint 3D should also display icons (Show
Icons option enabled) and/or keyboard short-
cuts (Show Shortcuts option enabled).

Look&Feel

In this part of the dialog you can modify the
look-and-feel of the program interface to your
own taste.

Colors

First choose from the pop-up menu the interface
element you want to change. Then click in the
color selection box to the right and choose the
new color for this element from the system color
chooser that appears. Note that backgrounds of
windows, buttons, dialogs etc. can have
patterns assigned to them. Select the Use
Patterns box and then pick a pattern from the
pop-up below it.

Note

You can use your own backgrounds in
BodyPaint 3D. Just create a folder called
‘Pattern’ inside the BodyPaint 3D Resource
folder (if this doesn't already exist) and place
your own background image files in this
‘Pattern’ folder.

Fonts

Here you can choose the font BodyPaint 3D will
use for displaying text in menus and dialogs,
etc. Choose the font type from the pop-up

menu and then click on the F button to the
right. A dialog opens in which you can choose
the font and its size.

Clicking the R button will change back to your
active system font.

Note

The font changes will be effective only after you
quit and restart BodyPaint 3D.

Delays

If you are a Windows user you may have
noticed that windows and menus open quite
slowly on your desktop but rather faster in
BodyPaint 3D. Now, you can use the options
under Delays to simulate this delayed reaction
for various actions within BodyPaint 3D.

Choose the action from the pop-up menu. Then
set the delay for this action in the box to the
right.

Have some fun with this - it's not the most
serious or useful option in BodyPaint 3D!
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BodyPaint 3D searches for textures in the
following locations:

- in the same folder as the scene.

- in a folder named ‘'tex’ which is inside the
scene's folder.

- in a folder named ‘tex’ inside the BodyPaint 3D
folder.

If a texture cannot be found in any of these
folders, you can add the texture's folder to the
Texture Paths.

You can specify up to 10 Texture Paths and each
is searched recursively, i.e. folders within folders
will be searched too. If a texture still cannot be
located after searching all of the Texture Paths,
BodyPaint 3D will report an error.

You can type the path name directly into a text
box. Alternatively, click on a text box and guide
the dialog that opens to the folder in question.
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Once you have located the folder, click on Open
(Windows) or the box at the bottom of the
dialog that contains the name of the folder
(Mac OS). The path will be added to the text
box of the settings.

BodyPaint
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Max. Memory Usage

This is a number in megabytes (MB) that is used
as a cut off point when undoing actions. This
will take affect only if you have already
exceeded the minimum number of steps
specified in the At Least box.

At Least

You may wish to have a minimum number of
undo steps when painting your textures, if this is
the case then you can choose how many here. If
the minimum number of undo steps has not
been reached, but the Max. Memory Usage
value has been, then more memory will be used
until the minimum number of steps has been
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reached. Users who often find themselves
running low on memory may wish to set this
value to 1.

Note:

These undo options apply only to the textures.
They will make no difference when undoing
camera or object actions.

Default Texture Format

BodyPaint 3D is capable of working in layers,
and indeed we recommend you do so. Of
course you will want to be able to save your
projects with all of this layer information intact,
so you have several choices when saving.

BodyPaint *.b3d

This is BodyPaint's own custom file format (b3d)
which is recommended for most users. Using
this format will ensure all texture data is saved
and that compatibility is retained for future
versions.

Photoshop *.psd

Users of Adobe Photoshop may wish to use this
format when saving. This will allow you to load
your textures into Photoshop should you wish to
use its tools. You should note that only the first
layer mask will be saved and that several of the
BodyPaint 3D blending modes are not available
in Photoshop.

TIFF *.tif

Saving you texture as a TIFF will flatten the
image so that all layers are merged into one.
These cannot be restored. Only use the TIFF
format if you know that you no longer wish to
edit individual layers or if your painting program
does not support either of the above file
formats.

Macintosh
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This tab is available only under Mac OS.

Use Navigation Services

This option activates / deactivates the
Navigation Services under Mac OS 9.

Exchange CTRL <-> COMMAND key

BodyPaint 3D uses the Ctrl (control) key as the
default modifier key. The Command key is used
for simulating the right mouse button (hold it
down and click). If you would like it the other
way around, select this option.

Hide System Menu

If selected, the Mac's standard system menus
are hidden while BodyPaint 3D is running.



BODYPAINT 3D

PAINTING @ TEXTURING @ MAPPING

4. Workflow
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4 Workflow

Introduction

Technical computer terms, despite their
widespread usage, are slow to be recognised by
dictionaries and perhaps that is why they often
take on several meanings. Workflow is no
exception. We define workflow to mean the
performance of all the steps involved in
achieving a task. If you can improve your
workflow (i.e. go about things in a more
efficient way), you can work more quickly as a
result.

The purpose of this chapter is to raise your
awareness of workflow issues.

Here To Help

There are many features in BodyPaint 3D that
can help improve your workflow. We list just a
few of the features below:

- If you need to move, zoom or rotate a camera,
use the icons at the top right of the view (drag
the right mouse button on the icon you
require). The fourth, right-most icon toggles
the active view between single-view and all-
views (see Toggle Active View, page 24).

- Define short-cuts for the functions you use the
most. Also, create an icon palette and fill it
with the functions. In this way, you can reach
high-frequency functions more quickly.

- Many commands can be performed with a
quick drag-and-drop rather than a trek
through the menus. For example, to allocate a
material, drag it from the Material manager
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and drop it on to an object in the Object
manager or View window.

- What if the Object manager is not the active
tab (see page 31) when you drag-and-drop a
material from the Material manager? Simply
drag the material on to the Object manager's
tab. After a short delay, the Object manager
will become the active tab and you can drop
the material on to the required object.

- There is no need to lock axes in order to move,
scale or rotate an object in one direction only.
There is a small arrow, cube or sphere at the
end of each object axis (the exact form
depends on the active tool). Click on the
arrow/cube/sphere for the required axis and
drag. Note that you can use this method to
move/scale/rotate selected points and
polygons as well as objects!

- When you need to select several adjacent
points or polygons, do not click on them one
by one. Instead, use the Live Selection tool and
paint over the points/polygons to select them.

The text above covers only a few of the ways in
which you can improve your workflow. Be sure
to read the entire manual at the earliest
opportunity, since many other workflow tips are
described along the way.

Working With Layouts

BodyPaint 3D has a wealth of configuration
possibilities. For example, you can define your
own short-cuts, create your own layouts, set
your own defaults and configure the Browser for
a specific project.
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The allocation of short-cuts is described in detail
in Allocating Shortcuts, page 36. The Browser
and default values are described later in this
chapter. First, we consider working with layouts.

The golden rule for improving your workflow is
to do it in stages. Make little changes at a time,
then once they have become second nature,
make further changes. If you attempt too much
to soon, you may worsen your workflow. Begin
with just a few (e.g. five) short-cuts. Once these
short-cuts have become instinct, create and
learn to use a few more short-cuts.

What's the big deal about being able to create
your own layout?

Well, we admit that we are not omniscient - in
particular, we cannot know your preferred way
to work. For example, do you prefer icons or
text in the command palettes? Should the
Material manager be open or do you prefer a
larger Perspective View?

Of course, we could activate everything, but
this would help no-one. The sheer number of
windows, icons, menus, functions and options
would almost make your monitor sag. Anyone
new to 3D would run a mile. As for workflow...

What is far more important is that you and your
colleagues can create and use your very own
layout settings. You will not have to deal with
the seemingly bizarre changes a colleague has
made to the layout, and vice versa. Anyone who
has used a colleague's computer will know what
we're getting at. (“Which folder did she say the
word processor was in? | need to get home
some time tonight...").

Not only are layouts good for office harmony,
you can also create several layouts for your own
use. For example, you may find it useful to
create a layout biased towards painting in three

dimensions (large Perspective View) and another
layout biased towards editing UV mesh (large
Texture View).

Start by using the default layout. As time passes
by, keep track of which commands you use the
most.

Is your mouse getting too much exercise? Is it
constantly darting between a command on the
bottom left and a command on the top right of
your 21-inch, 1600x1200 res. monitor? If so,
alter the layout! Put the commands next to each
other, within easy reach.

Previously, we learnt how to use layouts. In the
following, we take a look at the functions for
layout management. You can reach all of these
functions from the main menu bar under
Window > Layout.

Load Layout

You can use this function to load a previously
saved layout. Use the system dialog that opens
to choose the layout file (with a '.14d"
extension).

Reset Layout

This function resets the layout to the factory
settings. Use this function if you getin a
muddle.

It is also very helpful if you reset the layout
before contacting technical support. In that way,
you and the technician will be using the same
layout — it will be easier to help you locate the
problem.

Note

Remember to save the layout if necessary before
you reset it. You can save the layout with Save
Layout As (see below).



Save As Default Layout

This function saves the current layout in a
special file. The next time you launch

BodyPaint 3D, the layout will load automatically
as the new default.

Note

There is an option in the General Settings (Save
Layout At Program End , page 42) that, when
activated, will save the layout each time you
quit the program.

Save Layout As

You can use this command to save the current
layout. This enables you save several layouts,
e.g. one for painting in three dimensions (large
Perspective View) and another for editing UV
mesh (large Texture View).

Layout files are given the extension ‘.14d’
automatically.

Further Menu Items

The Window > Layout submenu also lists all the
layout files (extension '.14d") in BodyPaint 3D's
‘prefs’ folder. To load a layout, select one from
the list.
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The Browser
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A file catalog in the Browser

Working with the Browser

Introduction

Using the Browser, you can take a snapshot of
all files produced by or used in BodyPaint 3D
scenes. Many of these files can be viewed as
thumbnails. So, for example, before loading a
texture image into your scene you can view it,
and any other possible textures you may need,
directly within the Browser.

More accurately, using the Browser you can
capture scenes, materials, textures, pictures,
animations, sound, time curves and even
C.O.FF.E.E. programs (those files ending with
the extension COF and COB e.g. UNDO.COF).
A full list of all BodyPaint 3D supported file
formats can be found in Appendix 3. This list is
extended further through the picture and
animation formats available when you have
installed QuickTime on your system.
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Note

The Browser will only recognize a movie file if
its corresponding codec is installed on the
system.

When used correctly the Browser is a very
powerful control center and manager for your
3D development.

It makes sense to organize your scene
information into various image catalogs (e.g.
one for sunsets, one for floor tiles and so on...).
You can then add notes to these archived files;
these notes will aid in future archive searches.
Using a search with certain criteria you could,
for example, search for all of those files that are
copyright free and are able to be distributed
freely.

While working on a project you can load each of
the required catalogs into the Browser, e.g.
select suitable materials and load these directly
into the scene. We will see how this works
further on in this chapter. First, we need to
create a catalog.

Creating A Catalog

- To start with, scan a folder for all BodyPaint 3D
files.

From the File menu, select Import Directory.
From the dialog you can choose your desired
folder. For these first practice steps the 'Tex' or
the ‘Sample’ folders in the root of BodyPaint 3D
are recommended.

You may also limit the search to certain file
types, perhaps only pictures or scenes. These
criteria (and more options) can be defined in the
Browser preferences.

- During the search the Browser automatically
creates small preview pictures (slides). These
give you a good idea of the actual appearance
of a picture or a scene.

Tip
If the file read by the Browser contains only one
single material (and nothing else, absolutely
nothing at all different), then the Browser will
display only material pictures as in the Material
manager (see Material manager, page 207), In all
other cases the raytracer renders a picture of the
current view. (See also Save Material As on

page 209.)

- Once the Browser has finished cataloging the
data you are free to add personal notes,
comments, copyright notices and similar things
to the individual files.

Select a slide (click on it so that it is framed red)
and choose Info from the Function menu. Enter
your own text into the large box. Close the
dialog with OK.

Now move your mouse pointer over the slide
that you have added comments to and wait.
After a short time the text appears under your
mouse pointer.

- Lastly save your whole database as a catalog
file with a meaningful name.

Choose Save Catalog As from the File menu.
Again the system dialog appears. Enter a
sensible name, such as Test, and the file
'Test.cat' will be created in the selected folder.
This catalog can then be loaded into the
Browser.

So far, we have seen the basic use of the
Browser. The full potential of the Browser will
become much clearer when it is used in
combination with the various BodyPaint 3D
managers. Depending on where you drag a
thumbnail slide, you may create new materials,
load scenes etc.



Simply click on a thumbnail and keep the (left)
mouse button held down. Move the mouse
pointer over a manager and release the button.
This technique is known as drag-and-drop.

You may, of course, select several separate
slides. Keep the Shift key pressed as you select
your required slides. All selected slides are
framed in red.

Drag-and-drop With The Browser

Pictures, Animations
- Pictures, animations in the Material manager:

Creates a new material, containing the image,
or animation, as a color texture.

- Picture, animation on an object in the
Perspective View:

Creates a new material, as above, but assigns
this material directly to the selected object.

- Picture, animation on an object in the Object
manager:

Creates a new material, as above, using the
picture or animation as the color channel but
assigns this directly to the selected object.

- Picture on the Picture Viewer:

The picture is displayed in the Picture Viewer
window.

Tip

The texture must be located in the BodyPaint 3D

Texture Paths, otherwise the preview image
remains black in the Material manager (see
Material manager, page 207).
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Scenes

Scene on the Material manager:

All materials (if applicable) belonging to the
scene are imported to the materials list of the
current scene.

Scene on the Perspective View:
The selected scene is loaded.
Scene on the Object manager:

The selected scene is imported into the current
scene.

Materials

Material on the Material manager:

The material is imported into the material list
of the current scene.

Material on an object in the Perspective View:

The material is added to the material list and
assigned immediately to the selected object.

Material on an object in the Object manager:

The material is imported into the material list
and assigned immediately to the selected
object in the Object manager.

Tip
If a texture that you use in the BodyPaint 3D
Browser is located outside of the Texture Paths,
the program asks whether you want to copy the
file to the same location as the scene. This
allows BodyPaint 3D to find textures
automatically without user intervention.

If you have not yet assigned a name (and
therefore a location) to your scene, textures are
saved to the BodyPaint 3D startup folder.
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Tip
Drag-and-drop with C.O.F.F.E.E. programs will
have no effect.

Further Browser Functions

- Double-clicking on a picture file (usually a
texture) opens the Pictures manager and
displays the picture.

- Double-clicking on an animation file opens the
animation player for your system and plays the
animation.

- Double-clicking a scene file loads it into the
editor.

- Double-clicking on a material imports and adds
it to the current scene and the Material
manager.

- Double-clicking on a C.O.F.F.E.E. program
opens your system'’s default text editor (the
default under Windows is NotePAD and under
Mac OS is SimpleText) and loads the program,
ready for editing.

- Right-clicking on a preview picture will open a
context menu from which you can access
information about the selected slide and this
allows you to use the Search dialog.

Tip
To open the context menu on the Macintosh,
hold down the Command key while you click
the mouse button.

The Drawing Pin

Using this menu you can alter the layout of
BodyPaint 3D to your own requirements.
Further details are in The Pin Menu, page 39.

File Menu
New Catalog

Creates a new, empty catalog. Any existing
catalog in the Browser will be replaced with the
new one.

Open Catalog

Loads a previously saved catalog into the
Browser.

Import File

Loads and adds a file (scene, picture, material...)
to the current catalog. A preview picture is
generated.

Import Directory

Loads and adds the contents of a folder to the
current catalog. Depending on how the
preferences are set up, subfolders will be
searched or ignored.

Tip
It is advisable not to list the complete contents
of a CD-ROM unless your computer has lots of
memory. A quick calculation backs this up: a
small thumbnail picture with a size of 80x60
pixels and a color depth of 24 bits needs around
15KB of memory. So 1,000 images on a CD
would require a minimum 16MB of memory.
And don't forget the extra few megabytes for the
actual display of these images within the
Browser. In such cases it is simple to create a
number of smaller catalogs, which are easier to
manage.



Save Catalog

Saves the current catalog. The catalog is saved
using the name given in the Save Catalog As
dialog. This name also appears in the Browser
title bar.

If your catalog is still yet to be named (in which
case the Browser title bar will show Untitled),
the Save command acts in the same way as Save
Catalog As (see below).

Save Catalog As

Save Catalog As always opens the File selector.
The name you enter here will appear in the title
bar of the Browser window.

BodyPaint 3D always adds the extension ‘.cat’
to the catalog filename.

Making Catalog Paths Relative

Normally, when storing a preview image in a
catalog, the exact location is also saved. This is
essential when using the drag-and-drop
technique to pass objects over to BodyPaint 3D
for processing.

However, should you move, for example, a
texture folder from your own system to the
company's network server, the location of the
files is no longer the same as that of the saved
catalog. Therefore the Browser will not find the
required files.

A similar situation may arise when you compile
a catalog for a CD-ROM collection (textures,
objects, scenes etc.). These collections would
normally be created locally on a computer, using
the computer's local path definitions and drive
IDs (e.g. the drive could be D:\, or even X:\
under Windows, or possibly 2184: or 1601
under Mac OS). This system would be unusable
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for catalogs, as the Browser would look for the
various devices and paths of the computer,
rather than the CD-ROM.

The solution to this is to use relative paths. This
option ensures that paths are not stored as
complete path names, but instead as relative
paths, starting from the catalog folder. Here, the
location path of files is still used, but you are
free to define where the system is to begin its
search. This anchor folder can be anywhere on a
hard disk or CD-ROM. But, starting from that
anchor folder, and moving down, the same path
hierarchy as that of the catalog folder must
exist.

Here's an example of anchor folders. Let us
imagine that you want to list your winter
background pictures. These are located on the
system hard drive in the following folder:

Disk1/Texture/Backgrounds/Winter/...

So we define Texture as the anchor folder, the
relative path then reads:

Backgrounds/Winter/...

This (sub-) folder hierarchy can be now moved
to any other location e.g. to the company
server:

Server7/BP3D/Resources/Tex/
Backgrounds/Winter/...

The new anchor folder is now Tex. Starting from
this location, the hierarchy sub-items now have
the same path as before. To ensure that the
Browser finds the required files requires one
rule; the Browser catalog must always be in the
anchor folder. In the above example the catalog
would have been created in Texture and later
copied to Tex.
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Let's see a more practical example:

You need to collect together and write all of
your textures, materials, objects and finished
pictures, and all other useful items, to a CD.

Firstly, a relevant catalog for the files is created.
It is to contain all textures, objects and
materials. In addition the catalog will be located
in the root folder of the CD, so that you can
view and archive it directly.

You now create the entire archive on your
computer. On most systems you will have a
reserved hard drive partition which was defined
for such CD-ROM production. Only rarely
should you require more than the 650MB limit
of a CD-ROM for this work area.

A possible CD structure for your hard drive
might look like the following illustration.
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The CD-ROM structure in the Mastering folder

So this is how the structure could look. You have
created and filled the folders with the relevant
contents. As we are just concerned with
browsing from here, only the three folders Mat,
Obj, and Tex are of any interest to us. Or have
we forgotten an important folder?

Of course ... we need to know where the
anchor folder is located.

Let's look more closely. The CD will be called
BP3D Tools. Thus the folder of the same name
within the mastering partition forms the anchor.
This is also where the catalog is to be located,
making it easily accessible. So, proceed as
follows:

1. Start BodyPaint 3D and open the Browser.
2. Open File > Preferences.

Check the option Recurse Folders in the dialog
(see above) as well as Pictures, Movies and
Scenes (and, depending on personal
preference, from the drop-down menu to the
right of Scenes choose Raytracer, which will
cause a delay in catalog creation, Gouraud
Shading or Wireframe).

3. Select File > New Catalog.
4. Now each folder is added.

Select File > Import Directory. In the dialog
select, for example, the folder Mat. The
catalog and the preview pictures are created.
Use the Import Directory function twice more
for the folders Obj and Tex.

5. Now Select File > Save Catalog As.

In the system dialog define 'Disk3:Mastering:
BP34D Tools' as the location and, say, ‘BP3D
Tools.cat' as the name. This is the most crucial
(and also most difficult) step. Now (and only
now) does the Browser know where it has to
create relative paths.

6. Open the menu command File > Make
Catalog Relative..., so that the Browser
converts all information into relative paths.

7. Save the catalog with File > Save Catalog.

You are now ready to master the CD.



To summarize:

If Make Catalog Relative... is enabled, then
complete paths are no longer saved, instead

only the relative paths, starting from the catalog

folder are used. From this location the current
catalog folder and its sub-folders are scanned.

Tip
This method only works if you have named the
catalog and assigned the path with the Save
Catalog As command (see above) prior to
searching the catalog.

Close

This command closes the Browser. The current
catalog is removed from memory.

Edit Menu

Delete

Removes all selected pictures from the catalog.
The originals on the system disk remain
unaffected.

Select All

Selects all the preview pictures of the current
catalog.

Deselect All

Deselects all the preview pictures of the current
catalog.
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Thumbnail Size

This allows you to adjust (in pixels) the size of
the preview images in the Browser. The changes
are immediate, although actual recalculation
does not occur until later. The images are simply
scaled up or down.

The new calculation of all pictures is achieved by
the use of Render All from the Function menu
(see below).

Recurse Folders

If this option is checked, sub-folders are also
scanned for scene elements and displayed in the
Browser.

Pictures

If this option is active, pictures are displayed in
the Browser. All image formats unknown to
BodyPaint 3D are ignored.

Movies

If this option is checked, animations are
displayed in the Browser. All animation formats
unknown to BodyPaint 3D are ignored.
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Sounds

If this option is active, the waveforms of the
sound files are displayed in the Browser. All
sound formats unknown to BodyPaint 3D are
ignored.

Function Curves

If this option is activated, function curves are
displayed in the Browser.

C.O.F.EE.E. Files

If this option is activated, C.O.F.F.E.E. files are
displayed in the Browser.

Scenes

If this option is activated, scenes are shown in
the Browser. All scene formats that are not
recognized by BodyPaint 3D are ignored.

You can use the pop-up menu to the right of
this option to determine whether scenes are
shaded in Wireframe or Gouraud or rendered
with the Raytracer. If Raytracer is selected,
shadows and refraction are not rendered and
only the floor and sky can be reflected.
However, each scene is antialiased.

Function Menu
Render All

Recalculates all preview pictures that exist in the
catalog.

This is necessary, for example, if you change the
picture size in the preferences or add or change
files in the directories. You can cancel the new
calculation at any time with the ESC key.
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Opens an information window for the current
preview and displays information, including the
complete path, picture resolution and color
depth.

Tip
This command is also accessible from within the
context menu (right-click).

You may be surprised, when you are using
relatively small textures in a scene, if the
computer alerts you to a lack of memory. It's
very easy to forget that images often need
considerably more memory than their file size
suggests.

For example a compressed JPEG picture, which
on disk is just one megabyte in size, can quite
often need 10 or more megabytes of memory to
display. Using several such compressed files in
the Browser, the existing memory of your
computer melts like ice cream in a desert.

Using the information window of the Browser,
you can easily monitor the relevant values (file
size and actual memory requirement) and avoid
unpleasant surprises while working on a project.

On the right-hand side of the information
window is an area where you can enter your
own comments e.g. copyright notes, latest
changes etc.



These comments may run to many lines and up
to 255 characters. A comment can be displayed
from within the Browser itself. To do this, simply
leave the mouse pointer over a preview picture
for a couple of seconds. As with command
palettes (see Command Palettes, page 32), an
information box will open under the mouse
pointer.

To begin a new text line, simply press the Enter
or Return key. This dialog must be closed with
the mouse by clicking on OK or Cancel.

Tip
The contents of the comment box can also be
searched (see below). The Browser thus

effectively becomes a small picture database.

Tip
If the Browser finds a text file with the name
Readme.txt when scanning a folder, its contents
will be automatically transferred to the
information dialog of each thumbnail picture of
the folder, space permitting.

Search For
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Scans the name and/or comment boxes of the
current database of the Browser for the text
entered.

Tip
This command is also accessible from within the
context menu (right-click).
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You may use the Browser to scan for filenames
and/or comments. Simply choose the criteria by
checking the relevant box and enter the text or
value you wish to search for in the box to the
right. All thumbnails that match the find will be
outlined in the catalog.

Sort By

Use the sub-entries of this menu to define the
sort sequence of the current catalog in the
Browser.

Alternatively you may sort according to filename
or file size. Items are always sorted in ascending
order, i.e. the list starts with the smallest images
and ends with the largest.
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Initialisation Files

BodyPaint 3D loads several initialisation files
during startup. The content of these files is
integrated into the layout.

Template.c4d

During startup, BodyPaint 3D checks its root
folder for a file called ‘Template.c4d'. If the file
is present, its settings are loaded and are used as
default values.

This can be very effective if you keep using the
same scene-specific settings (e.g. several
different render settings).

For an overview of all the settings which are
saved with the scene file, see Overview,
page 27.

New.c4d

When you create a new file (main menu

File > New), BodyPaint 3D checks its root folder
for a file called ‘New.c4d". If the file is present,
its settings are loaded and are used as default
values.

For example, to change the default render
resolution, change the value in the Render
Settings (Output tab) and save the file in
BodyPaint 3D's root folder under the name
‘New' (BodyPaint 3D will append the extension
automatically).

Template.cat

During startup, BodyPaint 3D checks its root
folder for a file called ‘Template.cat'. If the file is
present, it is loaded into the Browser
automatically.

This can be useful, for example, when you are
working on a large project and wish to have all
the associated textures and/or scenes available
immediately after startup. In this case, create a
catalog which shows all the required files. Then,
save the catalog in BodyPaint 3D's root folder
with the name ‘Template’ (BodyPaint 3D will
append ‘.cat’ automatically). The Browser will
contain the catalog the next time you launch
BodyPaint 3D.

For more information on the Browser, see
page 57.

Note

If the template catalog is very large (lots of
preview pictures), expect a short delay during
startup.

Template.l4d

During startup, BodyPaint 3D checks its root
folder for a file called ‘Template.l4d'. If the file is
present, it is loaded and used as the active
layout.

You can create this file in one of two ways:

- Activate the corresponding option in the
General Settings (see page 40). The template
layout will be created automatically when you
quit BodyPaint 3D — each time you quit, for
as long as the option is activated!

- Create the template layout manually using the
function Window > Layout > Create Default
Layout (main menu).
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5 BodyPaint 3D Basics

This tutorial shows you how to paint an
imported object from scratch.

In preparation, load an unpainted object into

BodyPaint 3D. If you like, use 'face.c4d' from
the Examples folder on the BodyPaint 3D CD-
ROM.

Step 1: Create the Material

The object is gray to begin with. This is because
unpainted objects use the default material (gray
color, specular channel active). Create your own
material by choosing File > New Material in the
Material manager.

The new material's preview appears. Notice how
it is gray also. However, before you edit the
material, apply it to the object in the following
way: drag from the material preview until the
mouse pointer is over the object in the
Perspective View, then release the mouse
button. The Texture dialog opens:
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Set the Projection pop-up menu to Flat, then
click on the OK button. This maps the texture to
your object using flat mapping. To ensure that
the projection covers the entire surface, choose
Texture > Fit to Object in the Object manager.

Flat mapping is a good choice if you are using
the face example, since you will paint to one
side only. However, when you need to paint to
all sides of an object, you should use Spherical
or UVW mapping. For further details on texture
projection, please see page 255.

Step 2: Create the Texture

You need to create a texture before you can
paint the object, so select Channels > Color in
the Layer manager. This creates a texture for the
color channel.
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[ = New Texture —ee=—_g

Create a new texture

% New Texture ¢ From Disc
[ tame | [untitied_1

Resalution [72 2] [Pixet/inch ¢oP1} %]
Mode [RGB 24 Bit {3 Byte/Pixel) i]

B3] |

Color [Color
Max. Memory/Layer: 1054 kB

The New Texture dialog opens. The parameters

in this dialog are used to define the new texture.

Leave all the parameters at their default settings
with one exception: click on the color selection
box to the right of Color. The color dialog for
your operating system opens. Choose a
background color for your texture (e.g.
255,216,178 RGB for skin) then click on OK to
return to the New Texture dialog. Click on OK
once more to create the texture.

A texture with a background layer is created.
The background layer is filled with the color you
have just chosen, as can be seen in the Layer
manager. Now, activate the Enable option so
that you will be able to edit the texture.

The new texture has been mapped to the object
automatically. The speculars are a little
overpowering, so double-click on the material
preview (Material manager) and deactivate
Specular (click on the adjacent option field).

You are now ready to paint your object.

Step 3: Paint the Object

Click on a brush preset and a color preset to
choose your brush and paint. You can also
choose the painting color by clicking on the

foreground color selector (front rectangle) for
the color channel (C) in the multi-channel

palette:
EH

Choose the new foreground color using the

color dialog that opens.

You can paint in two different windows (and,
effectively, in two different ways):

1. Perspective View — paint directly onto your
object in three dimensions.

2. Texture View — paint onto the bitmap in two
dimensions.

Both the Perspective View and Texture View
show your paint strokes in real-time.

If you have activated the Show UV Mesh option
(Texture View: Tools > Show UV Mesh ) and the
UV mesh is at a different angle to the texture
plane, you can correct the angle by adjusting the
Rotation settings in the Texture dialog. (To open
the Texture dialog, double-click on the texture
tag in the Object manager.)

Tip:

To open the texture in the Texture View, double-
click on the Background layer in the Layer
manager.

Now, paint the object in an imaginative way. Try
a variety of brush presets and, above all,
experiment.



On the right is the painted face texture. The eyes were
allocated their own texture.

We painted the eyes for this example.

If you want to save your artwork, use File >
Save Project from the main menu.

The Save File dialog opens. Enter a name for the
project folder. A 'tex' folder will be placed inside
the project folder — this is where your textures
will be saved. This method ensures that
everything is saved.

BodyPaint 3D saves the scene file separately to
the textures.

The Save as command (main menu) saves the
scene (i.e. the object) only. You can save
individual textures using File > Save Texture in
the Texture View. If you want to save all the
textures, use File > Save All Textures (main
menu).

Keep in mind that BodyPaint 3D can load the
scene's textures only if they are in one of the
following locations:

1. In the same folder as the scene file.
2. In a 'tex' folder inside the scene’s folder.

3. In any folder specified as a texture path in the
General Settings. See page 51 for details.
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6 Color Manager

The Color Settings
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The Color Settings dialog is the most important
means for defining colors and patterns in
BodyPaint 3D. In addition, it enables you to
save the color/pattern as a color preset in the
Color manager.

Blending Mode

The Blending Mode slider controls the strength
(i.e. the opacity) of the color/pattern. The
preview picture shows the current state of the
color/pattern, which is the result of combining
the blending mode settings with the wallpaper
properties.
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You can, if you prefer, enter the strength value
numerically using the box to the right of the
slider. You can set values from 0% to 100%. A
value of 100% will apply the color/pattern with
full opacity.

If Texture Paint is selected, the texture will be
applied in the ratio of 1:1. The lower you set the
strength value, the more transparent the color/
pattern will be.

The pop-up menu on the right defines the
blending mode itself. These modes, such as
Multiply and Darken, have exactly the same
effect as with 2D paint programs.

The following terms are used below to help
describe the effect of the blending modes:

- background color — a pixel's original color, i.e.
its color before you paint over it.

- painting color/pattern — the color or pattern
with which you are painting.

- resultant color — the pixel's final color, i.e. its
color once you have painted over it.

The blending modes you can choose from are:

Normal

Each pixel you paint over takes some or all of its
color from the painting color/pattern according
to the brush pressure value. The greater the
brush pressure value, the more opaque your
brush stroke becomes.

Dissolve

This mode uses a random function to generate
an (almost) random distribution of the color/
pattern while you paint. Dissolve depends on
the brush pressure and it frays the edges.
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This mode is useful for simulating dirt effects.

Difference

With this mode, the resultant color of each pixel
is the difference between its background color
and the painting color. For example, if you paint
red onto black, the result is red. This is because
black's RGB values are 0,0,0, so the difference
corresponds to the painting color (red). A more
practical example is to paint onto a non-black
background with a soft brush — this creates
surreal edges.

Lighten

BodyPaint 3D compares the brightness values of
the background color and the painting color (at
the pixel level). If the background color is
brighter, the pixel's color remains unchanged. If
the background color is darker, the resultant
color is the same as the painting color.

Darken

BodyPaint 3D compares the brightness values of
the background color and the painting color (at
the pixel level). Where the background color is
darker, the pixel's color remains unchanged.
Where the background color is brighter, the
resultant color is the same as the painting color.

Multiply

The resultant color is obtained by multiplying
the background color by the painting color, then
dividing by pure white. The more often you
paint over a pixel in this mode, the darker it
becomes. The effect is always a darkening one.
This can be useful for increasing tonal variation.

Screen

Screen has the opposite effect of Multiply. It
multiplies the inverted values for the
background and painting colors, then divides by
pure white. (To invert a color, subtract it from
pure white.) The more times you paint over a
pixel in this mode, the brighter it becomes.

Add

The resultant color is obtained by adding the
colour channels of the background color and the
painting color. For example, if you paint red
(255,0,0) onto a green background (0,255,0,),
the resultant color is yellow (255,255,0).

Exclusion

This mode is similar to Difference, but it creates
a softer effect.

Erase

This mode erases pixels in the active layer — the
erased areas are transparent and the layer
underneath shows through.

Note:

If the Background layer is active, the Erase mode
paints white rather than transparency.

Ignore Filter

The Brush Settings dialog contains filters such as
Wet Edges and Smudge. Use this Ignore Filter
option to turn on or off the effect for the active
material channel.

Solid Color

This is where you choose your color. There are
seven different color modes. To change mode,
click on the triangle below the small preview
picture and select from the list that appears. You
can define the color using either a color table or



the four sliders and input boxes. The color is
shown in the small preview picture to the left. If
you click on the preview, you can define the
color using the color dialog that is native to your
operating system.

Color Table
This enables you to choose a color from a table
of presets. Click on a color to pick it.

Sliders

The sliders relate to either the RGB color system
or the HSV color system.

RGB: The color is defined by three color
components: red, green and blue.

HSV: The color is defined in terms of hue,
saturation and brightness.

Depending on the color mode chosen, you can
set the slider values between the following
ranges:

0%..100%
0..255
0..65535
The fourth slider defines the color’s brightness.

The four sliders combined enable you to specify
a color accurately.
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Activate this option if you want to paint textures
onto the object. You can pick the texture using
the eyedropper:

- Select the Eyedropper tool.
- Select Texture in the Active Tool manager.

- Click in the Texture View and the active layer
will be used as the texture.

Note that you can use the eyedropper between
all open scenes.

Preset Patterns

You can select a preset pattern by clicking on
the triangle to the right of the material preview.
You can add your own bitmaps to the list by
placing them in BodyPaint 3D's 'pattern’ folder
(although see Reread Directory below). You can
use any graphics format recognised by
BodyPaint 3D, such as tif, bmp and jpg.

Often, you will use your own paint patterns,
which you can pick using the eyedropper.

The pop-up menu contains two functions in
addition to the pattern list:
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Load From Disk — This enables you to load a
texture from a storage medium. You will be
asked if the texture should be copied to the
‘pattern’ folder. Click on Yes if you want the
pattern to be made available permanently.

Refresh Folder — If you have copied any
bitmaps to the ‘pattern’ folder during the
current work session, select Refresh Folder to
add the new patterns to the list.

Source X/Y

This defines the pixel in the texture that will be
painted first. For example, if the values are set
to 0 and O, the top-left pixel in the texture will
be painted first.

Tip:
If you picked the texture using the eyedropper,
the values are set to the pixel position where
you clicked.

Tiling
If this option is activated, the pattern will be
tiled as you paint.

Dest. X/Y

Dest. stands for Destination. You can enter
values only if the painting mode is locked (see
below); otherwise, the boxes are ghosted. If you
set the Dest. X/Y values to the same values as
Source X/Y, the pattern will be painted without
an offset — enter different values to offset the
texture. For example, to offset the texture 20
pixels lower, subtract 20 pixels from the second
box.

Painting mode

Locked — This mode paints the texture with an
offset as defined by the Source X/Y and Dest.
X/Y settings. This enables you to clone a texture
and paint it to another position with an offset.

For example, if you paint using the Fill Bitmap
tool, the texture will be offset over the entire
layer — or if you use a brush, the texture will be
offset in the areas you paint.

Mouse Hit — This mode is similar to Locked but
with the following difference: if you release the
mouse button and begin to paint in a new
position, the texture is painted starting from the
texture pixel defined by Source X/Y. Many paint
programs have a comparable tool called Rubber
Stamp.

Brush Pos. — This stands for Brush Position.
Each movement during the brush stroke paints
the texture on top of all previous movements in
the stroke. This tends to create fragments of the
texture in close proximity. If you select rotation
(select the Rot. option) and couple its effector
(see below) with the Draw Direction method,
the pattern will rotate according to the painting
direction, helping you to create tricky textures
such as fur and wool.

7 Saled Coiar T paabares Pt
[T 1T &fsstnm
Saucaiff [0 &[0 & ¥ Tieg




Scale — Select this option if you want to scale
the painting pattern. For example, if the original
texture size is 300x300 pixels, you can resize it
to 150x150 pixels by entering a value of 50%.
A value of 200% would resize 300x300 pixels to
600x600 pixels. Keep in mind that scaling up
textures may lead to pixelation. You can enter
any scale value from 1% to 1000%.

Rot. — This stands for Rotation. It lets you
rotate the painting pattern by any angle from
-180° to 180°. This can be useful, for example, if
you have imported a texture and picked it using
the eyedropper tool — sometimes the texture is
rotated by 90" in the process. In this case, use
Rot. to correct the texture's direction.

Effectors

(4 EMocien Getlingr ]
|- T [
I~ PenTi

[~ PenDescen

[~ PenFingesshas
[ Deawe Dissciian
(]

[ b wbedd
™ Rendorranm

a5 FanPesem[fn 4 108

o | Concl |

There are two buttons to the right of Rot. and
Scale. Click on one of the buttons to access the
effector for the corresponding setting.

An effector enables you to change the
parameter dynamically by means of a specified
input method. For example, you can use the
mouse wheel to change the texture's Scale value
while you paint.
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Most of the input methods have a graph that
you can edit to fine-tune their behaviour —
please see Profile on page 89 for details on
editing the curve.

Eight different input methods are available. You
can assign as many of the methods as you wish
to the same effector. For example, you can
change the texture's Scale value using the
mouse wheel as well as the draw distance. Also,
you can use the same input method with more
than one effector. For example, you can change
the texture's Size and Rot. values using the
mouse wheel.

Pen Pressure This adjusts the setting according
to how hard you push down on the graphics
tablet. The graph to the right defines exactly
how this input method affects the setting (the
graph is linear by default).

Pen Tilt This method adjusts the setting
according to the pen’s tilt. If the pen is at a
right-angle to the graphics tablet, the tilt is O°.
If the pen is resting on the tablet, the tilt is 90°.
The graph to the right defines exactly how this
input method affects the setting (the graph is
linear by default).

Pen Direction Adjusts the setting according to
the pen's rotation. The graph to the right
defines exactly how this input method affects
the setting (the graph is linear by default).

Pen Finger Wheel This adjusts the setting
according to finger wheel's angle. The graph to
the right defines exactly how this input
method affects the setting (the graph is linear
by default).

Draw Direction With this method, the setting
is adjusted in relation to the direction in which
you paint. For example, if you activate this
input method for the Rot. effector, the texture
will rotate automatically to follow your brush
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stroke. The graph to the right defines exactly
how this input method affects the setting (the
graph is linear by default).

Draw Distance The setting is adjusted in
relation to the distance the mouse is dragged
with the mouse button held down.

Mouse Wheel Here, the setting changes with
reference to the angle of the mouse wheel.
The graph to the right defines exactly how this
input method affects the setting (the graph is
linear by default).

Random — This adjusts the setting randomly.
You can enter minimum and maximum values
(Min and Max).

Wallpaper

& Loler Satlings

% Fle Edi

ersing Wads [l =]
———m= 3
[ IgeneFiba
1+ Sokd Coior 7 T nshars Funk
— g
i —— % 3
v——r—F 4
5 (Wigimes ——— e o

' nlpaE
T

Click on the triangle to choose a wallpaper from
a list of patterns. These are the bitmaps in
BodyPaint 3D's 'pattern' folder.

To blend a color with the wallpaper, define a
color in the color pane and use the slider in the
Wallpaper pane to set the blend strength.

Also, you can choose from the full complement
of blending modes — see Blending Mode on
page 75 for more details.

Do not shy from experimenting with
combinations of color, wallpaper and blending
mode. A vast number of diverse effects can be
achieved.

File Menu

These functions enable you to save your own
colors/patterns to the Color manager.

Once you have saved a color preset, you can
select it later by clicking on its icon in the Color
manager.

Add Single Channel Preset

This saves the parameters in the Color Settings
dialog as a color preset in the Color manager.

Add Multi Channel Preset

This function saves several colors/patterns and
channels under one color preset. When you
subsequently paint with the preset active, its
colors/patterns and channels are painted
simultaneously.

Overwrite Preset

Overwrites the active color preset with the
current color settings.

Close
This closes the Color Settings dialog.

Edit Menu

Copy
Copies the active color to the clipboard.

Paste

Copies the color in the clipboard to the active
material channel of the Multi Channel Palette.



The Multi Channel Palette

The Foreground and Background Colors

="

Click on the channel that you wish to
manipulate. A red frame will appear to indicate
that the channel is active.

Note the two overlapping rectangles. The front
rectangle represents the foreground color, the
rear one the background color.

If you click on the foreground color icon, the
Color Settings dialog opens so that you can pick
a new foreground color. Likewise, click on the
background color icon to choose a new
background color.

When using a brush, note that you can paint
with either the foreground color (left mouse
button) or the background color (right mouse
button). This interchanging of the foreground
and background colors applies to all the paint
tools including Fill Bitmap, Draw Line and Draw
Text.

The Edit Selection Mask Mode

0

The Edit Selection Mask mode enables you to
edit a bitmap selection using the paint tools and
filters by means of a temporary mask. There are
three main steps involved:

- The Edit Selection Mask mode is activated —
this changes the bitmap selection into a selection
mask; the bitmap selection’s dotted line is
replaced by a red overlay (the selection mask).

- The selection mask is edited using the paint tools
and filters (almost any paint tool can be used).
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- The Edit Selection Mask mode is deactivated —
this changes the selection mask back into a
bitmap selection.

This raises the question: “If you start with a
bitmap selection and you end up with a bitmap
selection, what is the point of this mode?” The
advantage of the edit selection mask mode is
that you can call upon (almost) all the paint
tools and filters, hence you can create more
accurate selections than would be possible using
the standard selection tools alone.

By convention, the selection mask appears as a
red overlay. Selected areas are transparent,
deselected areas are red. The red areas are
slightly transparent so that you can still see the
image underneath.

In spite of its red color, the selection mask is
grayscale internally. This means that you should
use white to paint a transparent (i.e. selected)
region, or black to paint a red (i.e. deselected)
region. Use grays for semi-transparency (i.e.
partial selection).

Once you have finished editing the selection
mask, deactivate the mode and the mask will
change back into a bitmap selection.

You can still activate the mode if you haven't
made a bitmap selection. In this case, the entire
selection mask will be transparent (i.e.
everything will be selected). Usually, though, it
is more efficient to refine an existing selection.
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Multi Channel Mode
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This powerful mode enables you to paint to
several material channels simultaneously. In
addition, you can paint a different color/pattern
to each channel.

For example, you can paint red to the color
channel and black to the bump channel
simultaneously. The black color in the bump
channel causes an indentation effect, hence the
red paint stroke appears to be indented. Were
you to use white in the bump channel instead,
the paint stroke would appear to be embossed.

If the Multi Channel Mode button is inactive:
the Brush (or any other painting tool) will paint

to the active material channel only, which is
indicated by a small pencil icon. Note that the

Layer manager also uses a pencil icon to indicate
the (same) active channel — the selection is
linked.

The small rectangles show you the foreground
and background colors/patterns.

If the Multi Channel Mode button is active:

Cat!
L

you can paint to several channels at once.

The material channels in the Multi Channel
palette are:

Color (C)
Diffusion (D)
Luminance (L)
Transparency (T)
Reflection (R)
Environment (E)
Bump (B)

Alpha (A)
Specular Color (S)
Displacement (DS)

For details on each material channel, please see
Chapter 12, The Material manager, on page
207.

Active channels (i.e. the material channels that
will be painted to) are marked by a pencil icon
in the Multi Channel palette. To activate or
deactivate a channel, click on the top right of
the channel's icon.

Note that the Layer manager also uses a pencil
icon to indicate the (same) active channels
(provided that the Active Material Channels
option is selected) — the selection is linked.

You can use a different color/pattern for each
channel. To do this, click on each channel icon in
turn and choose the color/pattern that you wish
to assign it. Note that the active channel is
indicated by a red frame.



Once you have activated all the channels you
wish to use and assigned textures to them, you
can paint to the channels simultaneously. A
preview of each channel is shown in the Multi
Channel Palette.

The Color Manager

A Color Misanic
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You can use this manager to access predefined
colors/patterns as well as any presets you have
created and saved yourself.

We recommend that you use the presets in the
following way: whenever you have a color/
pattern that you feel may be useful later on,
save it as color preset. When painting, have the
Perspective View (including the object to be
painted) in one window and the Color manager
in another. Choose a brush, click on a preset
color, then paint in the Perspective View.

When you want to change pattern, click on the
icon for the new pattern in the Color manager
and paint once more.

If you work in this way, you will move
frequently and swiftly between the two
windows and your object should be painted in
minimal time.
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Tip:
You can right-click on a color preset to define it
as the background color.

File Menu

New Group

Over time, the number of color presets will
grow as you add to them. This function enables
you to create and name groups so that you can
store your presets in a more organised manner.

Revert to Default

This function reverts the color presets to the
default settings. As a precaution, you will be
prompted for confirmation.

Save As Default

Imagine that you have created some presets.
However, the next time you use BodyPaint 3D,
the new presets are missing. This is because you
neglected to use Save As Default, which saves
the current presets (including their arrangement)
as the default.

Do not worry if you are forgetful — BodyPaint
3D will give you a chance to save the presets
when you quit.

Import

This function enables you to use BodyPaint 3D
patterns created by other artists. The file
selector will open. Choose any file exported
from BodyPaint 3D to add its presets to your
own.

Export Selection

This function saves your BodyPaint 3D patterns
so that other artists can use them. The file
selector will open. Choose a destination and a
filename for the selected presets (or group of
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presets). The file takes the extension 'b3d'. In
addition, a folder named 'pattern’ is created for
the textures used by the presets.

You can only export patterns that are in
BodyPaint 3D's 'pattern' folder. So, for example,
you cannot export a color if the pattern was
created in BodyPaint 3D and picked using the
eyedropper.

Export Visible
This function exports all visible presets.

Close

This function quits the Color manager and
closes its window.

Edit Menu

Rename

You can use this function to rename the active
preset or active group.

Duplicate

This duplicates the active preset or the active
group.

Delete

This function deletes the active preset or the
active group.

Group

If you choose All Presets, all color presets are
displayed.

If, on the other hand, you choose a different
group from the list, only the presets belonging
to that group are displayed.

View

As List

If this option is activated, the icons are displayed
as a vertical list and their names are specified.
The active icon is indicated by a red frame.

= gy Ly

To change the order of the icons, drag-and-drop
within the list. While you drag, a dark line
indicates where the icon will be moved to if you
release the mouse button.
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You can move presets into different groups to
help organise them. For example, you may wish
to create a group specifically for wood patterns.
To move a preset to a new group, drag the
preset's icon onto the center of the group icon.
The mouse pointer should turn into an arrow
pointing downwards before you release the
mouse button.

The small + icon to the left of the group icon
indicates that the group is closed. To open the
group, click on the + icon. Once the group is
open, a small - icon appears. Click on this icon
to close the group.

As Icon

If this option is activated, the icons are displayed
in rows and columns rather than as a vertical
list. Note that in this mode the names of the
presets are not shown. The active icon is marked
with a red frame.
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Small Icons
The preset icons are displayed small.

Medium Icons
The preset icons are displayed medium sized.

Large Icons
The preset icons are displayed large.

Tip:
You can drag-and-drop to change the order of
the icons.
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7 Brush Manager
Brush Settings ..
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7 Brush Manager

Brush Settings
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The Brush Settings dialog enables you to define
brushes by setting parameters such as Size and
Pressure. The current brush setting is previewed
in the top left of the dialog. You can, if you
wish, save the brush parameters at any time as a
brush preset.

Many of the parameters have an effector, which
enables you to change the parameter while you
paint by means of an input method. For
example, you might use the mouse wheel to
change the brush size while you paint.

Store Color

If you activate this option, the color in the Color
Settings is blended into the brush preview. If
you then save the current brush settings as a
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brush preset, the color will be saved together
with the brush parameters. If Store Color is not
activated, only the brush parameters will be
saved.

This has implications for painting. Imagine you
have picked a color in the Color Settings, then
you pick a brush in the Brush manager.

Suddenly, a different color replaces your chosen
color in the Color Settings — here, the brush you
picked used an active Store Color option, and so
its color displaced your own choice. This option
is intended for a brush that always paints with
the same color.

Generic Brush Type

The Type pop-up menu (next to the brush
preview) defines the brush type, which can be
either Generic or Bitmap. First, the generic
brush:

The tip of the generic brush is defined by means
of options and sliders. These are:

Shape

You have two basic brush shapes from which to
choose: Circle and Rectangle. The settings
below refine this basic shape.

Profile

The profile defines the pressure gradient for the
brush tip. The graphs below should help to
clarify. Each graph describes the strength of the
brush pressure over the brush radius.

You can choose from the following profiles:
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If you select this option, you can create your
own pressure gradient for the brush tip. Click on
the button to the far right of the Profile pop-up
menu to open the following window complete
with graph:
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The Y axis corresponds to the brush strength
(i.e. pressure) and the X axis represents the
brush radius. The curve is linear by default. Click
on the first point of the curve and notice how
the point turns orange to indicate that it is
selected. Drag the point and notice how the two
real-time previews to the right of the graph
change accordingly. The upper preview shows
you the brush profile, the lower preview shows
the brush itself.

If you click anywhere inside the graph (i.e. other
than on a point), a new point is created. The
curve adjusts itself to run through the new
point. You can add any number of new points.

You can delete points as well: click on the point
you wish to delete, then press the backspace
key.

You can use the Strength and Radius boxes to
read or enter values for the active point.



Examples:

pl 005

]

Suengh

[
IS

et

b
I
\

1

I 1I1
B

i | o

There is a small button in the top left of the
window. If you click on this button, a menu
opens with the following functions:

Copy Curve This copies the active curve to the
clipboard. Once you have copied the curve,
you can use the Paste Curve command to
paste it into an effector's graph. An effector
enables you to change a brush parameter
dynamically by means of an input device. For
example, if you have a graphics tablet, you can
use the pen direction to change the brush size
while you paint.

Paste Curve This command will appear in the
menu list only once you have copied a curve to
the clipboard. It pastes the clipboard's curve
into the graph.
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Reset to Default This restores the curve to its
default shape (a straight line).

Flip Horizontal This command flips (mirrors)
your curve horizontally.

Flip Vertical This command flips (mirrors) your
curve vertically.

Size

This defines the overall size of the brush. You
can edit the value using the slider, or you can
enter the value numerically in the box to the
right of the slider. The value defines the brush
diameter in pixels. You can set the value from 1
to 400 pixels.

Pressure

This slider defines the brush pressure. The lower
you set this value, the more transparent the
brush stroke becomes. The maximum value of
100% defines an opaque brush stroke.

Hardness

This determines the percentage of the brush
that is hard. The lower you set this value, the
softer the brush becomes at the edge and the
more its edge will blend into the background
color. If Hardness is set to its maximum value of
100% the brush stroke will not blend into the
background color at all.

g O

0% Hard 100% Hard

For example, you can create dirt textures using a
low Hardness value with the Dissolve blending
mode active in the Color Settings (see page 75).

You cannot access the Hardness slider if the
brush has a user-defined profile. In this case, the
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transparent areas of the brush are defined by the
profile curve itself.

Spacing

If you select this option you can define the
distance between brush marks in the stroke. A
large value will result in a trace of brush marks
that follow your mouse. A low value will
produce the effect of a continuous paint stroke.
Note that if Spacing is deactivated, the paint
stroke depends on processor performance and
may fragment during fast brush strokes.

High Spacing value

Jitter

The litter function causes the paint to be applied
at a certain distance from the brush tip. Please
study the following examples:

Linear brush stroke with Jitter selected

Jitter and Randomness selected

The curve in the top picture was produced with
a straight brush stroke.

Squeeze

Select this option if you want to squeeze (i.e.
narrow) the brush tip. The minimum value of
0% leaves the brush tip in its original form
(circular or rectangular). The higher you set the
value, the narrower the tip becomes.

O 0

0% Squeeze 100% Squeeze

Rotation

You can rotate the brush tip by moving the
slider or by entering a rotation angle in the input
box.

Effectors
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You can activate an effector for each of the
following brush settings: Size, Pressure,
Hardness, Jitter, Squeeze and Rotation. To open
a setting's effector, simply click on the small icon
to the far right of that setting. You will see one
of two icons, depending on whether there is
already an active effector or not.

Y

not active active

An effector enables you to change the
parameter dynamically by means of a specified
input method. For example, you can use the pen
pressure to change the brush size while you
paint.

Most of the input methods have a graph that
you can edit to fine-tune its behaviour — see
Profile above for details on editing the curve.

Eight different input methods are available. You
can assign as many of the methods as you wish
to the same effector. For example, you can
change the brush size value using the pen finger
wheel as well as the distance. Also, you can use
the same input method with more than one
effector. For example, you can change the brush
Size and Pressure values using the pen pressure.

Pen Pressure

This adjusts the setting according to how hard
you push down on the graphics tablet. The
graph on the right of the dialog defines exactly
how this input method affects the setting (the
graph is linear by default).

Tip:
The pen pressure is the most popular input
method with graphics tablet users. You may wish
to assign it to the Size or Pressure brush setting.
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Pen Tilt

This method adjusts the setting according to the
pen’s tilt. If the pen is at a right-angle to the
graphics tablet, the tilt is O°. If the pen is resting
on the tablet, the tilt is 90°.

The graph on the right of the dialog defines
exactly how this input method affects the
setting (the graph is linear by default).

Pen Direction

The Pen Direction method adjusts the setting
according to the pen’s rotation. The graph on
the right of the dialog defines exactly how this
input method affects the setting (the graph is
linear by default).

Tip
if you assign this method to the Rotation brush
setting, a narrow brush will paint a stroke similar
to that of a calligraphy pen.

Pen Finger Wheel

This adjusts the setting according to the finger
wheel's angle. The graph on the right of the
dialog defines exactly how this input method
affects the setting (the graph is linear by
default).

Tip
You may wish to assign this to the brush
Pressure so that you can adjust the setting
comfortably while you paint.

Draw Direction

With this method, the setting is adjusted in
relation to the direction in which you paint. For
example, if you activate this input method for
the Rot. effector (in the Color Settings), the
texture will rotate automatically to follow your
brush stroke. The graph on the right of the



94  BRUSHES ¢ CHAPTER 7

dialog defines exactly how this input method
affects the setting (the graph is linear by
default).

You can create some interesting effects with this
function, especially if you assign it to the
Rotation brush setting. For example, choose a
rectangular brush, set Spacing to about 130%
and set Rotation to 90°. Assign Draw Direction
to the Rotation brush setting to create the
following effect:
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This function’s speciality is fading brush strokes
— assign Distance to the Pressure brush setting
and your paint strokes will fade gradually.

The Pixel Length defines the effector’s area of
influence. For example, if the Pixel Length is set
to 200 the curve will be evaluated over the first
200 pixels of the brush stroke. So, if the default
(linear) curve is used with the example, the
Pressure will be 100% at the start of the brush
stroke and 0% by the time the stroke is 200
pixels long.

Tip:
You can use Distance with large bitmaps too —
you can enter values up to 700000 pixels.

You can also enter a value in the Loops box.
This determines the maximum number of times
the curve can be repeated should your brush
stroke extend beyond the Pixel Length value.

The picture should help to clarify:

You can also use Distance to create wobbly
lines. To add a wobble to your brush stroke,
assign Distance to the Size brush setting and
define a curve similar to the one shown below.



Note the large number of loops in the example.
This lets you paint (almost) as long a stroke as
you wish without the effect diminishing.

Mouse Wheel

Here, the setting changes with reference to the
angle of the mouse wheel. The graph on the
right of the dialog defines exactly how this input
method affects the setting (the graph is linear by
default). For example, if you assign this to the
Pressure brush setting, you can use the mouse
wheel to adjust the brush pressure while you
paint with the mouse. Alternatively, you may
prefer to use both hands: one hand paints with
a graphics pen while the other uses the mouse
wheel to adjust the Size or Pressure brush
setting.

Randomness

This function assigns random values to the
setting. You can specify minimum and maximum
values (Min and Max). For example, imagine
that you have set Size to 50 pixels. In the
effector for Randomness, you leave the Min and
Max values set to 0% and 100% respectively. If
you paint with this brush, the Size alters
randomly between 0 and 50 pixels. If, on the
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other hand, you set Min to 50% and leave Max
at 100%, the width of the paint stroke varies
between 25 and 50 pixels.

The effect above was achieved by assigning
Randomness to the Size, Pressure, Hardness
and Jitter brush settings.

Tip
Randomness behaves differently when assigned
to the brush's Rotation parameter. In this case
the Randomness value is added to the base
Rotation value.

Bitmap Brush Type

This mode enables you to use any bitmap in
BodyPaint 3D’s 'pattern’ folder as the brush tip.
Please keep the following in mind:

BodyPaint 3D handles all bitmaps in the
‘pattern’ folder as grayscale images. You can still
use RGB Color bitmaps, but BodyPaint 3D will
convert them (in memory) into grayscale for its
own use. Black areas of the bitmap are
transparent and white areas are opaque. Gray
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tones vary in transparency accordingly — tones
closer to black are more transparent than tones
closer to white.

Bitmap

If you click on the triangle, a menu opens with
the items Load From Disk and Reread Directory,
as well as a list of all bitmaps in BodyPaint 3D's
'pattern’ folder.

Load From Disk loads a bitmap from a storage
medium. Once you have chosen the bitmap,
BodyPaint 3D will ask if it should be saved to
the 'pattern' folder. If you decline this request,
the bitmap is loaded into memory temporarily
and you can work with it in the usual way.
However, the bitmap is lost the moment you
quit BodyPaint 3D. To prevent this from
happening, agree to the dialog's request
instead.

Reread Directory updates the list of bitmaps.
This is useful is you have copied any bitmaps
to the 'pattern’ folder since launching the
program, as they will appear in the list only
once you have used this command.

Choose any bitmap in the list. It becomes the
new brush tip (as confirmed by the preview) and
its name is shown in the box to the right of the
triangle.

The bitmap brush has fewer settings than the
generic brush — Shape, Profile, Hardness and
Squeeze are all absent. This is because these
properties are defined by the bitmap itself.

The Size, Pressure, Spacing, Jitter and Rotation
parameters have exactly the same effect as with
the generic brush type — please see Generic
Brush Type on page 89 for details.

Filter
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Filters can add effects to the brush such as
painting with watercolors and smudging.

The filters you can choose from are:

Wet Edges

This filter generates a watercolor effect. The
paint stroke is slightly transparent and paint
accumulates at the edges (i.e. the edges are less
transparent than the center).



Smudge

If you activate All Layers, smudging takes all
layers into account. However, note that only the
active layer itself is altered. The Color Mix slider
controls the extent to which the active color/
pattern (i.e. the one in the Color Settings) is
applied to the smudge. If the slider is set to 0%,
no new paint is applied, you smudge the
existing colors only. As you increase the slider's
value, so more and more of the active color/
pattern is applied to the smudge.

In addition, you can activate an effector for the
Color Mix value.

Tip:
Set Spacing to a lower value if the smudge
effect is too coarse. This will produce a softer
effect.
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File Menu

Add Preset

This saves the current brush settings as a brush
preset in the Brush manager. Enter the name for
the brush in the dialog that opens. Also, keep in
mind that it will be easier to change the color
used by the brush if Store Color is not activated.

Close
This closes the Brush Settings dialog.
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The Brush Manager

You can use this manager to access predefined
brushes as well as any brushes you have created
and saved yourself.

We recommend that you use the presets in the
following way: whenever you create a brush that
you feel may be useful later on, save it as a
brush preset. Likewise, save your interesting
colors/patterns as color presets.

When painting, have the Perspective View
(including object to be painted) in one window
and the Color manager in another. Choose a
brush, click on a preset color, then paint in the
Perspective View.

When you want to change pattern, click on the
icon for the new pattern in the Color manager
and paint once more.

If you work in this way, you will move
frequently and swiftly between the two
windows and your object should be painted in
minimal time.

File Menu

New Group

The number of brush presets will grow over time
as you add to them. This function enables you
to create and name groups so that you can store
your presets in a more organised manner.

New

This creates a new preset using the current
parameters in the Brush Settings dialog.

Revert to Default

This function reverts the Brush manager to its
default presets. As a precaution, you will be
prompted for confirmation.

Save As Default

Imagine that you have created some presets.
However, the next time you use BodyPaint 3D,
the new presets are missing. This is because you
neglected to use Save As Default, which saves
the current presets (including their arrangement)
as the default. Do not worry if you are forgetful,
BodyPaint 3D will give you a chance to save the
presets when you quit.

Import

This function enables you to use BodyPaint 3D
brushes created by other artists. When the file

selector opens, choose the BodyPaint 3D file to
add its presets to the Brush manager.

Export Selection

This function enables you to save your
BodyPaint 3D brushes so that other artists can
use them. The file selector will open. Choose a
destination and a filename for the selected
presets (or group of presets). The file takes the
extension 'b3d'. In addition, a folder named
'pattern’ is created for any textures used by
bitmap brushes.

Export Visible

This function exports all visible presets.

Close

This function quits the Brush manager and
closes its window.



Edit Menu

Edit

This function opens the Brush Settings for the
active preset. This has the same effect as
double-clicking on the preset.

Tip:
This changes the active preset directly. This is in
contrast to color presets, which can be changed
without affecting the active preset itself.

Rename

You can use this function to rename the active
preset or the active group.

Duplicate

This duplicates the active preset or the active
group.

Delete

This function deletes the active preset or the
active group.

Group Menu

If you choose All Presets, all brush presets are
displayed.

If you choose a different group from the list,
only the presets belonging to that group are
displayed.

View menu
As List

If this option is selected, the icons are displayed
as a vertical list and their names are specified.
The active icon is indicated by a red frame.
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To change the order of the icons, drag-and-drop
within the list. While you drag, a dark line
indicates where the icon will be moved to if you
release the mouse button.

You can move presets into different groups to
help organise them. To move a preset to a new
group, drag the preset's icon onto the center of
the group icon. The mouse pointer should turn
into an arrow pointing downwards before you
release the mouse button.

The small + icon to the left of the group icon
indicates that the group is closed. To open up
the group, click on the + icon. Once the group is
open, a small - icon appears. Click on this icon
to close the group.

As Icon

If this option is activated, the icons are displayed
in rows and columns rather than as a vertical
list. Also, the names are not shown. Once more,
the active icon is indicated by means of a red
frame.

Small Icons

The preset icons are displayed small.

Medium Icons

The preset icons are displayed medium sized.

Large Icons
The icons are displayed large.
Tip:

You can drag-and-drop to change the order of
the icons.
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Brush Groups

The Brush manager contains over a dozen
groups offering a variety of brush presets. Note
that you need to paint to several material
channels at the same time for a realistic effect. A
brush that paints to more than one material
channel simultaneously is called a MultiBrush
and you will find a selection of such brushes in
the MultiBrushes folder.

If you change any of the brush presets, a dialog
will appear when you quit BodyPaint 3D to
check if you want to save the current brush
presets as the default — click on Yes if you want
to overwrite the old settings. A more cautious
approach is to change duplicates of the original
brushes.

There are two types of brush presets:

- Brushes which paint to the active material
channel only.

- Brushes which paint to several channels
simultaneously (MultiBrushes).

The simplest way to judge the effect of a brush
preset is to try painting with it. For this reason,
only a small number of the presets are described
below.

Oil (soft) [Standard Tools]

This brush simulates a thick oil pencil which
smudges its own color into the existing colors.
This pleasing effect is painted to the active
channel only. The following settings were used
to create the oil pencil:

- Hardness 0%. This creates a very soft
transition between the color and the
background.

- Small Spacing value.

- Smudge filter active. This means that the color
being applied is smudged with the existing
color.

- Low Color Mix value. This ensures that the oil
has color (rather than smudge existing colors
only).



Metal 4 [MultiBrushes > Dosch Texture
Brushes]

This MultiBrush paints to three material channels
simultaneously: color, bump and specular. The
result is similar to rusty metal.

To find out how this effect was achieved, please
examine the individual channels in the multi
channel palette. For example, if you click on the
foreground color for the bump (B) channel, you
will see a texture in the Color Settings dialog
that opens. Click on a different foreground color
(e.g. for the color channel), and you will see a
different texture defined in the Color Settings.
All three channels have their own texture, and
this is what gives the MultiBrush its realistic
quality.
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Beard [MultiBrushes > Organic]

The Organic brush group contains a useful set
of brushes for painting human faces. The Beard
brush paints a beard stubble effect.

It is worthwhile examining the parameters for
this brush: double-click on the Beard preset. The
decisive factor here is the Jitter effector. This
distributes the small brush tip (Size: 1 pixel)
around the brush position using a randomise
function.

This completes our short overview of the brush
groups. We recommend that you test further
brushes and examine their settings. Once you
have done so, you may wish to create your own
MultiBrush — please see the following section.
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Creating your own MultiBrush

In this tutorial, you create a brush that paints as
demonstrated in the example picture below:

The brush paints a rusty red. Not only does it
paint the rust color, it also creates a bumpy,
rust-like surface by painting to the bump
channel simultaneously. The brush itself should
have a soft edge.

To create the brush:

Open the Color Settings and select the multi
channel mode in the Multi Channel Palette
(the brush needs to paint to the color and
bump channels simultaneously) — a green tick
indicates that the mode is active.

Check if there is a small pencil in the C (Color)
channel icon. If you cannot see the pencil, click
in the top right quarter of the icon to make it
appear.

Pick a reddish-brown color (RGB 145, 37, 15).

Load the Granite texture into the Wallpaper
pane using the triangle. (Granite is suitable
since it has a rust-like structure.)

Still in the Wallpaper pane, set the Strength to
100% and the Blending Mode to Multiply.
This blends the granite pattern into the
reddish-brown color.

o Codad Sediisgs M= E
b Fim Edi

L |
—— W% d

[ | e Filter
F ol Tl 1 Wissbuses Pt
. — [
B — [y
e |
i M'i-*ﬂ-l'_Jl "'--g

‘wtalyuire
T o e
| |

- Now for a rusty bump channel: check for a
small pencil in the B (bump) channel icon. If
you cannot see the pencil, click in the top right
quarter of the icon to make it appear. There
are now two pencils in the Multi Channel
Palette, meaning that you can use the current
brush to paint to two channels simultaneously.

- Choose the granite pattern once again and set
the Strength to 100%. This time, set the
Blending Mode to Normal.
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- Move into the Brush Settings and activate
Store Color. The preview updates to
incorporate the rust color and the granite
pattern.

- Set Hardness to about 20% so that the brush
is soft as planned.

- Choose any Size setting you like and set
Pressure to 100%.

- The default Spacing value (20%) is fine.

- Choose File > Add Preset in the Brush Settings,
enter a name for your new brush and then
click on OK.

Congratulations! You've just created and stored
your first multiple channel brush. Try painting
with the new brush preset if you haven't already
done so.

To use the brush at a later date, click on its icon
in the Brush Presets and then paint.

If the effect is less pronounced than in the
picture above, access the Material manager and
increase the material’s Strength setting on the
Bump page.
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8 Layer Manager

The Layer manager is the control center for all
your texture layers. Here, you can create new
layers and layer masks, specify a blending mode
and strength for each layer, change the layer
order and control which layers are visible.
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Tip:

Memory-permitting, you can create and use as
many layers and layer masks as you wish.

Tip:
You can import Photoshop files with layers, layer
masks and alpha channels preserved.

About Layers

A new material channel texture is made up of
just one layer initially, which is called the
Background layer. Think of the Background layer
as your canvas. Just like a real canvas, you can
paint onto the Background layer, and just like a
real canvas, it can be difficult to remove
unwanted effects that you painted some time
ago. The solution to this problem is to use
layers. Layers are like sheets of acetate stacked
above the Background — you can paint onto
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each layer, and where there is no image on a
layer, the layer below shows through. By
painting an effect onto a layer other than the
Background, the effect remains independent
and can be removed at any time by deleting the
layer. You can also select, transform and paint
the layer independently of the Background and
other layers. In addition, each layer has a
Blending Mode and Strength setting, making it
far easier for you to create and adjust effects
than with a single layer.

Managing Layers

Top Area
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This box, which is on the left side of the
manager, shows you the texture's name. This is
the filename if you imported the file; otherwise,
it is the name you gave to the texture when you
created it. All the layers belonging to this
texture are shown in the layers area which
dominates the right half of the manager.

Enable

Select this option if you want to make the active
material editable. All the textures belonging to
the material will be loaded into RAM.
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If you deactivate the option, a dialog will ask if
you want to save the textures. Following this,
the textures will be removed from RAM.

Tip:
The layers in the material channels are displayed
only when Enable is selected.

Strength

You can adjust the active layer's opacity by
using the slider or by entering the required value
into the adjacent input box.

Tip:
You can create interesting blending effects by
using various strength settings with multiple
layers.

Layers / Alphas

These two buttons are mutually exclusive and
they determine what is shown in the layers area
below. Select Layers to show the layers and
layer masks for the active material channel/
texture. If you select Alphas, any alpha channels
in the active material channel/texture are
displayed instead.

Blending Mode

This pop-up menu is located to the right of the
strength setting. It determines how the pixels in
the active layer are blended with the pixels in
the layers below. You can set a different mode
and strength for each layer, giving rise to many
combinations and effects.

The modes you can choose from are:

Normal

This is the default mode. If the strength is set to
100%, the layer is opaque. The lower you set
the value, the more transparent the layer
becomes.

Dissolve

This creates a speckled effect by blending out
small areas of the layer. These areas are chosen
at random and the strength of the effect is
determined by the strength setting.

Difference

With this mode, the resultant color of each pixel
is the difference between the active layer and
the layers below. For example, if the active layer
is red and the layer below is black, the result is
red. This is because black’'s RGB values are 0,0,0,
so the difference corresponds to the active
layer's color (red). You can create interesting
effects by using layers with various colors.

Lighten

BodyPaint 3D compares the brightness values of
the active layer and the layers below (at the
pixel level). Where the active layer is brighter,
there is no blending with the colors below.
Where the active layer is darker, the resultant
color corresponds to the layers below.

Darken

BodyPaint 3D compares the brightness values of
the active layer and the layers below (at the
pixel level). Where the active layer is darker,
there is no blending with the colors below.
Where the active layer is brighter, the resultant
color corresponds to the layers below.



Multiply

The color values of the active layer and the
layers below are multiplied, then divided by pure
white. The effect is always a darkening one. This
can be useful for increasing tonal variation.

Screen

This has the opposite effect of Multiply. Screen
multiplies the inverted color values of the active
layer and the layers below, then divides by pure
white (to invert a value, you subtract it from
pure white). Screen always results in a brighter
color.

Add

The color values of the active layer and the
layers below are added (at the pixel level). So,
for example, if there are three layers containing
red, green and blue, the resultant color is white
(provided that the strength for each layer is set
to 100%).

Exclusion

This blending mode is similar to Difference.
However, it avoids high contrasts.

Tip:
Make a point of experimenting with the
blending modes using a variety of strength
settings. Many effects can be accomplished once
you develop a personal feel for the modes.

Normal/Premultiplied

When you render a picture that includes an
alpha channel, both the bitmap and the alpha
channel are antialiased. If you load one such
rendered bitmap complete with alpha channel
into BodyPaint 3D, the bitmap and alpha
channel will be multiplied in the normal mode.
As a result, the transition from object color to
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background color is calculated twice, potentially
leading to an unattractive discoloring at the
edges. Activate the premultiplied mode to
prevent this from happening. Note that this
option is available only when you are working
with alpha channels.

If an asterisk is shown next to a material
channel’s name, changes have been made since
the texture was last saved.

Textures Area (Left List)

This area shows a list of textures. There are two
display modes for the list, which you can set
from the Layer manager's View menu:

Active Material Channels

This mode lists all material channels relating to
the active material. To open or close layers, click
on the + or - icons respectively. If you click on a
channel instead, all of its layers will appear in
the layers area to the right. If you double-click
on a channel name, the channel is shown in the
Texture view.

All Textures

This lists all the textures stored in RAM, i.e. all
the textures you have used during the current
work session. Even textures belonging to closed
scenes are shown. This mode is ideal for editing
textures that have not yet been assigned to an
object.

Tip:
The Texture View shows the composite image of
the layer stack. If you wish to see the active
layer only, drag-and-drop the layer into the
Texture View.
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The active layer is indicated by a red frame and
red text in both the textures area and the layers
area. To activate a different layer, click on it.
Note that you always paint to the active layer
only.

There is a small eye to the left of each layer's
name. Click on an eye to make its layer visible
or invisible.

There is an option box to the left of each
channel. If this box contains a pencil, the
channel is active and can be edited. Activate the
multi channel mode if you want to select more
than one channel at a time. To activate or
deactivate a channel, click on the box.
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Any alpha channels that exist are represented by
small icons to the right of the layer names. In
the illustrations above, the left icon indicates an
active alpha channel (black circle), the right an
inactive alpha channel (gray circle).

If you activate the Alphas button (top right in
the Layer manager), the alpha channels are
shown as layers in the layers area (see below).
These layers may be activated or deactivated
separately by clicking on the small alpha channel
icon.

Layers Area (Right List)

B

The layers area shows the layers of the active
material channel as a list of icons. Each icon
contains a preview of the layer — a

checkerboard pattern represents transparent
areas.

Any layer masks that exist are shown to the
right of the layers. Note that layer masks use a
small black circle rather than an eye to indicate
their visibility status.

Drag-and-drop Functions

To change a layer’s position in the stack, drag-
and-drop it to the new position — a dark line
appears while you drag to indicate where the
layer will be placed. The following variations are
possible:

- If you drag-and-drop the layer to a new
position within the same channel, the layer is
moved accordingly. However, if you drag-and-
drop the layer to a different channel, the layer
is copied to that channel.

5]

- If you drag-and-drop the layer with Ctrl held
down, the layer is always copied.

%

To copy a layer quickly, hold down Ctrl, drag the
layer a fraction up or down then release the
mouse button. Alternatively, right-click on the
layer and choose Duplicate Layer from the
menu that appears.



You can drag-and-drop a layer or layer mask
(see below) from the textures area to the layers
area and vice versa.

The following variations are possible:

- Drag-and-drop a layer (or layer mask) from the
layers area to the right of a material channel in
the textures area. This defines an alpha
channel for the material channel.

- Drag-and-drop a layer (or layer mask) from the
layers area onto a material channel's name in
the textures area. You can use this method to
move layers from one material channel to
another. If you want to move a copy of the
layer instead, hold down Ctrl while you drag-
and-drop. This is useful for creating similar
channels. For example, you may wish to copy
a layer from the color channel to the bump
channel so that the color and bump match
each other.

- When dragging from the textures area into the
layers area, the variations are similar to those
listed above: if you drag-and-drop to the right
of a layer, a layer mask is created; if you drag-
and-drop below a layer icon, the layer is
inserted there; if you want to move a copy of
the layer, hold down Ctrl while you drag-and-
drop.

Layer Masks

A layer mask is a grayscale image that defines
which areas of a layer are visible: white areas are
visible, black areas are transparent and gray
areas are semi-transparent.

You can, if you wish, use an RGB image as a
layer mask — BodyPaint 3D will convert it into a
grayscale image internally.
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Any layer masks that exist are shown to the
right of the layer icons. You can use the mask
icon on the right to activate or deactivate the
layer mask.

2E
You can edit a layer mask in much the same way
as you would a normal layer: click on the layer

mask icon to activate it, then apply the paint
tools in the Texture View or Perspective View.

M=Kl

You can convert a layer mask into a layer. To do
this, drag-and-drop the layer mask above or
below a layer.

Likewise, you can convert a layer into a layer

mask: drag-and-drop the layer to the right of
another layer. Note that if you hold down Ctrl
while you drag-and-drop, a copy of the layer
becomes the layer mask.
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You can use as many layer masks per layer as
you wish — the grayscale values are added.

Alpha Channel

An alpha channel is, in principle, the same as a
layer mask. However, an alpha channel affects
the composite image (i.e. the channel) rather
than one layer only. Black areas are transparent
in the composite, white areas are completely
opaque and gray areas are semi-transparent.

View Menu

Active Material Channels

This mode lists all the material channels used by
the active material. To change the active
material, click on the required preview in the
Material manager.

All Textures

This displays all the textures stored in RAM, i.e.
all textures you have used during the current
work session. Even textures belonging to closed
scenes are shown. This mode is suitable for
editing textures that have not been assigned to
an object yet.

Tip:

You can remove textures from the list by
choosing File > Close Texture in the Texture
View.

Left List (Textures Area)

No Icons

The list is displayed as text only. This mode
produces the most compact list, hence it may be
useful when you use a large number of layers.

Small Icons
The icons are displayed small.

Medium Icons
The icons are displayed medium sized.

Large Icons
The icons are displayed large.

Right List (Layers Area)
See Left List above.

Close

This function quits the Layer manager and
closes its window.

Channels Menu

The Channels menu enables you to create new
material channels and delete existing material
channels.

If you want to create a new material channel,
open the menu and choose from the list that
appears. Once you have made your choice, a
window opens in which you can define the
channel's parameters (See New Texture on
page 129). Once you have set the parameters
and clicked OK, the window closes and a small
tick appears next to the channel’s name in the
Channels menu.

To delete the channel, select it from the menu
once more.



You can create and assign textures to the
following material channels:

Color
Diffusion
Luminance
Transparency
Reflection
Environment
Bump

Alpha
Specular Color
Displacement

The RayBrush Mode supports the following
material channels:

Color
Diffusion
Luminance
Transparency
Reflection
Bump
Specular Color

The remaining channels can still be edited, but
you must render if you want to see their effect.
For a description of each material channel,
please see Chapter 12, Material Manager, on
page 207.

You can create new material channel textures
using the Channels menu. Consider an
unpainted object that you want to texture. First,
create a new material in the Material manager.
Next, choose the channel you want to assign the
texture to from the Channels menu (Layer
manager).
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Functions Menu
New Layer

L4

This inserts a transparent, visible layer above the
active layer. The new layer is activated
automatically. The maximum number of layers is
limited only by available RAM.

Duplicate Layer

£

This function creates a copy of the active layer.

Delete Layer

=

This deletes the active layer.

Merge Layer Down

5

This function merges the active layer with the
layer below to form a single layer. This frees
RAM and simplifies the layer stack, hence you
should merge layers once you have finished
editing them.

You can select this function only if both the
layers are visible.

Tip:
You can also merge layer masks with this
function. There are two outcomes depending on
whether the layer or the layer mask is active:
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1. Layer Mask Active. The layer mask is merged
with its layer — the masked areas in the layer
become genuinely transparent (rather than
masked) and the layer mask is deleted.

2. Layer Active. The layer mask is merged with
the layer as described in 1. Layer Mask Active.
Next, the layer down is merged with its layer
mask — again, as described in 1. Layer Mask
Active. Finally, the two resultant layers are
merged to form a single layer.

Flatten Visible Layers

F

This function merges all the visible layers to
form a single layer. Invisible layers remain
unchanged.

Flatten Layers

g

This function merges all the layers to form a
single layer. Invisible layers are deleted in the
process and any transparent areas in the
composite are filled with white. The new single
layer is identical in appearance to the preceding
composite in the Layer manager (with the
exception that white will have replaced any
transparent areas).

Add Layer Mask

:

This function creates a layer mask for the active

layer. If there is no selection in the Texture View
when you choose this function, the layer mask is
filled with white; otherwise, the layer mask is

white within the selection and black outside the
selection. In this way, the selection defines
which areas of the layer will be visible.

You can edit a layer mask in much the same way
as you would a normal layer: click on the layer
mask icon to activate it, then apply the paint
tools in the Texture View or Perspective View.

If you want to apply the layer mask
permanently, click on the layer mask with the
right mouse button, then choose Merge Layer
Down from the menu that appears. This crops
the layer.

A layer mask masks only the layer — the layer
itself is not altered.

Add Selection to Layer Mask

This function paints the selection white in the
layer mask. As a result, the corresponding areas
of the layer will be visible.

Subtract Selection from Layer Mask

When you choose this command, the selection
is filled with black in the layer mask. The
corresponding areas of the layer will be
transparent.

Selection from Layer

This creates a selection from the active layer.

ex




The example above shows how the function
was used to select the text. Everything that is
non-transparent is selected.

Selection from Layer (Add)

This function adds all non-transparent areas to
the existing selection.

Selection from Layer (Sub)

This command removes all non-transparent
areas from the existing selection.

New Alpha Channel

If you choose this function, a new alpha channel
is created for the material channel or texture
based on an existing selection. If there is no
selection, the alpha channel is filled with white
— the entire channel will be visible.

Convert to Gray

%

This converts the active channel or the active
texture including all layers into Grayscale (8-
bits).

Convert to RGB

You can use this function to convert the active
channel or the active texture from Grayscale
(8-bits) into RGB (24-bits). Convert to RGB will
not restore color to a black-and-white image,
but it does enable you to paint your own colors
to the channel.

CHAPTER 8 ¢ THE LAYER MANAGER * 115

Bitmap Info

This dialog provides information relating to the
active material channel or the active layer. In
addition, it enables you to change the strength
and blending mode of each layer. Furthermore,
the manager provides information on the size,
memory consumption and color mode
employed.
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To open the Bitmap Info dialog, choose
Window > Painter > Bitmap Info (main menu).
Alternatively, right-click on a material channel or
layer, then choose Bitmap Info from the pop-up
menu that appears.

If the Bitmap Info dialog is already open, you
can change its contents by clicking on a
different material channel or layer.

The Info Area

The small preview (top left) relates to the active
layer and takes all parameters into account apart
from the Blending mode.
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Name

This displays the name of the texture or layer. If
you have imported the file, this will be the
filename; otherwise, it is the name you gave to
the texture when you created it.

Photoshop files are an exception: BodyPaint 3D
imports these files complete with layers and
layer names. Any layers that are unnamed in the
file are given the name 'Layer' or 'Background'.

The Bitmap Info dialog enables you to rename
layers — click on a layer, then type its new name
into the Name box.

Size
This is the texture's size in pixels. If you wish to

change this value, use Painter > Functions >
Texture Size (main menu).

The Parameters Area

Visible

This option box controls the layer's visibility.
Click on the box to make the layer invisible.
Click once more, and the layer is visible again.
This box has the same effect as clicking on the
layer's eye in the Texture manager.

Blending

You can define a blending mode for each layer.
This determines how the active layer influences
the layers below. You can achieve a variety of
effects by using different modes within the layer
stack.

The modes from which you can choose:

Normal
Dissolve
Difference
Lighten
Darken
Multiply
Screen
Add
Exclusion

The blending modes themselves are described in
Blending Mode on page 108.

Strength

The Strength setting defines the layer's opacity.
You can set values from 0% to 100%. If you set
the value to 0%, the layer will be completely
transparent. If you set the value to 100%, the
layer will be completely opaque. Intermediate
values produce a semi-transparent layer.
Exception: transparent areas within the layer
itself do, naturally, remain transparent
regardless.

Offset X/Y

These settings can be used to move the active
layer. Enter offset values (in pixels) into X and Y
— use negative values if you wish to reverse the
direction of the offset.

Alternatively, you can move the layer using the
Move Layer tool (Painter > Tools > Move Layer).

One advantage of using Offset as opposed to
the Move Layer tool is that you can move the
layer back to its original position at any time by
entering a value of zero into both boxes.



Mode

This displays the active layer's color mode. Note
that you cannot change this value — it serves
for information purposes only.

The color mode is defined in the New Texture
dialog when the texture is created. Exception: if
you are using a file, the color mode is defined in
the file itself.

Memory

This box displays the amount of RAM used by
the single layer or complete texture.
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Working with Layers

The following tutorial describes how you might
go about texturing the leaf of an exotic plant.
Please keep in mind throughout that many
alternative approaches are possible.

You will need an exotic leaf for this tutorial, so
please load 'Leaf_1.c4d' from the Examples
folder on the BodyPaint 3D CD-ROM.
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Creating the Material

Create a material and allocate it to the leaf (if
you need help, please see Chapter 5,
BodyPaint 3D Basics). In the Texture dialog that
opens, set Projection to Flat.

In the Object manager, activate the texture tag
you've just created (i.e. click on it) and then
choose Texture > Fit To Object (Object
manager). This ensures that the texture covers
the entire object. Since the leaf consists of two
parts (the leaf itself and a stalk), a dialog opens
to ask if you want sub-objects to be included —
click on the No button.

Still in the Object manager, choose Texture >
Generate UVW Coordinates. Again, click on No
when the dialog asks if you want sub-objects to
be included.

You have just created UV coordinates for the
leaf — you will edit these coordinates later on in
the tutorial.

=]
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Creating a Color Material Channel
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To create the color material channel, activate the
material you created, then choose Channels >
Color in the Layer manager. The New Texture
dialog opens so that you can define parameters
for the new bitmap.

Set Width to 400 pixels, Height to 700 pixels
and ensure that New Texture is active. Click on
the OK button to create a 400x700 color
channel bitmap with a gray background.

Filling the Layer

The next step is to turn the leaf green. First,
double-click on the Background in the Layers
manager. This opens the texture in the Texture
View.

Now you need to define a green color.
In the multi channel palette, click on the
foreground color icon (the top left rectangle) in

the color (C) channel. The Color Settings dialog
opens.
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Ensure that the color mode is set to RGB 0..255
(to change the mode, click on the small triangle
to the left of the Brightness slider and choose a
mode from the list that appears). Set the color
to RGB 91,150,30. Fill the Background layer
with the green color by choosing Edit >

Fill Layer (Texture View).

Note that the Fill Layer command fills the active
layer with the color defined in the Color
Settings. For example, you could have chosen

the color by clicking on a preset color in the
Color manager.



As you can see in the Perspective View, the leaf
is now green. Green it may be, but it doesn't
look particularly real. For one, real-world leaves
do not have uniform color and tone. Your next
task is to introduce some tonal variation.

Ensure that the Background layer is active (it
should have a red frame; if not, click on it) then
choose Functions > New Layer (Layer manager).

The new layer is activated automatically, as
indicated by the red frame. So that you can see

the texture in its entirety, choose View > Fit To
Screen in the Texture View.

e

Painting the Layer

Next, you are going to paint several tones of
green to the new layer using several brush sizes.
First, click on the foreground color icon for the
color channel once more (multi channel palette).

The Color Settings dialog opens — it should
contain the green color still (RGB 91,150,30). To
obtain a new tone, simply move the Brightness
slider to about 95%.

Now, in the Brushes manager, double-click on
the icon named Brush.
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In the Brush Settings dialog that opens, set Size
to about 200.

Before you start to paint with your new brush,
make sure that the Brush tool is active (main
menu: Painter > Tools > Brush).

s

Add dabs of paint by clicking several times in
the Texture View. Notice how soft the edges
are. Try a few more brush sizes and green tones
until your texture looks something like this:




120 » THE LAYER MANAGER ¢ CHAPTER 8

Lapss Manges | ctive Tool | Disscts |
o e Chwrrsh Fureckom

| M - Mbrn_Coodn_1. b3 ™ 2 Ly Alphas
[ Ershi Y | [E _ﬂﬁ.w., =]
B Tk 1=l -

| T, g =
! ' 'Bﬂm'ﬂ

The tones make a big difference, but the leaf is
still rather bland, which is why you are going to
add some yellow to it in just a moment. First,
though, do some 'housekeeping' by merging
the two layers:

Choose Functions > Merge Layer Down (Layer
manager). This frees RAM and simplifies the
layer stack as well.

&

As it transpires, there was no need to create a
second layer for the dabs of paint — you could
have painted the dabs directly onto the
Background layer. However, it is a good idea in
general to use new layers during the creative
process to keep your options open. For example,
with the dabs on a separate layer, you were free
to change their opacity and/or to specify a
particular Blending Mode such as Darken.

Create a new layer (Layer manager: Functions >
New Layer). Click on the foreground color icon
for the color channel (multi channel palette) and
set the color to RGB 204,201,115. Next, fill the
new layer with the yellow color (Texture View:
Edit > Fill Layer).

Once again, the layer is too bland because it is
monotone. Introduce some tonal variation using
the same procedure as before:

- Create a new layer; alter the color brightness;
alter the brush size; apply several dabs; alter
brightness and size several times, applying
dabs each time.

Once you are satisfied with the result, merge
the two yellow layers with Layer manager:
Functions > Merge Layer Down.

Creating the Layer Mask

At this stage, there should be two layers in the
Layer manager: a yellow layer above a green
layer. The final leaf needs to be green but with
yellow edges — this effect can be achieved with
the help of a layer mask.

The layer mask will be applied to the green
layer, which means the green layer must be the
top layer:

Drag the green layer above the yellow layer in
the Layer manager.

Next, you need to create a layer mask for the
green layer based on a selection. Choose the
Select Rectangle tool (main menu: Painter >
Bitmap Selection > Select Rectangle). Click on
the green layer if it isn't already active, then
create a selection in the Texture View similar to
the one depicted below:




Notice how the selection appears in the
Perspective View as well. The selection is not
quite in line with the leaf due to projection
reasons. You will correct this discrepancy later
using the UV tools.

For now, create the layer mask from the
selection using Function > Add Layer Mask
(Layer manager).
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If you look to the right of the green layer in the
Layer manager, you'll notice a new icon for the
layer mask.

The purpose of making the selection before
creating the mask was to define the visible area
of the green layer. Consequently, the composite
image is now a broad, green stripe on a yellow
background.
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Editing the Layer Mask

The transition between green and yellow looks
anything but natural for a leaf. You can achieve
a more realistic transition by editing the layer
mask.

Drag the layer mask from the Layer manager
into the Texture View so that you can edit it
there. The Texture View displays the mask as an
8-bit grayscale image.

Now for the brush: double-click on the icon for
Brush average in the Brushes manager. In the
Brush Settings dialog that opens, set Size to 40
and Hardness to 100%.

Select a white color from the Color manager and
paint several dabs in the transition area.

Now, change the brush size, pick a black color
and paint several more dabs.

Continue applying black and white dabs of
varying size until your layer mask looks
something like this:




122 » THE LAYER MANAGER * CHAPTER 8

The transition area needs to be smoothed — a
blur filter is called for. Ensure that the layer mask
is active, then choose Plugins > BitmapFilter >
Gaussian Blur from the main menu. Set both
the radius values to 40 pixels, then click on OK
to apply the blur effect. Your layer mask should
look as follows:

As you can see in the Perspective View, the
transition is now soft and irregular.

Unfortunately, the texture is slightly out of line
with the leaf. You can correct this by editing the
UV polygons.

Editing the UV Polygons

To make the UV mesh visible, choose Tools >
Show UV Mesh (Texture View). The turquoise
UV mesh should appear. If the mesh is white
rather than turquoise, you have not created UV
coordinates for the leaf.

If your mesh is white (i.e. has no UV
coordinates), click on the texture tag in the
Object manager and choose Texture >

Generate UV Coordinates (Object manager).
The mesh will turn turquoise, indicating that it is
a bona fide UV mesh ready for editing.

The UV mesh needs to be rotated in order to
align the texture with the leaf. Make sure that
you can see the entire texture in the Texture
View (choose View > Fit to Screen if necessary).

Before you can rotate the UV mesh, you need to
select all the UV polygons — choose Tools >
Rectangle Selection (Texture View) then drag a
rectangle over the entire texture.

Do not confuse this selection tool with Select
Rectangle (main menu: Painter > Bitmap
Selection > Select Rectangle ). One tool selects
UV polygons, the other selects bitmap pixels.

The UV polygons are red, indicating that they
are selected. Activate the Rotate tool (Texture
View: Tools > Rotate) and drag to rotate the UV
polygons until they line up with the texture. If
one end of the UV mesh juts out over the
texture, move the UV mesh into place with the
Move tool (Texture View: Tools > Move).

The effect of editing the UV mesh can been
seen in the Perspective View.

The leaf is looking better all the time, but it
might benefit from some yellow at the tip.



Select a brush and change the Size to 50,
Pressure to 40% and Hardness to 0%. Paint
various shades of yellow directly onto the leaf in
the Perspective View until it looks something
like this:

Creating an Alpha Channel

The edges of the leaf are far too regular. In this
section, you are going to use an alpha channel
to snip at the edges.

First, you need a texture for the alpha channel,
so choose Channels > Alpha (Layer manager).
In the New Texture dialog that appears, set
Width and Height to 400 and 700 respectively,
then click on OK to create the alpha channel
texture.

By default, the Background is filled with white
so that the entire object is visible to begin with.

Black areas in the alpha channel texture make
the corresponding areas of the object surface
transparent when rendered.
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Although you can paint to the alpha channel,
the alpha channel itself is only evaluated when
you render. Therefore, do not expect parts of the
object to disappear when you paint the
corresponding pixels black in the alpha channel
— you must render to see the effect.

Double-click on the alpha channel in the Layer
manager. The texture appears in the Texture
View. Ensure that the UV mesh is visible
(Texture View: Tools > Show UV Mesh).

Next, choose a black color and a brush (set Size
to 35, Hardness to 70%) and paint along the
outside of the UV mesh until the texture is
comparable to the right-hand picture above.

Render the Perspective View (main menu:
Render > Render View). This time, the alpha
channel is evaluated and the edges of the leaf
look much more natural.
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To round off for now, allocate the material to
the stalk. Click on OK as soon as the Texture
dialog opens — the exact settings make little
difference in this case.

You may wish to refine the leaf further. Keep in
mind that several other channels can help
enhance the realism. For example, a bump
channel can be used to give the leaf a surface
structure. After all, no leaf is completely smooth.

We would like to thank Frank Vitale for the article which inspired this
tutorial.
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In contrast to the Perspective View, the Texture
View enables you to view and edit textures in
two dimensions.

Painting an object in the Perspective View is not
always the best option. Consider a sphere that
you wish to embellish with a flower pattern
around its entire equator. If you decide to paint
the ring of flowers in the Perspective View,
you'll need to rotate the sphere in the process,
since you cannot see all of its surface from any
one position. In this case, it is much easier to
paint in the Texture View, where the texture can
be shown in its entirety in two dimensions.

There are two ways to open a texture in the
Texture View:

- You can create a new texture or load an
existing texture via the Texture View's File
menu.
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- You can open an existing material channel by
double-clicking on the channel in the Layer
Manager. Alternatively, drag-and-drop the
channel into the Texture View. If you wish to
open a single layer instead of the entire
channel, drag-and-drop the layer into the
Texture View.

You can paint to the texture as soon as it
appears in the window. Note that you paint
exclusively to the active layers of the active
channels — each active layer is indicated by a
red frame in the Layer manager textures area
(Left List); each active channel is indicated by a
pencil icon in the Multi Channel Palette.

The Texture View can display only one channel
at a time. Bear in mind when using a
multi-channel brush (i.e. a brush that paints to
more than one material channel) that you will
be painting to channels in addition to the one
shown in the Texture View.

Another reason for having a Texture View is the
integrated UV Editor, which enables you to view
and edit an object’s UV mesh in two dimensions.
See UV Editor on page 134 for details on this
powerful module.

What are Textures?

The textures used by BodyPaint 3D are, without
exception, bitmaps. A bitmap represents an
image by means of a grid of small squares called
pixels. Each pixel has its own color and its own
position in the grid.
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The bitmap's picture quality and its size in bytes
(i.e. how much storage space it requires) are
affected by its dimensions, resolution, color
depth and the data compression method
employed.

The RGB color model is the most common way
in which colors are defined in the computer
world. The RGB color model defines colors in
terms of red, green and blue brightness
components. These components are combined
to form a particular color.

The term 'True Color' refers to 256 brightness
values per color component. The value of 256
was not chosen at random. It arises because
with True Color each color component is
specified in a computer byte. Since a byte is
composed of 8 bits, the total number of
possibilities per color component is 28 bits =
256. Therefore, a color component may have
any integer value between 0 (no brightness) and
255 (full brightness) inclusive.

Each True Color pixel requires 24 bits of storage
space (8 bits x 3 color components). It follows,
then, that a True Color image of size 600 x 600
pixels requires 600 x 600 x 24 bits = 8,640,000
bits of storage space, which is about 1 MB
(8640000 bits / 8 = 1080000 bytes / 1024 =
1054 KB / 1024 = 1.03 MB).

Compression formats such as JPEG enable the
bitmap to be saved to a storage medium with a
much-reduced file size. However, some image
quality is lost in the process unless something
called a 'non-lossy' compressor is used.

Compressed files may reduce the strain on your
hard disk, but do not make the common mistake
of thinking that a compressed file takes up less
space in BodyPaint 3D than an equivalent
uncompressed file. BodyPaint 3D always works

with bitmaps and so a 600 x 600 JPEG takes up
just as much RAM as, say, an uncompressed
colour TIFF image of the same dimensions.

In addition to the three color components,
bitmaps may also have an alpha channel. This is
usually an integrated 8-bit grayscale image that
is used for masking purposes. If you load such a
bitmap into BodyPaint 3D, the alpha channel
will be implemented as a layer mask.

You can paint finer details to your object if you
use a bigger texture (i.e. a texture with more
pixels). Consider an animation which zooms in
for a close-up of stubble on a chin — a relatively
large texture is called for so that individual hair
stubs can be shown.

The main disadvantage of larger textures is that
they consume more RAM. The demand on RAM
increases sharply if you use the RayBrush mode
in conjunction with multiple material channels.
Avoid encumbering your system — let the needs
of the day dictate the size of your textures.



File Menu

New Texture
=

The following window opens when you choose
New Texture:
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You can now do one of two things: you can
either create a new texture (specify the
dimensions, color mode, etc.), or you can load
an existing texture from a storage medium (e.g.
hard disk).

New Texture

You can type a name for your texture into the
top input box. This name will be used to refer to
the texture in the Layer manager and it is also
used to form the filename when you save the
texture (although you may opt to specify a
different filename at save time).
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Width, Height

These fields define the width and height of your
new texture. Select the unit of measurement
using the pop-up menus to the right. You can
choose between pixels (the default), inches and
cm.

Resolution

In most cases, the default resolution of
72 pixels/inch (dpi) is appropriate, since this is
the resolution used by most monitors.

Exception: you may need to change the default
resolution if you wish to print out the texture
and you have specified the dimensions (Width
and Height) in inches or cm.

Mode

This is where you establish the color mode for
the texture — either RGB 24 Bit (3 Byte/Pixel)
or Grayscale 8 Bit (1 Byte/Pixel).

Color

This defines the texture's background color. You
can choose one of four options:

Background
The current background color is used.

Foreground
The current foreground color is applied.

Color

To choose any color you like, click on the color
selector box to the right of the pop-up. The
color dialog native to your operating system
opens. Pick the color you wish to be used as the
texture's background color. Note that the pop-
up changes to Color automatically if it is not
already selected — there is no need to set the
pop-up manually.
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Transparent

This allocates a transparent background to the
texture.

The Max. Memory/Layer value, near the
bottom of the window, informs you of the
maximum amount of memory that will be
required per layer.

Once you have set the parameters as required,
click on OK to create the new texture. The
window will close and the new texture will
appear in the Texture View.

Allocating a Texture to a Material Channel

There are two ways to allocate a texture to a
material channel:

- Double-click on the material in the Material
manager. In the Material dialog that opens,
activate the material channel you want to
allocate the texture to. Next, click on the
triangle to the right of the Image button. From
the menu that opens, choose the texture from
the Bitmaps sub-menu. Note that the bitmaps
list shows all textures stored in RAM.

- When you create a new material channel in
the Layer Manager, the New Texture dialog
opens. Select the From Disk option, then enter
the name of the texture into the box to the
right of the Name button. Click on OK.

Open Texture
=

T

A dialog opens when you select this command.
Use the dialog to select the bitmap file you wish
to load. You can use the following formats as
textures in BodyPaint 3D: B3D (the native
BodyPaint 3D file format), PSD (Photoshop files

including all layers), TIFF, PICT, BMP, JPEG,
TARGA, IFF-ILBM. Please see the Appendices
for further details.

Note:

Although you can open a QuickTime or AVI
movie, you cannot paint it. Also, please note
when editing loaded scenes: you cannot paint
materials that contain animation (movies,
picture sequences).

Revert to Saved

e

This function reverts the current texture to its
last saved state. Any changes made to the
texture since it was last saved will be lost, hence
a dialog you ask you to confirm the action.

Close Texture
2

This removes the active texture from RAM. If
the texture's current state has not been saved, a
dialog will appear to offer you the chance to
save the texture. This safety measure should
ensure that you do not delete textures by
accident.

Close All Textures

This command closes all textures and removes
them from RAM. A dialog will request
confirmation.

As a precaution, you should use this command
before you render to the Picture Viewer. This is
because BodyPaint 3D can render to the Picture



Viewer only if all of the scene’s textures have
been removed from RAM. For example, you
cannot leave a texture open in the Texture View
and have it rendered to the Picture manager as
well.

Save Texture

e

This command will save your texture without a
dialog appearing. That is, unless you are saving
the texture for the first time, in which case a
dialog opens so that you can specify the
filename and the folder you wish to write the
file to.

Save Texture as

i

A small window will open when you select this
command.
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Use the drop-down menu to specify the
texture's file format. Your choice is:
B3D (BodyPaint 3D's native format)

PSD (Photoshop files complete with layers), TIFF,
PICT, BMP, JPEG, TARGA, IFF as well as any formats
installed on your system under QuickTime.
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Once you have chosen the file format and
clicked OK, a dialog will open so that you can
specify the filename and the folder you wish to
write the file to.

Note that textures are saved separately from
scenes in BodyPaint 3D. Ensure that you save
the textures to the same folder as the scene they
belong to, otherwise BodyPaint 3D will be
unable to access the textures the next time you
load the scene. The scene itself can be saved
using File > Save as from the main menu.

For further details, see BodyPaint 3D Basics on
page 69.

Save Texture as Copy

s

You can use this function to save a copy of the
current texture. Note that the current texture's
name in RAM and in the material channel is not
changed in the process. This is in contrast to
Save Texture as.

Save All Textures

P

Use this command to save all the textures in one
go. However, if any of the textures are being
saved for the first time, the following process is
repeated for each new texture:

1. A small dialog opens. Use the dialog's pop-up
menu to specify the file format for the texture
and then click on OK.

2. A dialog will open so that you can specify the
filename and the folder you wish to write the
file to.
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Close

This closes the Texture View window. The
textures themselves remain in RAM and may still
be accessed via the Layer manager. For
example, if you double-click on a texture in the
Layer manager, the Texture View will open
again to display the texture.

Edit Menu

Undo
)

This command reverses the last change you
made. You can select Undo repeatedly to
reverse the changes one by one. By default, you
can undo a maximum of 10 changes. You can,
however, set your own Undo Depth value in the
General Settings (choose Edit > General Settings
from the main menu).

Tip:

The Edit > Undo (Texture) function on the main
menu relates to texture changes, such as paint
strokes and filter effects, only. Note that this
command will not undo UV polygon
movements.

Redo
~y

Redo undoes an undo, i.e. it restores the last
change that was undone (see Undo above). You
can select Redo repeatedly to continue restoring
the changes. You can redo up to 10 changes by
default. Since you cannot redo more than you
have undone, there is no separate setting for the
redo depth in the General Settings.



Cut
Ha

If there is no selection in the Texture View, this
function is ghosted and cannot be selected.
Otherwise, it cuts the selected pixels from the
active layer and copies them to the clipboard.

Copy

If you have made a selection in the Texture
View, this function copies the selected pixels in
the active layer to the clipboard.

Copy Merged

In contrast to Copy, this function merges all
visible layers into a single layer internally. The
selection is then applied to the merged layer and
the resultant pixel selection is copied to the
clipboard. Invisible layers are ignored in the
process.

Paste

This command creates a new layer in the active
material channel/texture. Next, the clipboard’s
contents are copied to the new layer in their

original position when cut or copied to the
clipboard (see Cut and Copy above).
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Paste into Selection

When you choose this command, a new layer
and layer mask is created. The clipboard'’s
contents are pasted into the new layer and the
selection is used to define the layer mask. The
layer mask hides areas outside the selection so,
in effect, you have pasted into the selection but
you have the added benefit of an editable mask.

Delete
ﬂ.k

This deletes the selected contents of the current
layer. In contrast to the similar Cut command,
the contents are not copied to the clipboard in
the process.

Fill Layer

o

If you choose Fill Layer the selection is filled
with the active color in the Color Chooser. If, on
the other hand, no pixels are selected at the
time of the function call, the entire layer will be

filled — again with the active color in the Color
Chooser.
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Select All
P

All the pixels in the current layer are selected
when you choose this command.

Deselect All
s

This command ensures that all pixels are
deselected.

If, at any time, you are unable to paint to a layer
for no apparent reason, try the Deselect All
command. This may resolve the problem, since a
selection may have escaped your attention;
pixels outside a selection are masked
automatically and hence cannot be painted to.

Invert Selection

When you choose Invert Selection, the selected
pixels become deselected and, at the same time,
deselected pixels become selected. In other
words, the selection is inverted.

This can help to simplify the selection process at
times, offering an indirect approach. For
example, imagine that you wish to select a
parachutist and, conveniently, the parachutist is
surrounded by clear, blue sky. Simply select the
sky with the Magic Wand and then invert the
selection.

Tools Menu

The UV Editor - Introduction

The UV Editor enables you to adjust the way in
which a texture is mapped to an object. For this
to be possible, the object must have UV
coordinates (BodyPaint 3D can generate them if
required) and the texture must use UVW
Mapping.

Two important advantages of UVW Mapping
are:

1.UVW Mapping prevents texture slippage so
that whenever you deform an object (e.g. a
flag in the wind), the texture follows suit.

2.UVW Mapping, in conjunction with the
UV Editor, offers the most advanced way to
paint your textures. You can see and edit the
UV mesh in two dimensions. You can select the
UV polygons that constitute the UV mesh and
move, scale and rotate them as required.

For example, imagine that you are using a
relatively small texture for a male face. After
deliberation, you decide to add a moustache.

However, the UV polygons are too small (i.e.
cover too few texture pixels) to obtain the detail
required for hair. One solution is to select the
UV polygons in question, move them to an
unused part of the texture and scale them up.
The UV polygons will then cover more texture
pixels, enabling you to paint more detail than
you could in their previous position.

What is a UV Mesh?

If your object has UV coordinates, a UV polygon
is assigned to each object polygon. The UV
polygons have their own independent
coordinates and together they form a UV mesh.



What shall | do if the object has no UV
coordinates?

1.First of all, ensure that your object is editable
i.e. made of polygons (as opposed to
parametric). If you have imported your object,
this will always be the case but if you are using
BodyPaint 3D with CINEMA 4D and have
started, say, with a simple, parametric cube
you will need to apply Structure > Make
Editable.

2.Create a new material in the Material manager
with a suitable texture.

3.Drag-and-drop the new material onto your
object. The Texture dialog will open. Choose
the most relevant Projection setting (see the
Material manager chapter if you need help —
if you're still not sure which type to use, opt
for Spherical Mapping, which wraps the
texture around the entire object in the shape of
a sphere).

4.1n the Object manager, click on the object's
texture tag to activate the texture. Next,
allocate UV coordinates to the object by
selecting Texture > Generate UVW
Coordinates from the Object manager menu.

5.Now that your object has UV coordinates, go
to the Layer manager, with your material
selected, and check Enabled. Move into the
Texture View, choose your texture from the
Textures menu and activate Tools > Show UV
Mesh. The two-dimensional, turquoise UV
mesh should appear.

When setting up a texture on an object,
consider the projection mode quite carefully.
The example pictures below show two cubes
with UV coordinates. One UV mesh was derived
from Spherical Mapping, the other from Cubic
Mapping.
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ABC

The Perspective View and the Texture View for a cube with
spherical mapping and some selected object polygons

ABC

The Perspective View and the Texture View for a cube with
cubic mapping and some selected object polygons

Note how each polygon is allocated its own UV
polygon in the Spherical Mapping example. As a
result, you can paint each side of the cube
separately. In this respect, Spherical Mapping is
the next best projection setting after UVW
Mapping.

In the second picture (Cubic Mapping), you can
see that there are no separate UV polygons; the
sides cannot be painted separately, because the
texture has been applied six times — once to
each side. Any stroke that is applied to one side
is applied to the other sides automatically.

However, one of the disadvantages of Spherical
Mapping is all too apparent in the example: the
UV mesh is particularly distorted near the top
and bottom. These areas are at the poles of the
spherical projection.
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This distortion is caused by the fundamental
principle of projection: a two-dimensional
surface (texture) must be placed onto a 3D
spatial object. Distortion is inevitable. Think of
trying to wrap your child's favorite Pokemon™
sticker around a baseball!

Maps of the world face the same problem. For
example, Greenland appears to be larger than
the United States on a map. In reality, the United
States is more than three times larger than
Greenland.

Distortion arises automatically when a sphere’s
surface (such as that of the Earth) is represented
in two dimensions.

Nonetheless, you can paint your object free of

distortion using Functions > Optimal Mapping
(see page 147). This attempts an optimal fitting
of the UV mesh.

Show UV Mesh
cﬁi"

You can use this option to turn on or turn off
the display of UV mesh in the Texture View. The
UV mesh is usually turquoise in color, indicating
that it can be edited.

If the UV mesh is white instead, it cannot be
edited because the object lacks UV coordinates.
In this case the UV mesh is merely a preview
and, although you can select polygons, you will
be unable to edit them. To obtain an editable
UV mesh, select the texture's tag in the Object
manager and choose Texture > Generate UVW
Coordinates from the Object manager. The UV
mesh should change color to turquoise.

The following rules apply when Show UV Mesh
is active:

1. If you select a UVW Coordinates tag in the
Object manager, the UV mesh is shown and
can be edited.

2. If you choose a Texture tag in the Object
manager which uses a projection setting
other than UVW Mapping, the corresponding
UV mesh is shown in white and cannot be
edited.

3. If you click on a Texture tag which uses UVW
Mapping but for which there is no UVW
Coordinates tag, no UV mesh is shown.

There are two modes for editing a UV mesh:
Edit Points and Edit Polygons.

Edit Points

el

With Edit Points, the UV coordinates are
displayed as points which you can select and
modify using the tools described in the
following pages.

If you select points in the Perspective View, the
corresponding points in the Texture View
become selected as well. However, the converse
does not apply; selecting points in the Texture
View does not affect point selection in the
Perspective View.

The reason why points are not linked is that UV
polygons do not share points, whereas the
object's polygons do. Each UV polygon has four
independent points. As a result, UV polygons
can be moved, scaled and rotated without
affecting neighbouring UV polygons.



Edit Polygons
‘o

This is one of two modes for editing the UV
mesh. The other mode, Edit Points, is described
above.

Edit Polygons is the default mode and it enables
you to select and modify UV polygons using the
tools described in the following sections.

Selecting UV Points or UV
Polygons

You must activate Show UV Mesh before you
can make a selection.

UV polygon selection is linked to polygon
selection. In other words, if you select UV
polygons in the Texture View, the object’s
associated polygons will be selected in the
Perspective View (provided that the Polygons
Tool is active). The reverse applies also.

With regard to all the selections tools: hold
down Shift to add to an existing selection; hold
down Ctrl to subtract from an existing selection.

Selected points or polygons are colored red.

The selection tools you can choose from are
now discussed. Note that the icons for these are
found to the right of the Texture View.
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Live Selection

The Live Selection tool in action, with a large brush

To use this selection tool, hold down the mouse
button and drag over the UV points/polygons
you wish to select. You may prefer to think of
this tool as a brush which selects UV points/
polygons by painting over them.

Options in the Active Tool manager
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The Live setting determines the diameter of the
Live Selection. Returning to the brush analogy
above, it may help you to think of the Live
setting as the brush diameter. You can set values
between 0% and 10%.
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Rectangle Selection Polygon Selection

Rectangle Selection in action Polygon Selection in action

The Polygon Selection tool enables you to draw
a polygon around UV points/polygons in order
to select them. Your first mouse click creates the
starting point and subsequent clicks create new
Options in the Active Tool manager corner points. To complete the selection, either
click on the starting point or click the right
mouse button (Macintosh: hold down the
Command key while clicking).

To make a selection using this tool, hold down
the mouse button and drag a rectangle over the
UV points/polygons you wish to select.

Options in the Active Tool manager

If Tolerant is active, all UV points/polygons that
are inside the marquee or intersected by the
marquee are selected.

If Tolerant is inactive, only the UV points/
polygons that are fully enclosed by the marquee  The Tolerant option has the same effect as

are selected. described for the Rectangle Selection tool,
above.



Free Selection

%

Free Selection in action

With this tool, you select UV points/polygons by
holding down the mouse button while you draw
a loop (a lasso) around the polygons. To
complete the selection, release the mouse
button. The two ends of the loop are joined
automatically.

Options in the Active Tool manager
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The Tolerant option has the same effect as
described for the Rectangle Selection tool,
above.
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Editing UV Polygons

The key to editing UV polygons effectively is to
understand how they relate to polygons of the
object to which the texture is applied (termed
object polygons below for reasons of clarity).

Each object polygon is represented by a UV
polygon, so the number of UV polygons equals
the number of object polygons. If you delete an
object polygon, its UV polygon is also deleted.

A UV polygon determines which part of a
texture is mapped to the object polygon it
represents. The UV polygon is otherwise
independent and can be moved, scaled and
rotated.

In other words, no matter how you move, scale
and rotate the UV polygon, the position, size
and direction of the object polygon remains
unchanged. All that changes is the part of the
texture that is mapped to the object polygon.

For example, imagine that a UV polygon is
currently over a black area of the texture. As a
result, the object polygon it represents is black.
Next you move the UV polygon to a red area of
the texture. The object polygon itself is not
moved, but it now receives the red part of the
texture, and changes color.

To see textures directly in the Perspective View,
activate the Textures option from the Display
menu and choose a suitable shading mode (i.e.
Gouraud Shading or Quick Shading).

You can, if you wish, place UV polygons on top
of one another. In theory, all UV polygons can
occupy the same part of a texture. In this case,
every object polygon would receive the same
part of the texture.
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This concept is explored in the following
examples.

First consider a 2x2 plane which has a texture
consisting of the letters A, B and C but with its
UV polys edited so that they are all over the A.

Perspective View: plane (2x2) with 4 polygons. Its texture
contains letters A, B and C, but all the UV polys for the texture
are over the A, as shown below. So the plane shows just As.
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Texture View: The texture that is applied to the plane, above.
A top left, B bottom right, C bottom left. All four UV polys are
over the A.

To obtain the next example, all four UV
polygons were placed over the A, then one of
the UV polygons was scaled, rotated and moved
over the B.

Perspective View: plane (2x2) with 4 polygons. Its texture
contains the letters A, B and C. 3 UV polys are over the A. The
fourth UV poly has been scaled, rotated and placed over the
letter B.
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Texture View: The texture that is applied to the plane, above.
3 UV polys over the A. The fourth UV poly has been rotated,
scaled and placed over the B.




The next two pictures highlight the flexibility
offered by UV editing.

Perspective View: a plane (9x5) showing “BODYPAINT 3D".
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Texture View: the texture is the alphabet with its UV mesh
edited so that '‘BODYPAINT 3D’ appears in the Perspective
View. At the top right you can see the ‘unused’ UV polys.

The bottom picture shows how the UV mesh
has been edited to arrive at the required result.
First, the UV mesh, which originally covered the
entire texture, has been scaled down and moved
to an empty, black, area of the texture.
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The UV polygons of the second row have each
been scaled back up and placed over the
required letter to spell out 'BODYPAINT" while
two polys from the fourth row have been scaled
up and placed over the '3' and the 'D".

Other UV Tools

You can use the following UV tools to edit UV
points or UV polygons. In the description of
each tool, only the effect on UV polygons is
described, for clarity. The effect on UV points is
exactly the same unless otherwise stated.

Move
You can use this tool to move the selected UV
polygons: click anywhere in the Texture View

and hold down the mouse button while you
move the mouse.

Options in the Active Tool manager

Options Tab
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Keep Face Neighbors

If Keep Face Neighbors is active, the selected
UV polygons remain attached to adjacent UV
polygons (neighbors). You can still move the
selection freely, but the adjacent UV polygons
will distort to accommodate the move. This is, in
principle, similar to moving object polygons in
the Perspective View.
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Clip UV Coordinates (0..1)

When active, this option prevents you from
placing UV polygons outside the texture. This is
achieved internally by restricting the UV
coordinates to values between 0 and 1. If you
try to move the UV polygons outside the
texture, they will squash against the edge.

Magnet

If the Magnet option is enabled, UV polygons
outside the selection (but within the Distance
value of the selection) are pulled along when
the selection is moved. The further away a UV
polygon is from the selection, the weaker the
pull.

There is a Magnet tab to control this option.

Tip:
Do not confuse the Magnet option with the
Magnet tool. The Magnet option relates to the
Move tool, whereas the Magnet tool is a tool in
its own right.

Snapping Tab
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The Snapping options determine whether the
UV polygons you move snap to other UV
polygons. A cross will appear in a corner of one
of the selected UV polygons according to where
you click with the mouse. Keep the mouse
button held down and move the cross to move
the selection. If the Point option is active, the
cross will snap to UV points. If Edge is enabled,
the cross snaps to UV edges.

Point and Edge can be activated at the same
time. Point snapping takes priority.

Radius determines how close the cross must be
to a point or edge before it snaps to it. You can
set Radius to a value between 0% and 10%. If
you set it to the maximum value of 10%, free
movement will be limited severely as the cross
snaps from one point or edge to the next.

The Quantize options offer further ways to
restrict movement. If you activate the Move
option (or Scale or Rotate for the other tools),
you will only be able to move the selected UV
polygons in steps of the value entered. For
example, if the value is set to 10%, the distance
between each step corresponds to 10% of the
texture's width or height.

Taking this example further, if the texture is 300
pixels wide and 500 pixels high, the UV
polygons can be moved 30 pixels horizontally
and 50 pixels vertically, in this case.

Colors tab
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You can use this tab to assign any color you like
to each of the following mesh elements:

- Ghosted Polygons
- Inactive Polygons
- Active Polygons

- Inactive Points

- Active Points



To change the color for an element, click on its
color field and pick the color using the dialog
that appears.

Uniform Scale

&

This function scales the selected UV polygons
uniformly about their common centre, which is
represented by a cross.

If you have selected a single UV point instead of
a UV polygon, you will be unable to scale since
UV points have no spatial dimensions. You can
only scale if at least two UV points are selected,
in which case they will be scaled from their
centre of gravity.
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Scaling a grid of 5x5 points (showing the cross that represents
the common centre)
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Options in the Active Tool manager

The same options apply as for Move with one
exception; the Point and Edge snapping options
have no effect.

The Scale option under Quantize has the
following advantage: you can scale a UV
polygon safe in the knowledge that you can
return it to its exact original size later on.

Non-Uniform Scale

o

Non-uniform scaling works as described above
(for Uniform scaling), with the exception that
scaling is not uniform and instead takes place in
the direction in which you drag with the mouse
button held down.

Options in the Active Tool manager

The same options apply as for Move with the
exception that the Point and Edge snapping
options have no effect.

Rotate
&

This tool rotates the selected UV polygons about
their common centre: click anywhere in the
Texture View and drag horizontally with the
mouse button held down.

Options in the Active Tool manager

The same options apply as for Move with the
exception that the Point and Edge snapping
options have no effect.
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Shear U, Shear V
H &

Shear the selected UV polygons about their
common centre. You can shear horizontally
(Shear U) or vertically (Shear V).
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An example of using Shear U.
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An example of using Shear V.

Options in the Active Tool manager

The same options apply as for Move with the
exception that the Point and Edge snapping
options have no effect.

Magnet
¥

This tool distorts the UV mesh. If a selection is
active, only the selected UV polygons are
distorted. If no UV polygons are selected, all UV
polygons within the magnet's sphere of
influence are distorted.

Click anywhere on the UV mesh and move the
mouse with the mouse button held down. The
UV coordinates follow the mouse pointer. The
further away a UV coordinate is from the mouse
pointer, the less the Magnet pulls on it.

Options in the Active Tool manager

Nearest Point Method

If this function is inactive (the default), the
Magnet will only deform if you click directly on
a UV polygon. If the option is active, the
Magnet will deform no matter where you click.
In this case, the nearest UV point is chosen as
the centre of the deformation.

Radius

This is where you define the magnet's sphere of
influence.
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Type
You can choose one of six fall-off functions,
shown below.

Constant

Linear

This parameter determines how hard or soft the
magnet's sphere of influence is.
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Functions Menu

Bake UV

This function bakes the current UV coordinates.
In other words, it saves the current positions of
the UV coordinates. You can restore the baked
coordinates at any time using Restore UV and
Remap, which are described below.

Restore UV

This restores the UV mesh to its last baked state,
i.e. the UV coordinates are reset to their
positions when Bake UV (see above) was last
called. In this way, you can experiment with the
UV mesh safe in the knowledge that you may
revert to its original state at any time.

Remap

Until now, all you have edited in the UV Editor
are UV polygons and UV points. This function
allows you to edit the bitmap itself.

First, bake the UV coordinates (Functions >
Bake UV). Next, select the UV polygons that are
above the part of the texture you wish to move.
Move the selected UV polygons to an empty
part of the texture. If you call Remap now, the
bitmap will be copied (or cut and pasted) from
the original position of the UV polygons to their
new position.

The following window opens when you select
Remap:
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The list on the left side of the window
represents all the material channels — activate
the channels to which you wish the Remap
function to be applied. If you activate the Cut
option on the right side of the window, the
bitmap will be cut rather than copied from the
original position of the UV polygons.

Finally, there is a pop-up menu called
Oversampling. If you scale up a UV polygon
before using Remap, the corresponding part of
the bitmap is scaled up too and is interpolated
according to the Oversampling value.
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Perspective View with a polygon (over the ‘C’) selected.
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The polygon has been moved and scaled up without the cut
option.
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The polygon has been moved and scaled up with the cut
option active.

Tip:
Remap enables you to move and scale part of
the texture so that finer details can be added.
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Optimal Mapping

This is, without doubt, one of the Texture
View's most advanced functions. It attempts to
optimize the UV mapping with the help of the
polygon object. It aims to prevent parts of the
UV mesh from overlapping, which would soon
be the case with complicated objects.

In addition, groups of UV polygons are placed a
specified distance apart and are arranged so that
they make full use of the texture surface.

In this section, polygons from a model are
referred to as object polygons to help
distinguish them clearly from UV polygons.

The function carries out the following steps on
the selected UV polygons:

1. First, the algorithm attempts to sort the UV
polygons into groups. This is achieved by
comparing the surface normals of adjacent
object polygons. Provided that the angle
difference does not exceed a certain user-
defined value, the associated UV polygons are
defined as a group.

2. New UV coordinates are calculated for each
group with the assistance of a flat projection
projected from the common centre in the
direction of the average surface normal.

3. Each UV polygon group is rotated horizontally
until it occupies the smallest amount of texture
possible. This step can add noticeably to the
processing time.

4. BodyPaint 3D tries to arrange the UV polygon
groups by size, placing the largest groups in
the top left of the texture and the smallest
groups in the bottom right. In this way, as little
texture space is wasted as possible.

This makes the painting process much easier,
since the brush size will remain constant over all
parts of the object.
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The example shows a cube with Optimal
Mapping applied.

A cube in the Perspective View
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The optimized mapping for the cube

A dialog opens when you select the Optimal
Mapping command.
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Preserve Orientation

If you activate this option, the algorithm does
not attempt to arrange each UV polygon group
in the optimum horizontal direction. This saves
processing time.

Stretch to Fit

When this option is activated, the UV polygon
groups are stretched in the U and V directions
so that they cover the entire bitmap while taking
the Spacing value into account.

Maximum Distortion

Remember that Optimal Mapping arranges the
UV mesh into UV polygon groups based on the
object polygons. If the difference in angle
between the surface normals of two connected
object polygons is less than or equal to the
Maximum Distortion value, the associated UV
polygons are placed into the same UV polygon
group; otherwise, they are placed into different
groups.

In general, enter a relatively small value in the
field, otherwise the changes to the UV mapping
will be minor. Lower values produce more UV
polygon groups. The lowest value (0%)
separates each UV polygon from its neighbors.
A value of 100% corresponds to 90° difference
in angle, 50% corresponds to 45° and so on.



Spacing

Spacing determines how far apart the UV
polygon groups are placed from one another. In
general, enter a relatively small value, otherwise
the UV polygons will be scaled down to make
space for the gaps.

Note:

Naturally optimal mapping can never be perfect,
only an approximation. Do not lose heart if the
first call to the function does not bring about the
result you had in mind. Try different settings —
even a small change to the Maximum Distortion
value can have a dramatic effect on the UV
mesh.

Fit Canvas To UV

When you move UV polygons in the Texture
View, you are free to place them outside the
texture. Exactly what is mapped to the
associated polygons depends on the object’s
Texture tag: if Tile is active, the texture is tiled;
otherwise, nothing (neutral gray) is mapped to
the polygons.

More often than not, though, the reason you'll
move UV polygons outside the texture is
because you need extra texture space. In this
case, choose Functions > Fit Canvas To UV —
the texture's size will change accordingly. The
new texture pixels will be filled with the
background color.

Clear UV

This deletes the selected UV polygons. The
associated object polygons will adopt the
material's background color.
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Mirror U
oo

You can use this function to mirror the selected
UV polygons horizontally. The mirror axis runs
through the common centre of the UV

polygons.
Mirror V

This function mirrors the selected UV polygons
vertically. The mirror axis runs through the
common centre of the UV polygons.

Transform
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Transform enables you to move, scale and rotate
the selected UV polygons with precision. When
you select the function, the Transform dialog
opens. Enter numerical values under Position,
Scale and Rotate and the UV polygons will be
adjusted accordingly.

The X and Y fields under Position specify the
distance the UV polygons are to be moved in
pixels. Enter negative values if you wish to move
the selection in the negative U or V direction. X
represents the horizontal movement (U), Y the
vertical movement (-V1).
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To scale the selection, set the required values in
the Scale column. X scales in the horizontal
direction, Y in the vertical direction. Set X and Y
to the same value for uniform scaling. Values
below 1 shrink the selected UV polygons, values
above 1 enlarge them.

Finally, enter a value in the Angle field below
Rotation to rotate the selection.

Tip:

Enter values under all three columns to move,
scale and rotate the selected UV polygons in one
function call.

Start Interactive Mapping

This function offers a simple way to alter the
mapping for the selected UV polygons. For
example, imagine that you wish to change the
mapping for the left ear of a head mesh. First,
select the UV polygons for the left ear. Next,
select the Start Interactive Mapping function.
The following happens:

- A Texture dialog opens which relates to either
the active Texture tag or the Texture tag
belonging to the active UVW tag. You can
change any of the mapping parameters. By
default, the projection changes from UVW
Mapping to Flat. In most cases, this is the best
setting. However, you can choose your own
projection setting if you wish.

- Click on OK in the Texture dialog. The dialog
closes and the chosen mapping method is
applied. At the same time, the Texture Axis
tool is activated. To move the texture axis, click
in the Perspective View and drag with the
mouse button held down. The texture is
shown in real-time throughout, provided that
your processor is fast enough; otherwise, only
the texture envelope is displayed.

Move the texture axis until the texture is in a
suitable position over the selected polygons.
Now, finish the function by choosing
Functions > Stop Interactive Mapping.

Note how the texture moves over the entire
object in the Perspective View. Ignore this
temporary effect — the new mapping affects
the selected polygons only.

This function offers nothing new, as such. You
could carry out exactly the same steps using the
tools individually. However, you save a few
clicks and mouse movements in this way. In
short, this function has been implemented to
improve your workflow.

Stop Interactive Mapping

Select this function to signal the end of the
interactive mapping process (see Start
Interactive Mapping above). New UV
coordinates will be assigned to the selected UV
polygons and the tool that was active prior to
the interactive mapping process will be activated
once more.



Bitmap Filter Menu

Filters enable you to apply special effects to
your textures — among other things, you can
blur, emboss, sharpen and invert.

Filters affect the active layer only. If a bitmap
selection exists, only the selected pixels are
affected; otherwise, the filter is applied to the
entire layer.

To use a filter, activate the layer to which you
want to apply the effect, then choose the filter
from the Texture View's Bitmap Filter menu. A
dialog similar to the one pictured below opens.
The exact contents of the dialog vary according
to which filter you are using.
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The left window shows an area of the original
texture (the source texture). You can zoom in or
out on the area by clicking on the corresponding
magnify icon. To move the area, drag in the
window.
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The right window shows you the same area of
the texture, but this time with the filter applied.
This helps you to judge how the filter will affect
the texture.

The sliders below the two windows enable you
to adjust filter-specific parameters.

Most filter dialogs contain the following three
options:

Blend

The Blend slider defines the intensity of the
filter's effect. You can set a value between 0%
and 100%.

Wrap Texture

Activate this option if you intend to tile the
texture.

Imagine that you want to apply a blur filter to
your texture with a blur radius of 20 pixels.
What does the filter do at the edges of the
texture? Usually, the edge pixel is repeated
multiple times in the blur calculation to make up
the numbers.

The resultant texture is likely to produce
unattractive seams when tiled. However, when
the Wrap Texture option is active, the filter uses
the required pixels from the opposite side of the
texture, thus helping to avoid seams.

Document Preview

This option shows a preview of the filter in the
Perspective View and Texture View. Note that
the preview may take a few moments to appear.

Tip:
To reapply the last filter used, select Execute
Last Plugin (first item in the Plugins menu,).
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Filter Settings
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Preview Width

This defines the width of the preview in pixels.

Preview Height
This is the height of the preview in pixels.

Show Source Preview

Select this option to show a preview, as well as
the original, in the filter dialogs.

Live Action

If this option is active, the filter is applied in real-
time when you move the area in the preview
window. Changes to the sliders are also applied
in real-time. Deactivate this option if you need
to speed up the preview.

Wrap Texture
See the previous description of Wrap Texture,
above.

Document Preview

See the previous description of Document
Preview, above.

Filter Examples

The best way to learn about the filters is to try
them. In this section, we avoid an in-depth
mathematical analysis of each and every
parameter. Instead, we provide example pictures
to demonstrate the effects.

This is the original image. The remaining
pictures in this section show you the effect of
the relevant filter on the image.

Blur > Blur

This filter softens the texture by reducing the
contrast between neighboring pixels.



Blur > Gaussian Blur

This blurs your textures. You can set the
horizontal and vertical radii separately.

Gaussian Blur is particularly useful for removing
color banding.

Blur > Motion Blur

This applies a motion blur effect to your image.
You can set the angle and the length of the blur.
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Blur > Radial Blur

A filter which creates the impression that the
texture is rotating quickly and is blurring in the
process.

Blur > Selective Blur

This is similar to the Gaussian Blur filter, except
that it preserves more detail.
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Blur > Smooth

Y

A filter which smoothes your texture using
various methods.

Color Correction > Gamma Correction

The Gamma Correction filter enables you to
change the gamma value, contrast and
brightness.

If you change the gamma value, only the
midtones are lightened or darkened. Highlights
and shadows remain more or less unchanged.
This means that black remains black, even after
a gamma correction. White remains white.

Color Correction > Levels

This filter enables you to correct the tone levels
so that the darkest color in the layer is black and
the lightest color is white. In addition, you can
brighten the image, increase/reduce contrast
and influence the tonal range in the image.

Distort > Magnifying Glass

-

This filter distorts the texture as though you
were observing it through a magnifying glass.
Define the effect using the Refraction
parameter.
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Distort > Waves Noise > Despeckle

This filter simulates water waves. Think of your This filter levels out small irregularities in your
texture as being projected onto a water surface.  texture. It attempts to blur noise yet preserve
You can define the waves of the surface using edges in the image in accordance with the
several parameters. Radius and Feedback settings.

Distort > Whirl Noise > Distribute Pixels

Choose this filter if you want to whirl your This filter jumbles pixels according to the Radius
image. You can influence the rotation using settings.
several parameters.
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Noise > Noise Other > Invert

You can use this filter to add noise to your This reverses the image. The result is the same
image, helping you to break up areas that are as a photo negative of your texture.
too regular.

Other > Matrix
Other > Deinterlace

A special filter that has entire books dedicated
This is useful for video images — it can remove to it. The abridged version is that it enables you
odd or even interlaced lines. to define a matrix of up to 15 * 15 fields in size.
You can create your own filter effects by
entering values into the fields.
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Other > Mosaic Sharpen > Sharpen

-

Apply this filter to break down your image into Use this filter if you want to sharpen your

blocks, Roman-style. image. It works by increasing the contrast of
neighboring pixels. You can choose from various

Other > Oil Painting methods using the Filter Type pop-up menu.

Sharpen > Unsharp mask

Photo textures look too real at times. This filter l

adds an artistic touch by giving the image an oil

painting look. The Unsharp Mask filter uses three variables.
Radius, Amount and Threshold influence one
another, making exact modifications possible.
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Stylize > Difference Operators Stylize > Emboss (Texture)

This filter offers a number of methods by which This creates a raised effect based on the
contrasts in the image may be increased. brightness values of the texture's pixels.

Stylize > Emboss (Matrix) Stylize > Enhance Details

You can use this filter to raise or lower the Enhance Details can enhance or reduce effects
brightness values of the pixels. Several preset by increasing or decreasing contrasts in the
matrices are available. texture. Choose the effect you require from the

pop-up menu.
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Stylize > Enhance Structures

View Menu

Fit to Screen

This function zooms the texture so that it fills
the Texture View window.

Zoom 100%

The texture is shown at its original size.

Use this filter if you want to enhance structures. Zoom In
You can choose from diverse methods using the
Operator pop-up menu.

Stylize > Texture Blend Zoom Out
The texture is shown 25% smaller.

The texture is shown 25% larger.

Set Zoom

Here you can enter the zoom factor manually or
you can click on the small button to the right of
the field to open a menu with the particular
zoom settings.

Textures Menu

This menu shows a list of all the textures in
RAM. If you choose a texture from the list, the
texture will be displayed in the Texture View and
the corresponding texture will be activated in
the Layer manager.

This filter blends an image into the active layer.

Click on the Texture Name button and choose
the image using the Load File dialog that
appears. The image will be tiled and blended
into the active layer.

Note that transparent pixels will remain
transparent.
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10 Painter Menu 163
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10 Painter Menu

Bitmap Selection

The selection tools are more or less
indispensable for your day-to-day work in
BodyPaint 3D. They restrict the effect of tools to
the selected pixels and are otherwise well suited
to moving, cutting and copying areas of the
bitmap.

BodyPaint 3D's selection tools are divided into
three groups:

1. Polygon selection tools (Perspective View).
2. UV polygon selection tools (UV Editor).
3. Bitmap selection tools.

The bitmap selection tools, which are described
in this chapter, select pixels in the bitmap. There
are two types of bitmap selection tool:

1.Tools which you use to draw a shape (e.g.
Select Circle, Select Polylines).

2.Tools which select according to color
differences (e.g. Magic Wand, Color Range).

Bitmap selections appear as moving, dotted lines
in both the Texture View and the Perspective
View. To move a selection, move the mouse
pointer inside the selection and drag it to the
new position.

With the exception of Select Polylines , you can
use all of the bitmap selection tools in the
Perspective View as well as the Texture View.
Note that the selection outline may vary in
appearance between the two views. For
example, a single, circular selection outline in
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the Perspective View may correspond to several
irregular outlines in the Texture View if the UV
mesh is fragmented. (For details on UV mesh,
please see UV Editor on page 134.)

Select Circle
)
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Select Circle enables you to create circular and
elliptical selection outlines in one of three ways:

Box

Drag to define an imaginary rectangle inside
which the circle or ellipse will be fitted.
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Center

Click anywhere and drag to define the radius of
the circle.

Diameter

Drag to define the circle's diameter. In the
process, you can rotate the circle about the
point where you clicked.

Select Rectangle
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This tool creates rectangular selection outlines in
one of three ways as specified in the Active Tool
manager.

Box

Drag to create the top left corner and the
bottom right corner respectively.

Center

Drag to define the center and edge respectively.
Note that you can rotate the rectangle in the
process. The result is always a square outline.

Diameter

Drag to define the diameter of a square. You
can rotate the rectangle while you drag.



Select Polylines

This tool draws a polygonal shape around pixels,
to select them. Click to create the polygon's
starting point. Continue clicking to create
successive corner points. When you are ready to
close the shape, double-click on the last point to
connect it to the starting point.

If you hold down Shift while you create the
polygon outline, the lines will be constrained to
multiples of 45° to each other.
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Select Freehand

Fa .
b

Select Freehand is the most flexible selection
tool, yet potentially the least precise. This is
because it relies upon a steady hand for
accuracy. Drag to draw a freehand outline. The
two ends of the outline will be connected by a
straight line the moment you release the mouse
button.

Tip:
If you hold down Shift during the freehand
selection, straight lines will be drawn. These
straight lines will, in addition, be constrained to
multiples of 45° to each other.
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Additional Options Feather
The options described in this section apply to all ~ Feather defines the size of the transition
the bitmap selection tools. The options are between the selection and the background.

located in the Active Tool manager.
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Anti-Aliasing

A feather value of 20

Activate the Anti-Aliasing option if you want to
smooth the edges of the selection. The
advantage of this option becomes apparent
when you copy a selection to a new position on This creates a new selection. Existing selections
a different background color — anti-aliasing are deleted in the process.

softens the color transition between the
selection’s edges and the background.

New selection

New inverse selection

When this option is active, everything that you
select is, in fact, deselected. This may seem
paradoxical, but it can be useful. For example,
imagine that you want to select a large area
minus a small, unwanted region within that
area. Using conventional methods, you would
select the large area then remove the small
region using Subtract from selection (see
below). With New inverse selection, all you
need do is select the small region.

With anti-aliasing
Add to selection

This option, if enabled, will add the next
selection you make to the existing selection.
Alternatively, hold down Shift while you make
the new selection.

Without anti-aliasing



A circular selection exists and a square selection is being
dragged out ...

... to be added to the original selection

Subtract from selection

Activate the option if you want to subtract the
next selection you make from the existing
selection. Alternatively, hold down Ctrl as you
make the new selection.

A circular selection exists and a square selection is being
dragged out ...
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... to be subtracted from the original selection

Magic Wand
F

In contrast to the selection tools described in the
previous section, the magic wand does not
select pixels by drawing a shape around them.
Instead, the magic wand selects pixels according
to their color.

All contiguous pixels similar in color to where
you click are selected. A Tolerance value (in the
Active Tool manager) enables you to control just
how similar the colors must be.

Select Color Range

&

This function is very similar to the magic wand
with the key difference that the selected pixels
do not have to be contiguous.

Click in the bitmap and all pixels of similar color
to where you clicked will be selected. A
Tolerance setting enables you to choose how
similar the colors must be.
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Magic Wand / Select Color Range options
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All visible layers

If this option is activated, the selection will be
based on the composite image of all visible
layers. With the option deactivated, the
selection will be based on the active layer only.

Tolerance

The Tolerance value defines how similar in color
a pixel must be, compared to where you clicked,
in order to be selected. You can set values
between 0% and 100%. If you set Tolerance to
0%, only pixels of identical RGB color will be
selected. With a Tolerance of 100%, all pixels
will be selected.

The remaining options (New Selection, New
inverse selection, Add to selection and Subtract
from selection) have the same effect as
described in the Additional Options section on
page 166.

Select All
=

This command selects the entire texture area.

Deselect All
[

The entire texture area is deselected when you
choose this command.

Invert All

-

o

This command inverts the existing selection —
selected areas become deselected; deselected
areas become selected.

Feather

Feather softens the edges of an existing
selection.

A window appears when you select the
function.

Enter the distance in pixels over which the
selection should fade — you can enter values
between 0 and 1000. Click on the OK button to
apply the feathering.

This option applies feathering to an existing
selection. To apply feathering at the same time
as you create a selection, use the Feather setting
in the Active Tool manager instead.



Grow Selection

b4

This function expands the selection by a
specified number of pixels.

A window opens when you select Grow
Selection.

U |
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Enter a value between 1 and 100, then click on
OK to expand the selection by that number of
pixels. Note that you cannot expand the
selection past the texture's edges.

Shrink Selection

(=

Use Shrink Selection to contract the selection by
a certain number of pixels.

A window opens when you select the
command.

Aeba [
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Enter a number between 1 and 100 to specify
the number of pixels you want the selection to
contract by, then click on OK.
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Edit Selection Mask
L]

This function activates the edit selection mask
mode (see The Edit Selection Mask Mode on
page 81).
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Tools

You can use all the tools described in this section
(except Magnify and Transform Bitmap) in the
Perspective View as well as the Texture View.

Move Layer

L

This tool moves the active layer.

Drag in the Texture View to move the layer. Any
parts of the layer outside the texture will be
discarded.

Magnify
p=;

Drag a rectangle with this tool selected to zoom
in on its contents of the Texture View. To zoom
out, hold down Shift or the right mouse key
while you drag.

Eyedropper
o

L

You can use this tool to pick a color or a texture
— click on the corresponding position in the
Texture View to choose which. If you click with
the left mouse button, the color/texture
becomes the new foreground color. Click with
the right mouse button to define the color/
texture as the new background color.

Options in the Active Tool manager
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Solid Color

This option loads the color you click on into the
Color Settings.

You can also pick the color by clicking on the
object in the Perspective View.

Texture

If you activate this option, the texture you click
on is loaded into the Color Settings. You can
then paint the texture using a paint tool — for
details on how to paint the texture, please see
the Texture Paint section in the Color chapter,
on page 77.

All visible layers

If this option is active, the color you click on in
the Texture View is picked. With the option
inactive, the color in the active layer is picked —
this may be completely different from the



composite color you see in the Texture View.
With this in mind, keep the option active unless
you have a specific reason to deactivate it.

Sample Radius

This option applies to the Solid Color option
only. Rather than pick the color of the exact
pixel that you click on, this option picks the
average color of all pixels within the specified
radius — you can enter values between 0 and
100 pixels.

Example: if you click on the border between a
black column and a white column with a large
Sample Radius, the color picked will be medium

gray.
Brush

The brush is the single most important tool in
BodyPaint 3D. Therefore, brushes are dealt with
in a separate chapter of their own. Please see
Chapter 7, Brushes for full details.

Clone
4

You can use this tool to clone parts of your
texture. When you select the tool, the mouse
pointer changes into a pipette. Move the pipette
to the region you want to clone, then click the
mouse button. The pipette changes into a brush
and stamp. Now, drag anywhere you like to
paint the clone.

To clone a new region, click on the Clone Tool
icon. The pipette appears once more, ready for
you to select the new region to be cloned.
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Note that the Clone Tool uses the current Brush
Settings for the Generic brush type. Brush
effects such as Spacing and Jitter are evaluated
— usually, you will want to deactivate these
effects when cloning.

Finally, there is an All visible layers setting in
the Active Tool manager. If the option is active,
the composite image (i.e. the image you see in
the Texture View) is cloned; otherwise, only the
pixels in the active layer are cloned.

Cloning in action

You can use the Clone Tool in the multi channel
mode as well. Activate the mode. All the
material channels that you activate in the Multi
Channel Palette via pencil icons will be taken
into account by the Clone Tool.
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Eraser
P4

The Eraser erases pixels in the active layer by
making them transparent with the exception
that, if the Background Layer is active, the
eraser paints the pixels white.

Note that the Eraser adopts the parameters in
the Brush Settings, including effects. Deactivate
all effects for a standard eraser.

Fill Bitmap
Ly

With Fill Bitmap, all contiguous pixels of similar
color to where you click are filled with the color
in the Color Settings. The Tolerance value
determines how similar the colors must be.

Options in the Active Tool manager
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All visible layers

Activate this option is you want to fill all like-
colored pixels in the composite image. If the
option is deactivated, only the like-colored
pixels in the active layer are considered. Note
that, even if this option is selected, the color is
painted to the active layer only.

Tolerance

The tolerance, which can be set to values
between 0% and 100%, defines how similar in
color a pixel must be compared to where you
clicked in order to be filled with the color in the
Color Settings. A value of 0% will fill only those
contiguous pixels of exactly the same RGB color.
100% will cause all pixels to be filled.

Transform Bitmap

)

This tool can add interest to your textures by
rotating, scaling and shearing them among
other things.

A rectangular frame will appear when you
activate the tool. The frame has five handles:
one in the center, and one in each corner. Each
handle can be moved separately.

To move the entire frame, drag the center
handle. The other handles affect the frame
according to the option that is selected in the
Active Tool window (Move, Scale, Rotate,
Perspective, Shear).
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Note that only the frame is transformed in real-
time — transform the frame as you intend the

active layer to be transformed, then click on the
Apply button to transform the active layer itself.
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Also be aware that Transform Bitmap affects the  Rotate
active layer only. If you attempt to activate
another layer (by clicking on it) while the frame
is active, the following dialog opens.
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Click on the Yes button to apply the
transformation, or click on Cancel to abort it.
Perspective

N\

You can transform in one of five ways:

Move

.
‘».‘}_

Scale
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Draw Line

/-

This tool draws straight lines. Drag in the
Texture View to create the starting point and
ending point respectively.

Options in the Active Tool manager
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Endings

You can define different shapes for the starting
point (left pop-up menu) and ending point
(right pop-up menu).

/

4

Line Width

This is the line's width in pixels — enter any
value between 1 and 100.

Feather

This setting determines the size of the transition
between the line and the background — enter a
value between 0 and 50 pixels.

Anti-Aliasing

Activate this option to smooth the edges of the
line. Anti-aliasing helps to avoid or reduce
staircasing effects (jagged edges).

Draw Text

T

This tool paints text to the active layer. You can
use any TrueType font installed on your system.

Options in the Active Tool manager
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Type the text into the text box in the Active Tool
manager. The text can span several lines and
you can also paste text from the clipboard.
Once you have entered the text, drag in the
Texture View to move or rotate the text. As
soon as you release the mouse button, the text
is fixed in place.

Note:

Parts of the text that you place outside the
texture will be discarded.

Font

Click on this button to choose your font from
the Font dialog. If you are using a PC, you can
also set the font style here (e.g. Bold, Italic).



Size
This is where you define the size of the text. In
theory, values may range between 1 and 1000.

Align

Set this pop-up menu to your favoured text
alignment. Your choice is between Left, Center
and Right. For example, if you set the pop-up to
Left, your first mouse click defines the left edge
of the text.

Some examples of aligned text

Move

If this option is selected, you can drag in the
Texture View to create and move the text. Note
that the text will be fixed in place as soon as
you release the mouse button — a second drag
will merely create and move a new copy of the
text.

Rotate

When this option is active, drag in the Texture
View to create and rotate the text about the
point where you clicked. The text is fixed in
position the moment you release the mouse
button. The next time you drag, a new copy of
the text will be created and rotated.

CHAPTER 10 © THE PAINTER MENU ¢ 175

Outline

Activate this option if you want to stroke the
text's outline with the current Brush Settings.
The text will not be filled. You can achieve some
interesting effects with this option — try it in
conjunction with a slight Jitter effect.

Anti-Aliasing
Activate this option if you want the edges of
your text to be smooth.

Feather

This function is more or less enhanced anti-
aliasing. Enter a value between 0 and 50 pixels
to specify the size of the blending region
between the text and the background.

Draw Polygon Shape
This tool will assist you in drawing certain
polygon shapes.

To draw a polygon shape, drag in the Texture
View to set the position and size respectively
(the shape itself is drawn automatically). You
can rotate the preview while you drag — hold
down Shift at the same time to constrain the
rotation to multiples of 45",

When you release the mouse button, the shape
will be filled with either the foreground color
(drag with left mouse button) or the
background color (drag with right mouse
button).

You can access parameters specific to your
chosen shape by clicking on the Edit button. A
window opens. Ignore all parameters that do
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not relate directly to the shape — this window
originates from CINEMA 4D XL, the program on
which BodyPaint 3D is based.

Tip:
You can draw shapes directly onto your object in

the Perspective View.

Options in the Active Tool manager
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The shapes from which you can choose are:

Circle

Use this shape to draw rings or circles. If Ring is
activated, enter a value under Inner Radius. To
draw the ring, drag to define the position and
outer radius respectively (the inner radius is
drawn automatically according to the value you
entered).

Rectangle
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To round the corners of the rectangle, activate
the Rounding option and type the size of the
rounding in pixels into the adjacent box.

4-Sided
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Select this shape if you want to draw a
diamond, kite, parallelogram or trapezium —
make your choice using the Type pop-up menu.
If you set the Type to Parallelogram or

Trapezium, you can also enter a value in the top
Angle box.
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Enter the number of sides into the Sides box. If
you want to round the corners, activate the
Rounding option and type a value into the

Radius box.
Star

e

i Rl [41 231
Dot Pk 22 452 1,
T iE|
Pty f

E—
Plarm [ =] I Rinsmess Ports

0 | coed |

I'-IﬁPutF;m 'I
sk E

The Twist and Points parameters determine the
star's appearance. Twist rotates the star's arms
(see the star on the right in the picture above).
Points defines the number of arms.
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Cog Wheel
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Enter the number of teeth into the Teeth box
and type the degree of bevel into the Bevel box.

Flower
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This shape draws flowers for you. Type the
number of petals into the Petals box.
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General Options

i At Tl =10l =|
4, Foiegon Shaps Tool

Shage [tk =] W |

" Bes 7 Cenda ™ Diswsta

[ Ouins

e S iy

Fashm J—f 1

The following options apply to all shapes:

Box

Drag to define the top left and bottom right
corners respectively of a temporary rectangle
inside which the polygon shape will be drawn.

Center

Drag to define the center and radius respectively
of a temporary circle inside which the polygon
shape will be drawn.

Diameter

Drag to define the diameter of a temporary circle
inside which the polygon shape will be drawn.

Outline

This option strokes the polygon shape's outline
with the active color and the active Brush Settings.

Anti-Aliasing

This option softens the edges of the polygon
shape. This prevents a staircasing effect (jagged
lines).

Feather

You can use the slider to alter the size of the
blending region between the polygon shape and
the background. This is more or less enhanced
anti-aliasing.

Functions

Texture Size
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You can use this function to scale the textures of
the individual material channels.

When you select the function, the Scale Texture
dialog opens. All material channels are listed on
the left — unused channels are ghosted. Select
the channels you want to scale from the list. The
current texture size is listed next to each
channel.

There are four scaling modes:

User Defined Size

Enter the new size into the Width and Height
boxes. If Lock Aspect Ratio is selected, the
width to height ratio is maintained. So, if you
enter a new width value, the height value is
changed automatically to maintain the original
ratio. Lock Aspect Ratio is available only in this
mode.



Maximum Size

This mode sets the Width and Height values to
the values of the largest texture.

Average Size

This sets Width and Height to match the
average size of the textures.

Minimum Size

In this mode, Width and Height are assigned
the dimensions of the smallest texture.

Finally, define the way in which the pixels are
interpolated using the Interpolation pop-up
menu.

Interpolation

When bitmaps are scaled, pixels must be added
or removed and new color values calculated.
The new color values can be calculated using
one of two interpolation types:

Bilinear

Bilinear maintains high image quality. However,
it is relatively slow to calculate, especially if
several material channel textures are being
scaled at the same time.

Nearest Neighbor

This is quick to calculate but low on image
quality.

Although you can assign different texture sizes
to each material channel, you can only use a
MultiBrush if the channels it paints to all have
the same texture size. If this is not the case, a
dialog will notify you when you attempt to use
the MultiBrush.
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Select the channels you want to add borders to
using the list on the left — channels not in use
are ghosted. Use the top four boxes in the Add
Borders pane to enter the size of the border (in
pixels) to be added to each side. If Symmetric is
active, any border value you enter is copied to
the other three boxes.

Example: you want to add a border 100 pixels
long to the top of the texture.

Deactivate Symmetric, enter 100 into Top, then
click on OK to add the new border.

Activate Transform UVW if you want to fix the
UV polygons to the canvas pixels they currently
cover. This prevents the UV polygons venturing
into the new border(s).

If you do not understand why a transformation
is required, bear in mind that UV coordinates are
specified as values between 0 and 1 relative to
the texture's size.

If you are not sure why you might want to
create empty borders, please read The UV Editor
— An Introduction on page 134.
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Rotate Texture
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This function rotates your texture by a specified
angle. Note that the texture size will alter for
rotations other than 90°, 180° and 270°, as
demonstrated by the two example pictures.

Original texture

¢

The same texture, rotated by 25°

When you call the function, the Rotate Texture
dialog opens (see above). Use the left list to
select the channels you want to rotate —
channels not in use are ghosted. You can select
a rotation value of 90°, 180°, 270° or Free. If
you choose Free, you can enter your own

rotation value in the Angle box. Positive values
rotate the texture clockwise, negative values
rotate it anti-clockwise.

Interpolation

Textures must be recalculated during the
rotation. Choose the interpolation type for the
calculation from this pop-up menu. You can
choose from two types:

Bilinear

This maintains high image quality, but it is
relatively slow to calculate, particularly when
several channel textures are rotated at once.

Nearest Neighbor
This is low on quality but quick to calculate.

Transform UVW

Activate this option if you want to rotate the UV
polygons as well.

You can only select Transform UVW if all
channels to be rotated have the same texture
size.



Flip Texture Horizontal/Vertical

When you call either of these functions, the
following window opens:

2Lz ]

Select the channels you want to mirror. Select
Transform UVW if you want to mirror the UV
mesh as well.

Tip:

You can only select Transform UVW if all
channels to be rotated have the same texture
size.

Fill Layer
.

The selection is filled with the color in the Color
Settings. If no pixels are selected, the entire
layer is filled.
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Fill Polygons
W

This fills the selected UV polygons with the
color/pattern in the Color Settings.

Object polygon selection and UV polygon
selection is linked. Sometimes it is easier to
select object polygons. For example, if you want
to fill a specific side of a six-polygon cube, it is
easier to click on the object polygon in question
rather than figure out which UV polygon you
need to select. Note that you must activate the
Polygons Tool in order to select object

polygons.

Selected UV polygons (Texture View) and
selected object polygons (Perspective View) are
indicated by red edges.

Outline Polygons
22!

This strokes the edges of the selected UV
polygons with the current Brush Settings and
the active color. This is useful for UV mesh
visualisation on the texture.

Create Mask from Selection
e

This function creates a bitmap selection from an
existing UV or object polygon selection.
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Bitmap Filter

See Chapter 9, The Texture View, on page 127.

RayBrush Mode

The RayBrush mode enables you to paintin a
pre-rendered view in real-time and in three
dimensions. You can view the following
channels simultaneously:

- Color

- Diffusion

- Luminance

- Transparency

- Reflection

- Bump

- Specular Color

The RayBrush mode is relatively close to
rendering in terms of image quality. However, a
few restrictions are made so that a reasonable
display speed is maintained. Note that these
restrictions apply to the RayBrush mode only.
Also, some of the restrictions apply to imported
CINEMA 4D XL scenes only. When you render
proper, BodyPaint 3D uses the full power of

CINEMA 4D's rendering engine (BodyPaint 3D is

based on CINEMA 4D XL technology).

RayBrush Mode Restrictions

- CINEMA 4D's Sky, Foreground and
Background objects cannot be painted.

- Post-processing effects such as glow, lens
effects, depth of field and motion blur are not
displayed.

- Anti-aliasing is not shown.

Textures are not interpolated (e.g. there is no
SAT and MIP interpolation).

Only the raytracing mode can be used (e.g.
you cannot use Cel-Render Color mode).

Morphing materials are not displayed.

You cannot paint over additively mixed
materials. Consider an object A with materials
X (base material) and Y (additively mixed
material), and an object B with material Y (its
only texture). You can paint material Z onto
object B only.

Objects with Visibility tracks in the Timeline
cannot be displayed (only relevant when
running CINEMA 4D XL with BodyPaint 3D).

You cannot paint to sub-channels. For
example, you cannot paint over a third-party
shader which in turn uses textures.

Imagine that you have assigned three materials
to an object and you are editing the second
material. Only the materials above this material
are shown.

Irregularities may appear at the edges of
textures (e.g. if you tile them).

Fresnel reflections with transparent objects are
not shown.

You cannot paint objects that are behind
transparent, refractive objects.

You can paint transparency and reflection, but
only as a rough approximation of the rendered
result. Also, double transparencies cannot be
displayed. For example, consider a tin: if you
paint transparency to the front and back of the
tin, only the front will become transparent.

Transparency and reflection are not taken into
account when you paint to the bump channel.



The more light sources you use, the more
processing time is required when you paint to
the bump channel. Likewise, the processing time
increases with the use of Tube and Area lights.

RayBrush Render View

Choose this function to RayBrush render (i.e.
pre-render) the active view. The RayBrush
render will take a few moments. Once it has
completed, you are in RayBrush mode and you
can paint in the view.

The RayBrush mode is deactivated the moment
you move, scale or in any way change the view
or object.

RayBrush Render Active Object

Only the active object (including its child
objects) is RayBrush rendered. All other objects
are ignored.

RayBrush Render Region

After activating this function, drag a frame in
the Perspective View (or a 2D view). Only the
framed region will be RayBrush rendered,
although you will be able to paint outside the
region (in which case, the view's shading mode
is used).

High Quality Shading

The high quality shading mode displays the
mapped active material in high resolution. The
following channels are evaluated: Color,
Luminance, Diffusion, Reflection, Bump and
Specular Color.
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Tip:

The high quality shading mode is slower than
the standard shading modes, but faster than the
RayBrush mode.

The following restrictions apply to the high
quality shading mode: the Sky object cannot be
painted. The bump channel is only a rough
approximation, since only the first light source in
the Object manager is considered.

Display Selected Channel

This mode displays the active channel only. In
the process, the channel is evaluated as a color
channel. For example, if you click on the bump
channel to activate it, grayscale colors will be
mapped to your object. You can then edit the
channel in the usual way (e.g. by painting with
a brush). This mode is available in the high
quality shading mode only.

TileU/V

Activate these options so that if you paint over a
texture's edge, the stroke will continue from the
opposite edge. Activate Tile U to apply this
feature horizontally, Tile V to apply the feature
vertically.

Tip
In general, always work with Tile U and Tile V
activated — you can achieve texture continuity
by painting over the edges, thereby helping to
prevent seams where the texture edges meet on
the 3D object.
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11 Object Manager 187
File Menu
Edit Menu

(@] T =Tel K 1V 1T T SR URSTPRPR PR 198

TGS IVMBINU ...t e e s h e e e b e e e s b e e e s e e e s e e e e e s 201

201

Texture Menu



CHAPTER 11 « OBJECT MANAGER = 187

11 Object Manager
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The Object manager is the center of object
administration in BodyPaint 3D. You can use it
to activate objects, change object hierarchies or
manipulate tags.

On the left side of the manager is a list of all the
objects in the scene. Hierarchies are shown as a
tree structure. You can collapse and open
hierarchies, just as you can on your computer
desktop. You can use drag-and-drop to re-group
or copy objects.

The narrow column running down the center of
the Object manager contains up to three
switches for each object. The switches are
described in detail later in this chapter.

To the right of the switches are the object tags
(e.g. texture tag, smoothing tag). You can use
drag-and-drop to move or copy these tags to
other objects. The tags are described in detail
later in this chapter.

You can use context menus in the Object
manager. To do this, click the right mouse
button within the manager (Macintosh - hold
down the Command key and click the mouse
button to simulate the right mouse button).

When you select a command in the Object
manager, it is applied to the active object.

Drag-and-drop in the Object Manager

Drag-and-drop is the technique of clicking on an
object, holding down the mouse button and
dragging the object to another position; when
the target location is reached, you release the
mouse button and this will drop the object
there. Depending on the target location, this
may have different results.
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To re-arrange objects in the Object manager

There are many ways that you re-arrange
objects in the Object manager and these are
described below. The icon on the left shows
what the mouse pointer will look like while you
are doing the action described on the right.

[ Drag an object between two others or to
0O the end of the list.

[& If you wish to move a duplicate, rather
than the original, use Ctrl-drag.

[ To change the object hierarchy, drag the
object on top of an existing one in the list.
This makes the dragged object a child of
the other.

[ If you wish to create a duplicate and
make it a child of another object, use Ctrl-
drag and move the mouse pointer over
an object.

IS You can also drag-and-drop tags. To
0 transfer a tag from one object to another,
drag the tag icon on to the line of the
other object.

I3 If you wish to create a duplicate, use Ctrl-
drag.

S If an operation is not available, this icon
appears.

Each object in BodyPaint 3D has a type, e.g.
polygon object, light.

To open an object's dialog, double-click on its
type icon. These dialogs are described in
Chapter 18.

You can apply tags to objects (e.g. texture tag,
smoothing tag). Double-click on a tag icon to
open its dialog.

Mouse actions in the Object manager

Function
Activate object

Rename object

Activate object type
Activate tag
Edit tag

Move active
object or tag

Copy active
object or tag

Open/close
object hierarchy

Activate previous /
next object

Context menu

Action
Click on object

Double-click on object
name

Click on type icon
Click on tag
Double-click on tag

Drag-and-drop

Drag-and-drop with
Ctrl key

Click on icon left of
the object name

Up / down
cursor keys

Right-click on name,
type icon or tag
(Macintosh:
Command key and
mouse button)



File Menu

New Tag

You can use this menu to select a tag. The tag
will be added to the active object.

Display Tag
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Display, Backface Culling, Use Textures

These settings have the same effect as their
counterparts in the View menu (see Chapter 2),
although the effect of a tag is limited to an
object and any children it may have.

The display tags enable you to mix display
modes within the editor. For example, some
objects may use Gouraud shading, the others
Wireframe. The main purpose of this is to
reduce the strain on the processor so that the
redraw rate remains fast.

If your scene is becoming sluggish in the editor,
try a simpler display mode for objects of lesser
importance.

Note that Display > Use Display Property must
be activated in a view window for the display
tags to have an effect there (the option is
activated by default).
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Level of Detail

You can use this to control the level of detail for
generators and deformers.

The tag's value is used in preference to the value
in the project settings of CINEMA 4D. For
example, you can set the Level of Detail in the
project settings to 50% and allocate a display
tag with Level of Detail set to 100% to the
object that you are currently working on.

If the tag's Level of Detail option is activated, it
is always used in a view window, even if Use
Display Property is not selected there.

Protection Tag

O

This tag does not have a dialog. An object with
a protection tag cannot be moved, rotated or
scaled. If you wish to make changes to a
protected object, you must first remove its
protection tag.

Smoothing Tag
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Smoothing is an extremely important tag. It
gives object surfaces a rounded appearance.
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The picture below left shows a sphere before a
smoothing tag is applied; on the right a
smoothing tag has been applied.

)

If you look closely, you will see straight lines
around the right sphere’s silhouette. Smoothing
does not increase the number of polygons. You
can think of it as an illusion that loses its effect
around the silhouette. If you wish to smooth the
silhouette region, you must use more
subdivisions.
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You can use the dialog to specify the maximum
smoothing angle. To do this, activate the Angle
Limit option and type the required angle into
the text box. Adjacent polygons equal to or
below the angle will be smoothed.

The following pictures demonstrate the effect of
the smoothing angle. The cylinder on the left
has smoothing with no angle limit specified (i.e.
all angles are smoothed), the middle cylinder has
an angle limit of 89.5° and the cylinder to the
right has no smoothing at all.

When BodyPaint 3D calculates the smoothing, it
assumes that the surface normals are aligned. If
this is not the case, shading anomalies may
appear. All primitive objects are aligned by
default.

Smoothing is a good way to reduce render time
and save on memory. Without the smoothing
tag, an object would require a far greater
number of polygons in order to appear smooth.
Note that smoothing can only take place across
connected surfaces (surfaces that share points).

How smoothing works

During rendering, the program creates a normal
for each surface. Each normal is perpendicular to
its surface. The color and brightness of a point is
determined by the angles which the normal
forms with the rays of the camera and the light
sources.

Without smoothing, two connected surfaces will
have a hard transition, since each surface has its
own normal. This will cause brightness bands.

If a smoothing tag is activated, the normals will
be interpolated. There will be a soft transition
between one normal and the next (provided
that the surfaces are connected).

If a smoothing tag is not applied, there will be
no interpolation.
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light course light course

The top-left picture shows three connected
surfaces. The middle surface is not aligned to
the other surfaces (you can tell by the normals).
The bottom-left picture illustrates how the
normals are interpolated for smoothing. The
light bar shows the hard transition caused by the
non-alignment.

The top-right picture shows the same three
surfaces, but this time they are aligned. Notice
how the interpolation (bottom-right picture) is
much smoother this time. The light bar is
smoother as a result.

These pictures illustrate why it is important for
surfaces to be aligned. The convention for the
alignment direction is that the normals should
point outwards from the object. For example, if
you have an apple, the normals should point
outwards into the world, not inwards towards
the core.

This convention does not matter for smoothing
in BodyPaint 3D - the important point is that
they must be aligned, i.e. point in a consistent
direction. However, it is best to follow
convention. For example, the normal direction
plays an important part in decal mapping (see
page 263).

Note

The normals are shown for selected polygons
only. To see the normals, activate the Polygons
tool. Next, select some polygons using a
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selection tool (or choose main menu: Edit >
Select All).

To see the normals, select their polygons. For
example, create a sphere, then choose

Structure > Make Editable in the main window
(this will convert the sphere into polygons).
Next, activate the polygons tool and select some
polygons using one of the selection tools (or
choose Edit > Select All in the Selection menu).

To align normals, choose Structure > Align
Normals in the main window.

Render Tag
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This tag has several options that affect
rendering.

Cast Shadows

Sometimes it is useful to prevent objects from
casting shadows — especially for technical
illustrations. To turn off shadow-casting,
deactivate this option.

Receive Shadows

Sometimes it is useful to prevent shadows
appearing on an object — especially for
technical illustrations. To turn off shadow-
reception, deactivate this option.
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Seen by Camera, Seen by Rays

You can use these options to create vampires in
your scene — according to legend, a vampire
has no reflection. Joking apart, there are
instances where it can be useful to make a
visible object have no reflection. It can also be
useful to make an object invisible yet have it
cast a shadow.

If Seen by Camera is activated, the object will be
visible in the render. If the option is deactivated,
the object will be invisible.

If Seen by Rays is activated, the reflection and
refraction of the object will be visible in the
render. If the option is deactivated, the
reflection and refraction will be invisible.

You can combine these two options.

For example, you can create a visible object
which casts no shadow, receives no shadows,
has no reflection and cannot be seen behind
glass; or perhaps an invisible object which casts
a shadow, can be reflected and can be seen
behind glass.

Normal object

Visible object

Invisible object

Compositing Background

This option will cause the object to be self-
illuminated yet still receive shadows.

An example

You are creating a cartoon character for your
website. Your website uses a white background
and you need to render the character so that it
appears to cast a shadow on to the webpage.

You import a large rectangle to serve as a floor
and assign it a white material (with the RGB
values matching the white color of the web
page), but when you render the picture, the
floor is not of the correct brightness.



To solve the problem, create a render tag for the
floor and activate Background Compositing.
The floor will now illuminate itself evenly and
with full brightness yet it will still receive the
character's shadow.

Note

The object in question (in our example, the
floor) must have its own material.

Texture Tag

b

This command creates a new texture geometry.
Initially, no material is assigned. To assign a
material, type its name into the Search for text
box. This dialog is described in detail on

page 256.

Note

If you allocate a material to an object, a texture
tag will be created automatically. As a result,
you rarely need to use this menu item.

You can assign as many texture tags as you like
to an object. This allows you to apply several
texture layers to the same object. The texture
priority increases to the right in the Object
manager. This means that the right-most texture
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will be the top layer and the left-most texture
will be the bottom layer. The top layer will cover
the object completely unless it is limited in size
or has an alpha channel activated.

Note

If a child object has no texture tags applied to it
it will use the texture tag(s) of its parent.

Warning

The note above does not apply to light sources
i.e. if a light object has no texture tag and is a
child of another object it will not inherit its
parent's texture tags. This is to prevent child
lights receiving gels automatically.

Stick Texture Tag

B

This function is relevant only if you are running
BodyPaint 3D with CINEMA 4D because the
Stick Texture tag is unique to CINEMA 4D. As
soon as you export a scene or object from
BodyPaint 3D in a foreign file format, any Stick
Texture tag information will be lost.

The Stick Texture tag fixes all of an object's
textures to its surface. You can use the tag with
polygon objects and HyperNURBS as well as
with parametric primitives and NURBS objects
imported from CINEMA 4D.

Once the tag has been applied, the textures
remained fixed to the object when the object is
deformed (e.g. using CINEMA 4D's Twist
deformer).

The following pictures show part of a face
including an eye. The object contains a relatively
small number of points for a face — it is
smoothed by the HyperNURBS object it is
placed in.
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The pictures demonstrate a problem that can
arise when UVW mapping is used with a
HyperNURBS object.

A cage object. The point density is comparatively high in the
eyelid area

Flat projection

Flat projection converted to UVW mapping. The texture is
distorted where areas of high point density meet areas of low
point density

There are not enough points to fix the texture to
the object properly, so when the object is
smoothed by the HyperNURBS, the texture is
distorted.

The stick texture tag solves this problem. With
the tag, you no longer need to use UVW
mapping to fix textures. Instead, use a suitable
projection type (e.g. Flat or Cylindrical for a
head), then fit the texture to the object (Object
manager: Texture > Fit to Object). Next, choose
File > New Tag > Stick Texture Tag (Object
manager).

If you deform the object now, the texture
deforms along with the mesh. This enables you
to avoid the problem of texture distortion with
HyperNURBS.



The stick texture tag works in the following
way:

If a texture tag is created, the program checks
whether the object has a conventional
projection type, i.e. not UVW or Frontal, and
whether the object has been deformed in any
way, e.g. using CINEMA 4D's Twist deformer.

If so, the texture projection is calculated by
comparing the deformed object to its original
state, the original state is stored in the stick
texture tag. This enables the texture to be
mapped taking the deformation into account
and without the distortion mentioned earlier.

If you double-click on the Stick Texture tag, the
following dialog opens:
ﬂ‘l-&:l Fiamy |
F scoe I f |
0t | Comnl|

Active

if you deselect this option, the stick function is
disengaged. The original state is still stored in
the tag — activate the option to resume the
stick function.

Record

This button saves the object's current state to
the texture tag.

Reset

Click on this button if you want to return the
deformed object to its original state (as stored in
the tag). This is useful, for example, if you want
to reset an object that you have animated using
CINEMA 4D's point-level animation (PLA).

Tip:
Only polygon objects can be recorded and reset.
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The point copy becomes invalid as soon as you
add points to a polygon object. This is not a
problem when using CINEMA 4D's deformation
objects, because a new reference copy is stored
in the stick texture tag automatically before each
deformation. However, if you use PLA in
CINEMA 4D, the copy stored in the tag as well
as all PLA keys already created become
unusable. Hence, you should finish modeling the
object in CINEMA 4D, then create the Stick
Texture tag, then create the PLA keys.

The Stick Texture tag has an interesting side
effect:

If you put a polygon object inside CINEMA 4D's
symmetry object and texture one half in
BodyPaint 3D, the texture is mirrored to the
other side automatically. So, for example, you
can paint half of a face, project it using flat
mapping, then let CINEMA 4D do the rest.

If you do want this behaviour (for example, not
all faces are symmetrical), just put the texture
onto the symmetry object itself.

URL Tag

A

You can assign a URL to an object. This is useful
if you are creating VRML files for the Internet.
These VRML files (.wrl) contain complete 3D
scenes and can be viewed in web browsers
provided that you have a corresponding VRML

plug-in.
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The viewer can click on a 3D object that has a
URL tag in order to link to an Internet address.

URL contains the link address. Take care to enter
the complete address (do not forget http://,
ftp://, https://). You can use Info to define the
text that will appear when the mouse pointer
moves over the object in the web browser.

C.O.F.F.E.E. Error Tag

When loading a scene which includes tags
created by plug-ins and, for whatever reason,
BodyPaint 3D cannot find a plug-in, a question
mark will be displayed instead of the tag icon.
The same happens with C.O.F.FE.E. errors.
Please contact the plug-in author in such a case.
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C.O.F.F.E.E.-Error-Tags

Restore Selection

In this submenu the point and polygon
selections are displayed and can be activated by
selecting them.

The selections are displayed only in point mode
(see page 366) or polygon mode (see page
366). If you are working with a different tool
this menu remains empty.

If your selections are unnamed they will be
numbered and displayed as 'selection1’,
'selection2’, etc.. If you select one of the
selections displayed the points or polygons
stored inside this selection are selected.

This function can also be accessed by clicking on
each selection tag (see page 382).

Load Object

You can use this command to load a file
containing object information (e.g. DXF,
BodyPaint 3D, lllustrator path, etc.). The objects
in the file will be loaded into the scene along
with any material and animation data.

Save Object As...

This function saves the active object. The
standard system dialog for saving files will open.
Display Tags

You can use this option to switch on or off tag

display in the Object manager.

Close

This function closes the Object manager.



Edit Menu
Undo

This function reverses the last change (action)
that you made, restoring the scene to its
previous state. You can select Undo repeatedly
to continue reversing the actions.

Redo

Redo restores the last action that was undone.
You can select Redo repeatedly to continue
restoring the actions.

Cut

This function deletes the active object and
copies it (including its materials and animation
data) to the clipboard. The object can be copied
back from the clipboard with the Paste function
(see below).

Copy

The Copy function copies the active object
(including its materials and animation data) to
the clipboard. The object can be copied from the
clipboard to the active scene with the Paste
function (see below). You can paste repeatedly
to create additional copies.

Paste

This function inserts an object from the
clipboard into the scene.

Delete

This function deletes the active object or the
active tag without copying it to the clipboard.
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Select All

You can use this function to group all the
objects in the Object manager into a null object.
The null object is selected, including its child
objects.

Deselect All

This function deselects all active elements (e.g.
objects, tags, etc.).

This function deletes the active object or the
active tag without copying it to the clipboard.
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Objects Menu

Obiject Display

The items on this menu control the editor and
renderer visibility for the selected object.
Alternatively, you can change the visibility using
the switches in the middle column of the Object
manager:

ﬁqq

The two switches (we could call them traffic
lights) are colored grey by default. Each can
have one of three states: grey, green and red.
These switches control the object's visibility.

Polygn 4 |3

The top switch controls editor visibility, the
lower switch controls render visibility.

Editor Unchanged / top switch grey

The object adopts the editor visibility of its
immediate parent. If the object is on the top
hierarchy level (i.e. has no parent), it will be
displayed as normal. Editor Unchanged is the
default setting for new objects.

Editor On / top switch green

The object will be visible in the editor, even if
the hierarchy parent is invisible (red).

Editor Off / top switch red

The object is not displayed in the editor, even if
the hierarchy parent is visible (green).

Note

An object that is invisible in the editor will
nonetheless be visible in the renderer.

Renderer Unchanged / bottom switch grey

The object adopts the renderer visibility of its
immediate parent. If the object is on the top
hierarchy level (i.e. has no parent), it will be
rendered as normal. This is the default setting
for a new object.

Renderer On / bottom switch green

The object will be visible in the renderer, even if
the hierarchical parent is invisible (red).

Renderer Off / bottom switch red

The object is not displayed in the renderer, even
if the hierarchical parent is visible (green).

Note

To apply a status to all child objects, Ctrl-click
on the switch for the parent object. The status
will be transferred to all child objects.

Obiject Activation

Two important object types that you can use in
BodyPaint 3D are generators and deformers.
These objects can be created only if you are
using BodyPaint 3D with CINEMA 4D.

Exception
You can create the HyperNURBS generator
directly in BodyPaint 3D.

Generators include most NURBS types imported
from CINEMA 4D as well as BodyPaint 3D's
HyperNURBS object. Deformers include
CINEMA 4D's Twist and Melt objects.



All generators and deformers have the two
standard visibility switches (see Object Display
above) in the Object manager. In addition, they
have a third switch for Object Activation.
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The activation switch is represented as either a
tick (activated) or a cross (deactivated).

You can use this switch to turn on or off the
effect of the generator/deformer.

An example

You are editing the polygon cage of a
HyperNURBS object. So that you can see the
points more clearly, you turn off the
HyperNURBS activation switch.

Note that the HyperNURBS is not invisible.
Rather, it ceases to generate a mesh.

Note

If you have an object in the scene that uses
deformers, you can increase the redraw rate by
deselecting object activation for each deformer.

Edit Object

You can use this function to edit the object type.

A dialog will appear. For a detailed description
of the type dialogs, see Chapter 18, Objects
Menu, on page 309. You can also call this
function by double-clicking on the object’s type
icon.

If an object type cannot be edited (e.g. a
polygon object), the Rename Object dialog will
open instead.
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Rename Object

You can use this function to change an object’s
name. You can also call this function by double-
clicking on the object's name.

Group Objects

You can use this function to group several
objects in the Object manager. When you select
this function, the mouse pointer changes into
crosshairs. Use the crosshairs to drag a box over
the objects that you wish to group. Child objects
will also be incorporated into the group —
existing hierarchies will be preserved within the
new group.

Expand Object Group

This function is the reverse of Group Objects. It
removes all objects from the group and places
them on the same hierarchy level as the group
parent. Existing hierarchies within the group will
be preserved.

Information (Object)
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This function displays the following information
about the active object (including its children):
size in kilobytes, number of points, number of
polygons and number of objects.

Note

Polygons that are created by generators will not
be included in the number of polygons.
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Information (Scene)
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This function displays the following information
about the scene: size in kilobytes, number of
points, number of polygons and number of
objects.

You are not required to select an object before
calling this function.

Note

Polygons that are created by generators will not
be included in the number of polygons.

Search Active Object

You can activate an object by clicking on it in
the editor window. You may then wish to find
the object in the Object manager. However, the
object may be out of sight and nested deeply
within a hierarchy, or perhaps there are
thousands of objects in your scene. Searching
for objects manually can be time-consuming.

If you call this function, the active object will be
shown in the Object manager. The manager will
scroll and the hierarchy tree will be opened if
necessary.

Fold All

This command collapses all hierarchies in the
Object manager. In this state, the objects take
up the least amount of space in the Object
manager.

Unfold All

This command is the reverse of Fold All (see
above) — it expands all hierarchies. In this state,
the objects take up the most space in the Object
manager. The advantage is that all objects will
be visible (although you may need to use the
scroll bar).

Warning

Unfold with caution if your scene is very large.
In this case, it may be wiser to unfold the
hierarchies by hand. Large projects often have
more than 1000 objects. The display speed will
be just as slow as if 1000 files were to be
displayed hierarchically in your operating
system's window. You can query the number of
objects in your scene by selecting the Objects >
Information (Scene) command.
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Tags Menu
Edit Tag

You can use this function to edit the active tag.
The tag's dialog will open. You can also access
this dialog by double-clicking on the tag.

Copy Tag to Children

If you select this function, the active tag will be
copied to all child objects of the active object.

If a child object already has a tag of the same
type, its tag will be overwritten with that of the
parent. There is one exception, the texture tag.
This tag is still copied, but the child will keep its
own tag as well (an object can have more than
one texture tag).

Proceed with caution when using this function
with complex scenes.

Delete Tag from Children

This function does the reverse of Copy Tag to
Children (see above). Delete Tag from Children
will delete the active tag from the active object
and its children.

Proceed with caution when using this function
with complex scenes.

Texture Menu

Generate UVW coordinates

You can use this function to generate UVW
coordinates. This is particularly useful for
imported objects that do not have UVW
coordinates. UVW coordinates prevent a texture
from slipping when you deform the object.
Proceed as follows:

- Create a texture and allocate it to the object.

- Set the required projection type (e.g. spherical,
cylindrical, etc.).

- Generate UVW coordinates.

- Deform the object.

The effect of UVW coordinates is shown in the
picture above. The object to the left uses cubic
mapping. The texture slips when the object is
deformed. The texture for the object to the right
does not slip since its original cubic mapping has
been fixed with UVW coordinates.

You may use more than one UVW geometry to
texture an object. To do this, give the object a
new texture tag and set the required projection
type, e.g. flat mapping for a label. Next, choose
Generate UVW coordinates. A new UVW
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geometry will be created and the active texture
tag will switch over to UVW mapping so that
the texture is fixed to the object surface.

For more details on UVW mapping, see
page 260.

Assign UVW coordinates

This function enables you to texture an object
with several different projection types using a
single UVW geometry and a single texture tag.

Proceed as follows:

- Import a polygon sphere.

- Create a new material with a texture, e.g. the
Checkerboard shader, and allocate it to the
sphere.

- Change the projection type from UVW
Mapping to e.g. Flat.

- Activate the polygon tool and select several
polygons.

- Select Texture > Assign UVW Coordinates in
the Object manager.

If you are in RTTM mode, you can see
immediately that the selected polygons use flat
projection while the unselected polygons
continue to use the normal UVW mapping. If
you deform the object later (e.g. using a twist

function in your main 3D application), the
texture will remain fixed in the selected region
as well.

Note

Selective UVW mapping is intended for you to
optimise projection for a single texture. If you
wish to use more than one texture, use Restrict
To Selection - see page 269.

If the object has no UVW coordinates (i.e. no
UVW tag), new coordinates are created
automatically.

Fit to Object

If you select this function, the texture will be
made to cover the object completely - the
texture will have a length of 100% in both the X
and Y directions.



Fit to Image

You must apply your texture with flat projection
if you wish to use this function. Type the name
of an image into the dialog. BodyPaint 3D
calculates the image's X and Y resolution and
scales the texture image accordingly.

You can use this function to ensure that your
texture uses the correct proportions, thereby
avoiding distortion.

Fit to Region

You must apply your texture with flat projection
if you wish to use this function. Use the mouse
to drag a box. BodyPaint 3D will set the
projection so that the size of the texture
matches the specified region exactly.
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Adapt to Object Axis

&

World System

A

Chject Sysiem

This function rotates the texture axes in such a
way that they are parallel to the object axes.

Adapt to World Axes

. ]

World Syslem  Dhject Systam

This function rotates the texture axes in such a
way that they are parallel to the world axes.

Adapt to View

world Syslem  Ohject Systen

This command rotates the texture axes in such a
way that the texture is perpendicular to the
viewing perspective. For a 3D view this is the
camera plane; for all other views it is the work
surface.
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Mirror Horizontally

This command flips the texture horizontally.

Mirror Vertically

This command flips the texture vertically.



BODYPAINT 3D

PAINTING @ TEXTURING @ MAPPING

2. Material Manager




206 * MATERIAL MANAGER ¢ CHAPTER 12

12 Material Manager
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12 Matenial Manager

i Fr TW Faihe
[ L+ [~ r [ L [+ [~ [ 5
bbbl ol
e ¥ E [ [ g
3 L 3 L ?’ [ -
et e il
You use the Material manager to create
materials for the objects in your scene. Good

materials and lighting are essential for photo-
realistic images.

The Material manager contains all the materials
and 3D shaders used in the active scene. A
preview picture and a name is shown for each
material. Names that are too long for the display
space are shortened with a full-stop.

The material preview shows how the texture
looks when placed on a sphere which is in front
of a striped background. This helps you
determine how the material will look when
applied to an object. You can choose between
three different preview sizes.

When an object is active, all the materials it uses
are shown indented. This makes it easy for you
to tell which materials an object uses.

If an individual texture tag (rather than the
object itself) is active in the Object manager,
only that corresponding material is shown
indented.

You can apply a material to an object using
drag-and-drop from the Material manager. You
can drop the material on to the object in the
Object manager, or you can even drop it directly
on to the object in the Perspective View (see
Applying a Texture, page 255).

If you drop a material on to a texture tag (aka
texture geometry tag) in the Object manager,
this material will replace the previous one and
the existing texture geometry will be used.

If, instead, you drop a material on to an object
name, a new texture geometry tag is created.

Any existing texture tags remain intact so that
you can layer textures. For details on layering,
material administration and texture geometry

see Texture Mapping, page 255.

If you click on a material preview, the material's
name becomes red to indicate that it is the
‘active material’ (also known as the ‘selected
material’). Only one material can be selected at
a time. You can also use the cursor keys to
change which material is selected. All menu
functions in the Material manager operate on
the selected material.

If the Material editor is open, the active
material’s settings are displayed there. If the
Material editor is closed, you can open it by
double-clicking on the material you want to
edit.

You can access many of the menu commands
via the context menu. Please note that the
context menu is accessible only if you have at
least one material in the scene. If you are using
a Windows operating system, you access the
context menu by clicking the right mouse
button in the Material manager. If you are using
a Macintosh, hold down the Command key and
click in the Material manager.



208 « MATERIAL MANAGER ¢ CHAPTER 12

File Menu

New Material

This function creates a new material with the
default material values (white with 80%
brightness and a specular width and height of
20%). The new material will be placed at the
start of the material list.

You can also access this function via the context
menu.

New 3D Shader

New 3D Shader opens a submenu showing all
the 3D shaders installed on your system. Select
the name of a shader to add it to the material
list.

Shaders, also known as procedural textures, are
more sophisticated than conventional textures.
Shaders are computed using mathematical
formulae whereas conventional textures are
pixel-based. One advantage of shaders is that
they do not become pixelated when viewed
close-up.

BodyPaint 3D recognizes two-dimensional and
three-dimensional shaders.

2D shaders can be loaded in the Material editor
in the same way you would load a conventional
texture.

3D shaders cannot be loaded from the Material
editor. This is because 3D shaders take an
object’s volume into account, whereas 2D
shaders and standard textures are simply applied
to the object’s surface. 3D shaders are
independent of the object’s geometry and the
texture projection type (an exception is that
UVW projection can be applied to volume
shaders).

The difference between conventional textures
and 3D shaders is particularly apparent when
applying them to an object with a section cut
out. With conventional textures, you can see
the edges of the cut very clearly. With 3D
shaders, the cut is taken into account.

The following picture compares a 2D texture
with a 3D shader. Note how the 3D shader
seems to flow from the sides and into the
hollow.

A 2D shader (top) in comparison with a 3D shader

3D shaders can do even more. For example,
the Fog shader fills a volume with fog clouds.
Shaders are often used with simple objects
(such as a cuboid) to create computer-
generated landscapes.

Please note that you cannot load 3D shaders
into a material; they are materials in their own
right.

Note

BodyPaint 3D computes 3D shaders using SAT
Mapping (see page 217).



Note

The shaders can only be evaluated in
CINEMA 4D or BodyPaint 3D. If you save an
object or a scene in another file format, the
shader information is lost.

For a detailed description of the 2D and 3D
shaders supplied with BodyPaint 3D, please see
page 238, The Shaders.

Load Materials

This function loads materials, adding them to
any materials already in the scene. You can also
import materials from another scene by loading
the scene file.

A word of caution regarding textures: when
BodyPaint 3D renders the scene, it must locate
all the textures. BodyPaint 3D will look for the
textures in the same folder as the scene, as well
as in a sub-folder called ‘Tex'. In addition, you
can specify up to 10 alternative search paths
(see Texture Paths, page 51). When the scene is
to be used on another computer (perhaps by a
colleague) we strongly advise that you save the
scene using Save Project (see page 291). This
will ensure that all of the textures are saved in a
‘Tex' sub-folder along with the scene.

Save Material As

This function saves the active material. The

standard system dialog for saving files will open.

Once you have saved the material, you can
reload it at a later date using Load Materials.

Save All Materials As

This saves all the materials in the active scene.
You can use this function to create your own
material libraries. Use Load Materials to import
the materials at a later date.
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Close

This function quits the Material manager and
closes its window.

Edit Menu
Undo

Undo will undo the last change that you made
to a material. Keep calling this function to
continue undoing (multiple undo).

You can set the maximum number of undos
using Undo Depth in the General Settings (see
page 42).

Note

The functions Remove Duplicate Materials and
Remove Unused Materials cannot be undone. If
you delete a material, any objects which used
that material will use the default material
instead. Although it is possible to undo the
deleted material, it will not be reapplied to the
objects; you must do this manually.

Redo

Redo undoes an undo. You can set the
maximum number of undos using Undo Depth
in the General Settings (see page 42).

Cut

Cut removes the active material from the
Material manager and copies it to the clipboard.
You can use the Paste function to retrieve the
material from the clipboard, even if you have
changed the active scene (i.e. you can paste
between scenes).
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Copy

This copies the active material to the clipboard.
Use the Paste function to retrieve the material
from the clipboard. Note that you can paste
more than one copy; each new copy is added to
the start of the material list.

Note

To quick-copy materials, drag-and-drop with the
Ctrl key held down. Drop the copy at the
required position in the material list. The first
copy will be called ‘name.1’, the second copy
will be called ‘name.2" and so on.

Paste

The Paste function inserts the last material that
you copied (or cut) to the clipboard. The copy
will be placed at start of the material list. The
first copy will be called ‘name.1’, the second
copy will be called ‘'name.2’ and so on.

Delete

This function deletes the active material.
Alternatively, press the Delete or Backspace key.

Small, Medium, Large Icons

Select one of these three settings to determine
the size of the material previews (the default is
small). Small icons are 45x45 pixels, medium
icons 60x60 pixels, large icons 90x90 pixels. The
preview pictures may be slightly pixelated with
some graphics cards. Do not be concerned,
there are technical reasons for this.

Function Menu

Render Material

This function redraws the preview picture of the
active material.

When you create a new material, it is rendered
automatically. Why, then, would you need to
use this function?

When you save a scene, the preview pictures
are compressed to reduce the file size. As a
result, when you load a previously saved scene,
you may notice artifacts with some materials.

Also, preview pictures are not rendered
automatically when importing foreign formats
such as DXF or 3D Studio R4.

If only the base color is shown after rendering
the material, BodyPaint 3D was unable to find
the texture(s).

When saving scenes for use on another
computer, you can ensure that all textures are
included by using Save Project (see page 291).

If you cannot find a texture, select an alternative
texture or delete the name on the appropriate
page of the Material editor.

You can also access this function via the context
menu.

Render All Materials

This function redraws the preview pictures of all
the materials.

When you create a new material, it is rendered
automatically. Why, then, would you need to
use this function?



When you save a scene, the preview pictures
are compressed to reduce the file size. As a
result, when you load a previously saved scene,
you may notice artifacts with some materials.

Also, preview pictures are not rendered
automatically when importing foreign formats
such as DXF or 3D Studio R4.

You can cancel the render process with the Esc
key. If you are using a Macintosh, you can also
cancel with the standard Command-dot
keypress.

If only the base color is shown after rendering
the material, BodyPaint 3D was unable to find
the texture(s).

When saving scenes for use on another
computer, you can ensure that all textures are
included by using Save Project (see page 291).

If you cannot find a texture, select an alternative
texture or delete the name on the appropriate
page of the Material editor.

You can also access this function via the context
menu.

Sort Materials

This will arrange the material list into
alphabetical order.

You can also sort materials manually using drag-
and-drop. This lets you position the materials in
any order you like. Drop the material in the
position of your choice. The insertion is right-
justified, which means it will appear to the right
of the material that you drop it on.
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If the target position of the material is outside
the visible range of the Material manager, you
can scroll by moving the mouse to the upper or
lower edge of the window.

You can also access this function via the context
menu.

Edit

This function opens the Material editor if it is
not already open, and the Material editor will
become the active window. You can use the
Material editor to change the properties of the
active material.

You can also open up the Material editor by
double-clicking on a material's preview picture.
For more details on the Material editor see
below.

You can also access this function via the context
menu.

Apply
Apply creates a texture geometry for the active

object. The active material is applied to the
texture geometry.

You can alternatively apply the material with
drag-and-drop. If you drop the material on to
an existing texture geometry tag...

b
...the previous material in the tag is replaced by
the new one. If, however, you drop the material

on to the object name, a new texture geometry
is created for the material.
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Texture geometry is described in detail on
page 255 under Texture Mapping.

Note

Hold down the Shift key if you do not want the
texture geometry dialog to open.

You can also access this function via the context
menu.

Rename

Use this function to change the name of the
active material.

It's also possible to rename a material by
double-clicking on its name, which is just below
its preview picture.

You can also access this function via the context
menu.

Remove Unused Materials

This deletes all materials which have not been
applied to objects in your scene.

This function is particularly helpful when using
material libraries as it will remove the (possibly
many) unused materials.

You can also access this function via the context
menu.

Note

The Remove Unused Materials function cannot
be undone.

Remove Duplicate Materials

This deletes all materials of the same name
which have identical parameters.

You can also access this function via the context
menu.

Note

The Remove Duplicate Materials function
cannot be undone.

The Material Editor

You use the Material editor to change a
material's properties.

Open the Material editor by double-clicking on
a preview in the Material manager. The Material
editor is a non-modal window, which means
that it does not have to be closed before you
can edit another material. Simply click once on
another material in the Material manager and it
will appear in the Material editor. This helps
speed up your workflow.

You do not have to close the window in order
for the parameter changes to be remembered.

If you do not like the changes that you have
made and wish to revert the material to its
previous state, click on the Undo button. This



function is for the active material only. You can
restore other materials by using the Undo menu
function.

Click on the Refresh button to reshade the
objects in the Perspective View (an automatic
refresh would take up too much CPU time).

The Material editor window is divided into as
many as five panes. The material display is at
the top-left.

There are also 13 parameter pages. The settings
on the parameter pages combine to form an
overall material property. The entire settings for
a parameter page can be activated or
deactivated using the corresponding checkmark
below the material preview. Do not be daunted
by the sheer number of settings! Each parameter

page operates in a similar way and the control
elements are located in the same place. To
access a parameter page, click on the parameter
name that you require, e.g. Diffusion.

Property What it controls

Color Surface color

Diffusion Irregularities in surface color
(works by lightening and
darkening the color channel)

Luminance Luminescent color (light-
independent color)

Transparency  Transparency (including
refraction index)

Reflection Ability to reflect other objects

Environment

Environment reflection (simulates
reflection)

Fog Fog effect
Bump Virtual bumps on a surface
Alpha Localized texture invisibility

Specular

Highlight
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Specular Color Highlight color

Glow Halo around an object

Displacement Authentic bumps on a surface

The Color Pane

Most parameter pages have a color that you can
adjust. Depending on your General Settings (see
Color System, page 43), you will adjust the color
using either a color table or sliders. The meaning
of each slider also depends on the General
Settings. You can use either the HSV color
system or the RGB color system and you can
choose whether the units should run from 0-
100%, 0-255 bits, or 0-65535 bits.

Use the Brightness slider, which is below the
three color sliders (R red, G green, B blue or H
hue, S saturation, V value), to adjust the overall
brightness of the color. Note that if you are
using the HSV system, the Brightness slider has
the same effect as the V slider (i.e. you do not
have to use the Brightness slider; you can leave
it at 100%).

The resultant color is shown just to the left of
the sliders. Click on this color field if you want
to open the color dialog for your system.

Earlier we said you can change the color system
by using the General Settings. You can also
change the color system by clicking on the
small, right-facing triangle just below the color
field. A popup menu will open for you to select
your color system. The Material editor will use
the new system (or color table) for as long as it
is open. The moment you close the Material
editor, it will revert to the color system that is
selected in the General Settings.
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The Texture Pane

Use the texture pane to select a two-
dimensional picture, a 2D shader or a movie
(QuickTime, AVI or a frame sequence). Your
selection will be used as a texture. BodyPaint 3D
recognizes these formats: JPEG, IFF (ILBM), TIFF,
TGA, BMP, PICT, Photoshop PSD, MOV and
AVI. All formats supported by QuickTime are
also recognized, provided that QuickTime is
installed on your system.

Note

Avoid using numbers in picture filenames such
as 'leaf01’, ‘leaf02'. This is because

BodyPaint 3D tries to interpret files numbered in
this way as a frame sequence. Unless you really
are working with a frame sequence, use more
descriptive names rather than numbers (e.g.
‘leaf_maple’, ‘leaf_oak’).

Note

You can load an animation into a material, but
you cannot paint it. If you are editing

CINEMA 4D scenes that contain animated
textures, replace the textures if necessary.

The shader pop-up also contains submenus to
provide a better overview. This makes it easy to
find the shader you need. You can define the
hierarchical structure yourself by arranging
folders and subfolders inside the ‘Plugins’ folder.
However this is possible only if the plug-in
author has not defined the menu position for
the plug-in; if so, you cannot change the menu
position of the plug-in.

You can copy and paste shader settings from
one material channel to another by using Copy
Channel and Paste Channel. So it is just a few

clicks to adjust, say, the bump channel to the
color channel. Of course, this works only for
channels which accept textures and shaders.
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Once you have selected a texture, its preview
will appear to the right with three numbers
immediately below. These numbers tell you the
width, height and color depth of the texture.
You can copy a color from the preview to the
color pane by clicking within the texture
preview; this acts like a color picker.

Image

Use the Image button to load a texture into the
texture pane. Use the system dialog to load an
image file from either your scene’s folder, your
scene’s ‘Tex' sub-folder, or a texture path that
you have specified in the General Settings (see
page 51). A dialog will warn you if the image
file is not in a search path and you will be asked
if you wish to copy the image to the document'’s
folder or, if your scene does not have its own
folder yet, to the BodyPaint 3D root folder.

Once you have loaded a texture, its path name
appears in the text field. To the right you can
see the texture's preview picture.

Note

BodyPaint 3D searches for textures in the
‘BodyPaint 3D/Tex' folder, the scene's folder, the
scene’s ‘Tex' sub-folder and the texture paths
specified in the General Settings (including sub-
folders).



If BodyPaint 3D cannot find a texture when
rendering, a message will appear to tell you
which textures are missing and which materials
use these textures. You can still render the scene
(just click on OK); the materials concerned will
be used without the missing textures.

You can load a 2D shader into the texture pane
by clicking on the small, right-facing triangle to
the right of the image button. Select your
shader from the popup menu.

You can also use the small, right-facing triangle
to reload the image. This is useful if you have
changed the texture in an imaging program and
the preview is now out of date. Reload the
image by selecting the top entry, Reload Image.

Note

You cannot reload a texture while it is in use
(e.g. during rendering).

Note

The shaders can only be evaluated in
CINEMA 4D or BodyPaint 3D. If you save an
object or a scene in another file format, the
shader information is lost.

Blur Offset / Blur Strength

MIP and SAT mapping only approximate the
optimum computation, since a precise
computation would increase the render time
greatly. SAT mapping is more accurate than MIP
mapping. But sometimes these approximations
can make a texture too blurred or too sharp.
Hence the usefulness of these options.

Blur offset softens a texture. The illustration
below shows how you can use this setting to
blur a texture.
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Use Blur Strength to fine-tune the strength of
the MIP/SAT mapping. A positive value
increases the blur; a negative value weakens it.
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Use Interpolation to change the method by
which a texture’s pixels are interpolated.

Interpolation

There are several interpolation types. Each type
is explained below using an example picture. In
particular, we pay special attention to MIP and
SAT mapping.

The texture we used was a mere 16x16 pixels in
size and was placed on to a floor object.



216 * MATERIAL MANAGER ¢ CHAPTER 12

None

When the interpolation type is set to None, the
original texture values are used without any
interpolation. This method is very fast but often
gives poor results. Textures tend to become
pixelated.

You can try to compensate for the pixelation by
using a high antialiasing setting.

Generally, avoid using this interpolation type
unless you are sure of what you are doing.

Circle

Circle interpolation uses a circle of texture pixels
(those that surround the intermediate value).
Textures that are enlarged at render time tend to
look more natural than with the None
interpolation type. However, as the picture
below demonstrates, straight lines are a
problem.

The lines seem to be frayed at the edges.

Circle interpolation is, however, well suited to
very small textures (e.g. 3x3 pixels), since it
helps the pixels to blend softly.

Square

Square interpolation uses a square of texture
pixels (those that surround the intermediate
value). This leads to a softer transition between
texture pixels than with the None interpolation

type.

The image quality is good, although it
deteriorates towards the horizon (especially with
floor textures).

Alias 1, Alias 2, Alias 3

Alias 1, Alias 2 and Alias 3 interpolation blend
the texture more strongly than with Circle and
Square interpolation. Alias 3 blends the most,
Alias 1 the least.



In the picture above, the texture is difficult to
recognize with Alias 3 because it is so small
(16x16). Alias 3 can give smoother results than
Alias 1, but it also takes longer to calculate.

MIP

MIP stands for multum in parvo, which is Latin
for many things in a small place. When many
texture pixels effectively lie within a single
screen pixel, an approximation is made based on
the (known) texture pixel values.

This results in very smooth blending. MIP is the
default mapping type.

SAT

SAT stands for summed area tables and it does
an even better approximation than MIP
mapping. As with MIP mapping, the
approximation is based on the texture pixels
that lie within a single screen pixel.
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SAT is the highest-quality interpolation type.

Note

SAT mapping works with textures up to
4000x4000 pixels. BodyPaint 3D will use MIP
mapping automatically if you try to use SAT
mapping with larger textures.

MIP/SAT mapping

MIP and SAT mapping are very important for
top-quality rendering. MIP mapping is the
default interpolation type.

The next two pictures demonstrate MIP/SAT
mapping. The top picture was rendered with the
antialiasing set to Always and oversampling set
to 2 x 2. The tiled texture used Circle
interpolation. Although the quality is relatively
good, you can see how it falls apart near the
horizon.

The texture breaks up near the horizon.
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This effect is caused by perspective distortion.
Each screen pixel representing the floor near the
horizon contains perhaps hundreds or even
thousands of texture pixels. MIP and SAT
mapping approximate a value using these pixels.
Only an approximation is made, since
calculating the exact value would increase
render time greatly.

The lower picture shows Edge antialiasing with 2
x 2 oversampling. The material used SAT
interpolation. Now even the reflection in the
sphere looks great.

A smooth horizon!

SAT and MIP mapping give you superb render
quality. As with most things wonderful, there is
a price to pay; MIP and SAT mapping love
memory.

MIP mapping needs an extra byte of memory
per texture pixel. SAT mapping is even greedier,
consuming an extra 12 bytes per texture pixel.

So, although SAT mapping gives you higher
render quality than MIP mapping, MIP mapping
needs far less additional memory. Because of
this, MIP mapping is BodyPaint 3D's default
interpolation type.

As a rule of thumb, use MIP mapping initially,
then switch over to SAT mapping if required.

Interestingly, BodyPaint 3D's shaders use SAT
mapping automatically without consuming
additional memory.

MIP and SAT mapping will affect your render
time. On the one hand, MIP and SAT mapping
take longer to render. On the other hand, you
may be able to reduce the antialiasing setting.
Sometimes you can even work with just Edge
antialiasing. In any case, the superior render
quality more than makes up for a slight increase
in render time.

MIP Falloff (Bump page)

Use MIP Falloff to help enhance the MIP/SAT
mapping effect for bump maps. This will reduce
the strength of the bump map with increasing
distance from the camera.

Left, no falloff; right, MIP falloff active

Edit
If you have loaded a 2D shader into the texture

pane, you can access its parameters by clicking
on the Edit button.

If you are using the integrated version of
BodyPaint 3D with CINEMA 4D, you can load a
movie from the texture pane (QuickTime, AVI or



a frame sequence) - click on the Edit button to
access the time control for the movie. Please see
your CINEMA 4D Reference manual for details.

Note

You can load an animation into a material, but
you cannot paint it. If you are editing

CINEMA 4D scenes that contain animated
textures, replace the textures as necessary.

The Mix Pane

You use the Mix pane to mix the color and
texture channels using one of four mixing
modes. The default mixing mode is Normal,
apart from the Environment page which uses
Multiply as the preset.

Not all pages have a mixing pane.

If you load a texture or a 2D shader, it is placed
on a layer above the color (i.e. the texture is
placed on top of the color) and you can use the
Strength slider to set the mixing proportion
between the texture and color panes.

The Mixing Modes

Normal

In normal mode, Strength sets the opacity of the

texture. If Strength is set to 100%, then you see
the texture only (remember, the texture is the
top layer, so if it is opaque, you will not see the
color underneath). If Strength is set to 70%, the
result is 70% of the texture and 30% of the
color.

Let's take an example: if a texture pixel of RGB
255/0/0 (red) is used with a color value of RGB
255/255/0 (yellow) with Strength set to 50%,

the resultant color is 255/128/0 (orange).
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Add

The texture's RGB value is added to the colour’s
RGB value. Color channel values cannot exceed
the maximum of RGB 255. So if a texture pixel
of RGB 0/255/255 (cyan) is added to a color
value of 255/255/0 (yellow), the result is 255/
255/255 (white).

Subtract

The colour's RGB value is subtracted from the
texture's RGB value. Thus if a texture pixel is
RGB 255/255/255 (white) and the color value is
255/0/0 (red), subtracting with 100% strength
gives the result 0/255/255 (cyan).

Multiply

The RGB value of the texture is multiplied by the
RGB value of the color. Multiply takes as its
result the lowest R value, the lowest G value
and the lowest B value of the texture and color.
For example RGB 255/128/0 (orange)

multiplied by RGB 0/255/0 (green) results in
RGB 0/128/0 (dark green).

By layering textures over colors you can create some
spectacular materials
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The Material Editor Pages

Color

You use the Color page to set the basic color of
the material, e.g. RGB 255/0/0 (red).

FTir =T

r‘. L“ |

I Tunpeero i Tl

F:‘-ﬂ- gt f l'l- 3

I Fea mil: -I L I

rr_l"' L]

i, e (|
™ Spaculs Cukce

I B

™ Displscssresy

| Riskesh|

Diffusion

The Diffusion page lets you darken and lighten
the material in specific areas using a diffusion
map. One reason why you might want to use a
diffusion map is to add dust or dirt to the
material, helping you achieve a more natural
look. The diffusion property is a must for
photorealistic results.

If you want to create a more complicated
material (such as a chequered pattern using
several colors), use the Texture pane. The
texture is layered above the color. If you want to

see the color only and not the texture, set the
Strength slider in the Mix pane to 0%.

Note

If you set the Strength slider to 0%, the texture
is not loaded into memory since no calculation is
required.

?’E Vﬁrﬂfmfﬁfg
You use either a conventional texture or a 2D
shader as the diffusion map. (If the texture is
colored, it will still be treated as a grayscale
map.) The darker a pixel in the diffusion map,

the darker the corresponding region of the
material.

You select the Luminance option if you want to
use a diffusion map with the luminance
property. The darker a pixel in the diffusion



map, the darker the corresponding region of the
luminance. This helps you add irregularities to
the luminance to achieve a more natural look.

The Specular option applies the diffusion map to
the specular property as well. This will reduce
the material's specular values where the
diffusion map is dark. This option is selected by
default, since it enhances the realism
considerably.

Select Reflection if you want to apply the
diffusion map to the reflection and environment
properties for an even more natural look. The
darker a pixel in the diffusion map, the darker
the corresponding region of the reflection.
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Luminance

A luminescent object can be seen even when
there are no lights in the scene. It is self-
illuminated.

You can use the Image button to load an image
that is to act as a luminance map. The brighter a
pixel in the luminance map, the more
luminescent the corresponding region of the
material.

IEI-'q A Ol J—F 3
S ——
& paule Lok

[ Eles

[ Diepisscamnens

M= | [Pt |

Ll

If you have chosen a Luminance Color and
loaded a texture (luminance map) as well, the
color will be added at 100% strength to the
texture. If you want to see the result without
the chosen color you can set the Mix slider to
0%.
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Luminescent materials are used to help simulate
objects that seem to be self-illuminated in the
real world, e.g. the windows of an office block
late at night, or neon writing.

Note

The Luminance property does not emit light, i.e.
an object with a luminescent material will not
cast light on to other objects. If you want to
simulate the light cast by luminescent objects,
use light sources.

Transparency

You use this page to make a material
transparent or semi-transparent.
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If your material also has a color, the color is

automatically reduced with increasing
transparency.

The equation is: color percentage +
transparency percentage = 100%.

So a white material with 0% transparency is
white (100%). A white material with 50%
transparency is 50% white (gray). A white
material with 100% transparency has no color.

If you select the Additive option, the color
strength is not reduced automatically and unless
you take care the material will look unnatural.



Transparency is similar to a light filter; black lets
no light through, white lets all light pass.

You can use a texture as a transparency map.
The brighter a pixel in the transparency map,
the more transparent the corresponding region
of the material.

To control the transparency via the Transparency
Color only, set the Strength slider in the Mix
pane to 0%.
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A transparency texture is similar to a
photographic slide. Red parts of the slide allow
only red light to pass through; white parts allow
all the light through. With black, no light can
pass through the slide.

You can use a transparent material with a light
source to create a light map. If a transparent
texture is assigned to a light source, the light
will be filtered according to the texture's
coloration, just like a real slide. You can use this
effect to simulate disco lights, light cast from a
monitor and so on.

You can also simulate the refractive index of a
material by setting the n value on the Refraction
pane. There is, of course, no point setting the
refractive index unless the material is
transparent or semi-transparent.

Objects that are not closed (such as a
hemisphere without a cap) can give unexpected
results with refraction:

R

m="1_0

When a ray hits a surface with transparency and
refraction, the ray is bent to simulate refraction.
The bent ray is considered to be inside the
object. When the ray reaches another surface of
the object (the exit side), it is bent back as in
real life. If, however, you are using an open
object, the ray may not hit a second surface of
the object.
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The raytracer will think that the ray is still inside
the object (e.g. the open hemisphere), because
it never meets an exit surface (which would
bend the ray back as in real life).

Avoid using open surfaces with refraction,
otherwise you may get unexpected refraction
results. In the example, you could effectively
close the open hemisphere with a second wall or
a cap; the important thing is to make sure there
is an exit surface, otherwise the poor ray still
thinks it is inside the object.

n=1.0

If you activate the Fresnel option, the viewing
angle (i.e. the angle between the camera and
the surface) will affect the transparency and
reflection values. If in real life you look at a pane
of glass with your eyes parallel to the pane (i.e.
with a 90° viewing angle), you will notice that
the pane barely reflects; almost all light passes
through. However, look at the pane from a
narrow viewing angle and you should see that it
reflects much more of its surroundings. The
transparency and reflection values are
dependent on the viewing angle. The Fresnel
option simulates this phenomenon for you.

For example, if you have transparency with RGB
values 80%, 80%, 80%, the material is 80%
transparent and 0% reflective with a viewing
angle of 90°. With a very low viewing angle, the
material is approximately 0% transparent and
80% reflective.

If you have entered a reflection value in addition
to transparency, the reflection value is added to
the angle-dependent reflection.

With Fresnel switched on, the water’s reflectivity increases
towards the horizon

If Fresnel is not selected, the transparency and
reflection values are used as they are,
irrespective of the viewing angle.

Note

If there are a large number of overlapping
transparent objects in your scene, you may
notice that some of the overlapping areas are
black when rendered instead of transparent. In
this case you need to increase the Ray Depth
value on the Options tab of the Render Settings
(see page 417).

You may also encounter problems with the
Threshold default value of 15% (see page 418).
Try lowering the Threshold value to 0%.



Some useful refraction values

Material
Vacuum

Air

Ice (H,0)
Water
Glass
Obsidian
Onyx
Acrylic glass
Benzene
Crown glass
Jasper
Agate
Amethyst
Common salt
Amber
Quartz
Sugar
Emerald
Flint glass
Topaz

Jade
Sapphire
Ruby

Diamond

Refractive Index

1.000
1.000
1.310
1.333
1.440 - 1.900
1.480 - 1.510
1.486 - 1.658
1.491
1.501
1.510
1.540
1.544 - 1.553
1.544 - 1.553
1.544
1.550
1.550
1.560
1.576 — 1.582
1.613
1.620 - 1.627
1.660 — 1.680
1.760
1.760 - 1.770
2.417 - 2.419
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Reflection

You use the Reflection page to set a material's
ability to reflect. The color that you set
determines the color of the reflection.

”gmfi '!‘i a’i Er :
You can use a grayscale texture as a reflectivity
map. The brighter a pixel in the reflectivity map,

the more reflective the corresponding area of
the material.

You can also use a coloured texture in the
texture pane. The color of a pixel will affect the
color that is reflected from the corresponding
area of the material.

To control the transparency via the Reflection
Color only, set the Strength slider in the Mix
pane to 0%.
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The picture above shows some reflectivity
effects including a reflectivity map. The flask has
a simple reflective material. Note how the
reflection of the rod is distorted as you would
expect in real life.

Look closely and you will see that the flask itself
is reflected on the tiles.

Look even more closely and you should see that
the flask is reflected on the tiles but not on the
joints, even though the tiles and joints are part
of the same tiled material.

This effect was created by using a grayscale
reflectivity map. The reflectivity map was based
on the original tile and joint texture. In the areas
covered by a tile the reflectivity map is white. In
the joint areas the reflectivity map is black. The
resultant map means that only the tiled areas,
not the joints, are reflective.

This is just one example of how you can

combine several properties to create more
realistic materials.

Note

If there are lots of reflective objects in your
scene, you may notice that with some of them
shadows do not appear in the reflections. To

make the shadows appear, increase the Shadow
Depth value on the Options tab of the Render
Settings (see page 418).

Similarly, you may notice that subtle reflections
are missing. In this case set the Threshold value
in the Render Settings to O (see page 418).



Environment

The Environment page uses a texture to
simulate reflection. Here, in contrast to the
other pages, the Color and Texture are
multiplied in the Mix pane (i.e. not added).

Why would you want to use the environment
property instead of reflection? One reason is
that your scene may not have enough objects in
it to produce good results with reflection.
Another reason is that the environment property
renders more quickly than the relatively sluggish
reflection property.

However, the reflection property has a very
important advantage: it can simulate the object
reflecting itself. Just how important self-
reflection is depends on the object.

Imagine the handle of a gold carriage clock. The
clock looks odd if the handle is not reflected on
the top lid. With a metal ball-bearing, on the
other hand, there is no self-reflection in real-life,
so environmental reflections are fine.
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. 7l
In practice, sometimes you will use an
environment map and reflection in the same
material to get the best of both worlds (self-

reflection and realistic reflection despite a lack of
other objects to reflect).

Environment reflections are very useful for
simulating metal surfaces, which typically have
soft transitions from black to white.

R

The environment property is independent of the
projection type of the material. The environment
is always placed spherically around the object,
parallel to the world axis. Use Tiles to set the
number of tiles in the X and Y directions. Note
that these tile settings are used instead of the
tile options in the texture geometry (see page
255). The latter settings are ignored for the
Environment property.

Note

Environment reflections are rendered very
quickly, since the raytracing mode is not
required.
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The reflections on the BNC connectors were simulated using
the environment property only

Fog

With these parameters you can simulate fog or
gas clouds. Objects with such materials are
translucent but weaken the light that shines
through them, depending upon their density.
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If a light ray penetrates into the fog, it is
weakened. You can control this weakening with
Distance. The larger this value, the thinner the

fog. Distance indicates at which distance a light
ray is completely weakened.

You can also color the fog and this also affects
its visibility. The further you look into the fog,
the less the objects are visible and the more the
fog color becomes visible.

The fog color therefore also depends on the
distance value. If you choose, say, a Distance of
500 units, a light ray of originally 100%



intensity has an intensity of 50% after a
distance of 250 units while after a further 250
units it is extinguished completely.

The shorter the distance, the thicker the fog
appears. In addition to this effect, after 250
units half the fog color is added to the light and
after 500 units the full fog color is added.

You can use fog objects for the simulation of
smoke and vapor in mountain valleys or for
clouds, among many other things.

Fog objects should be always closed volume
objects. Non-closed objects can lead to
physically incorrect results since a light ray,
having once entered the object never again
emerges from the object. The raytracer then
assumes that the light ray is still lost in the fog.

In the illustration above the scene was placed
into a square filled with fog.

Note

Fog uses the refractive index defined in
Transparency and deactivates the transparency.
Fog and transparency are thus never rendered
together, you can render either fog or
transparency.
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Bump

Activate this option to produce a bump map, or
relief map, for your material.

ST

When you select Bump you must always choose
a texture since it is only from the greyscales in
such an image that a bump map (a height or
relief map) can be calculated.

You can change the strength of the bump map
with the Strength slider. This value controls how
far the normal vectors of the object to which the
material is applied change when the bump is
calculated at render time. The higher the value,
the rougher the surface.

However, apply large values carefully since a
material can look unrealistic with high bump
values due to the large jumps in lighting. If you
move the slider to the left, you can choose
negative values. If the strength is negative, the
bump effect is reversed; bright pixels within the
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map cause the material surface to indent and
darken while darker pixels elevate the height of
the normals.

Note

You can type in values over 100% (up to
500%). This can be meaningful and useful if you
are using MIP or SAT mapping since, in those
cases, the bump map is rendered somewhat
flatter than usual.

Here is an even surface, viewed from the side.

profile to render

LTI

brightniess

Since during the lighting of such an even surface
the same normal vector is used, the surface
shows a uniform brightness. But if you use a
bump texture, BodyPaint 3D interprets the
brightness values of the picture as height values
for the surface, as you can see in the following
picture.
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These height values are converted into a profile,
whose height affects the inclination of the
normal vectors. Although the surface is actually
smooth, through the change in the normal
vectors an apparently three-dimensional surface
with a bump-like structure is created at render
time; this is shown in the picture below.

You can strengthen the MIP/SAT mapping effect
when using bump mapping by selecting MIP
Falloff. The bump mapping effect is then
reduced more strongly with increasing distance
from the camera.

Left without, right with MIP Falloff



Alpha

With the parameters of this page you can mask
parts of a texture by selecting an image to apply
to the material. There are two ways to do this:

- Use hard genlocking (so-called clip mapping)
to mask particular areas with a color value.

- Use Alpha channels to mask areas softly and
more accurately.
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The idea is to define areas of your material that
effectively become non-existent so that any
underlying materials show through. The
difference between the two modes is that with
clip mapping color seams can be visible around
the masked texture. Using alphas this can be
avoided. Further, using alphas you can fade
textures and materials softly from one to
another, which gives you even more ways of
creating realistic-looking objects.

If you switch off Soft, you can choose the color
(using the RGB sliders) that is to be masked in
the material.
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Alternatively you can click on the texture preview
picture and pick any particular color that exists in
the material's color.

By setting values for dr (delta red), dg (delta
green) and db (delta blue) you can define extra
color deviations; in this way the color seam
around the masked color can be adjusted.

Similarly, alpha/genlocking is often attempted
with texture images that are antialiased; this
produces a bright border around an object
(caused by the antialiasing of colours between
the main texture and the alpha color); by
adjusting these deviation sliders you can remove
this border.

With Soft enabled (the default setting) the color
and delta sliders lose their meaning. The texture
map is now used to decide which ranges should
be faded. A white texture pixel within the image
means that here the material is to be 100%
opaque. If the texture pixel is black the
underlying material shines through 100%.

With Image Alpha checked you can use any
existing alpha channel of the loaded image. The
following image formats support alpha channels:
TIF, TGA, PICT and Photoshop. If you have
installed QuickTime, additional formats may
support the alpha channel. If no alpha channel is
present, the Image Alpha option will be ignored.

Use the Invert function to invert the result of
your genlock operation, without having to
rework the texture in your image processor (e.g.
Photoshop, PaintShop Pro).

Note

Many of the built-in shaders have built-in alpha
channels (see Shaders below).
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The simple clip mapping does not work with
MIP and SAT mapping - only if you work with
alpha channels can you use MIP and SAT
mapping.

If many alpha materials are present on an
object, it can happen that some underlying
materials are not calculated at render time or are
rendered partly with black areas. If this is the
case, increase the Ray Depth option in the
Render Settings (see page 417).

If clip mapping or alpha mapping affects a part
of the surface, then the underlying material
becomes visible. If the object does not have an
underlying material, the object will be non-
existent at this point.

An example

If you want to place, say, a scanned picture of a
tree into a scene, you will create a material,

activate the Color option, choose a picture of a
tree as the color texture/image and then assign
this material to, perhaps, a rectangular polygon.

If you render this scene now, you should see the
tree on the rectangular polygon. However the
area around the tree is probably not transparent
but may well be blue (if the scanned picture has
a blue sky background).

Now edit your tree material, check the Alpha
option, switch to the Alpha page and load the
tree texture there as well. Use the mouse to
choose the color which you want to mask - in
our case the blue sky around the tree.

BodyPaint 3D immediately sets the color sliders
to this color and masks it according to the
picture. You should now see only the tree
without surrounding background (yes, in the
Perspective View), assuming you have Gouraud
Shading or Quick Shading on). You can now
select a slightly different color on the Alpha
page, click Refresh and see the effect
immediately.

However it may happen that there is still some
background left around the leaves, branches
and the trunk. So the result is not quite right
yet. To obtain a more accurate result, create an
alpha channel in your favorite image processor
(e.g. Photoshop, PaintShop Pro) and integrate
this into your tree image - for details on how to
do this consult your image processor manual.
Then load that picture into the Alpha page and
check Soft and Image Alpha. Now the texture is
masked cleanly.



In the illustration below two materials have
been used, a reflecting gold and a matt wood.
To make the wood visible, one of the two
colours was masked (i.e. genlocked) from a
scanned black-and-white graphic.

The section on texture mapping describes the
handling of several materials in detail, starting
on page 255.
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Specular

Here you can adjust the width and height of the
specular, or highlight.
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If you want a matt surface you should select
broad and low specular values; for polished and
shiny surfaces, however, narrower and higher
values are appropriate.

You can also choose between two lighting
models for the surface:

With Plastic the color of the specular is
independent of the color of the material i.e. it
will normally appear white. This mode is
particularly useful for materials such as plastics,
glass or wood.

" L "

With Metal the color of the specular is
calculated from the material color. This lighting
model is well suited to matt (i.e. not highly
reflective) metal surfaces such as silver, brass
and gold.

il El
Note

You can enter values over 100% (up to 1000%)
for the height of the specular to achieve almost
any result you want. To do this you must enter
the values, numerically, into the box and not use
the slider. High values can be very effective if
you are using the Metal mode.

e
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Specular Color

Here you can select the color of the specular.
The strengths of the Color page and the
Specular Color page are added together.
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The total color here is multiplied with the

normal color of the highlight. If, for example,

you have a white plastic highlight, you can
define its color here directly.

The intensity of the specular is affected by any
chosen texture image (color or grayscale). The
brighter a pixel in the image, the more evident
the highlight is at that point.
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Glow

This property enables you to create a glow, a
kind of halo that emanates from the object and
surrounds it.
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Inner Strength specifies the intensity of the glow
above the material surface; Outer Strength is
the intensity of the glow on the outside (at the
edges).

Outer Strength

Inner Strength

Fadius

The Radius determines how far the glow is to
extend from the object. This value is rendered
relative to the distance of the object from the
camera. The further the object is, the smaller the
glow and vice versa.

You can define a random factor as a percentage:

0% No change
100% Maximum change

Frequency (CINEMA 4D integrated version only)
specifies how often you wish the glow to
change. The amplitude of the change is given by
the Random value.

1Hz  the glow reaches a new random value
after 1 second

25Hz the glow has a new value for each
frame (for 30 fps), which causes a

flicker

Selecting Use Material Color causes the glow to
be calculated on the basis of the material color,
rather than from the color specified here.

If this option is turned off, the object color and
the glow color will be mixed; green objects, for
example, will appear yellowish under a red glow.



Above are two examples of using glow. For the
neon advertisement only an outer glow was
used. For the coal the glowing areas were
created with Use Material Color.

Notes

The glow you specify here does not act as a
light. In other words, other parts of the scene
will not be lit by the glow, nor will any shadows
be cast.

Glows cannot be seen through transparent
objects, nor in reflections.

Glows are restricted to a maximum image
resolution of 4,000 x 4,000 pixels.
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Displacement

Displacement is similar to Bump, the difference
being that here the object is actually (not just
apparently) deformed.
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This difference is best seen at the edges of
objects. Look carefully at the illustration below.
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A bump texture has been applied to the left half
of the sphere, a displacement texture to the
right. The bump region is characterized by a
smooth edge, the displacement region has
distinct deformities; as a consequence of the
actual deformation, the shadows on the inside
of the sphere’s surface have changed slightly.

You can adjust the strength of the displacement
with the Strength slider. Under Maximum
Height you specify a distance from the object
surface, which may not be exceeded whatever
the strength setting.

The illustration above illustrates that fairly
complex models can be created using relatively
simple means.

Note

It is in the nature of the displacement effect that
objects must be finely subdivided for this effect
to work.

The Shaders

Shaders are mathematically computed textures
which can be two dimensional or three
dimensional. The advantage of shaders is that
they are always only as large (detailed) as
necessary since they are computed on the fly.
That means that you are able to zoom infinitely
close to a shader without ever seeing a pixel.

You will find shaders in different places in
BodyPaint 3D. There are native BodyPaint 3D
shaders which are built into the program, and
there are external shaders that are found within
the ‘Plugins’ folder.

External shaders may be in C.O.F.EE.E. format
(extension ‘.cof’ ASClII or ‘.cob’ binary) or
programmed natively in C for a particular
platform (extension ‘.cdl').

All shaders are loaded when you start the
program and can be invoked directly from the
Material manager using File > New 3D Shader
from the menu or from within the Material
editor, directly from the Texture input field.
Shaders cannot be invoked by directly typing
their name.

Note

The shaders can only be evaluated in
CINEMA 4D or BodyPaint 3D. If you save an
object or a scene in another file format, the
shader information is lost.

2D Channel Shaders

2D shaders are also known as channel shaders
because they are only ever used for a single
material channel in BodyPaint 3D lingo, i.e. for a
particular material property such as Color or



Transparency. These shaders are always flat and
are applied to an object using a particular type
of projection (see page 258).

2D shaders are loaded in the Material editor in
place of bitmap textures. To open a 2D shader
click on the right-facing triangle, which is to the
right of the texture input field in the texture
pane. This opens a popup menu from which you
can select the appropriate 2D shader.

To edit a 2D shader, click the Edit button in the
Material editor.

Note

There are three ways of changing the detail (i.e.
the frequency) of the shading; adjust the length
of the texture axes, change the actual frequency
values in the shader dialog, or modify the tiling
or texture lengths.

There follows a description of each built-in 2D
shader, complete with a description of its
parameters (accessible through the Edit button)
and the effects of changing those parameters.
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Brick

This shader generates brick patterns. The Brick
shader has an alpha channel which you can use
within the Material editor on the Alpha page.
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Color 1 determines the color of the brick.

Color 2 determines the color of the joints.

Joint is the width of the joint relative to the size
of the brick.

Bevel defines the width of the sloping edge
between joint and brick, as a percentage of the
brick width; this gives a fuzzy edge to the brick.

Note

You change the number of bricks using the
texture tiling.
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Checkerboard

This shader creates checkerboard patterns.
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Color 1 and Color 2 determine the colours of
the two tiles.

U-Frequency and V-Frequency determine the
size of tiling, the fineness of the structure, in
two independent directions. Higher values result
in a smaller tiles and vice versa. If you use
unequal values such as 1/2, instead of square
tiles you'll get rectangular ones.

Cloud

This shader simulates simple cloud structures. The
Cloud shader has an alpha channel which you can
use within the Material editor on the Alpha page.

Color 1 determines the color of the sky.
Color 2 determines the color of the clouds.

U Frequency and V Frequency determine the
fineness and shape of the structure. Thus 1/1
results in rather regular cloud structures, 1/0.25
rather oblong clouds and the higher the value,
the finer (less wispy) the clouds.

Clouds affects the number of clouds in the sky.

Note

Effective Cirrus-like clouds can be created with
asymmetrical UV parameters (e.g. 0.25/1).



Cyclone

This shader simulates a cyclone. The Cyclone
shader has an alpha channel which you can use
within the Material editor on the Alpha page.
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Fire

This shader simulates a wall of flame. The Fire
shader has an alpha channel which you can use
in the Material editor on the Alpha page.

Color 1 and Color 2 define the start and end
colours for the color transition.

T Frequency (integrated version only) defines
the timing of the cyclone rotation, the strength
of the storm.

Rotation determines the effective density of the
cyclone, the higher the value the more spirals in
the storm.

Clouds affects the number of clouds (Color 1
areas) in the cyclone.

U-Frequency and V-Frequency determine the
fineness of the structure. Thus 1/1 results in
regular flames, 1/0.25 rather elongated flames.
T-Frequency (integrated version only) affects the
speed of the flicker, how quickly the flames
change - the higher the value, the higher the
frequency of the flicker.

Turbulence (integrated version only) determines
how violently the flames move around, or break
up, in a notional wind. A setting of 2 doubles
the speed of movement (i.e. the wind); a setting
of 0 suppresses all wind.
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Note

The wall of flames stretches infinitely in the U
direction. Good fire materials can be created by
using this shader both in the Alpha channel and
the Transparency channel (in the Alpha channel,
dr/dg/db should be set relatively high, to
approx. 30%).

Flame

This shader simulates a single flickering flame,
such as a candle. The Flame shader has an alpha
channel which you can use within the Material
editor on the Alpha page.

T-Frequency (integrated version only) is a
scaling factor that affects the speed of flicker,
how quickly the flame changes.

Turbulence (integrated version only) determines
how violently the flame moves around, or
breaks up, in a notional wind. A setting of 2
doubles the speed of movement (i.e. the wind);
a setting of O suppresses all wind.




Galaxy

This shader simulates a galaxy with spiral arms.
The Galaxy shader has an alpha channel which
you can use within the Material editor on the
Alpha page.

Color 1 is the color of the star clouds.

Angle is the degree of rotation of the spiral
arms.

Spiral Arms is the approximate number of spiral
arms.

CHAPTER 12 « MATERIAL MANAGER « 243

Gradient

This shader creates a smooth gradient between
two colours.
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Color 1 and Color 2 specify the start and the
end colours for the transition.

Mode gives the type of the gradient. Axial is
color gradient along a line, the orientation of
which is defined by Angle (see below). Radial is
a radially expanding gradient starting from the
center of the texture.

Angle gives the direction of the (axial) color
gradient. 0° is the X axis, 90° is the Y axis, etc.
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Marble

This shader creates marble structures.

Color 1 and Color 2 determine the marble
coloring.

U-Frequency and V-Frequency determine the
fineness and shape of the structure. Thus, for
example, 1/1 results in a radial-like pattern, 1/
0.25 rather elongated shapes. The higher the
value, the higher the frequency, or detail, of the
pattern.

Turbulence adds noise to the detail. 0% = no
turbulence.

Neptune

This shader has no dialog. It simulates the planet
Neptune with its typical colouring and cloud
structure.




Noise

This shader creates a random pattern that can
be used, for example, for sun surfaces and stone
reliefs.

By overlapping several Noise shaders with
different amplitudes and frequencies, you can
create masses of interesting patterns (this is like
signal synthesis).

Color 1 and Color 2 determine the start and end
colours of the transition.

U-Frequency and V-Frequency determine the
fineness of the structure. Thus, for example, 1/1
results in a radial-like pattern, 1/0.25 rather
elongated shapes. The higher the value, the
higher the level of detail in that direction.
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Saturnring

This shader has no dialog. It creates, for use
with the Saturn shader, an astronomically
correct simulation of the rings around Saturn —
the D, C, B, A, F and G rings, with the Cassini
and Encke gap.

The Saturnring shader has an alpha channel
which you can use within the Material editor on
the Alpha page.

Notes

Saturn is approximately one third as wide as the
width of the ring structure.

So that stars shine through between the rings,
you should activate the alpha channel of any
material to which this is applied.

You may want to make the rings quite
transparent since in reality these rings are
millions and millions of tiny rock and ice
particles which allow the light from beyond to
shine through.
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Saturn Starfield

This shader has no dialog. It simulates the planet ~ This shader has no dialog and simulates a starry
Saturn with its typical coloring and cloud night. The number of stars can be controlled by
structure. tiling the texture.

The texture is cyclic in the U direction.

Note

Note The stars are always computed with a
continually varying size. In addition, the
brightness of the stars varies. Thus you should
have the impression that some stars are closer
than others.

Because of its fast rotation speed (a mere 10
hours) Saturn has an elliptical shape. If you want
an astronomically accurate representation of the
planet, you will need to flatten any sphere to
which this shader is applied — in other words its
Y axis should be scaled by about 0.85.

Tip
If you mix the Saturn shader with, say, a brown
color (50% shader/50% brown color) you can
simulate many rock formations which you can
then project on to a Landscape object.



Stars

This shader creates a star-filled wallpaper.

Color 1 is the color of the wallpaper.
Color 2 is the color of the stars.
Points is the number of star tips or points.

Inner Radius and Outer Radius determine the
dimension of each star, given as a percentage of
a U/V unit.

Stars is the average number of stars per UV
unit.

Although we use the term U/V unit above
accurately, you may want to think of the
preview as an element that is one U/V unit in
each direction - this will help you visualize the
changes you make.
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Sunburst

This shader generates sun flares and eruptions.
The Sunburst shader has an alpha channel which
you can use within the Material editor on the
Alpha page.
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R Frequency determines the radial frequency; a
value of 0 yields a lovely aurora.

A Frequency gives the angular disturbance; O
gives individual layers.

T Frequency (integrated version only) defines
the speed of the sunburst; 2 doubles it, 0
suppresses all movement.

Turbulence changes the appearance of the
eruption; the higher the value, the more
fragmented this region appears.

Radius defines where the eruption begins, as a
percentage of the overall size.

Height defines the width of the eruption region
relative to the radius.
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Turbulence

This shader creates colored, fractal turbulence.
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Color 1 and Color 2 specify the ends of the
color transition.

U Frequency and V Frequency determine the
fineness of the structure. 1/1 creates a radial-
like pattern, 1/0.25 elongated shapes. The
higher these values, the greater the detail (or
frequency) in the relevant direction.

Steps is the number of iteration steps for
generating this fractal turbulence.

The more steps you have the more added detail
you obtain. With a setting of 1 the Turbulence
shader is almost identical to the Noise shader;

there is no point in setting this value too high since

only a certain amount of detail can be added.

An example of using the Turbulence shader on a cube

Uranus
This shader has no dialog.

It simulates the planet Uranus with its typical
colouring and cloud structure.

~y




Water

This shader generates water surfaces and is ideal
for use in a material’'s Bump channel for
simulating water surfaces perturbed by wind. It
can simulate slight turbulences (ripples) and
more significant ones (waves).

U Frequency and V Frequency determine the
fineness of the structure. 1/1 creates radial-like
wave patterns, 1/0.25 rather elongated wave
fronts. The higher the values, the higher the
effective wave detail in that direction.

T Frequency (integrated version only) is the
speed at which the water moves in the U
direction (0O means no movement, 2 doubles the
speed of movement).

Wind specifies the amplitude of a notional wind
that breaks up the water — the higher this value
the more the wind disturbs the water surface.
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3D Volume Shaders

3D shaders are also known as volume shaders
because they penetrate the volume of the object
and emerge on its surface. This means that they
cannot be used as textures within the Material
editor; instead, a 3D shader directly defines a
material - or, in other words, a 3D shader is the
material.

3D shaders are loaded in the Material manager
in place of materials. To load such a shader go
to the menu File > New 3D Shader and select a
shader from the submenu.

3D shaders are edited, like all materials, by
double clicking in the Material manager on their
preview picture.

All volume shaders can be applied to a 3D
object very precisely either by changing the
values in the relevant Shader dialog or, often
more simply, by adjusting the texture axes
values (double-click on the texture attribute icon
in the Object manager). By changing the length
of the texture axes (in addition to modifying the
shader settings) a change of the effect of the
shader is possible.

A 3D shader will always adapt to the size of (or
grow on) the 3D object to which it has been
applied. There will be no edges or seams. Since
they exist throughout an object’s volume, 3D
shaders can give much more realistic results
when applied to objects that have areas cut out.

Note

3D shaders cannot be combined, unlike normal
textures.
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Color

This colourful shader uses sine functions to cycle
through the RGB color range.

Kﬁw-ﬂli_
Thegeng [l
3Fr-:-w|1—.

% | Corcal

X-Frequency, Y-Frequency and Z-Frequency
specify the behaviour of the colours: e.g. high
values mean more detail in that direction,
different values for X, Y and Z give asymmetrical
behavior.

Earth

This simulates an Earth-like planet with mountains.
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Sea Level determines the color for areas which
have a height of less than zero.

Land Level is the color for middle height terrain.
Mountain Level is the color for high terrain.

Bump gives the degree of bump mapping —
0% means a smooth surface with only patches
of color. Note that water is always smooth; only
land areas should be covered with a relief.

Frequency adjusts the level of land detail. 0% is
practically all water; 50% is equal parts of land
and water; 100% is practically all land.

Specular is the specular factor, which appears
only on water surfaces. 0 is none; 1 is large; 50
is small; 150 is very small




Fog

This shader simulates volumetric fog.
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General pane

Samples defines the average number of samples
that need to be computed per raytracing ray.
The higher this number, the greater the quality
of the fog but the longer the calculation time.

Tip
Start with low numbers, say 6 or 8. Increase this
value only if you get disturbing artifacts or if the
detail is not good enough (e.g. in relation to
visible shadows in fog). Note that after a certain
point (depending on what's in the scene) higher
sample values will not produce better images.

Volumetric is the ultimate performance killer. If
the option is switched off, the basic color of the
fog is all pervading. Light sources have no
effect. This is normally sufficient to simulate fog
in a fractal valley.
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With Volumetric switched on, all light sources
(including the type of the light source) will be
taken into account. If the light sources cast soft
shadows and there are objects in the beam,
these will cast shadows even in fog.

Caution!

The Volumetric option costs a tremendous
amount of computing time.

X-Frequency, Y-Frequency and Z-Frequency
determine the appearance of the fog: double
the values to get twice as much detail, use
different values for X, Y and Z for asymmetry.

Fog pane
Color is the color of the fog.

The popup allows you to control the fog
intensity over distance. Linear decreases the fog
intensity along the Y axis of the texture axes.
Exponential decreases the fog intensity along
the Y axis of the texture axes. None means
constant fog density.

Thickness: the lower this value, the thinner the
fog.

Decrease: the lower this value, the lower the
volume (or depth) of fog that is generated.

Turbulence pane

In addition to the above parameters you can
also create turbulent fog patches. Turbulence
specifies the degree of whirl within the fog (0 =
no turbulence). Amplitude specifies the average
size of the rotating turbulence cells (rolling fog).
T-Frequency (integrated version only) controls
the speed of the swirling fog (0 = no
movement).
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Marble

This shader generates 3D marble structures.
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Color 1 and Color 2 specify the marble coloring.

Reflection is the degree to which the
environment is reflected in the marble. To see a
weak reflection you will need to activate
Reflections in the Render Settings and possibly
reduce the Threshold from its default 15%.

Specular determines the factor for the
specularity. O is none; 1 is large; 50 is small; 150
is very small, etc.

X-Frequency, Y-Frequency and Z-Frequency
determine the detail of the marble in those
directions (e.g. double values mean twice as
much detail). Use different values for X, Y and Z
for asymmetry.

Turbulence changes the overall complexity of
the marble.




Metal

This shader simulates metallic surfaces.
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Color specifies the color of the metal.

Bump and Frequency define the roughness of
the surface. The surface is reflective and
optionally takes a metallic specular.

The strength of the reflection is determined by
the Reflection setting.

Specular is the strength of the specularity.
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Rust

This shader simulates rust on metal surfaces.

You choose the colours for the metal and the
rust using the color fields, Metal... and Rust....

Rust specifies the percentage of rust on the
metal surface.

The rust is initially flat. It can be raised by
optionally using the Bump (relief) setting.
Frequency determines the degree of jaggedness
of the rusty areas.

You define the degree of reflection of the clean
part of the surface with the Reflection setting.
The rust-free areas are reflective and may be
enhanced by an optional metallic specular.
Specular defines the size of this specular.
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Terrain

This shader generates virtual, fractal landscapes
featuring mountains and valleys. The popup
menu at the top allows you to select from a list
of predefined types of terrain or to start from
scratch with user-defined.

Using the buttons below the popup menu you
can assign colors to different heights of terrain.

The values are percentages of the fractal height.

Height defines the vertical dimension of the
fractal within a 3D object. With a value of 50
the fractal covers half the object (assuming the
texture is adapted by size to the object).

The Terrain shader is not infinitely large. Its
maximum size is determined by the size of the
texture geometry. If this is smaller than the
object on which the shader is used, the shader
does not fill the object. If necessary adapt the
size of texture geometry to the object.

Venus

This shader simulates a gaseous planet with
cloud structures whirled around by the Coriolis
stream.
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Color 1 and Color 2 define the colours of the
clouds and the background sky.

Rotation determines the degree of whirl or
turbulence caused by the Coriolis stream.

X-Frequency, Y-Frequency and Z-Frequency
determine the fineness of detail in those
directions.




Wood

This shader simulates wood patterns. The popup
menu at the top allows you to choose some pre-
defined wood types (which you can then change)

or go for a user-defined wood from the beginning.
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Color 1 and Color 2 change to color of the
wood and its grain.

X-Frequency, Y-Frequency and Z-Frequency
affect the look of the wood. X and Y change the
frequency of the rings in those directions (high
values lead to fine detail) while Z affects the
grain — for example, values of X=0.5, Y=1 and
Z=1 will produce elliptical rings.

Turbulence determines the degree of growth
irregularity (0% = even concentric annual rings,
100% = a more natural, uneven ring
appearance).

CHAPTER 12 « MATERIAL MANAGER e« 255

Texture Mapping

Texture geometry
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The Texture geometry dialog opens when you
allocate a material to an object. The settings in
this dialog tell BodyPaint 3D how to apply the
material. For example, you may want the
texture to be tiled (i.e. repeated), or you may
want to place the texture in a specific region of
the object. You can also have the texture
mapped on one side only (decal mapping). In
this chapter we will explain all the options in the
Texture geometry dialog.

Applying a texture

You can apply a texture to an object in the
following way:

- First, make sure that you can see the object in
the Object manager. Then, hold down the left
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mouse button while you drag the material
from the Material manager and drop it on to
the name of the object in the Object manager.
The Texture geometry dialog will open for you
to enter details of how to apply the texture.
This dialog can be skipped if you hold down
the Shift key while dragging the material on to
the object.

The mouse pointer will change during this
process to indicate the add state.

a1

- You do not have to use drag-and-drop, you
can also use the following method: first,
activate the object in the Object manager, then
activate the material in the Material manager.
Now select Function > Apply in the Material
manager. The Texture geometry dialog will
open for you to enter details of how to apply
the texture. This dialog can be skipped if you
hold down the Shift key while dragging the
material on to the object. Once this dialog is
OK'd (or if the Shift key was held down), the

active material will be allocated to the active
object.

- You can drop a new material on to an existing
texture geometry. The new material will
replace the old one but will inherit the existing
geometry settings.

If the material does not use texture maps (pure
glass, for example) or if it a 3D shader, you will
not need to change any settings in the Texture
dialog; you can click on OK to close the dialog
immediately. Such materials do not use the
texture geometry settings.

Note

Remember, to prevent the Texture geometry
dialog opening hold down the Shift key when

you apply the texture. This is particularly useful
for 3D shaders or materials that do not use
textures, since they do not use the texture
geometry settings.

If, on the other hand, your material does use
texture maps, you will need to set the Texture
geometry dialog to specify the projection type,
the position of the texture and so on.

Search For

The first text box contains the name of the
material that is being applied. If you type in the
name of a different material, BodyPaint 3D will use
the new material instead of the previous one for
this texture geometry. Also, note that you usually
need type only the first few letters of the name,
since BodyPaint 3D will complete the rest of the
name for you in the area to the right of Name.
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Comment

Perhaps you are wondering why you must type in
the material name rather than select it from a list.
Imagine that you have started a new project and
you have loaded your standard material library,



which contains 100 woods, 50 marbles, 20 relief
textures, 30 backgrounds and so on. You want to
add one of the mahogany textures to an object.
Up pops the selection window. Okay, it's down
here. Down a bit more. Oops, missed it. Back a bit
... Once you have become accustomed to typing
in material names (and giving your materials
sensible names!), you should find this a much
more efficient way to work.

Offset, Length, Tiles

These settings are to be found towards the
middle of the dialog. Offset and Length set the
position and size of the texture respectively on
the texture geometry. You can also change these
values interactively in the Perspective View with
the Texture tool active (see page 369).

Offset defines the position of the texture on the
texture envelope (the texture geometry). You
can use Length to increase or decrease the size
of the texture on the texture envelope. The
Offset X and Offset Y values are given as
percentages, since the actual size is irrelevant.
100% for both means that the texture covers
the envelope completely.

The Tiles X and Tiles Y values define how many
times the texture fits on to the texture envelope
in the X and Y directions. Hold on a moment,
isn't that the same as changing the length? Yes,
exactly. You can change the length either in
terms of tiles (Tiles) or as a percentage of the
texture envelope (Length). Either way, changing
one will cause the other to change too.

Using the Tiles X and Tiles Y settings does not
mean that the texture will be repeated (tiled)
automatically. This only happens if you activate
the Tile option (which we will return to later).
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Position, Size, Rotation

These settings appear near the bottom of the
dialog window. You can also change these
values interactively in the Perspective View with
the Texture Axis tool selected (see page 369).

The following pictures show you the difference
between the Texture tool and the Texture Axis
tool. Both pictures demonstrate a movement in
the X direction. In the first picture, the texture is
moved about the texture envelope (Texture tool,
Offset). In the second picture, the texture
geometry itself is moved (Texture Axis tool,
Position).

The texture geometry can be shown either as a
texture grid or as a realtime texture. You can set
this option globally (enable Display > Textures
in the Perspective View), or you can give the
object its own (local) display tag with this option
on or off (see page 196).
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Projection (mapping types)

The Projection setting determines how the
texture is projected on to a surface. The
projection surface is independent of the real
surface of the object, although often it has the
same basic shape (e.g. flat, spherical, cubic...).

UVW mapping (which is explained in more
detail later) fixes the projection on to the surface
points of an object so that, when the object
surface is deformed (like a flag would be in the
wind), the texture deforms with it.

The best mapping type to use depends on the
shape of the object to which you apply it. First
let's take a look at some examples for the first
three mapping types (spherical, cylindrical and
flat) and then we'll describe the others with
fewer examples.

You can change the mapping type using the
Projection pop-up in the Texture dialog.
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Spherical mapping

Spherical mapping projects the texture on to the
object in a spherical form.
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Spherical mapping applied to a sphere
Spherical projection is rarely suitable for flat

objects. There is distortion with cylindrical
objects too.



Cylindrical mapping

This mapping type projects the texture on to the
object in a cylindrical shape.

Cylindrical mapping applied to a plane
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Cylindrical mapping applied to a sphere

Cylindrical projection is rarely suitable for flat
objects. It also leads to distortion when used
with spherical objects. Notice how the pixels
near the top and bottom of the texture map are
pulled inwards on the caps. You should apply
separate textures to the caps.
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Flat mapping

Flat mapping projects the texture on to the
object in a planar direction.

Flat mapping applied to a sphere

Flat projection tends to be used with flat objects
only. The texture is soon distorted when applied
to a sphere or cylinder, as the examples
demonstrate.



260 * MATERIAL MANAGER ¢ CHAPTER 12

Cubic mapping

Cubic mapping projects the texture on to all six
sides of a texture cube.
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Cubic mapping applied to a cuboid

We have halved the size of the texture above
left so that you can see the mapping more
clearly. In the rendered picture the texture
length has been restored to 100%.

Frontal mapping

The texture is projected from the camera
position on to the object.

IEEE
Frontal mapping applied to a cuboid

The picture above shows how the cube blends
into the background using frontal mapping -
only the cube’s shadows are visible.

Spatial mapping

Spatial mapping is similar to flat projection.
However, with spatial mapping, the texture is
pulled up and to the right as it passes through
the object.

The difference between flat and spatial mapping

On the left, notice how flat projection can lead
to unattractive stripes. The picture on the right
shows how spatial mapping solves this problem.

Spatial mapping does, however, cause some
distortion and as such it is not suitable for
photographic images. Spatial mapping is more
suitable for structure textures (e.g. marble,
plaster, ...).

UVW mapping

If an object has UVW coordinates you can select
them as the projection type. In this case the
texture geometry is fixed to the object surface
and is subject to all subsequent movement and
deformation applied to the object.

All polygon objects with UVW coordinates
display a UVW coordinates icon in the Object
manager.



g

In the illustration below, flat projection was used
for the object on the left, UVW mapping for the
one on the right.

Notice how the UVW texture has been
deformed along with the object.

You may be wondering why there are three
coordinates (UVW). What is the third coordinate
for?

The third texture coordinate (W)

Conventional textures have two coordinates,
one for the horizontal position X, and one for
the vertical position Y. In order to make it clear
that the coordinates refer to a texture, X is
renamed U, and Y is renamed V. Two
coordinates (U and V) would be sufficient were
it not for 3D shaders. These are three
dimensional textures (see The Shaders,

page 238), and as such they require a third
coordinate (W) in order to be fixed to the
object.

You can apply more than one UVW texture
geometry to an object. Create a new texture
geometry for the object, then set the projection
you require, e.g. flat mapping for a label
texture. Next, create new UVW coordinates for
the active texture by selecting Generate UVW
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Coordinates in the Object manager. The active
texture geometry will be set to UVW mapping
and will deform together with the object.

The UVW coordinate system

What is the structure of UVW coordinates?
Imagine a grid divided into a U direction and a
V direction.

, u 1,8
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The UV range starts at 0,0 and ends at 1,1. For
an upright polygon 0,0 describes the top left;
0,1 the bottom left; 1,0 the top right and 1,1
the bottom right. A texture is stretched out
between these four coordinates.
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But where is the W coordinate in this system?
Recall that conventional textures are two-
dimensional - the W coordinate is created only
when it is needed. Once created, the W
coordinate behaves in the same way as the UV
coordinates.

Selective UVW mapping

BodyPaint 3D has two ways of allocating texture
projections to polygon selections (rather than to
the whole object as described above). The first
method is described below. The second method,
Restrict To Selection, is described on page 269.

Selective UVW mapping allows you to apply a
different projection type to several regions of
the object using the same texture geometry.

Proceed as follows
- Import a sphere.

- Create a new material with a texture, e.g. the
checkerboard shader.

- Set Projection to Flat.

- Activate the Polygons tool and select several
polygons in various locations.

- Select Generate UVW Coordinates from the
Texture menu (in the Object manager).

If you are in RTTM mode you can see
immediately that the selected polygons use flat
projection while the unselected polygons
continue to use the normal UVW mapping. If
you deform the object, the texture remains fixed
in the selected region.

Note

Selective UVW mapping is designed to allow
you to allocate an optimum projection type to
specific areas. If you want to use different
materials in these areas you should use Restrict
To Selection - see page 2609.

Shrink Wrapping

With this projection type the centre of the
texture is fixed to the north pole of a sphere and
the rest of the texture is stretched over it. The
advantage of this mapping type is that the
texture meets itself at the south pole only. This
avoids a seam running between the poles.

Only a circular section of the texture is used,
with the centre of the circle corresponding to
the centre of the picture. The remainder of the
picture is discarded.

*Morth Pake

“south Pole™

In the illustration above, notice how the texture
meets itself at the south pole.



Decal mapping

Unfortunately, the term decal means different
things in different programs. Therefore we need
to be clear on BodyPaint 3D's definition.
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Imagine that you project a texture on to a
rectangular polygon with flat mapping. If you
move the camera around the rectangle to look
at the other side of the surface, you will still see
the texture, but it will be the wrong way round.
You can solve the problem by using a decal - a
material that is projected on one side of a
polygon only.

It is very important for you to understand how
decal mapping works, since guessing is not
always enough. (You may find that, whatever
you guess, you still cannot get the decal you
require.)

The direction of the surface normals for each
polygon (see page 14) plays a pivotal role in
deciding to which side of the polygon the
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texture is mapped. Front is in the direction of
the surface normals and Back means in the
opposite direction to the surface normals.

face normal faoe ncemal
front ! back
Example

You wish to place a label on a tube. With flat
projection this ought to be simple enough. You
have adjusted the settings (see Labels,

page 267) and you render the tube. Hold on a
moment, that's not right... the texture also
appears on the reverse side of the tube:

i\

What has happened? With flat projection a
texture is projected from the front through to
the back of an object. As a result, the texture is
also visible where it is not wanted. Decal
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mapping comes to the rescue - change Front
and Back in the texture geometry to Front. Now
render the tube again. This time the label is
visible on the front side only:

The explanation is simple. If the viewing angle
(i.e. the camera angle) and the surface normal
form an angle of less than 90° to each other, the
polygon is a front polygon; otherwise it is a back
polygon.

The only exceptions are for flat and spatial
mapping. Here there is an additional criterion:
the direction of the texture projection’s Z axis. If
the texture's Z axis points in the opposite
direction to the surface normal, and if the
viewing angle and surface normal form an angle
of less than 90° to each other, the polygon is a
front polygon; otherwise it is a back polygon.

Front and Back

If you choose Front and Back the texture is
projected in the direction of the surface normals
and also in the opposite direction.

Front

If you have selected Front you see the texture
where the surface normals point towards the
camera, otherwise the material is invisible.




Back

If you project the texture from the back you will
see the texture only where the surface normals
point in the opposite direction to the camera.
The material is otherwise invisible.

A practical example of decal mapping

CHAPTER 12 « MATERIAL MANAGER ° 265

Tiled Textures

Sometimes we need to do more than merely
project the texture on to an object. Imagine you
are texturing a brick wall. Do you really want to
create a texture for an entire facade and four
walls? There is a much easier way.

All you need is a seamless texture, which you
project, perhaps with cubic mapping and a
suitable number of tiles.

Tiles

You can use the Tile X and Tile Y settings to
define how many times the texture picture is
repeated, i.e. you use these settings to specify
the number of tiles. BodyPaint 3D calculates the
size of an individual tile from the current texture
size. For example, if you have scaled the texture
so that it has a length of 25% in the X direction
and 50% in the Y direction, the texture fits four
times in the X direction (1.0/0.25) and twice in
the Y direction (1.0/0.5) on the surface.
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If you change the Tile X or Tile Y settings, the
Length settings change automatically. For
example, if you change the number to 3, the
texture shrinks from 50% to 33.33%. You can
see this immediately if you leave the window by
clicking on OK.

Tile
If you activate this option the texture picture
will be repeated endlessly on the surface.

The effect becomes visible when you scale down
the texture (see page 369), or when the texture
geometry has not yet been fitted to the object
(see Fit To Object, page 202). Otherwise, the
texture map fills the entire texture geometry
once.

%‘.l

If this option is not active, the texture map will
not be repeated on the surface.

Any materials that are underneath (see Texture
Layers, page 267) will show through in the parts
not covered by the texture tile.

Note

If you select the Tile option for a 2D or 3D
shader it is not, strictly speaking, tiled, but
instead fills the entire object seamlessly. There
may or may not be a repeating pattern
depending on the programming of the shader.

Seamless

If the Seamless option is activated, tiles are
mirrored to prevent visible seams. This is
particularly useful for objects that are not
seamless, although typically it generates a
butterfly pattern.

Note

Seamless is generally of little use for photo
textures (although you can generate some
interesting patterns). This option is better suited
to pictures with a pattern, such as wood, stone
or marble.



Labels

By now you know how to apply textures, how
to tile (or not tile) them, and how to prevent
seams. How, though, can you put a label on a
bottle?

This is what you need to do:
- Open the Texture geometry dialog.
- Deselect the Tile option.

- Check that only one tile is created in the X and
Y directions.

Done. OK, the texture probably covers the
entire object (that's one big label) but now you
can scale it down.

Usually, the quickest way to scale (and for that
matter position) your textures is to work in
RTTM mode. Select the Scale tool, then select
the Texture Axis tool. You can use the mouse to
reduce the scale of the texture. Next, select the
Move tool and place the texture wherever you
like on the object surface.

The texture is often slightly out of proportion
after scaling. However, we have a little trick for
you. Open the texture geometry dialog and
adjust the size of your texture in the length
fields. Since the length cannot exceed 100%,
you may need to divide both values.

For example, if your texture is 800 x 600 pixels,
you might set the lengths as follow:

X Y Conversion Factor
80 60 /10

8 6 /100

32 24 /100 x 4 etc.
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Texture Layers

BodyPaint 3D lets you use as many materials
and texture geometry tags on an object as you
like. Think of a suitcase with travel stickers -
there is a base material (e.g. the leather of the
suitcase) and many materials on top (e.g. the
stickers).

You cannot see the original suitcase material
(leather) in those places where there are stickers.
Also, when there are many stickers on the
suitcase, they overlap each other. The stickers
on top cover those underneath. Where several
stickers share the same space, only the top
sticker is visible. If you want to see one of the
old stickers, you must either remove one of the
newer ones or make a hole in it.

This analogy can be related closely to
BodyPaint 3D’s behaviour. Your object has a
base material. You have additional materials on
top of the base material. In order to see the
base material, the overlying materials must be
scaled down and not tiled. You can do this by
scaling down the texture geometry and at the
same time turning off the Tile option (see Labels
above). If two materials overlap and you want
to see the bottom one, you must make a hole in
the top one. You can do this using alpha
mapping or clip mapping (see page 231).

Only one question remains unanswered: how
does BodyPaint 3D know which layer a material
ison?

The answer is quite simple. When you apply
several materials, each new material is placed on
top of the previous one. The order of the
texture tags in the Object manager (see pages
188 and 189) defines the layer - the right-most
material is the top layer, the left-most is the
bottom layer.
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You can change the layering order simply by
swapping the positions of the texture icons
using drag-and-drop.

Note

The Transparency material property does not
allow the next layer to show through. Instead,
use alpha or clip materials.

Tera
WLt 1
bl daeeT

In the example above T1 is a wall material, T2 is
a plastic material (scaled down, no tiling) and T3
is graffiti (with alpha mapping to remove the
non-graffiti parts of the texture).

The order of the materials in the Object
manager (from left to right) is: T1-T2-T3.

The graffiti (T3) is the top material layer.
However, it uses the alpha channel to remove
the non-graffiti parts, thereby exposing the next
layer down (the plastic material (T2). Even
though the plastic material (T2) is on a layer
above the bricks (T1), the bricks can still be seen
because the plastic was scaled down and is not
tiled (i.e. the plastic does not cover the entire
surface).

Additive Textures

In the previous example a wall material was
created using a color channel and a bump
channel. The bump channel creates the illusion
that the wall has joints. Now we want to add a
second bump map to the wall without changing
the texture itself. How can this be done?

The powerful function that makes this possible
is called Mix With Other Textures and, no prizes
for guessing, you can use it to mix textures
together. The material properties are added
together, hence the term additive textures.

For example, the sum of the colours 100/0/0
(red) and 0/100/0 (green) is 100/100/0
(yellow). If the green color has a brightness of
50%, then only 50% of the color is added. The
result in this case would be 100/50/0 (orange).

However, the result cannot exceed the
maximum color values. Adding 100/0/0 to 100/
100/0 does not produce 200/100/0, but 100/
100/0.

Some channels cannot be added meaningfully,
e.g. two materials with a refractive index of 1
would result in a material with a refractive index
of 2, which is probably not what you intended.
So in such cases the value of the additive
material is used (provided that the channel is
active).

Notes

You can add together as many textures as you
wish.

Only the following properties are additive:
Color, Transparency, Reflection, Relief,
Displacement and Luminance.

Only active properties are evaluated.

The alpha channel marks the parts of the
additive material that should not be added.



3D shaders cannot be added.

An additive texture (option ticked) must be to
the right of the texture to which it should be
added in the Object manager.

All textures to the right of the first additive
texture, up to but not including the next non-
additive texture, are added.

The Transparency property does not expose the
next material layer. Use alpha mapping instead.

It's time we returned to our example:

Now you can see the second bump map (T2) on
the wall in addition to the original bump (T1).

Mixed Textures

By now you should know how to use several
material layers and how to add materials
together.

Let's combine these two techniques to place
several materials on the same object and add
some of them together.

Our example graffiti wall uses five materials.
Their order in the Object manager (from left to
right) is: T1-T2-T3-T4-T5. T1 (wall), T2 (poster)
and T4 (graffiti) are normal materials. T3 (50%
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bump of T1) and T5 (100% bump of T1) are
additive. T4 (graffiti) uses alpha mapping to
remove the non-graffiti parts of the texture.

T3 is added to T2, giving it an additional bump
texture. Since T2 is not tiled, T1 is visible. T5 is
added to T4, giving it an additional bump map.
T4 uses an alpha channel to expose the lower
layers, hence you can see T1 and T2.

Restrict to Selection

The function enables you to use different
materials on different parts of the same object.
This is a convenient way to add, for example,
labels to objects. First of all you need a selection
tag.

Proceed as follows

- Activate the object and select the Polygons
tool.

- Select several polygons using the selection
tool.

- Choose Set Selection from the selection menu.

A polygon selection tag appears in the Object
manager to represent the selection.
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See Chapter 20, Selection Menu, page 373 for
more details on selections.

- Double-click on the polygon selection tag.
Enter a name for the selection in the dialog
that appears, then click on OK to close the
dialog.

If your object does not have a texture yet,
apply a new texture (drag the material from
the Material manager and drop it on to the
name of the object in the Object manager).
The Texture geometry dialog opens. Enter your
settings (e.g. the projection type, tiles, etc.),
then enter the name of the selection in the
Restrict To Selection field. Close the Texture
geometry dialog by clicking on OK.

Tip
When you are positioning a texture on a
selection you may find it helpful to hide the
unselected surfaces. You can hide them using
Selection > Hide Unselected.
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13 Picture Manager

The Picture manager (also known as the Picture
Viewer) is the external output window of
BodyPaint 3D. This is where the render is
displayed if you have chosen Render to Picture
Viewer from the Render menu (see page 402).
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But the Picture manager is able to do more. For
example, it displays textures if they have one of
the known formats (TIFF, JPEG etc.). Other

Picture manager functions are described below.

Note

You must use the Picture manager when
rendering a scene to hard disk.

File Menu

A

Open

This function opens an image file and displays
the image in the Picture manager. All 2D image
formats supported by BodyPaint 3D can be
loaded. For a list of these formats, please see
page 439.

Export

With this function an image can be saved to
hard disk in different formats. This enables you
to use the Picture manager as an image format
converter as well.

Stop Rendering

This stops the rendering of the scene. All picture
data is lost in the process; you cannot restart
from where you left off, hence you will need to
start the next render from the beginning.

Note

Alternatively, you can stop rendering by pressing
the ESC key.

Close

This closes the Picture Viewer.
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Edit Menu

Copy

This copies the image in the Picture manager to
the clipboard. You can then paste the image into
another program, e.g. an image editor.

View Menu

Fit to Size

If Fit to Size is activated, the displayed image is
scaled automatically to the size of the Picture
manager window, assuming the window is
smaller than the image itself. The aspect ratio is
kept constant. Fit to Size is recommended if the
Picture manager is docked to other parts of the
BodyPaint 3D interface.

Zoom Factors

You can display the image in different
predefined zoom factors from 12.5% to 800%.
At 100% the image is displayed actual size.

Zoom In, Zoom Out

Use these to zoom in or out of the image,
stepping through the predefined zoom factors.

Red, Green, Blue

BodyPaint 3D renders all images in the RGB
color system. Using these three options you can
filter out these separate colors. So you can save
the red separation of a render without needing
to launch a separate image editor.

Alpha

If this option is enabled the Picture manager
displays the image's alpha channel instead of the
image itself.

Note

This option works only with images that have an
integrated alpha channel.

Grayscale

If you enable this option, the image will be
displayed not in color but in grayscale. This
function is useful for checking certain aspects of
the render, perhaps to evaluate the contrast of
an image for monochrome printing.
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The Structure manager resembles a spreadsheet;
both can process data directly within cells which,
in turn, are divided into lines and columns.

Within BodyPaint 3D's Structure manager,
various attributes of the active object are
displayed and can be edited directly in the cells.
The points and polygons of an object and its
UVW coordinates can all be displayed (if
relevant) by selecting from the Mode menu; by
default, an object’s points are displayed.

Values in the cells can be edited directly, lines
can be moved by means of drag-and-drop and
cut, copy, paste is supported. Larger quantities
of data can be processed rapidly, even if the
object has a large number of points or polygons.
The selection frame (a red frame around an
active box) shows you which data you are
working on; navigating around the table is thus
very simple.

Navigation

Selection

Clicking on one of the line numbers to the left
of the table selects this line and highlights it.

If you keep the Shift key pressed while clicking
(known as Shift-clicking), several lines can be
selected at the same time; Shift-clicking an
already-selected line will deselect that line.

To select all the lines of a particular attribute
(such as all the points) click directly in the
relevant name field (e.g. Point). Shift-clicking a
selected set will deselect the set.

Selection frame

When you first open the Structure manager, the
selection frame is over the cell at the top left of
the display (the first column of the first line).
Single-clicking on a particular cell moves the
selection frame to this cell i.e. makes it active.
You can also move the selection frame with the
cursor keys.

Using the TAB key moves the selection frame
left-to-right and top-to-bottom over the cells;
Shift-TAB reverses this.

The Home key moves the selection frame to the
very first cell of the table whilst the End key
moves it to the last cell.
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Note

The Apple USB Keyboard does not have an End
key. Please use the ‘+' key on the numeric
keypad instead.

Page Up and Page Down move the selection
frame a page at a time, back and forward
respectively.

Double-clicking on a cell moves the selection
box there and enters Edit mode, where you can
modify the value of the cell. While in Edit mode
you can use Tab and the cursor keys as
explained above and you will remain in Edit
mode.

The Return key acknowledges input and
switches between editing and selection modes.

If you press the ESC key, the previous value of
the cell is restored and you revert to selection

mode; assuming, of course, that you have not
already pressed Return!

Drag-and-drop

By means of drag-and-drop you can re-order
one or more lines and thus modify, say, the
point order. Click at the left of the display, over
a line number, hold the mouse button down and
drag; a red line appears to show where the
selected row(s) will be moved. The row(s) will
be inserted at the position of the red line and all
rows above will be shuffled up.

Note that, if you change the order of points, the
associated polygons will be deleted!

Additionally you can transfer the contents of an
individual cell to another cell; simply click on a
cell and move the mouse with the left button
held down until you the pointer is over the
target cell. Release the mouse button and the
value of the original cell is copied here.

File Menu

New Line

A new line is inserted into the table, below the
selection frame.

If you are in the point mode (default), a new
point is added to the object. This is created at
the world origin (X=0, Y=0, Z=0). By the input
of suitable X, Y and Z coordinates, you can
change the spatial position of the point.

If you are in the polygon mode, New Line adds
a new polygon to the object. The new polygon
will not be visible yet, since it has not been
allocated suitable points (see Mode). You must
do this point allocation by hand.

If you are in UVW mode, New line creates a
new UVW coordinate. Since an entire UV mesh
can be created easily (see Generate UVW
Coordinates, page 201), you may find little use
for this function.

Import ASCII Data

BodyPaint 3D is able to import point data,
polygon data and UVW coordinates into the
Structure manager. The data to be imported
must be present as an ASCII file and have the
following format:

Point XY Z
1 <Coordinate> <Coordinate> <Coordinate>
2 <Coordinate> <Coordinate> <Coordinate>

3 <Coordinate> <Coordinate> <Coordinate>



Here's a real Point mode example for a cube:

Point X Y Z
0 -100 -100 -100
1 -100 100 -100
2 100 -100 -100
3 100 100 -100
4 100 -100 100
5 100 100 100

6 -100 -100 100
7

-100 100 100

The ASCII file must start with a header (the
‘Point XY Z' in the example above) and the line
numbering as shown is required. The values
within each line may be separated with a TAB
character, a comma, a semicolon or a
combination of these. Each line must end with
the ASCII LF (linefeed) character or the CR
(carriage return) character, or a combination of
both. Thus it does not matter whether the ASCII
file was created on a Macintosh, Windows or
Unix computer.

If data already exists in the Structure manager,
the imported data is inserted before the line
containing the selection frame.

Export ASCII Data

BodyPaint 3D can export the Structure manager
data so that you can use it within, say, a text
editor or some other 3D program or perhaps
import it into a spreadsheet for analysis.

In Point mode, the X, Y and Z coordinate for
each point is exported.

In Polygon mode, the coordinates of each three
or four point polygon are exported.

In UVW mode the UVW coordinates of each
polygon (defined so far) are exported.

Close

Exits the Structure manager, closing the window.
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Edit Menu
Undo

This cancels the last action that changed the
object and restores the previous values to the
cells. The undo level (i.e. how many actions are
remembered) is set in the General Settings
(Undo Depth, see page 42).

Redo

Undoes or cancels the last undo. The redo level
is the same as the undo level, set in the General
Settings (Undo Depth).

Cut

Removes the selected line(s) from the table and
copies to the clipboard. Use Paste to insert back
into the table, below the selection frame.

Copy

Copies the selected line(s) from the table into
clipboard, without deletion. Paste will insert
line(s) from the clipboard back into the table,
below the selection frame.

Paste

Insert any data already copied or cut into the
clipboard back into the table, below the
selection frame.

Delete

Deletes the selected line(s) from the table.

Select All

All lines within the table are selected.
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Deselect All

All selected lines of the table are deselected.

Invert All

All the not-selected lines of the table are
selected and the selected lines are deselected.

Select Area

The mouse pointer changes into a crosshair and
you can now draw a selection area with the
mouse. All lines within the area you draw are
selected. If lines that you want to select are
outside the visible area, move the mouse outside
the Structure manager window in the direction
that you want the window to scroll; the window
will then scroll until you move the mouse back
within the window.

View Menu

Jump Last Selection

The selection frame moves up to the last active
line.

Jump Next Selection

Move the selection frame down to the next
available line.

Jump Page Up

Display the previous page of information (if it
exists) in the table and move the selection frame
to the first column of the first line on the page.

Jump Page Down

Display the next page of information (if it exists)
in the table and move the selection frame to the
first column of the last line on the page.

Jump Home

The selection frame moves to the first column of
the first line in the table.

Jump End

The selection frame moves to the first column of
the last line in the table.



Mode Menu
Points (default)

In Point mode, the spatial coordinates of the
individual points of the object are displayed in
the Structure manager.

The display is organised as follows:

XYZ

show the coordinates of the respective point in
the world system. No unit is displayed; the unit
of measurement is selected in the General
Settings and is assumed here.

Polygons

If you are in Polygon mode, the number of each
defining point is displayed, as follows.

A, B, C, D (which could be blank) correspond to
the respective point numbers of the three (or
four) corner points of the polygon.

Note

If C and D are identical, BodyPaint 3D interprets
the polygon as a triangle.

uvw

If you are in UVW mode, the UVW Coordinates
of the polygons of the object are displayed, as
follows:

UIA], U[B], U[C], UID]
are the U coordinates of the corner points of a
polygon.
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VIA], VIB], VIC], VID]
are the V coordinates of the corner points of a
polygon.

WIA], W[B], WIC], W[D]
are the W coordinates of the corner points of a
polygon.

Note

Avoid changing the UVW coordinates unless you
are sure of what you are doing. Otherwise, the
object's mapped textures are likely to distorted.
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15 Coordinate Manager

The Coordinate manager allows you to
manipulate objects numerically. It displays
information relating to the tool you are using.
For example, if you are using the move tool, the
position, size and rotation values of the active
element are shown; if the camera tool is active,
you can enter the focal length for the lens
instead of its size.

Once you have made changes to the values you
can update the element by clicking on Apply.

L e, T

A Foation S Fimlion

1 ET = EL EE |
TR T E | B
Z[diEnn HEfin E | eS|
)

You can use the pop-up menu at the bottom left
to determine how the values are interpreted. If
the menu is set to Object, all the values relate to
the object's (immediate) parent system. If the
menu is set to World, the position and rotation
values are converted into world coordinates. The
Rotation values always use the HPB System (see
page 370).

The pop-up menu below the middle coordinates
column (Size) specifies which object size is shown.

Size
This displays the size of the object, not
including sub-objects.

Size +

This, on the other hand, shows the size of the
active object including all sub-objects.

Scale

shows the axis length for each axis of the object
coordinate system. The default values are 1/1/1.

World Coordinates

The size or scale is also specified in world
coordinates, although along the local axes. For
example, if a cube of length of 100 lies askew in
3D space, it still has a size of 100 units in world
coordinates.

Relative Values

You can also enter relative values. BodyPaint 3D
has a parser which enables you to include
mathematical operators.

For example, you can append +100 to an
existing position value. The active element will
then move 100 units relative to its initial
position. BodyPaint 3D supports many other
functions - see the Appendices for a complete
list of valid operators, functions and constants.

Some values must be entered as relative ones,
e.g. for the rotation of points. This is because
points do not have their own coordinate system,
so the program cannot keep track of previous
rotations.

Tip
Keep in mind that you may be changing the axes
of sub-objects unintentionally when you change
the axes of the parent.
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16 File Menu

Introduction

There are several ways of starting BodyPaint 3D:
- Double-click on the program icon.
- Double-click on a scene file.

- You can also drag one or more BodyPaint 3D
files in the Explorer (Windows) or the Finder
(Macintosh) on to the BodyPaint 3D icon.

The File ‘New.c4d’

In the BodyPaint 3D startup folder you may find
a scene with the name ‘New.c4d': if there, this is
loaded into BodyPaint 3D when you create a
new file (File > New). Thus, BodyPaint 3D does
not use a separate preferences file, it uses
whatever preferences have been set for this
‘New.c4d' scene

In order to change, say, the default output
resolution to 800x600, create a new file, change
the value on the Output page of the Render
Settings (main menu: Render > Render Settings)
and save the file as ‘New.c4d' into the
BodyPaint 3D folder.

The File ‘Template.c4d’

In the BodyPaint 3D startup folder, there is also
a scene with the name ‘Template.c4d’; this is
loaded automatically when BodyPaint 3D is
launched, thus enabling user-defined
preferences to be set at startup.
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New

This command opens a new document and
makes it the active (current) document. All icons
that are selected from the toolbar, and
commands from any of the menus or managers
then refer to this new document.

Until you save the new document and give it a
name, the title bar of the document window will
show ‘Untitled'.

If you have several documents open you can
switch quickly between them using the Window
menu on the main menu bar.

Open
£

This command loads a file (a scene, a material,
etc.) from a storage device (such as a hard disk)
into memory and opens it in a new document
window. If the current document window is
empty, this is used instead.

The following formats are understood by
BodyPaint 3D:

- BodyPaint 3D scenes ('.c4d’), catalogs ('.cat’),
preferences (*.prf')

CINEMA 4D scenes (‘.c4d")
DXF to AutoCAD R12

- QuickDraw 3D (*.3dm’) (binary only, not
ASCII)

VRML V1 and V2 (".wrl")
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- 3D studio R4 (*.3ds") (including materials, light
sources and textures)

- Wavefront (‘.obj')

- LightWave (".lwo’, “.lws") (including scene
descriptions, light sources, and textures; with
LightWave [6], UV coordinates and focal
lengths as well)

- DEM scenery files (‘.dem’)

lllustrator paths as polygons ('.ai’, .art’, .eps’)

Recognition of these formats is automatic.
Filename extensions (Windows) are superfluous,
as are types and creators (Macintosh).

You can also use this command to view images,
play animations or load other settings. If you
open a QuickTime movie or an AVI animation,
this will launch the default system movie player.

Alternatively, you can also open a new file by
dragging it and dropping it into the Editor
window.

Import

o
This command lets you add scenes, objects,
materials etc. into the active document.

Revert to Saved
e

This command will load the last saved version
from disk. Before this happens, a dialog opens
asking for confirmation. You will lose any
changes that were made to the current
document after it was last saved.

Close
-

Closes the active document. If it contains any
unsaved changes, a dialog opens asking if you
want to save the scene before closing it.

Close All
i

Closes all open documents. If any documents
contains unsaved changes, a dialog opens
asking if you want to save the scene before
closing it.

Close All Textures

This closes all the textures in RAM that are not
used by any materials. If any of the textures
have been changed since they were last saved, a
dialog will check if you wish to save the
changes.

Save

w

This command saves your document without
first opening the file selector. The scene is saved
using the name chosen when you selected the
Save As command (i.e. the name that appears in
the title bar). If this is the first time you are
saving a new document and it does not have a
name yet, then the Save command behaves just
like Save As.



Save As

(&}

Save As always displays the file selector. The
filename you enter here will be displayed in the
title bar of the document window. BodyPaint 3D
automatically appends the appropriate extension
(‘.c4d’ for scenes) to the filename.

Save All
=]

This function saves all open documents. If a
scene has not yet been saved (and therefore is
untitled), the appropriate system file selector
appears for you to choose a name and folder.

Save All Textures

You can use this command to save all the
textures. A dialog will appear for each texture
that is being saved for the first time — specify
the file format using the pop-up menu, then
click on OK. Next, the Save dialog will open for
you to choose name and folder.

Save Project
=

Transferring scenes from one computer to
another is always particularly challenging for a
project leader. When the question of missing
textures for materials arises, you know that
these can be found automatically in your own
local search path (Edit > General Settings >
Paths).

BodyPaint 3D helps you build complete scenes.
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Selecting this command opens the usual system
file selector for saving files. Choose a folder here
and enter a name. BodyPaint 3D creates a new
folder in the specified path and saves the scene
there. In addition, it creates a sub folder, named
Tex, into which it copies all the pictures and
textures necessary for rendering the scene.

There is now nothing to stop you moving the
project to another system.

Export

A scene can also be exported to a foreign file
format for subsequent work in other 3D
software. The filetypes described below are
available. BodyPaint 3D automatically adds the
relevant file extension to the file.

In principle each 3D program works differently.
Therefore it is not always possible to convert all
information within a scene. Further, the result
will always differ according to the materials and
lighting used; so a manual re-working may often
be necessary.

As well as the following built-in export formats,
BodyPaint 3D can export in a variety of other
formats via separate plug-ins (e.g. for exporting
in LightWave format).

3D Studio R4 (.3DS)

Common data format under DOS/Windows.
3D Studio is the predecessor of 3D Studio MAX.
The last freely available file format is release 4
and the MAX data format is not accessible to
other manufacturers.

In principle the MAX format is not generally
readable since MAX (like BodyPaint 3D) uses
parametric objects, which are useless without
their associated specific algorithm. For example
a teapot is not saved with points and surfaces,
but only with the dimensions and the
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subdivision rate. For re-creating the surfaces (to
display the teapot on the screen) one needs to
know the internal routines of MAX.

Therefore, because of this, there is also no
external conversion tool for the MAX format.
Direct3D / DirectX (X)

Direct3D is a Microsoft specific 3D format,
which is used by Windows 95/NT (provided
DirectX is installed). This export module is
particularly useful to game developers.

DXF (DXF)

The standard exchange format for graphics files.

BodyPaint 3D splines are generally written as
POLYLINEs, independent of the surface settings
for polygons.

QuickDraw 3D (3DM)

The standard format for three-dimensional
graphics on the Apple Macintosh.

VRML 1 (WRL)

The Virtual Reality Modeling Language enables
you to produce platform-independent three-
dimensional representation of objects and
scenes on the Internet. It has also proved useful
as an exchange format for CAD programs, since
it contains more file information than the often-
used DXF format.

VRML 2 (WRL)

Version 2 of the standard format for three-
dimensional graphics files on the Internet. The
advantages for data exchange with CAD
software mentioned above also apply to
VRML 2.

Wavefront (OBJ)

A common 3D data format in the UNIX world,
developed by Alias.

Import / Export Settings
3D Studio R4
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Factor

This is for specifying whether and to what
degree 3D Studio files are scaled when they are
loaded and saved.

Adapt Textures

3D Studio does not support as many graphics
file formats for textures etc. as BodyPaint 3D. Its
main format is TIFF.

If you enable this option, all texture filename
extensions are changed to that which you have
specified (for example ‘frame.jpg’ becomes
‘frame.tif').

However, you will still have to do the actual
conversion of the images yourself. This is very
simple if you use one of the graphics programs
that are provided with the package (PaintShop
Pro or Graphics Converter).
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Factor

This is the scaling factor for saving the scene in
this format. When exported, the scene is
reduced by this factor.

Format

Direct3D is a text format. To facilitate manual
editing of the file, this option formats the whole
file automatically. This increases the file size
somewhat.

Save Templates

When enabled, the template header is written to
the file.

Export Textures

When enabled, all texture information is saved
for all objects. This includes creating UV
coordinates for each object.

Adapt Textures

DirectX uses mainly the ‘ppm’ (Portable-Pixel-
Map) graphics format, but also ‘.bmp’
(Windows-Bitmap). BodyPaint 3D does not
recognise the former, which means that textures
need to be converted.
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This can easily be done using the graphics
programs PaintShop Pro or Graphics Converter,
which are provided in the package. But what
about adapting the names?

If you enable this option, all texture filename
extensions of scene materials are automatically
changed when they are imported (so that
‘image.jpg’ becomes ‘image.ppm’). This has the
benefit that you do not need to check for each
material and for each attribute whether a
change of name is required.

Note

This really does only change the name. You still
need to convert the image!

Note that DirectX can only process graphics
measuring 2" pixels (i.e. textures need to be
2x2, 4x4, 8x8, 16x16, 32x32, 64x64, 128x128,
256x256, ...).

Save Normals

If this option is enabled, normal vectors are
created for all surfaces. If not, calculating the
normals is left to Direct3D.

Generate Mesh

Direct3D works with two types of models;
Frame and Mesh.

Frames, as with BodyPaint 3D, consist of objects
arranged in a hierarchical structure. Objects
remain encapsulated.

In a mesh, on the other hand, all objects are on
the same level. The hierarchy disappears.
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DXF

BodyPaint 3D can work with DXF files of all
versions. It can correctly interpret the following
elements: SOLID, 3DFACE, LINE, POLYLINE,
CIRCLE, ARC, POINT and TRACE. All three-
dimensional data is read in accurately.
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All documented POLYLINE combinations as well
as height and elevation data are supported. The
same is true of element coordinate systems,
layer names and various line thicknesses.

Factor

This specifies whether and to what extent DXF
files are scaled during loading and saving.

Circle

This determines the number of polygon
segments that are used for subdividing circle
segments.

Frozen Layers

Enable this option if you want to convert frozen
layers of a DXF file when loading. Many CAD
programs offer the option of freezing (i.e.
hiding) temporary or unused layers.

2D Elements

This specifies whether or not two-dimensional
DXF elements should be converted when
loading a file.

Align Normals

BodyPaint 3D assumes that all surfaces of an
object are uniformly aligned. This is not
necessarily the case with DXF files.

If adjacent surfaces are differently aligned, their
normal vectors point in a different direction.
During rendering, this can result in undesirable
color jumps. BodyPaint 3D uses this option to
re-align all adjacent surfaces in the same
direction.

Triangulate Polygons

DXF files may contain three-dimensional
polygons. BodyPaint 3D can triangulate these if
this option is enabled. This means that the
inscribed surface is generated as a 3D object.
This is useful in most cases, and it is therefore
the default setting.

Unless the option is disabled, polygon lines are
converted as such, which is useful for further
processing in BodyPaint 3D.

Layer

DXF files often consist of a great number of
small elements. When this option is enabled,
BodyPaint 3D attempts during a load to
combine elements of the same color (Connect
by Color) or of the same layer (Connect by
Layer). If you wish to prevent this, use Don't
Connect.



Export

The DXF standard offers several options for
saving an object. Here you can choose the type
into which the object is converted when being
saved. The choices are Polyline, Solid and
3DFace.

DEM

DEM files are used in geography and are often
used for the description of landscapes. This
format can be imported only.

Factor

Use this to determine whether and how much
DEM files are scaled when they are loaded.

Illustrator

If you want a high-quality 2D vector graphic
(e.g. a company logo) to be three-dimensional,
then import it in the Illustrator format.

Also vector graphics from other programs, such
as FreeHand or CorelDraw, can be imported if
they were saved in lllustrator format.

Please also read about how to export files in the
relevant product manuals.

Factor

Use this to determine whether and how much
lllustrator files are scaled when they are loaded.
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LightWave

When you load a file in LightWave format,
object geometries, lights, texture maps and the
focal length are copied over.
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Factor

This specifies whether and to what extent
LightWave files are scaled during loading and
saving. The default value is 100, since
LightWave uses a smaller construction scale
than BodyPaint 3D.

Textures

This lets you decide whether BodyPaint 3D
should import a LightWave object’s texture
information.

Lights

This lets you decide whether BodyPaint 3D
should import a LightWave object’s light source
information.

Split selections

In LightWave 3D, it is possible to create objects
with double-sided polygons. When you load
such an object into BodyPaint 3D, each double-
sided polygon is replaced by two polygons and
this may lead to render anomalies.

If the scene you are importing contains double-
sided polygons, select this option. Two object
groups will be created — delete one of the
groups if necessary.
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QuickDraw 3D
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Factor

Use this to determine whether and how much
QuickDraw 3D files are scaled when they are
loaded.

Sphere

Use this to specify whether and to what extent
QuickDraw 3D spheres are triangulated during
loading.

Cone/Cylinders

Use this to specify whether and to what extent
QuickDraw 3D cones and cylinders are
triangulated during loading.

NURBS

Use this to specify whether and to what extent
QuickDraw 3D NURBS are triangulated during
loading.

Save Textures

If this option is enabled, all objects are saved
with their textures (including any UV
coordinates).

If this option is disabled, objects are saved with
their color information only (i.e. without
textures).

Maximum

BodyPaint 3D allows you to use any size of
texture — provided of course that you have
plenty of memory. However, when viewing a
scene it can be irritating to wait for textures
which are very large to load.

This option lets you restrict the size of
QuickDraw 3D files. The material images are
scaled to the specified value (in pixels); the
proportions remain intact.

Note

If imported QuickDraw 3D models contain
textures you have the option when loading them
to either ignore them or to save them separately.

VRML 1
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Factor

This is for specifying whether and to what
degree VRML files are scaled when they are
loaded and saved.



Optimize Hierarchy

If Optimize Hierarchy is selected, the scene
structure will be optimized once the VRML1 file
has been loaded. Superfluous dummy objects
will be removed and the object hierarchy will be
optimized. This creates a clearer overview,
helping you to work more quickly.

Format Text

VRML is a text format. To facilitate manual
editing of the file, this option carries out
automatic formatting on the entire text file
during export.

Backface Culling

This option enables an attribute on all exported
objects which switches off drawing of the non-
visible sides of all objects in the www browser.
This gives a much faster display.

Textures

This menu specifies the action BodyPaint 3D is
to take when exporting textures.

None ignores the textures and saves only color
information.

Referenced means objects are saved with the
paths to the textures.

With File saves all textures directly in the VRML
file (so-called inline textures). Any UV
coordinates are also saved.

Maximum

BodyPaint 3D allows you to use any size of
texture — provided of course you have plenty
of memory. However, when viewing a scene it
can be irritating to wait for textures which are
very large to load.
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This option lets you restrict the size of VRML
files. The material images are scaled to the
specified value (in pixels); the proportions
remain intact.

Note

If imported VRML models contain textures you
have the option when loading them to either
ignore them or to save them separately.

VRML 2
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Factor

This is for specifying whether and to what
degree VRML files are scaled when they are
loaded and saved.

Optimize Hierarchy

If Optimize Hierarchy is selected, the scene
structure will be optimized once the VRML2 file
has been loaded. Superfluous dummy objects
will be removed and the object hierarchy will be
optimized. This creates a clearer overview,
helping you to work more quickly.
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Format Text

VRML2 is a text format. To facilitate manual
editing of the file, this option carries out
automatic formatting on the entire text file
during export.

Backface Culling

This option enables an attribute on all exported
objects which disables the drawing of the non-
visible sides of all objects in the web browser.
This gives a much faster display.

Save Animation

With this option enabled, it is possible to export
animation sequences into VRML2 format.

Keys/Second

When animation export is enabled you choose
the frequency with which the keys are being
written.

Since VRML2 has only linear interpolation
available you can increase the precision of the
export by setting this value higher (expect a
proportional increase in the file size).

Sensible values are in the range 5 to 25. More
keys than frames per second does not seem
particularly usefull

Textures

This menu specifies the action BodyPaint 3D is
to take when exporting textures.

None ignores the textures and saves only color
information.

Referenced means objects are saved with the
paths to the textures.

With File saves all textures directly in the VRML
file (so-called Inline textures).

Any UV coordinates are also saved.

Maximum

VRML-2 provides two options for making
textures available to their objects:

The first option is identical to the one used in
BodyPaint 3D; a reference to the texture file is
saved along with the VRML scene. If you want
to go with this option, specify the value 0.

The second option integrates the graphics data
directly into the VRML2 file.

Since the texture is written uncompressed, in
text format, a texture of 1000x1000 pixels
quickly reaches a file size of 4MB. If you wish to
avoid having such large files, you can specify a
value (larger than 0), to restrict the size of
textures. The materials are then scaled to that
value (in pixels). The proportions remain intact.

If you have a texture of 800x600 pixels and you
set a maximum value of 100, the texture is
proportionally scaled down to a size of 100x75
pixels before being saved.

Note

If imported VRML models contain textures you
have the option when loading them to either
ignore them or to save them separately.

Wavefront

Factor

This specifies whether and to what extent
Wavefront files are scaled during loading and
saving.

Recent Files

BodyPaint 3D remembers the files opened last
and lists them in this sub-menu for quick access.
You can define the maximum number of
remembered files in Edit > General Settings.



Recent Files
BodyPaint 3D remembers the files opened last

and lists them in this sub-menu for quick access.

You can define the maximum number of
remembered files in Edit > General Settings.

Quit

This command quits BodyPaint 3D.
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17 Edit Menu

The Edit menu contains some of the most
important and most frequently used functions
(like Undo) in the entire BodyPaint 3D program.
We often take these functions for granted, but
we would soon be lost without them. These
functions are of such fundamental importance
that you will find them in almost all managers
(within a local Edit menu).

As we work through this chapter we will present
you with a little theory. For example, we will
explain how the internal buffers work. Please
avoid any natural instinct to skip over the
theory; it is very relevant to your everyday work
because it helps you to understand and predict
BodyPaint 3D's behavior.

Also, it helps you to solve problems. Little is
more frustrating than knowing you are doing
something wrong but not knowing what it is.
Here is your chance to be well-prepared!

Undo/Redo

BodyPaint 3D has multiple-undo, which means
that a single undo can reverse multiple actions
that logically belong together. Confused? Here's
the explanation:

Imagine you have 10 objects in the Object
manager, then you use the Group Objects
command to place them into a group. Internally,
12 actions are required: first a new (null) object
is created, then 10 transfer actions place the
objects into the null object, finally the null object
is activated. BodyPaint 3D's intelligent undo
recognizes that these 12 actions belong together
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and it will treat them as though they were one
action, i.e. you can undo all 12 actions with a
single undo command.

Not only does BodyPaint 3D have multiple
undo, it also differentiates between memory-
intensive actions and non-memory-intensive
actions.

Examples of memory-intensive actions include
the deletion of an object and the movement of
an object’s points. Non-memory-intensive
actions include the activation of an object and
the renaming of an object.

Non-memory-intensive actions can be recalled
10 times more than the Undo Depth value in
the general settings.

For example, with an undo depth of 12 you can
undo either 12 delete object actions or 120
activate object actions. You can also mix both
types of action, e.g. you can undo 6 delete
object actions and 60 select object actions.

The Undo Buffer

When you perform an action in BodyPaint 3D,
information about that action is written to an
area of memory referred to as the undo buffer.
The Undo and Redo functions use the
information in the undo buffer to revert the
scene to a previous state.

An example

Imagine that you import an object and then
change its scale to (400/400/400) units. Next, you
move the object to coordinates (100/-300/0).

The undo buffer would then contain the
following action history:
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1 Import object
2 Scale object to (400/400/400) units
3 Move object to position (100/-300/0)

The buffer's current state is step 3, the move
action. If you call the Undo function,
BodyPaint 3D will undo the current state
(move), then set the current state to step 2
(scale).

If you call the Undo function again, the scale
action is undone and the current state is set to
step 1 (import).

What particularly interests us here is that
throughout the process the buffer content itself
is not altered - nothing is deleted. As a result,
you can restore the undone actions with the
Redo function.

You can use Undo to move backwards through
the undo buffer. Redo will advance you through
the buffer.

Recall that nothing is deleted from the buffer.
There must, however, be some constraint on the
size of the buffer to prevent it taking up too
much memory. This is the purpose of Undo
Depth in the general settings - it specifies the
maximum number of actions that can be
undone (see Undo Depth, page 42).

Note

Some functions, such as Save and General
Settings, are not recorded in the undo buffer and
subsequently cannot be undone.

Undo (Undo View)
s

This function will reverse the last change you
made, restoring the scene to its previous state. If,
for example, you move an object by accident,
Undo will put the object back into position.

You can select Undo repeatedly to continually
reverse actions. By default, you can undo a
maximum of 10 changes. We refer to the
number of actions that you can reverse as the
undo depth. You can set the undo depth in the
program settings (see General Settings,

page 42).

In the View window, Undo View operates
exclusively on the editor camera. It will not
affect camera objects. You can undo a maximum
of 500 editor camera changes.

Redo (Redo View)
™y

Redo will restore the last action that was
undone (see Undo, above). You can select Redo
repeatedly to continue restoring the actions.

You can traverse the recent development stages
of your scene by using Undo to move
backwards and Redo to move forwards.

Naturally, the number of steps you can redo
cannot possibly be greater than the number of
actions you have undone. Therefore, there is no
separate setting for the redo depth in the
program settings.

In the View window, Redo View operates
exclusively on the editor camera. It will not
affect camera objects. You can redo a maximum
of 500 editor camera changes.

Undo (Texture)

This function differs from the conventional
Undo function in that it only undoes texture
changes. Hence you can use this function to
undo paint strokes, filter effects and so on.



Although this function undoes texture changes
only, it shares the same buffer as the standard
Undo function. However, you cannot use this
function to undo changes to e.g. UV polygons.

The Clipboard

When you use the Cut or Copy commands, the
active object or element is copied into a
structure in memory known as the clipboard.
When you select the Paste command, the data
in the clipboard is inserted into the current
scene. For example, to copy an object from one
scene to another scene: open both scenes,
activate the scene that contains the object, copy
the object, activate the other scene and then
paste.

The clipboard can hold only one data element at
a time. If you want to copy several objects,
group the objects first, then copy the group.

The size of the clipboard is determined by the
size of the data stored there. If, for example,
you copy an 18 MB object, the clipboard will use
18MB of memory. Naturally, you may want to
purge the clipboard (e.g. before you render) to
free up memory. You can purge the clipboard by
cutting a null object (see Null Object, page 309)
- the null object wastes only a few bytes.

Cut

|:':11.

This function deletes the active object or active
element from the current scene and copies it
(including its materials) to the clipboard. The
object can be copied back from the clipboard
with the Paste function (see below).
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Copy

The Copy function copies the active object or
element (including its materials) to the
clipboard. The object can be copied from the
clipboard to the active scene with the Paste
function (see below). You can paste repeatedly
to create additional copies.

Note

You can copy and paste objects using drag-and-
drop in the Object manager. Keep the Ctrl key
held down while you grab the object's name
with the mouse and drop it elsewhere within the
Object manager. The first copy takes the name
of the original and appends *.1'. The first copy of
‘Apple’ will be called ‘Apple.1’, the second copy
will be called ‘Apple.2" and so on.

Paste
This function inserts the contents of the

clipboard (i.e. the last object that was cut or
copied there) into the active scene.

Note

You can cut and paste between scenes - use the
copy command in the source scene, then
activate the target scene and select the paste
command.

The names of the inserted objects are appended
with numbers to differentiate them from the
original (‘Name.1’, ‘Name.2', etc.).

The trio Cut, Copy and Paste are found in almost
all programs. Sometimes they are referred to
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collectively as cut-copy-paste, prompting
instructions such as “Remove the item with cut-
copy-paste”. Only Cut removes the item - this
has nothing to do with Copy and Paste.

Delete
b

This function deletes the active object or
element from the current scene without copying
it to the clipboard (see below).

deselected. Similarly, if the Polygon tool is
active, all the polygons of the active object will
be deselected.

Screen Refresh

Use Generators

If you turn off this option, any generators will
stop generating mesh. This can help simplify the
view and speed up the redraw rate.

Note

Selection
Select All

£

P

This function selects all the objects in the scene.
If it is not possible to select all the objects
directly, the objects will be placed in a group
and the group will be selected.

If the Points tool is active (see Points, page 366)
when you call Select All, all the points of the
active object will be selected. Similarly, if the
Polygon tool is active, all the polygons of the
active object will be selected.

Deselect All
S

This function deselects all the active objects or
elements. If the Points tool (see Points,

page 366) is active when you invoke Deselect
All, all the points of the active object will be

BodyPaint 3D's only built-in generator is the
HyperNURBS object. If you are running
BodyPaint 3D with CINEMA 4D XL6, you can
use XL's generators as well (e.g. loft NURBS).

Use Deformers

If this option is switched off, any deformers
imported from CINEMA 4D (e.g. twist) will stop
deforming their associated objects. This can
simplify the scene and improve the redraw rate.

Customisation

General Settings

The General Settings enable you to change the
way BodyPaint 3D operates and the way the
program looks.

The numerous options are explained in detail in
General Settings, page 40.
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18 Objects Menu

Null Object
L2

With the null object one could say it's a “I
cannot do anything, I'm nothing” object. And
that's right ... well, alImost.

If you call this function, BodyPaint 3D creates
only an empty axis system in the 3D space. The
object contains neither points nor surfaces and
cannot be edited in the normal way.

So why use a null object?

Well, the null object can have other objects
placed within it. So it is useful for grouping
matching elements of a scene. Null objects are
also created by an automatic grouping in the
Object manager (Group Objects, page 199).

Let's not forget one of the most frequently used
applications of the null object; its use as a
dummy object for accurate rotation of
previously rotated objects.

As long as the axes of an object lie parallel to
those of its parent system (with newly created
objects the parent is the world coordinates
system), an object rotates around its Y axis (a
heading rotation). However, if the object, or its
local object coordinate system, is already rotated
(so that its axes are not parallel to those of its
parent), the result often astonishes even the
most experienced 3D designers.
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Left: rotation with parallel axes systems, Right: with an
already rotated object system (in each case the final rotation
is through 90°)

The use of a null object gives the desired result.
Here the null object and the object which is to
be rotated lie on top of each other. The axes of
the two objects have the same direction and —
quite importantly — the object in question is
within the hierarchy of the null object.

Correct rotation behavior through the use of a null object
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NURBS > Hyper NURBS

NURBS objects are generators, meaning that
they use other objects to generate a new
geometry. BodyPaint 3D's Hyper NURBS object
uses a polygon object to generate a smooth,
organic mesh.

The Hyper NURBS object is interactive, which
means that as you edit the polygon cage (the
source object), the generated mesh changes
automatically.

The Hyper NURBS object uses an algorithm to
subdivide and round the object interactively - a
process termed subdivision surfaces. This is an
extremely quick and simple way to create
organic forms.

To use the Hyper NURBS, make a polygon
object a child of the Hyper NURBS object (drag-
and-drop the polygon onto the Hyper NURBS in
the Object manager).
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Both the Hyper NURBS object and the cage object are visible

Only the cage object is visible

Double-click the Hyper NURBS icon in the
Object manager to change the appearance of
the Hyper NURBS.
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You can use the dialog to specify the subdivision
level for shading in the editor and for raytracing.
Normally the value you use for raytracing will be
equal to or greater than the resolution for the
editor. The higher you set the resolution, the
smoother the object becomes, but also the more
memory it uses and more slowly it renders.

Note

Each 3D program has different options and
mechanisms for subdivision surfaces. You may
find that BodyPaint 3D's implementation differs
slightly from other 3D programs.



Scene > Camera

As well as the default camera in the Perspective
View, you may add as many additional cameras
as you need. Each camera can view your scene
from a different perspective.

When you select this command a new camera is
placed in the scene using the default position
and focal length values of the current View.

To open the Camera dialog, double click on the
camera's icon in the Object manager:
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When placing and aligning a camera,
BodyPaint 3D uses the camera coordinate
system. This system behaves in such a way that
the X and Y axes define the focal or film plane,
and the Z axis indicates the direction that the
camera is pointing and displays this view in the
Perspective View.

In the Perspective View, the camera is shown as
a cube with two spools of film and a lens:

Additional camera parameters are described
below.

CHAPTER 18 « OBJECTS MENU ¢ 311

Projection

To show all objects in a scene, BodyPaint 3D
displays them using a central perspective
projection. By default, objects are shown from
the viewpoint of this virtual camera.

Alternatively you can select from a variety of
other types of projection (e.g dimetric or
isometric views, which are commonly used in
technical applications).

Some examples follow: top left; central
perspective, top right; gentleman projection,
bottom left; dimetric and bottom right;

isometric.
L P
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From this pop-up you may select from a list of
typical types of camera lens with preset focal
lengths:

Normal 36 mm
Telephoto 200 mm
Super-Telephoto 1000 mm
Wide Angle 18 mm
Fish Eye 10 mm
Super Telephoto 1000 mm
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Zoom

For all camera projections except Perspective, by
definition there is no focal length, so you may
type a zoom factor into this box if required.
Values from 0.1 to 10000 are acceptable.

Typing a number in this box is the same as
zooming with the Camera tool selected.

Focal Length

The BodyPaint 3D cameras, like their real world
counterparts, use a lens system. You are free to
choose from different lenses and to specify the
focal length.

Note

The camera model used in computer graphic
programs corresponds to a pinhole camera with
infinite sharpness. Therefore CG focal length is
to be understood only as a simulation and
corresponds in no way to a physical model.

Short focal lengths give a wide-angle view and
are ideal for a good overview of the whole
scene. They do, however, distort objects in the
scene - a particularly striking effect is that of a
very short focal length such as a fisheye lens.

Large focal lengths correspond to a telephoto
lens, they display a very small area of the scene
since they can capture only a small spatial angle.

This is compensated by the fact that you can
capture far more detail with hardly any
distortion. With an extremely high value used as
a focal length, the perspective depth is lost
completely as the perspective projection
changes into a parallel projection.

Aperture Width

You can manually adjust the field of vision
(FOV) and focal ratio by typing an aperture
width into this box and/or manually adjusting
the focal length.

Depth of Field

BodyPaint 3D will also let you simulate the
quality of the lens system, blurring with an
increased aperture, which is known as depth of
field.

Depth of Field lets you specify which part of a
picture will be out of focus. You have a choice
of Front or Back, depending on whether you
require the objects at the front or the back to be
displayed clearly.

You can also choose to have the central range in
focus, in which case both the front and back of
the scene will be out of focus. Selecting None
will leave the settings unchanged and will
display all objects in focus.



If you use depth of field in your scene, the
following options will let you define the effect
more precisely. Depending on the settings, not
all options may be available to you.

Sharpness

Defines the distance from the camera at which
the picture will be perfectly sharp. Depending
on the Depth of Field values, the sharpness will
decrease towards the front or the rear.

Front/Rear Focus

Determines the distance from the camera to the
front and to the rear of the scene where objects
will become completely out of focus.

Note

The contrast of the grayscale depth channel is
controlled by the sharpness settings of the
camera. You will get optimum contrast if Front
Focus is set to immediately before the first
object of the scene and Rear Focus set to
immediately after the last object. The easiest
way to control these values is to interactively
adjust the camera’s handles in the editor (see
below - Interactive control of the camera).

Note

Remember that depth of field will appear less
obvious at high resolutions.

Show Cone

If you select this option the exact area seen by
the camera will be displayed in the Perspective
View.
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Interactive control of the
camera and its parameters

Cameras will be frequently used, so ease of use
is important. To make things simple, you can
adjust the camera parameters without having to
open the dialog. Instead use the adjustable
handles in the Perspective View. Follow this
example to see how:

1.Create a new, empty document.

2. Create a camera object and set the Depth of
Field Front and Rear values to 500 and 2000
respectively.

3.Now take a look at the camera object in the
Perspective View.

Select the menu option Edit > Frame Scene.
Zoom out until you can see the camera object
completely. The camera symbol is now relatively
small, similar to this illustration (you might want
to switch to a Perspective View for a better view
of the scene):

We will now describe the process in more detail.

A green line runs from the camera origin, ending
in a single orange point. This is the target point
of the camera. You can grab this point with the
mouse, move it and align it to other objects,
thereby rotating the camera around its origin.



314 « OBJECTS MENU ¢ CHAPTER 18

At the same height as the target point there is a
4-sided plane with grab points. This is the focal
length plane. At the center point of each side of
this plane is an orange handle. These handles
allow you to change the focal length
interactively.

Switch to the Perspective View, activate the
camera object and adjust the focal length. You
can see the adjustments in real time in the
editor.

There are two further, optional, planes that run
parallel to the focal length plane, one in front
and one at the back. These two planes (or just
one of them) are only available if you select a
depth of field. At the center of each plane you
will see another orange handle. Use this handle
to shift the depth of field plane interactively
along the Z-axis of the camera. Again, you can
see these real time adjustments in the editor.

You may also adjust the focal range i.e. the area
that is shown in focus.

By holding down the Shift key while dragging
the handles you will see that the entire plane,
rather than just the focal length, can be moved
along the Z-axis.

As you see, interactive control of the camera is
very easy.

As mentioned earlier, you may create as many
cameras in BodyPaint 3D as you wish. Keep in
mind that it is always the active camera that is
used for rendering.

Cameras Menu

Scene Cameras

Each view may have its own camera. The editor
camera is used by default but you may create
and use your own cameras. The Scene Cameras
sub-menu will display a list of all the cameras
you have placed in your scene, from which you
may choose one for each view.

Link Active Object

After creating a camera, the view is not initially
switched to the new camera. You can move the
camera in the Perspective View and see your
adjustments to the camera in the scene.

In order to view using your new camera you
must activate the view by selecting Link Active
Object from the Cameras menu of the
appropriate Perspective View. Now the
Perspective View will show the new camera
view.

Note

With more than one camera in a scene, you may
assign each of the respective camera views to
your main Perspective View and very easily
switch between different cameras and their
views. Alternatively you can open and attach an
individual Perspective View for each camera
object and its view. Then you may control all the
scene’s cameras at the same time.

Editor Camera

To cancel the view from a selected camera,
detach it using this command. This removes the
view connection from a camera and shifts back
to the editor camera view.



Note

Camera objects are not only used as cameras.
You can also use a camera to help you align your
scene elements and objects. This would make
sense with a spotlight for instance (see

page 319) when, like camera objects, the Z-axis
is used as the line of sight.

Scene > Target Camera

A camera with a target is, in principle, no
different to the camera described above.
However, when you choose a target camera, a
target expression tag is created. If you double-
click on this tag in the Object manager, you can
enter a name in the Object dialog that opens.
Type in the name of an object, then click on OK.
Now, the camera will track the object
automatically.

Note that a null object is created at the same
time as the camera. The camera aligns to this
null until you define your own target object.

As you would expect, everything is interactive; if
you move the camera in the Perspective View, it
stays aligned to the target object; if you move
the target object, the camera follows it.
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Scene > Light

When starting a new scene in BodyPaint 3D, a
default light is used. This light is positioned to
the left of your initial perspective view.

If you wish to change the default lighting setup
for all future scenes, build a new scene that
contains only the lights that you require for your
default lighting and save this scene as ‘new.c4d'.
This setup will then be opened automatically
each time you start a new BodyPaint 3D scene.

Note

You can also add settings such as the output
resolution to your default scene setup in this
way.

Displaying Lights in the Perspective View

The lighting within a scene can be easily
previewed by turning on the Gouraud shading
option. This option will update your lighting in
real-time, even adjusting the lighting and
updating your scene as you move the lights
around.

If your scene is complicated and updates too
slowly when moving your light with the Object
tool, adjust your light's position with the Model
tool.

o 4

The Obiject tool and the Model tool

Name your light in the Object manager by
double-clicking on its name.

To change the properties of your light, double-
click on its icon in the Object manager.

# This opens the Light settings dialog.
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Light Settings

This dialog provides the details of each light
source in your scene.
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Many of the light attributes that you select here
(such as Noise) have their own tab on which
you can give more detail of the particular
feature. We will give an overview of these
features here; more detail can then be found in
the section on the relevant tab, later in this
chapter.

Color

You can adjust the color of each of your lights
using the slider controls and the input boxes for
each color element (R,G,B). You may change the
color system (perhaps to HSV 0...255) using the
pop-up menu below the color box.

The brightness of each light is independent of
the light's color and can be controlled with the
Brightness slider. By adjusting brightness values
you can simulate any type of light from the
small glow of a candle to the extreme flare of
sunlight.

In most cases the maximum slider value of
100% will suffice, but in extreme cases a value
of up to 1000% can be manually typed into the
adjacent box.

It is also possible to use the color sliders to
achieve negative lighting effects, which is
discussed in detail below.

Type

You may change the type of light with this pop-
up. Detailed explanations of each light type are
given later in this chapter.

Shadow

Using this selector you may choose to have
various shadows generated by your light source,
or no shadows at all. Detailed explanations of
the different shadow types are given in the
Shadow section of this chapter.

Select None if your light is to cast no shadow.
This is a helpful option in a scene with many
lights, allowing you to turn on shadow-casting
for the main lights only. Any real world
photographer will envy you this option and its
possibilities.

Visible Light

With this pop-up you can adjust the visibility of
the light in your rendered scene.

In nature, light normally becomes visible only if
small particles such as dust, insects, smoke or
fog are present in the air. For example, if a car
headlight shines in fog, you will see its cone of



light quite distinctly. Detailed explanations of
these various types of visibility are given later, in
the Visible Light section of this chapter.

Noise

With this option you can make your lights
exhibit irregularities in the visible light or on the
surface lit by the light.

Note that noise will add to the render time.

No Light Radiation

If you need to see just the visible light and/or its
lens effects without the light source actually
casting light onto your objects, activate this
option. Should you need your light sources for
special effects check this box, otherwise the
render time will increase.

Show Illumination

Selecting this option will show a wireframe
approximation of the light's illumination range in
the Perspective View. This range can then be
adjusted by dragging the handles on the
wireframe representation.

CHAPTER 18 « OBJECTS MENU ¢ 317

Show Visible Light

Selecting this option will display in the
Perspective View an approximation of the light's
visible range, not to be confused with the
aforementioned illumination range. It may
become confusing if both indicators are turned
on in the Perspective View. For this reason, this
option is turned off by default. Again, this range
can be interactively adjusted with its handles.

Show Clipping

Selecting this option shows an approximation of
the selected light's clipping range (restriction of
the light range - see later) in the Perspective
View. Again, the range can be adjusted using
the wireframe’s handles.

Memory

This indicator shows the amount of memory
needed for the selected light sources in your
scene.

Here is an overview of the memory
requirements for light sources:

- Hard shadows and area shadows need
memory-intensive raytracing calculations.

As more objects are added to a reflection or
refraction dependent scene, additional memory
will be required.

- a soft-shadowed visible light will need a
shadow map of at least 250KB X-resolution x
250KB Y-resolution

- Omni light sources require six times as much
memory for their shadow maps.

- When used in combination with textured
transparencies (Light Maps), up to 20 times
more memory can be needed.
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Render Time

This indicator gives an approximate render time
for the selected light source.

Here is a short overview of lighting render times.

- Soft shadows are calculated more quickly than
hard shadows.

- Hard shadows are calculated far more quickly
than area shadows.

- Making a light visible in a rendered scene adds
a negligible amount to its render time.

- Using a volumetric light increases render time
in inverse relation to the sample distance (i.e.
the shorter the sample distance, the longer the
render time).

- Noise adds to render time, with hard and soft
turbulence requiring more calculations than
basic noise, while wavy turbulence roughly
doubles rendering time over that of standard
noise.

- Using a high sample radius will increase the
render time of soft shadows.

- Tube light and area light sources also increase
render time, although not to the same extent
as the processor-intensive volumetric light.

Types of Light

This section describes the kinds of light sources
you can select from the Type pop-up on the
General tab.
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An Omni light acts like a real life light bulb —
casting its rays in all directions.

Placing an Omni light into the center of your
scene will illuminate your scene evenly.



Spot (round/square)

Spotlights cast their rays in just one direction,
which is along their Z axis by default. Once
created, they can be easily moved and rotated
to light individual objects and certain areas of a
scene. The spotlight source can project a round
or a square cone of light.

Square light cones are ideal for, among other
things, the simulation of projectors which
require a square picture to be cast onto a wall.

Some typical examples of round spotlights are
car headlights, torches etc.
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Distant

The Distant light type is so called because it
mimics the light that is cast from an extreme
distance. Using a Distant light would, for
example, evenly illuminate the whole of a floor
object in all directions.

Since a Distant light is effectively infinite, the
light has no actual origin. Thus the exact placing
of a Distant light, near or far, has no effect on
your scene's objects. Only the actual direction in
which the light is facing is important with this
light source.

Distant light sources are very suitable for the
simulation of sunlight.

Note

Owing to its characteristics, the Distant light
source cannot radiate visible light.
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Parallel

Parallel lights resemble a very distant light
source. Unlike the Distant light source however,
the Parallel light has an origin and simulates a
large, single axis wall of light.

Parallel spot (round/square)

Parallel spotlights resemble the regular spotlight
source object, but do not have light cones to
define falloff or distance. Instead, light rays are
cast along cylinders and/or bars.

By default, all Parallel lights when created will
radiate light rays along the Z-axis. These lights
take the appearance of an infinitely large
surface, radiating parallel light in a single
direction; anything behind the point of origin
will not be illuminated.

Note

Like the Distant light, Parallel lights cannot be
rendered as a visible light.

The origin is important in defining which objects
in a scene will be affected by this light. The
radius of the spotlight can also be modified
using the adjustment handles.



Tube

Tube lights do not have an exact point of origin,
but a linear one. The Tube light is represented
by a line, from which light is radiated in all
directions. When used as a Visible light, this is a
very quick and easy way to make neon tubes.

A classic example of the use of the Tube light is
of course the laser sword.

Quick tip

Tube lights are a great way to produce long-
drawn-out specular highlights, as on the vase in
the illustration below.
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Area

The light rays from an Area light expand from its
origin outwards in all directions. A rectangular
computer screen is a good example of such a
light.

The resultant lighting and specular effects are
somewhat different from those of an Omni
light. Specular highlights are more angular and
the surface illumination is richer (see illustration
below). The closer the light source is to the
object, the more apparent this becomes.

However, an Area light with a small radius that
is placed far away in a scene will hardly seem to
differ from an Omni light source.

Note

As with the Distant and Parallel lights, an Area
light cannot be rendered as a visible light source.
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Types of Shadow

This section describes the different types of
shadow you can select from the Shadow pop-up
on the General tab. The Shadow tab itself is
described on page 333.
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You can combine all light source types with all
shadow types in BodyPaint 3D. For example an
area light can cast not only area shadows, but
hard shadows as well. And a parallel light can
easily cast soft shadows.

There are no restrictions to this mixing of lights
and shadows, since the shadow is computed
independently of the light source.

Hard shadow

Traditionally in raytracers, genuinely raytraced
scenes contained hard shadows. As this
technique needs to compute many more
additional rays, this method increases the render
time dramatically.

Hard shadows, because of their abrupt, sharp
appearance (see illustration below), are of
particular interest for technical illustrations.

However, in other more natural pictures they
look rather unrealistic because such hard, sharp
shadow borders are rarely found in real world
environments.

Soft shadow

In reality all objects, whether they are trees
growing in the wild or a vase in a room, are lit
by several partial light sources. The result of this
is a gradual transition of light to shadow.

This soft edge, or umbra, can be simulated in
BodyPaint 3D by using a so-called shadow map
— the Soft shadow.

A shadow map is a grayscale picture of the
scene seen from the view of the light source.
Contained in this are all the objects lit by the
light source. During the render calculation the
renderer will determine exactly which objects
will fall into this shadow of the light source.




The major advantage of this method is the fast
computing speed and the soft shadow's natural
appearance.

However, the one disadvantage of soft shadows
is the memory required to calculate them.
Depending on the size of the shadow map, a
great deal of additional memory may be
needed. So be careful in your allocation of
shadow maps or you may find your scenes
wasting precious memory.

Area

Although soft shadows are more natural than
hard shadows, they are still not perfectly
natural. On careful examination you can see
that the soft edge always has the same width. In
nature this does not happen; the nearer an
object is to a surface on which it casts its
shadows, the sharper this edge will be. Area
shadows simulate this effect perfectly.

Take a look at the above illustration. Where the
shadow borders on the cube, it has a very hard
look. As the shadow falls away from the cube it
becomes softer.

How does this work? Quite simply really;
BodyPaint 3D calculates the shadow at the
origin of the light source outwards (for all lights,
whether Omni, Spot or Area). Only a hard
shadow is computed at this point. The softer
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area shadow is the result of a virtual area light
source, which simulates the overlay of several
light sources. This provides the natural
scattering of light.

However, as usual, this method comes with a
price; longer render times. Sometimes the result
may not justify the length of render time as a
soft shadow will almost always be sufficient.
Carefully assigned Area shadows, however, can
produce very impressive effects.

An example of a realistic shadow

Types of Visible Light

This section describes the different types of
visible lights you can select from the Visible
Light pop-up on the General tab. The Visible
Light tab itself is described on page 338.

In BodyPaint 3D all light sources and/or the
light cone can be made visible. This type of
effect can be seen in a smoke-filled room.

This effect is comparable to fog, which does not
diminish light, but rather adds to its brightness.

With visible light you can produce the most
stunning computer graphic effects. Headlights,
glowing and shimmering lights, laser beams and
atmospheric effects to name just a few.
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There follows a description of the various types
of visible light, available from the Visible Light
pop-up in the General tab.
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Visible

If only the Show Visible Light option is
activated (General tab), then the light source
penetrates all objects, no shadows are cast by
the objects. For example, you might place a
visible light in the center of a sphere to simulate
an atmosphere around a planet.

A simple example of visible light

Volumetric

If you have experimented with the visible light
settings, you may already know that a visible
light pays no attention to objects which lie in its
cone of light. The light rays penetrate objects
unhindered, casting no shadow in the light's
beam.

In order for shadows to be cast in the visible
light, volumetric lighting must be added.

The parameters for the visible volumetric light
are taken from the light source’s shadow map
values, X-resolution, Y-resolution, parallel width
and the sample radius. The algorithm for
volumetric light is based on the shadow map
and needs these parameters. (These shadow
map parameters are covered in more detail in
the Shadow section of this chapter.)
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Types of Noise

This section describes the different types of
noise you can select from the Noise pop-up on
the General tab. The Noise tab itself is described
on page 343.
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This is volumetric visible light; shadows can be cast within the
light cone

Inverse Volumetric

Using the inverse volumetric function has the
interesting effect of inverting your volumetric [ Shosili  Hione
light — that is, the light is visible where the light F Shos's  amnation
cone would normally be in shadow (see the a ::1"5"
illustration below for an example).

Imagine a company logo, behind which you
have placed an inverse volumetric light source. Illumination
This inverts the light's volumetric effect, giving
the impression that the light is radiating from
the logo itself.

You can add irregularities to your light source in
order to give it a realistic appearance.

With inverse volumetric lighting, the light appears to emanate
from the object
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A real-world surface is unlikely to be evenly lit,
especially if dust or particles are in the air.

Visibility
This option adds irregularities not to your lit
surface, but to the visible light itself.

With this you can simulate for example the
waving effect of fog, which is visible in the light
cone.

Here is an example: Using Noise you can
produce very interesting effects, such as a
supernova, simply by setting the internal and
external colors of the visible light to yellow and
red.

Both

Using this option will ensure that both the basic
light and any visible light are provided with
noise irregularities.
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Using the options on the Details tab, you can
access the individual properties of each of your
light sources.

Inner Angle

Depending on the type of light you use, this will
adjust either the inner angle (for a standard
spotlight) or the inner radius (for a parallel
spotlight) of the light.

Within the inner angle area, the luminosity value
of the light source is 100%. From the inner to
the outer angle the luminosity value falls from
100% to 0%.
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If you switch off the Inner Angle option, the
luminosity of the light source in the entire light
cone amounts to 100%, resulting in a hard cone
of light; the following picture illustrates this.

If Inner Angle has a value of 0, the light source
will have a soft transition spreading from the
center of the light to the light's edge, as
illustrated below.
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Outer Angle

Adjusting this value will define how large the
light will be in total. The Outer Angle value
indicates the limits of the light source's
luminosity.

Aspect Ratio

This option allows you to stretch and shear the
shape of the light's cone angle. The standard
aspect ratio value is 1; increasing the value to 2,
for example, will double the light cone’s height
relative to its width. Similarly, reducing the value
to 0.5 will make the light cone only half as high
as it is wide.

Note

This effect can also be achieved by scaling the
axes of the light source using the Object tool
and/or the Object Axis tool.

@§ Object tool

E‘ Object Axis tool

Brightness

This value controls the overall brightness of the
light source.

While this control may be seen as just a way of
brightening or dimming your light source, it's
also capable of another interesting, and very
useful, effect. Using a negative value with this
option results in negative lighting.

The color of your light source (set in the General
tab) is important here. That color will not be
added to the scene where a negative light

source is in effect. With this technique you can
artificially darken and shade specific areas of

your scene.

This type of lighting works even better when
used with carefully constructed environment
lighting and falloff ranges. A good
understanding of environment lighting is needed
for this and this is covered later in this chapter.

Contrast

The intensity of a light source on an object is
not dependent on the distance of the light from
the object (unless you explicitly adjust its falloff),
but rather on the angle at which its rays hit the
object.

If a ray hits a surface at an angle of 90°, the
surface is illuminated with the light's maximum
intensity (taking any falloff into account). As this
angle (called the angle of incidence) decreases,
the strength of the illumination decreases as
well. Therefore, in an average scene, a soft
transition is normally seen on any lit surfaces.
The Contrast value controls this transition.

In the illustration below you can see a series of
pictures of a planet, towards which a light is
directed. You can clearly see how little the
planet's front and sides are lit using 0%



contrast. The transition on this lit surface is not
very soft; this surface contrast is not natural for
planets. If you look at photographs of a planet
you will see that the transition of its lit surface
to its shadowed edge is hard - as illustrated
further to the right in the series of pictures.

0% 50% 100%

With the contrast control you can adjust how
soft or hard you wish the lit surface transition to
be.

If you need a special over-soft look to your
objects you may even enter negative values,
here's an example:

0% -50%

-100%

Inner Color

Independently of the light source’s color, which
was assigned in the General tab, you may assign
another color to the internal range of the light.

When used, this Inner Color is the core color of
the light source. Starting at 100% of its value,
the inner color spreads outwards and gradually
changes into the light source’s general color. For
the inner color to be used, the Colored Edge
Falloff option (see below) must be activated.
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The inner distance of the falloff determines the
expansion of the inner color. Click on the color
chooser to select the color properties of your
inner color.

In this illustration the light source is yellow and
the inner color is red. The light shows a gradual
progress of color change from red to yellow.

Colored Edge Falloff

This option is available only when using a
spotlight with an Inner Color option selected.
The normal behaviour of the inner color is to
spread in a linear direction along only the Z-axis
of the spotlight, from its origin to the light
source’s color (selected in the General tab).

If you select Colored Edge Falloff, however, the
inner color will also radiate outwards from the
inner angle through to the light source’s general
color.
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In this picture Colored Edge Falloff is deactivated.

Here Colored Edge Falloff is on — you can see the inner color in LY

the center of the light cone. \H

Falloff ' Qﬁ

A normal virtual light source will illuminate its L

surrounding environment with a continuous,

linear brightness. However, this is not how all g,

lights work in reality; real light sources will have

their luminosity absorbed.

Just as in nature, BodyPaint 3D light sources are ~ /nner Distance

able to have their luminosity reduced over any Within Inner Distance there is no falloff. Up to
distance. To achieve this, several falloff functions  this point, the brightness of the light remains
are available in this pop-up and are illustrated constant. Outside of this boundary is where the

below. inner distance falloff begins.



Outer Distance

The range between the inner distance and the
outer distance is where the brightness of the
source light changes from 100% to 0%. This
Outer Distance value indicates the maximum
range that will be illuminated by the source
light.

Near Clipping

You can use clipping to restrict the illumination
and visible light (if present) radially with an

Omni light and linearly with all other light types.

This means your light source does not have to
radiate light from its origin; the radiation may
begin, for example, five meters from the light
source's origin.

The two values used for this effect are From and
To and signify, in metres, the distance for the
clipping effect. The larger the difference in the
two values, the softer the transition.

-

From = 90, To = 90

From =90, To = 150
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An example:

If values of 10m and 50m are used in the two
boxes, it means that there will be no
illumination from the light source between O
and 10 meters; from 10 metres the luminosity
begins, reaching full luminosity at 50 metres.

Far Clipping

Far clipping can be used to cut off your light
source’s illumination abruptly.

To use far clipping, once again two values are
needed. This time the From and To values
denote where the cut off begins, and where the
light source will fully vanish. Again, the larger
the difference between these two values, the
softer the transition.

Examples of clipping with point and spotlights
are shown below.

-

From = 300, To = 300

-

From = 220, To = 300
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Schematic display of the individual clipping ranges using the
example of an Omni light source

Ambient lllumination

Normally the brightness of a surface is
determined by the angle at which a ray of light
hits it. The greater the angle between the ray
and a tangent to the surface, the more the
surface will be lit by the light.

When Ambient Illumination is switched on,
however, this physical law is waived. Here the
angle does not matter. All surfaces are lit with
the same intensity. Thus a much flatter look
results. Only the material color is considered in
the lighting calculations.

In the example picture above, the light's Falloff
was also activated.

With both Ambient Illumination and Falloff
activated for the light source, you can lighten
certain regions of your scene in a similar way to
how you darken them with negative lighting,
explained earlier.

No Diffuse

When No Diffuse is selected, the color
properties of an object are ignored by the light
source; only specular surfacing is produced by
the light. This can be useful for some objects
e.g. a golden signature, where you would like
some specular glints, but no lightening of the
color properties.

Writing with No Diffuse off

CINEMA 4

Writing with No Diffuse on



No Specular

When this option is selected, the light source
produces no specular highlights on your scene's
objects. Imagine you have a wineglass on a
table with two or more light sources in the
scene. Your wine glass may then show too many
specular highlights, with the glass material
looking too busy. To avoid this, turn on No
Specular for some of your light sources.

The bottle below is lit by two light sources,
causing several highlights to develop.

Below, the No Specular option has been
activated for one of the light sources.
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Shadow
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This attributes tab is used for the fine-tuning of
your scene's shadow maps.

Density

Adjusting this value will vary the intensity of
your shadow. A value of 100% means the
shadow has full intensity. With 50% your
shadow will be semi-transparent, and at 0% the
shadow is invisible.

Color

Here you can change the shadow’s color. You
may be asking yourself why you would ever
need to do this. With a little thought, however,
you may realise that in nature a shadow is
hardly ever truly jet black. Coloring your shadow
with a shade of brown, for example, could give
a particular scene some natural, extra warmth.
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Bias

Because of the particular principle involved in
the calculation of shadow maps (shadows do
not begin at the object's origin), you may at
times find the need to adjust the shadow’s
position using the Bias value. Usually a value of
1m will suffice for most scenes. However,
sometimes an adjustment may be necessary.

When zooming the camera in on extremely
small objects, this distance between object and
shadow will become apparent (see

illustration 1).

Entering a lower value can correct this error (see
illustration 2).

You may also at times have too small a Bias
value (e.g. with very large objects), which can
result in the object casting the shadow on to
itself (see illustration 3). In a case like this, set
the Bias value somewhat higher.

Ilustration 1

Illustration 2

Illustration 3

Note

The smaller an object is and the more you zoom
in on it with the camera, the smaller the bias
value must be set. This ensures no gap between
object and shadow is visible. If the object is
excessively large and unwanted self-shadowing
occurs, raise the bias value. Generally speaking,
a value of 1m is adequate for all objects up to a
size of 70000m.



Absolute
You should leave this option activated!

If you switch it off, the distance of the shadow
from the object depends also on the distance of
the light source from the object - so-called
relative bias. With relative bias, the further the
light source is from the object, the further the
shadow will be from the object.

It can be useful to deactivate the option in cases
of extreme scale.

Transparency

If you need your shadow maps to consider the
transparent (alpha channel) properties of your
objects, you should switch on this option. When
activated, your shadows will take into account
the transparent surfaces of your objects and
render your shadows with the correct
transparency. Transparencies can also be
computed with all other shadow types.

The Transparency option is on

The Transparency option is off
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Note

Transparent soft shadows use lots of memory
during rendering. An Omni light source can
sometimes use six times as much memory as a
spotlight, as six shadow map calculations must
be computed compared to the spotlight’s single
shadow map.

Clipping Influence

If you select this option, the clipping settings on
the Details tab will be applied to shadow-casting
as well.

Area Shadow

This value will set the parameter range for your
area shadow.

Width

As described above, the area shadow is
produced by a virtual area light source
(independently of the actual light source). This
Width value indicates the size of this surface.
The larger you make this value, the more the
light is scattered and the softer the shadow
becomes. However, as the value is increased, so
is the render time, sometimes substantially.

A

With large radius (300 m)
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k

With small radius (50 m)

Samples

If you lower this value, the quality of the area
shadow is reduced, but it is calculated more
quickly.

Soft Shadow

Use this for the finer details of your soft
shadows.

Map Size

When using soft shadows, BodyPaint 3D initially
sees the scene from the point of view of the
light source and calculates the complete scene
from this view. All objects seen in this view are
interpreted as shadows for the scene. This
results in shadow maps being created.

Map Size assigns memory for each shadow
map. The smaller the memory assignment, the
more pixelated the shadow will appear. This can
result in a shadow map with a jagged, staircase-
like appearance at its edges. The more memory
used for the map size, the smoother the shadow
and its edges, but the higher the memory usage.

By default, a standard size of 250x250 is used
for Map Size. Shadow map sizes are commonly
set anywhere up to 1000x1000. Although you
can define a larger map size, you should rarely
need to do so.

T50xT50

You can see clearly that, in order to keep your
shadow sharp and smoothly defined, your
shadow map will need to increase in size.

If you simply need to keep your shadow edge
soft, you can increase the Sample Radius (see
below). Again, this will increase render time.



Note

Rather than use a map with a doubled map size,
you can achieve an equivalent soft edge by
doubling the sample radius.

Sometimes when you have a small shadow map
created by a very distant light source, a problem
may appear with spherical objects casting
rectangular shadows.

You can check this by viewing the scene
through your light source. A light source, like
any other scene object, can be defined as a
camera view. To do this make sure your light
source is selected and from the Perspective View
menu select Cameras > Link Active Object.

X-resolution

If the pre-set value of the map size is not giving
you the desired result, you may optionally adjust
the X-resolution manually. In general it is
standard to set the manual X-resolution (width)
to the same value as the Y-resolution (height)

Y-resolution

With a spotlight source, you can also provide a
non-square shadow map by manually entering a
value for the Y-resolution.

Memory Usage

BodyPaint 3D automatically calculates the
maximum memory use for the shadow map,
which is shown here. This can help you in
estimating exactly how much memory will be
allocated for your light sources shadow map
calculations in your scene.

Sample Radius

The sample radius determines the accuracy of
the shadow map. The higher the sample radius,
the more accurate the shadow is, at the expense
of a higher render time. If, for some reason, you
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must use a small shadow map, selecting a higher
Sample Radius value will improve the shadow
quality. So you can trade off render time against
memory usage.

Parallel Width

This setting will only be active for distant and/or
parallel lights.

Here we meet a visible light setting known as a
light cube (more accurately, a light cuboid). This
light cube has its length/width dimensions set to
the Parallel Width value, the depth (z-axis) of
the light cube being infinite. Importantly, only
objects within this cube can cast shadows.

This boundary for shadow-casting is a necessity
since the scope of parallel/distant light sources is
infinite.

Outline Shadow

Using this option will result in your shadow
being seen as just a thin outline, instead of a
full, darkened surface.

Note

With this option, it is recommended you use
higher values for the shadow maps resolution
and sample radius.



338 « OBJECTS MENU ¢ CHAPTER 18

Use Shadow Cone

One of the main problems with Omni light
sources is that six shadow maps must be
computed in total, which can sometimes
produce small artifacts at the shadow's edges. If
the Use Shadow Cone option is activated, the
shadow production is limited to a cone, thus
generating a single shadow map without
artefacts.

Additionally, producing these shadow maps only
where necessary will save considerable render
time.

Soft

Activating this option will give the shadow cone
a softer edge.

This option is used to ensure that any object
which is only partially in the shadow cone area
casts a soft, fading shadow.

Angle

This value changes the vertex angle of the
shadow cone.

Visible Light
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Falloff

This is the percentage reduction in the light's
density. The axial falloff of the visible light is set
to a standard 100%.

This means that from the origin of the light to
its outer distance, the density of the visible light
falls from 100% to 0%. So, if a value of 10% is
entered, the outside edge will be at 90%
visibility.

100% Falloff

0% Falloff



Edge Falloff

Edge falloff is relevant only with spotlight
sources. The edge falloff determines how
quickly the light's density decreases towards the
edge of the light cone.

If you enter a value of 0% (or leave the option
unselected), you will produce a very hard visible
light.

A value of 100% gives a more gradual falloff
from the inside of the light cone to its outer
edge, until it reaches 0%.

0 % Edge Falloff

100 % Edge Falloff

Custom Colors

With this option you can assign your own colors
to the visible light, independently of the actual
color of the light source (General tab) and the
inner color (Details tab).
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Outer

Use the color selector to define your light's
outer color edge.

Inner

Use the color selector to define your light's inner
color edge.

Colored Edge Falloff

This option is only available with spotlight
sources and works with your selected custom
colors. Normally the inner color behaves in such
a way that it travels along the Z-axis of the
spotlight source linearly to the outer color.
However, selecting Colored Edge Falloff will
cause the inner color to also spread outwards
radially from the inner angle to meet the outer
color.

In this picture Colored Edge Falloff is off

Here Colored Edge Falloff is on — you can see the inner color
within the light cone
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Inner Distance

Within this value, the density of the visible light
is always a constant 100%. The falloff begins
only outside of this distance.

Outer Distance

Between the inner distance and the outer
distance the density of the visible light changes
from 100% to 0%. This value thus gives the
maximum visible range of the visible light.

Outer Distance Y

When using Omni light sources, you have the
ability to set the falloff distance for both Y and Z
axes. This option sets the distance of light falloff
for the Y axis.

Outer Distance Z

This option sets the value for the Omni light's
falloff along the Z-axis.

Sample Distance

The sample distance is relevant for only visible
volumetric lights. Adjusting this value defines
how finely the visible light's volumetric shadow
will be computed.

Larger values lead to a somewhat rough (but
swift) calculation, while smaller values lead to a
much finer, but more time-consuming result.

The value of this sample distance is measured in
world units. This value thus determines how
finely the shadows within a visible light will be
sampled. Values will usually be from 1/10th to
1/1000th of the light source radius.

By increasing the value your scene will render
noticeably quicker but certain parts of your
scene will be sampled very roughly, resulting in
sampling artifacts. To reduce these sampling

artifacts requires a reduction in your sampling
value too. The smaller the value, however, the
higher the cost in rendering time.

BodyPaint 3D contains an integrated antialiasing
technique for surface shine, ensuring even the
roughest surfaces render smoothly, allowing you
to set the Sample Distance value somewhat
higher than without this feature.

Sample distance tips

If you want to create fine shafts of light, such as
light beams radiating through cracks or from
behind stone columns, set the sample distance
to a relatively small value. On the other hand, a
light that is completely covered and allows no
beams of light to break through may be
sampled using a much higher value.

The following example demonstrates this. The
pumpkin in the picture has a radius of 150 units,
the visible volumetric light a radius (outer
distance) of 700 units.

top left

Sample Distance: 10 units
Render time: 105s

The pumpkin looks perfect.



top right
Sample Distance: 20 units
Render time: 60s

Here the rays emitting from the mouth and the right
eye are showing the first signs of artifacts.

bottom left
Sample Distance: 40 units
Render time: 35s

You can clearly see now how the rays in the visible
light are losing their fine edges.

bottom right

Sample Distance: 80 units

Render time: 23s

The picture has, quite literally, been rendered useless.

Why is volumetric lighting so render-intensive?

When a beam hits a light cone, it is not only the
intensity of the light that needs to be computed.
Additionally, for each part of the beam, the
program needs to check for other objects within
the light cone that might be casting shadows.
So for every part of the beam of light, an extra
raytracer ray needs to be initiated and emitted.

However, segments in the fog cannot be
reduced below a certain length, and as a result,
an approximation must be used - the length of
the light cone is subdivided into equal parts.

Let's say the raytracer ray hits the light cone and
the distance between the entry and the exit
points of the light cone is 1,000 units. So a
sample distance of 50 units will mean that an
intensity value and a shadow beam will have to
be calculated 20 times (1000 divided by 50).

The shorter the sample distance, the longer the
calculation will take. Even if you have only five
subdivisions (so a sample distance of 200 in the
above example) this will require a five-fold
increase per raytracer ray and per contact with
the light cone than without volumetric lighting.
Using progressively finer subdivisions, the
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processing time involved will very quickly
become astronomical. Alas, this is an inherent
problem with computer graphics which cannot
be resolved or accelerated other than by
throwing processor power at it.

So why can't you input a fixed value for the
number of samples?

Well, if the raytracer beam hits the light cone at
its beginning, the distance between the entry
and exit points might be, for example, 100
units. But if the beam hits the cone further from
the light source, this distance might grow to
5,000 units or more. So if you used a fixed
number of samples, at the narrow end of the
cone a lot of unnecessary calculations would be
made and later too few (which would result in
ugly artefacts).

Tips

Volumetric lighting needs a lot of calculation
time, therefore render such light sources only
when it is absolutely necessary. If you choose to
use a volumetric light as a particle (which is
perfectly possible), then perhaps you should
consider buying a second computer which you
can leave to render that scene over a period of
days. Take care with your sample distance
values. Finding a happy medium (small for fine
detail, but as large as possible for reducing
render time) is the key here.

Brightness

This value gives the brightness of the visible
light source.

Dust

With this option you can determine the darkness
of the light cone. With a Dust value of more
than 0% brightness is not added, but
subtracted. To make sure you see the full effect
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of this, lower your light's brightness accordingly.
The difference between a normal bright light
and a dust-assigned light can be clearly seen in
the following illustration. To the left is a bright,
visible light. To the right a dark, dusty,
somewhat sooty light.

Dithering

This produces small irregularities in the visible
light which, in certain cases, can help prevent
unwanted banding (aka contouring) in the
visible light source.

Explanation

With certain light source combinations (e.g
visible lights that overlap), you may find that the
24-bit picture depth of your output device is
insufficient and it may display color gradients in
large steps. This display problem is known as
banding or contouring. To avoid this problem
use the dithering option to give your visible light
a certain irregularity and help to smooth the
color graduations.

Adapt Brightness

This option prevents a light beam from being
over-exposed. The brightness is reduced until
the over-exposed effect disappears.

Adapt Brightness off

Adapt Brightness on
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Additive Noise Tab
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Additive on

Type

Select from four Noise types.

Simple Noise produces dark and bright areas:

-

Additive off

Then there are three types of turbulence that
change the characteristics of the noise by
adding cloud-like effects.
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Soft Turbulence:

Hard Turbulence:

Wavy Turbulence:

Octaves
(Only relevant for the Turbulence types above)

The Octaves value determines the graininess of
the noise. The higher the value, the more gritty
the appearance.

Velocity

Indicates the speed at which the irregularities
will move.

Brightness

Using this you can raise the overall brightness of
the irregularities. You may also enter negative
percentages and reduce the brightness.

Contrast

Changing this will allow you to adjust the
contrast of the noise. Higher values increase the
contrast, lower values reduce it.

Use Local Coordinates

Selecting this option will ensure that the local
coordinates of the light source are nailed down.
If the light source is moved now, the noise/
turbulence will move also.

In normal use you should leave this option off,
as dust and particles in the real world move due
to the forces of nature, not because the light
itself moves.

Scale

This value will determine the size of the
irregularities in relation to the scene's absolute
Cartesian coordinates. If the noise effect is too
severe, try reducing this value.

Illumination

This is where you set the general intensity of the
noise.



Wind
This is only relevant when you are using
BodyPaint 3D in conjunction with CINEMA 4D;

please see the CINEMA 4D reference manual for
details of this function.

Lens Effects

BodyPaint 3D is a powerful tool when it comes
to producing the aberrations of real-world
camera lens systems and film material.

Basic sunbeams are brought to life with a solar
corona or a halo. A lens reflection of a low-
quality camera lens can be easily simulated, as
rainbow colored circles develop and run
diagonally across the screen. A welcome flaw in
an otherwise too perfect virtual world.

You may recall that the General tab has an
option for turning off light radiation (No Light
Radiation). If this option is chosen, the light
source will no longer illuminate the scene but its
lens effects will still be visible. This is useful, for
example, if you are already satisfied with the
lighting in your scene and you wish to add a
lens flare but no further surface illumination.
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The parameters for these lens effects are many
and varied and take up three tabs of the Light
settings dialog. But fear not, with a step-by-step
approach you will soon be comfortable with all
the effects and their various options.

On the main Lens Effects tab you can define
your basic effect, choosing both reflexes and
glows separately. Using the two related tabs
(Glow Editor and Lens Editor) you may fine tune
the finest details of the entire lens effect. To aid
you in this, a preview window will constantly
update the adjustments as you make them.

Tip
It's very easy to build yourself a light source
library containing spectacular effects. You can
produce many types of light sources with
different effects that can then be saved as
individual objects in the Object manager. When
you require one of these specific lights for your
scene you may simply load it from your source
light library.
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So to the details of the Lens Effects tab. From
here you can quickly access a number of pre-
defined glow and reflex examples. You can also
change the basic properties of the lens
aberration from here.

Glow

From this popup menu you can select, from a
pre-defined library, the glow of the light source.

Reflexes

From this popup menu you can select the type
of lens reflection from a pre-defined library.

You will find a detailed overview of all the
effects at the end of this section.

S (brightness)

Adjusting this value will change the global
brightness of the glow or reflex. Smaller values
will reduce the effect, values of 100% or more
will strengthen it.

R (aspect ratio)

Change the global aspect ratio of both glows
and reflexes with this value. At the default value
of 1, both will appear circular. Smaller or greater
values will give you a squeezed/stretched
ellipse.

Scale

This value will adjust the size of the whole lens
effect (rays, glows and reflexes). This saves you
from adjusting each effect individually.

Rotation

Use this value to rotate the lens effect to any
angle.

Use Light Parameters

When this option is activated, the light source
properties defined in the General tab will also
affect the glow/reflex effects. So if the light
source color is red then the glow/reflex effect
will also appear red.

Fade if near Border

Using this option will make the lens effect fade
the nearer it is to the edge of the image. When
at the center of the screen, the lens effect will
have maximum intensity. This corresponds to a
light's physical behaviour in the real world.

Fade if behind Objects

Using this option will determine whether light
sources that lie behind objects are still to
produce their effects or not.

Lens flares do not occur if light sources are
behind objects, but glows or radiation can
produce attractive effects.

Fade if approaching Objects

Normally, if a light source with a lens effect
disappears behind an object, the effects are still
at maximum strength until the light source
origin is fully behind the object. With this option
enabled, the effect’s strength will gradually fade
as the light source approaches the object.

Note

The gradual fading of the sun behind a planet,
complete with atmosphere, is a good example of
this effect.

Scale Glow with Distance

This option will scale the glow effect according

to its distance from the camera. The further the
distance from the camera, the smaller the effect
will be.



Scale Reflexes with Distance

This option will scale the reflex effect according
to the distance. The further the distance from
the camera, the smaller the effect will be.

Reference Size

With this option you can adjust the distance
value with which the glow and reflex effects are
calculated. The smaller the value the more
distant, thus smaller, the effect will appear.
While increasing the value will make the effect
appear closer, thus larger.

Normally lens reflexes have a constant size, no
matter how far removed from the camera they
are.

Glow Editor
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With this tab you can tweak the lens glow to
your exact requirements. This dialog is divided
into three parts, the glow properties (top left),
the ring properties (top right) and the beam
properties (bottom left), which incorporates the
Streak Editor.
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Of major importance is the preview window
that updates your effect as you modify it.

Glow properties

Glow

Select the required glow element from this
menu of pre-defined light source glows, to
change the overall shape of the light's glow.

Type

Selecting a glow type from this pre-defined set
will change how the glow's brightness is
distributed.

Size

Adjusting this value determines the size of the
glow's element. The radius is shown as a
percentage, where 100% is the distance from
the center of the screen to the edge.

R (aspect ratio)

Modifying this value allows you to change the
aspect ratio of the glow. At its default size of 1
the glow will appear circular. Smaller or larger
values will shrink/stretch the glow's aspect,
making it a horizontal or vertical ellipse.

Color

From this dialog (obtained by clicking the box to
the right of Size) you can select the color of the
surrounding outer glow.

Ring properties

Using these values will produce a ring, or halo,
around the lens effect. Adjust this effect to your
requirements by consulting the preview window.
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Ring

From this drop-down menu you choose the halo
type you require; Inactive, Ring or Rainbow
Ring.

Size
Adjust the size of the ring from here, the value
being a percentage.

R (aspect ratio)

Adjust the ring's aspect ratio with this value.
Decreasing the default value of 1 will flatten the
ring, while increasing it will stretch it into an
ellipse.

Color

Choose the color for the ring from this color
picker.

With this dialog you can define the corona of
your lens effect — the rays of light that are cast
in star-like fashion around the effect.

Change this effect until you see what you want
in the preview window.

Beam properties

Choose your preferred beam/corona from this
pre-defined, drop-down set.

Type

Choose the corona type from here. Depending
on the type chosen, the pattern and number of
beams cast will vary.

Size

Use this value to determine the size of the
element. The radius is indicated as a percentage,
where 100% is the distance from the center of
the screen to the edge.

R (aspect ratio)

Adjust the aspect ratio of the corona with this
value. At the default value of 1 it will appear
circular. Smaller values will flatten the effect into
a small horizontal ellipse, while increasing the
value stretches it into a taller, vertical ellipse.

Color

Choose a color for your corona from this color
picker (click to the right of Size).

Angle

To rotate the beams of your star/corona to any
angle you want, enter a new value here.

Edit
Still not satisfied? OK, there's more; click this
Edit button to open the Streak Editor.

The Streak Editor
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This dialog enables you to adjust the light that
defines the appearance of the corona. These
values are set with four sliders and three option
boxes. As usual, a preview window is updated
constantly to let you see your changes.




Thickness

Change this value to specify the width of the
beam'’s rays. The smaller the value, the sharper
the beam (or streak) appears.

Beams

You can choose the number of beams produced
by your corona effect here. Up to 200 beams
can be produced by each light source.

Breaks

With this option you can insert interruptions or
breaks into your corona. These are added to the
gaps which already exist between the beams.

Width

Adjust the size of the above breaks with this
value.

Random Distribution

Activating this option ensures that the beams
are arranged randomly, rather than in a
symmetrical pattern.

Random Beam Length

To ensure that all beams are not the same
length, activate this option. All individual beams
will then be different lengths.

Star-like

Once activated, this option will arrange the
beams in a more star-shaped pattern, thickening
the beams towards the center.

This effect is particularly effective when used
with a small number of thick beams.
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Lens Editor
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The Lens Editor helps you to create and adjust
those famous, often infamous, lens reflections
(aka lens flares) to your specific needs. Once
again, all changes are shown in the preview
window.

Element no.

Use this slider to select the reflection you wish
to edit. You can add or remove extra reflections
to and from the existing set by using the + and -
buttons. A maximum of 40 reflections are at
your disposal, enough to recreate any
combination of light/lens flares or aberrations.

Type

Select the shape of your reflection with this
slider. Only in the rarest case, if at all, should
different reflection types be used in a scene. For
example, apply only circular or only hexagonal
types to the one scene. Remember, your scene is
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shot through one simulated real-world lens —
these lens reflections depend upon that lens
system, not on your existing scene lights.

Here are some examples:

Pos

This value sets the positioning of the element on
the screen. The axis on which all reflections lie
travels through two points; the light source and
the center of the screen (which is also the centre
of the lens).

Here the following values apply.

0% = light source
50% = screen center
100% = 2x distance light source center

Negative values place the reflections behind the
light source.

Size

This value determines the size of the element.
The radius is shown as a percentage, where
100% is the distance from the center of the
screen to the edge.

Color
Select the color for the element.

Real World Glows, Halos and Reflexes

Glows

Glows are a type of over-exposure to light.
When the light intensity is sufficient, this
exposure bloom includes film grain in the areas
surrounding a bright light, even though those
areas are not illuminated at all.

Halos

Halos are also caused by over-exposure, but
with added color distortions caused by the
diffraction of the film grain.

Reflexes

Lens reflections are caused by the focal image of
poor quality lenses. The colored shape produced
is an artifact of the lens surface, the shape
resulting from the shape of the lens.

Large apertures produce small reflections, small
apertures produce larger ones.

-

Default CINEMA 4D V4
Wide angle Zoom
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Hi-8

Camcorder

Artefact

Floodlight

Star 1

Star 3 Violet Red Yellow-green 1

Flash 1 Flash 2 Yellow-green 2 Candle




352 « OBJECTS MENU ¢ CHAPTER 18

Making Gels

A gel is produced by assigning a material with a
transparency map texture to a light source. The
light's colored areas are then filtered by this
texture and colored in exactly the same way as a
slide projector will project a still picture.

You can assign as many gels as you wish to each
light object. Thus you are able to produce many
complex picture effects with ease.

For example, the striped-shadow effect of a
venetian blind can be simulated, without the
complicated and time-consuming shadow
calculations normally associated with such an
effect, simply by assigning a black-and-white
striped gel (aka light map) to a light object.

Note

Lights do not take on the material properties of a
parent object

Three Point Lighting

A simple and very common lighting principle is
the three point lighting technique. This method
is excellent for lighting individual objects
correctly e.g. a character in a scene.

The object is illuminated by a main (key) light, a
fill light and a third light from the rear, known as
the backlight. Naturally all scenes and objects
are unique and require individual setups, but this
system is a good starting point for your scene’s
lighting properties.

The first light is the main light of the scene (the
key light) — often a white spotlight with a soft
shadow and the brightest light of the three. This
light is placed to the right of the camera and
aligned to your object. The radius is then
adjusted to illuminate the whole of the object.

%

The second light is the fill light which
complements the key light by illuminating the
parts of the scene not reached by the key light.
Changing this light to another color (e.g. yellow
or red-brown) will make the scene appear softer
and warmer. This fill light should be at roughly
50% brightness and placed to the left of the
camera and key light.



The third of these lights is the backlight. This
spotlight provides lighting from the rear and
above in order to emphasize the outline of your
object against the background.

Blue is a suitable color here, as cooler colors are
seen by the human eye as somewhat more
distant than warmer colors, thus giving more
apparent depth to your scene.

A :
ot
i .
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Here is an image lit with simple, one-source
lighting ...

Now here is the same image lit with carefully-
designed three-point lighting ...

The light sources do not have to be spotlights
but the limited and more central spread of a
spotlight's illumination means the objects won't
become lost in a lighter, more evenly lit
environment.
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It is also preferable to have just one light (the
key light) cast shadows. All three lights casting
shadows can become confusing. One shadow-
casting light is often more than sufficient.

Note that you should not place your light
sources too close to your object, otherwise
unwanted specularity may result. The further
away the light source is from the object, the
more evenly lit the object will be.

Target Light

When you choose Objects > Scene > Target
Light, a null object is created, containing a light
source and another null object. The latter is the
target object to which the light is tied at all
times.

The light source can be any light type of your
choosing and you simply move objects into the
hierarchy of the target object for the light to
become aligned to them.

You can edit the whole structure interactively
within the editor so, if you move the light
source, it stays aligned to the target object and,
conversely, if you move the target object the
target light follows it.

Floor

This command creates a floor object. The floor
always lies in the XZ plane of the world
coordinate system, stretching to infinity in all
directions.

You may create as many floors as you need and
use them all at the same time in BodyPaint 3D.
You could, for example, use multiple floors as
pseudo skies on to which you can add cloud
layers of differing transparency. In the following
example four floors were used, one for the
actual ground and three for the layers of cloud,
each one situated higher than the other.

As you may have realized, floors can be moved
and rotated relative to each other. This feature
can help you avoid cloud layers appearing
identical, by avoiding repeating textures.



Sky
L

This command will create a sky object which, to
all intents and purposes, is an infinitely large
sphere whose center is the origin of the world
coordinate system.

If you want to apply a texture (e.g the 2D cloud
shader) to the sky, you should use Spherical or
Cubic projection. If the clouds appear too large,
increase the repetition of the texture's tiling and
ensure you switch on Seamless (see Texture
Mapping, page 255).

Do the clouds seem a little artificial? The
possible reason for this is that the clouds have
the same tiling in both the X and the Y
direction. Adjusting the repetition of the tiling
on the Y-axis, making them approximately twice
as high as for the X-axis, ensures the clouds look
somewhat stretched and they appear nearer and
more natural.

Alternatively, you can use several floor objects
for the simulation of cloud layers.
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For simulating a starlit sky, Cubic projection is
recommended as this will avoid unwanted
distortions at the poles.

Aiming the camera directly up will display a
problem — the cloud texture tends to gather at
the zenith. You can fix this by assigning Shrink
Wrapping (see page 262).

Starirk Merapping

When rendering note that only one Sky object is
taken into account. If you have several Sky
objects in your scene, the uppermost one in the
Object manager is used when rendering the
scene.

Note

With environment fog switched on the sky
object's visibility will be lost. How you create a
sky to appear with environment fog is explained
on page 228.
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Environment

You can use the Environment object to define
several global scene parameters.

Note
Only one environment object can be rendered.

Environment Color Tab

This is the color of the environment light (aka
ambient light). The environment light illuminates
the scene evenly from all sides and is meant to
simulate the background light of a daytime sky
or the indirect lighting of a room light.

A || CEE |
b Ipox g
E oz g
Bt ——— [ 3

The brightness slider is set to 0% by default. If
you wish to simulate environment light, increase
the value of the brightness slider to, say, 10%
for architectural scenes.

Be very careful when increasing the brightness,
since it reduces the contrast in the scene; often
you can get better results by adding omni lights
that do not cast shadows.

Note

Environment color can be useful for increasing
the color contrast. For example, you can use it to
introduce complementary colors into the scene.
Perhaps you will set a dark blue to contrast with

a warm yellow window glow as well as to
simulate night. Or imagine a moonlit scene; you
can enhance the bright yellow moonlight by
using a dark purple environment.

Fog Tab

Use environment fog for, among many other
things, atmospheric autumn images or
underwater scenes.
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Environment fog fills the entire screen,
stretching to infinity. Use this dialog to select the
fog's color.

Distance

Distance refers to the fog's intensity by
specifying the distance over which a light beam
will lose its intensity completely. As the light
loses intensity, the fog color is added.

If, for example, you have entered a value of 500
for Distance, a light beam that starts off with
100% intensity will reduce to 20% after
travelling 400 units; at the end of a further 100
units, the light will have faded out completely,
giving way to the fog color. The shorter the
distance, the thicker the fog.

Beams that penetrate the fog beyond the limit
defined in Distance are absorbed completely by
the fog color — if you enable environment fog,
you cannot see a sky or a background image.



Background

In order to render a background image, or to
display one in the Perspective View, you may
assign a textured material to a background
object, just as you would to any other object.
For transparent areas, assign an alpha channel
to the material (see page 231).

The background picture might be a landscape,
into which your scene will fit. For this you assign
a material, with the required texture in its color
channel, to the background object.

These images will be neither reflected by your
scene's reflective objects nor lit in any way by
the scene. Nor will they change with any change
of camera settings.

The background image will show through
transparent and refractive objects but will not
change with altered camera settings.

You could compare it to a background layer
generated by the alpha channel feature, on
which the rendered image is then superimposed.

Note

As soon as you have applied a texture to a
background object, it will be displayed in the
Perspective View. If this display distracts you,
you may turn it off by selecting the object in the
Object manager and choosing Objects > Object
Display > Editor Off (see page 198).

Note

Any background picture (see page 15) is
normally displayed in the Perspective View only,
so as not to distract you when working in the
flat views. However, attaching the camera to the
view in any Perspective View will make the
background object appear in all view modes for
that window. Any background picture already
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displayed will then be covered by the
background object texture.

The background picture can also be tiled. For
this effect, use the texture geometry dialog (see
page 255).

The background picture is scaled to the film
format during rendering (see Output Tab, page
410). Transparent sections of the background
are ignored.

Note
Only one background object can be rendered.
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19 Tools Menu

Move

p 9

This command will let you place the active
object or element anywhere in the work area,
subject to other options like snap, the mouse
grid, whether certain axes are locked etc.

When moving objects, BodyPaint 3D
distinguishes between the world coordinate
system and the local object coordinate system.

This distinction is particularly noticeable when
movement takes place in different axial systems
and only the X axis is activated, say.

Let's assume you are moving a cuboid which is
positioned somewhat askew relative to the
world coordinate system and you have locked
the Y and Z axes for movement (see below). If
you move within the world coordinate system
the cuboid moves parallel to the X axis of the
world system.
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If, on the other hand, you select the object
coordinate system, the cuboid moves along its
own (the object’s) X axis, which results in a quite
different behavior as you can see.

Both can be useful but you should always be
aware which you are currently using (check on
the Tools menu).
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The X, Y and Z symbols allow you to lock
certain axes. This can be useful, for example,
when you have constructed an object that is at
floor level. If you now move it in one of the
perspective views, it automatically changes its Y
value and could, in the worst case, end up
below the floor.

By taking the precaution of locking the Y symbol
the object remains on the floor and moves only
in the other directions.

A left/right movement of the mouse while
holding down the mouse button moves the
object horizontally on the screen.
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An up/down movement moves it vertically.
Keeping the right mouse button depressed
(Macintosh users Command-click) while right/
left moving the mouse moves the object into
the screen and out of it.

When editing textures, mouse movements have
a somewhat different effect. A left/right
movement of the mouse moves the texture
along its X axis, an up/down movement moves
the texture along its Y axis.

Scale

.

With this function you can resize the active
object or element.

When in Scaling mode, BodyPaint 3D
distinguishes between the world coordinate
system and the local object coordinate system.

The difference between the systems becomes
particularly clear if you activate only the X axis.
Imagine you scale a cuboid, which lies inclined
in the world coordinate system. If you choose
the world coordinate system for scaling, the
cuboid becomes larger/smaller parallel to the X
axis of the world coordinate system and is
therefore distorted.
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If, on the other hand, you select the object
coordinate system of the cuboid when scaling,
the cuboid becomes larger/smaller along its own
X axis and does not distort.
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Scaling is performed by left/right movement of
the mouse. You can hold down either mouse
button.

When editing textures, mouse movements have
a somewhat different effect. A left/right
movement of the mouse resizes the texture
along its X axis, an up/down movement rescales
it along its Y axis.



The default size of any axis in the object system
is 1.0. If for example you resize the X axis from
1.0 to 2.0, the object doubles its size along the
X axis. This results in a distortion of the object
system, making precise construction more
difficult since all local positions are now also
distorted and no longer correspond to the
length units of the world system. We
recommend therefore that you do not use
scaling in combination with objects until the
construction phase is completed.

Rotation

This command will rotate the active object or
element.

When rotating objects, BodyPaint 3D
distinguishes between the world coordinate
system and the local object coordinate system
and you can choose to rotate in either system.
As long as the object lies parallel to the axes of
the world coordinate system you will not notice
a difference when you rotate in either system.
But when the object is askew, there can be large
differences between rotating in the world or
object systems - see above for more details and
consider carefully what you need.

A left/right movement of the mouse while
holding down the left mouse button will rotate
the object around its Y axis. An up/down
movement rotates it around its X axis, while
holding down the right mouse button causes
rotation around the object's Z axis (Macintosh
users use the mouse button with the Command
key pressed to simulate a right mouse button).
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The behavior of the rotation is totally different
if, in General Settings, you have switched on the
HPB system (see General Settings, page 40). A
left/right movement will now change the
heading, an up/down movement changes the
pitch and holding down the right mouse button
while moving left or right will change the bank
(Mac users, remember the Command key). The
HPB angles here refer to the object's parent
system i.e. if the object which is to be rotated
lies within a hierarchy, the parent object
functions as the world coordinate.

Navigation with the Mouse and Keyboard

Moving, Scaling and Rotating with the Mouse

You can use the mouse for moving, scaling and
rotating. A left/right movement manipulates the
X axis while a back-and-forth movement
controls the Y axis. For the Z axis you have to
use the right mouse button.

Macintosh users; as usual, use the Command
key to simulate the right mouse button.

You can toggle instantly between the left and
right mouse buttons. If you are currently
pressing the left button, press the right one
before releasing the left and vice versa.

Moving, Scaling and Rotating
with the cursor Keys

On the keyboard, use the directional (cursor)
keys for moving, scaling and rotating:

Cursor right + X axis
Cursor left - X axis
Cursor up + Y axis
Cursor down  -Y axis

Shift + cursor right or cursor up + Z axis

Shift + cursor left or cursor down - Z axis
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If you are working with the Edit Camera tool
selected (see page 364), it is the camera that is
affected. In all other cases the object currently
selected is moved, scaled or rotated.

Moving, Scaling and Rotating
with Quick Navigation

Using Quick navigation you can edit objects,
the editor or the active object camera
independently of the chosen tools. Use the
following keys:

Key 1 - Move the view/camera
Key 2 - Scale (zoom) the view/camera
Key 3 - Rotate the view/camera (only in the
central perspective view)
Key 4 - Move the active object
Key 5 - Scale the active object
Key 6 - Rotate the active object
Tip

If you want to zoom, in the central perspective
view, onto an object, you can use the move tool
instead of the scale tool. That has the advantage
that you can zoom without perspective
distortions.

Magnify
~

Use the Magnify command to zoom in on a
particular region of the work area. To define
that area, drag a rectangle around it.

Alternatively, click once using the left mouse
button. This will magnify the work area by 25%.
If you wish to reduce it, hold down the Ctrl key
while clicking.

Using the Keyboard

These are the keyboard short-cuts for the Zoom
function:

+ Zoom In (magnify)

- Zoom Out (reduce)

Camera
Ei'_

When you select this command you can edit the
camera in the Perspective View. All subsequent
actions affect this view. In two-dimensional
views (XY, ZY, XZ) you can move and magnify
the displayed area; in three-dimensional views
you can change the Editor camera or the Object
camera.

Using the mouse, you can move in the following
ways.

Move

The camera always moves in the opposite
direction to the mouse. For example, when you
move to the left, this will shift the camera to the
right, thus causing the objects to move left. This
is the most intuitive method and easy to learn.
Since mouse movement is restricted to two
dimensions, BodyPaint 3D needs to make use of
the right mouse button. This modifier allows
you to control not only left/right and up/down
movements, but also depth movements
(backwards and forwards). If you hold down the



right mouse button while moving left or right,
this will be interpreted as going back and forth.
It is possible to alternate between the left and
right mouse buttons at any time.

Macintosh users; use the Command key to
simulate the right mouse button.

Movements, scaling and rotation processes may
be cancelled at any time by pressing the ESC
key.

When moving objects you can choose which
axis system you wish to use. Normally, this will
have no effect, since the X, Y and Z symbols are
all selected. However, if you switch certain axes
on or off, you will observe that certain actions
will show different results. If for example you
have activated the X symbol only and you are
working with the world coordinate system, the
camera will move parallel to the X axis of the
world system. If on the other hand the object
system is selected, the camera will move left and
right within its own camera coordinate system.

No grid is applied for the camera or the visible
section of the document so that you can reach
any position, even if a motion grid is active.

Scale

Using scale the visible section of the scene can
be resized. You do this by moving the mouse
left/right while holding the left or the right
mouse button down (in this case it does not
matter which).

In the two-dimensional views the zoom factor,
(which initially is set to 1.0) is changed. In the
perspective views it is the camera's focal length
that changes. Its default value is 50mm. The
shorter the focal length, the greater the
distortion.
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If you wish to avoid distorting your scene, do
not change the focal length, instead move the
camera further away from the scene. Do this by
selecting Move and then right-dragging the
mouse to the left. (Try it out to see the
difference.)

Rotation

Rotation only makes sense if you are working
with a perspective view. Two-dimensional views
cannot be rotated.

When rotating the perspective view, certain
mouse movements affect particular rotational
axes. For example, if you hold down the left
mouse button and move left or right, this results
in a rotation around the Y axis of the camera'’s
coordinate system. An up/down movement with
the left mouse button held down rotates the
camera around the X axis of the camera’s
coordinate system.

If on the other hand you hold down the right
mouse button, the camera will rotate around its
Z axis. What is special about this function is that
the selected coordinate system (world or object)
has a somewhat different meaning from that
which you might expect: the rotation is always
around the camera’s axis and not around the
world’s axis.

Macintosh users: use the Command key to
simulate the right mouse button.

If an object is active, the camera also changes its
position while it rotates. This occurs in such a
way that the centre of the active object remains
in the same position on the screen. This feature
is extremely useful when you wish to move
around an object. If no active object exists, the
rotation is around the world origin.
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Object
e,

Selecting this allows you to edit an object. For
example, you can change the object's position
and direction.

The current position of the active object in space
is shown in the Coordinate manager. That is
where you can change any of the values
individually.

Changing objects is performed by manipulating
their coordinate axes. Scaling, for example, does
not scale the number of points of an object, it is
the object axes that are scaled. If you want to
know what this means or why this is the case,
read the section at the end of the Model tool,
below.

Points

By selecting this tool you can edit the points of
an object. All subsequent actions will affect the
points. In addition, the Delete function in the
Edit menu now refers to the points of the object
rather than to the object itself.

As soon as the tool is selected, all points of the
object are represented by small squares.
Selected points are highlighted in color.

It is possible to select individual points by
clicking on them. If several points are visually on
top of each other, only the topmost is selected.
The selection may be extended by Shift-clicking.
If you want to select several points use one of

the four selection options (see page 375-378).
To deselect points, select them again by Shift-
clicking.

All points can be selected with the menu option

Edit > Select All. With Edit > Deselect All the
complete selection can be deselected again.

To move a point, grab it with the mouse and
drag it to the new position.

To delete the active point, use the Delete
command from the Edit menu or use either the
Del key or the Backspace key.

You can also edit a point by double-clicking on
it. A window opens in which you can change
the position of the point.

Alternatively you can edit the points with the
Structure manager (see Mode menu, page 281).

Polygons
B

There are polygons with three vertices (triangle
polygons) and polygons with four vertices
(rectangle polygons).

Editing polygons hardly differs from editing
points. As soon as you activate the polygon
tool, the polygons of the chosen object are
displayed. Select a polygon by clicking on it with
the mouse; selected polygons are shown in a
brighter color.

You can select several polygons at once by
holding down the Shift key while selecting a
polygon. If you Shift-click on a polygon a
second time, it is deselected. All other (active)
polygons remain unchanged. Another way of



selecting several polygons at once is to use one
of the four selection options (see page 375-
378).

To delete active polygons, use either the Delete
command from the Edit menu, or the Del key or
the Backspace key.

Object Axis
L,

The Object axis tool modifies the axes of the
active object.

The current position of the axes of the active
object is shown in the Coordinate manager,
where you can change all values individually.

Scaling object axes is a rather special case. Here,
it is not only the axes that are resized, but also
the points and the textures of the active object.
In contrast, Model scaling changes points and
textures, but does not resize the axes.

Model
LA

Selecting this allows you to edit an object. For
example, you can change the object's position
and direction.

The current position of the active object in space
is shown in the Coordinate manager. That is
where you can change any of the values
dynamically.
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While the Model tool is selected, changing
objects is achieved by scaling the object points
rather than the object axes. If you want to know
what this means or why it has to be this way,
read on.

Tip
Note that if you scale an object to zero in any
direction by using the Model tool, this operation
cannot be undone.

If the active object contains sub-objects, these
are also changed. If you wish to restrict the
change to the active object, modify the action
by holding down the Ctrl key.

Use the Model tool during the modeling
process.

The difference between the
Object and the Model tool

We strongly recommend that you read this
section, otherwise you may be in for some
unpleasant surprises when you create
animations.

Let's start by clarifying the problem with the
help of an example, then we'll tell how you
avoid the problem altogether and how you can
correct it if it does crop up.

Consider a scene with two objects, a (polygon)
sphere and a cube. The cube is a child (sub-
object) of the sphere. The axial length of both
objects is 1/1/1.
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Now we choose the Object tool (Tools >
Object) and scale the sphere with the
Coordinate manager only in X direction to, say,
2/1/1 (ensure that Size, rather than Scale, is
selected in the popup at the bottom of the
Coordinate manager). As to be expected, sphere
and cube are distorted.

Now rotate the cube around its Z axis (lock the
X and Y axes and rotate the cube). During the
rotation you will see an up and down pump-like
distortion.

The points of the cube no longer obey a circular
trajectory while they are rotated in the XY plane.
Instead, the distorted parent system causes this
movement to be elliptical.

And that is where the problem lies. It invariably
occurs when objects exist in a distorted parent
system.

Effects of this type are encountered by each and
every 3D application, since it is a fundamental
problem. Many resolve it by implementing
separate editors for modeling and animation. In
this way, you do not see the problem but,
instead, you have to keep changing editors.

So how can we prevent the problem? Use the
Model tool for scaling the sphere. You will then
get the required result when rotating the cube:

Tip
If all this is a bit much to grasp, simply
remember these rules:

Use the Model tool when constructing objects
(modeling).

Use the Object tool when animating (integrated
version only).



Texture
=

This allows you to edit the active texture. As
soon as you choose this tool the texture of the
object is represented by blue grid lines.

Or, if you have activated Real Time Texture
Mapping, or RTTM, (Display > Textures on the
editor Window menu), you will see the texture
displayed on the object. The chosen projection
type is taken into account (see Projection
Mapping Types, page 258).

If the texture is displayed with grid lines, their
axes are labelled in color (X and Y). Since the
texture is in two dimensions only (the image has
no depth information), there is no Z axis.

The grid lines are drawn according to the kind of
chosen projection, e.g. spherical mapping is
shown with a spherical blue grid.

An exception is UVW mapping. Here the blue
grid is displayed over the entire editor window.
The axes are not shown in RTTM mode.

The texture axes of the object are shown with
an envelope on whose surface the texture can
be moved by using the familiar Move and Scale
functions. The texture itself cannot be rotated
(but see Texture Axis below).

A left/right movement of the mouse will move
the texture along its X axis, an up/down
movement will move it along its Y axis.

The Scale function uses the same principle, only
here the texture does not get moved but
resized.

The data for X and Y referring to positioning
and dimensions of the texture in the Coordinate
manager are always given as percentages, since
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the actual size is not relevant. A size of 100%
for both coordinates means that the texture
covers the cylinder, the sphere or the area
completely.

Texture Axis
[

This tool allows you to edit the texture axes of
the active texture. As soon as you select this
tool, the texture with its envelope is displayed.
In RTTM mode you will see the texture itself.
You can move, scale and rotate the envelope in
the usual fashion.

The difference between Edit Texture and Edit
Texture Axes is illustrated by the following two
pictures. In both cases, the movement is along
the X axis; in the upper picture using the Edit
Texture tool (the texture is moved on its
envelope) while in the lower picture by using
Edit Texture Axes (the envelope itself is moved).
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3D Painting Mode

This mode enables you to paint the object’s
active texture in the Perspective View using any
of BodyPaint 3D’s paint tools.

You can paint in the default High Quality
Shading mode (see page 183) or in the
RayBrush mode (see page 182).

Keep in mind that you always paint to the active
material in the Material manager only.

The Axes

'Ll X Axis / Heading
LW v Axis / Pitch
“ & 7 Axis / Bank

These three tools allow you to lock movement,
scaling or rotation along certain axes.

With a rotation you have the option of locking
each axis separately. If, in General Settings (see
page 40), you have selected Use HPB System,
the HPB designators apply. (The letters HPB
stand for Heading, Pitch and Bank.)

For each type of operation, BodyPaint 3D
remembers the state of the axes (locked or
unlocked). If for example you have made a
movement along the Y axis while X and Z were
locked, and subsequently change to Rotate, all
axes are unlocked again. When you change
back to Move, the program remembers that
only the Y axis was unlocked.

World System
o9

Here you decide in which coordinate system an
operation will take place.

Not all options work with both systems. Scaling
of object axes for example can occur only within
the object coordinate system.

The object coordinate system is the local system
of an object, shown in the editor by the
coloured axes; X (red), Y (green) and Z (blue).
Every BodyPaint 3D object has its own object
coordinate system.

If you chose the HPB system in the settings (see
page 40), HPB angles will be used for the
rotation - independently of the chosen axis
system.

Internally BodyPaint 3D works exclusively in the
HPB system. HPB is an abbreviation for
Heading, Pitch and Bank.

You may have come across the terms heading,
pitch and bank in connection with flight
simulators. An aeroplane turning left or right
changes its heading; when it tilts upwards or
downwards it changes pitch; when rolling it
changes its bank.

Hewding

So when you are changing angles you may find
it helpful to think of a plane.
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20 Selection Menu

With the tools from this menu you can select
and deselect points and polygons in many
different ways; in addition you can hide or
reveal selected points/polygons.

Fundamentals

BodyPaint 3D works with polygons (surfaces)
and points. There are two types of polygons in
BodyPaint 3D: triangles and quadrangles.

Polygons

A polygon is a triangle or a quadrangle. A
triangle has the points A, B and C; a quadrangle
has the points A, B, C and D.

So-called perfect polygons, like the one shown
below, are not that common, since the points
may lie anywhere in 3D space...

D C

A B

A ‘perfect’ polygon
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This is not a problem if the points are planar -
i.e. if they all lie on the same plane...

D C

A
B

The quadrangle is no longer a rectangle. However, all the
points are on the same plane - the quadrangle is still planar.
If the quadrangle's points are not on the same
plane, the quadrangle is said to be non-planar.
In the diagram below, point B has been moved
into the depth plane. Now, BodyPaint 3D must
render this polygon as two triangles. This is
dealt with internally without any negative
effects.

D C

A B

Point B has been moved into the depth plane. Now, the
polygon is non-planar.



374 » SELECTION MENU ¢ CHAPTER 20

If the angle at points B or D is greater than

180°, problems can occur when rendering - this

is because the polygon overlaps itself...

D C
B

A

The angle at point B is greater than 180° - the polygon
overlaps itself.

Another problem arises if all of the polygon's
points are on the same line. In this case, a
surface normal cannot exist and the polygon is
called a degenerated polygon...

C

D
B

A

All the points for this polygon are on a line.

Selection Menu

You can use the tools in this menu to select the
active object's points or polygons. The following
applies:

To select an element click the (left) mouse
button.

To remove an item from your selection, hold
the Shift key down while left-clicking on the
already selected item.

To add to your selection, hold the Shift key
down while left-clicking on a new, unselected
item.

To select points/polygons with the rectangle,
freehand, polygon and live selection tool

b

Select with the (left) mouse button down and
dragging.
To add to your selection, hold the Shift key

down while applying the relevant tool to your
new, unselected items.

To reduce the items in your selection, hold
down the Ctrl key while applying the relevant
tool to the already selected items.

The editor display

In the polygon mode selected surfaces are
framed in red and shown more brightly than
unselected surfaces.

In the point mode selected points are shown in
light red while unselected ones are colored
dark red.



Rectangle Selection

If you choose this selection tool you can frame
polygons and points with a rectangle-shaped
marquee. Hold the left mouse button down and
drag; all items that are fully enclosed within the
resulting rectangle will be included in your
selection.

Active Tool Manager

Tolerant Selection

This option makes sense only in polygon mode.
Enabling this option means that polygons are
selected as soon as a corner point of the
polygon is within the selection marquee. If this
option is not active, a polygon is included only if
all corner points of the polygon are within the
marquee.

Only Select Visible Elements

If this option is active only items which are not
hidden by other items are selected. For example,
with a sphere you could select only points or
polygons at the front of the sphere.
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It does not matter whether the back of the
sphere is visible in the screen mode or not. As
soon as a polygon and/or point lies over
another, the latter element is invisible as far as
the selection tool is concerned.

With backface culling on (see page 22) the
backs of objects are always invisible and cannot
be selected even if you turn off the Only Select
Visible Elements option.

Of course, elements are also invisible if they
have been made invisible with Selection > Hide
Selected or Selection > Hide Unselected
commands. Then again they cannot be selected
even if you turn off the Only Select Visible
Elements option.

The same applies to objects which have a red
visibility switch (see page 198). Naturally, the
polygons and points of such objects cannot be
selected.
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Freehand Selection

Freehand selection behaves like a lasso. Using
the mouse with the left button pressed you pull
a loop around all the elements that you want to
select. The loop does not have to be closed.

Active Tool Manager

Tolerant Selection

This option makes sense only in polygon mode.
Enabling this option means that polygons are
selected as soon as a corner point of the
polygon is within the selection marquee. If this
option is not active, a polygon is included only if
all corner points of the polygon are within the
marquee.

Only Select Visible Elements

If this option is active only items which are not
hidden by other items are selected. For example,
with a sphere you could select only points or
polygons at the front of the sphere.

It does not matter whether the back of the
sphere is visible in the screen mode or not. As
soon as a polygon and/or point lies over
another, the latter element is invisible as far as
the selection tool is concerned.

With backface culling on (see page 22) the
backs of objects are always invisible and cannot
be selected even if you turn off the Only Select
Visible Elements option.

Of course, elements are also invisible if they
have been made invisible with Selection > Hide
Selected or Selection > Hide Unselected
commands. Then again they cannot be selected
even if you turn off the Only Select Visible
Elements option.

The same applies to objects which have a red
visibility switch (see page 198). Naturally, the
polygons and points of such objects cannot be
selected.



Polygon Selection

With this selection tool you set the corner points
for an n-Side that frames the elements which
are to be included. The first mouse-click defines
the starting point of the n-Side. All further
mouse clicks define further corner points.

The selection ends either with a right-click of
the mouse (Macintosh: Command-click) or by
clicking again on the starting point of the n-
Side.

Active Tool Manager

Tolerant Selection

This option makes sense only in polygon mode.
Enabling this option means that polygons are
selected as soon as a corner point of the
polygon is within the selection marquee. If this
option is not active, a polygon is included only if
all corner points of the polygon are within the
marquee.

Only Select Visible Elements

If this option is active only items which are not
hidden by other items are selected. For example,
with a sphere you could select only points or
polygons at the front of the sphere.
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It does not matter whether the back of the
sphere is visible in the screen mode or not. As
soon as a polygon and/or point lies over
another, the latter element is invisible as far as
the selection tool is concerned.

With backface culling on (see page 22) the
backs of objects are always invisible and cannot
be selected even if you turn off the Only Select
Visible Elements option.

Of course, elements are also invisible if they
have been made invisible with Selection > Hide
Selected or Selection > Hide Unselected
commands. Then again they cannot be selected
even if you turn off the Only Select Visible
Elements option.

The same applies to objects which have a red
visibility switch (see page 198). Naturally, the
polygons and points of such objects cannot be
selected.
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Live Selection

This selection tool behaves somewhat differently
from the others. Live selection functions like a
paint brush with which you can paint over your
objects. The painted elements are included in
the selection set.

You can choose a radius for this tool from the
Active Tool manager. During the live selection
you can increase this radius with the ‘+' key and
make it smaller with the ‘-’ key. With a trackball
the radius can be changed with the wheel.

Active Tool Manager

Radius

This determines the radius of the "selection
brush".

Only Select Visible Elements

If this option is active only items which are not
hidden by other items are selected. For example,
with a sphere you could select only points or
polygons at the front of the sphere.

It does not matter whether the back of the
sphere is visible in the screen mode or not. As
soon as a polygon and/or point lies over
another, the latter element is invisible as far as
the selection tool is concerned.

With backface culling on (see page 22) the
backs of objects are always invisible and cannot
be selected even if you turn off the Only Select
Visible Elements option.

Of course, elements are also invisible if they
have been made invisible with Selection > Hide
Selected or Selection > Hide Unselected
commands. Then again they cannot be selected
even if you turn off the Only Select Visible
Elements option.

The same applies to objects which have a red
visibility switch (see page 198). Naturally, the
polygons and points of such objects cannot be
selected.

Note

By its very nature the live selection tool has a
high memory requirement when you turn off
Only Select Visible Elements. Therefore you
should switch off this option only if it is
absolutely necessary.

Vertex Painting pane

The options in this pane apply to the integrated
version with CINEMA 4D only - please consult
the CINEMA 4D Reference manual for details.



Select All

With this command you can select all points or
all polygons of an object. If you are in polygon
mode only the polygons are selected; in point
mode only the points are selected. Hidden
elements are not selected.

Deselect All

With this command you can deselect all points
or all polygons of an object. If you are in
polygon mode, only the polygons are
deselected; in point mode only the points are
deselected.

Invert

This command inverts a selection. All selected
elements are deselected and all deselected
elements are selected. If you are in polygon
mode, only the polygon selection is inverted; in
point mode only the point selection is inverted.
Hidden elements are not inverted.
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Select Connected

Polygon objects often consist of several
segments that are not connected by polygons. If
you wanted to select one of these individual
segments completely you might encounter
problems if this segment overlapped with other
segments; it can be difficult to see which
elements belong to this segment.

So BodyPaint 3D comes to the rescue; select just
one point or polygon of the required segment
and then choose the Select Connected
command. All points or polygons which are
connected to the selected element are then also
selected. If you are in polygon mode, only
connected polygons are selected; in point mode
only connected points are selected.

First some polygons, then Select Connected...

All connected polygons are now also selected
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Grow Selection

With this command you can add to a selection.
All adjacent points or polygons (depending on
which mode you are in) are added to the current
selection.

The initial selection

Adjacent polygons are now also selected

Shrink Selection

This command reduces the selection. All
polygons or points (depending on which mode
you are in) on the outside of the current
selection are deselected.

If the polygon is closed (such as a sphere is) and
you select all polygons, the selection cannot be
made smaller because there is nowhere to start
(there are no elements that can be considered to
be on the outside).

The initial selection

The outside polygons deselected



Polygon Selection From Points

This selects the polygons which border on the
points that are already selected. Polygon mode
will then be entered automatically. Only
polygons that have all their corner points
selected are included.

Point Selection From Polygons

This selects the points which belong to the
polygons that are already selected. Point mode
will then be entered automatically.

Select Adjacent Polygons

This command affects only polygons and only
makes sense when you are in point mode. It
selects polygons which directly border the
existing chosen set of points.

You will be switched to polygon mode when
you use this command.

The initial selection

The polygons bordering on the selected points are selected
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Hide Selected

This makes all selected points or polygons
invisible. If you hide selected polygons, the
associated points are also hidden. However, in
point mode, only the selected points are hidden,
not the polygons attached to them.

Hiding of elements is useful if you want to
concentrate on a particular area of an object
while painting; hide the areas that you are not
interested in.

Hide Unselected

This command hides all elements which are not
selected. If you hide deselected polygons, the
associated points are also hidden. However, in
point mode, only the deselected points are
hidden, not the polygons attached to them.

Unhide All

This command makes all hidden elements visible
again. In polygon mode only hidden polygons
are made visible, in point mode only the hidden
points.

Invert Visibility

The visibility of all elements is inverted. Visible
elements are hidden and hidden elements are
made visible. In polygon mode only the visibility
of all polygons is inverted whereas in point
mode only the visibility of all points is changed.
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Set Selection

Here you can freeze selections for the long term.
You can freeze either polygon or point
selections. You can then manipulate frozen
selections at any time using these icons in the
Object manager:

A

Frozen point selection Frozen polygon selection

More information can be found below under
Frozen Selections in the Object manager, below.

Warning

If a Polygon Selection tag is active in the Object
manager (shown by a red frame) when you call
this command, the tag is replaced with the new
selection. If you do not want to lose your old
selection tag in this way, make sure it is not
activel

Information on how to apply separate material
properties to these frozen selections is in Restrict
To Selection, page 269.

Frozen Selections in the
Object Manager

If you froze one or more selections (see the
preceding section), some useful functions are
now available to you in the Object manager.
These are hidden behind particular small icons
which are associated with the active object:

A

Frozen point selection Frozen polygon selection

Frozen Point Selection

A double-click on this icon opens a dialog which
contains the following choices:

E
FE

| =)

All actions are performed as soon as you click on
the relevant button.

Name

Enter a name for the selection; press OK to
confirm or Cancel to lose the name change.

Restore Selection

This restores the frozen selection. All other
elements of the object are deselected.



Select and Hide Others

Restores the frozen selection and makes all
other points of the object invisible.

Select Points

The points of the frozen selection are added to
the existing selection.

Deselect Points

All points of this frozen selection are deselected.

Hide Points
All points of this frozen selection become invisible.

Unhide Points

All hidden points of this frozen selection become
visible.

Frozen Polygon Selection

Double-click on this icon to open a dialog which
contains the following choices:

All actions are performed as soon as you click on
the relevant button.
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Name

Use this text box to enter a name for the
selection; press OK to confirm or Cancel to lose
the name change.

Restore Selection

This restores the frozen selection. All other
elements of the object are deselected.

Select and Hide Others

Restores the frozen selection and makes all
other polygons of the object invisible.

Select Polygons

The polygons of the frozen selection are added
to the existing selection.

Deselect Polygons
All polygons of this frozen selection are deselected.

Hide Polygons

All polygons of this frozen selection become
invisible.

Unhide Polygons

All hidden polygons of this frozen selection
become visible.
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21 Structure Menu
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21 Structure Menu

Functions selected from the Structure menu take
effect on the selected object - any sub-objects
remain unchanged.

With most functions the object is modified if a
function can be applied to the current selection.
However, some of these menu functions will not
be available if you are not in Point or Polygon
mode or if no elements are selected.

Hidden elements are therefore not modified (see
Frozen Selections In The Object Manager,
page 382).

Edit Surface

Disconnect

Surfaces, either individual or connected surfaces,
can be split from an object. Select some
polygons of an object and choose Disconnect to
see the results. The separated polygons will still
be at the same position, but physically they are
no longer connected to the object. The original
object still contains the points of these separated
polygons, so the geometry is not destroyed.

The polygons mode must be active and a

polygon selection must exist in order for you to
use this tool.

A good example of using Disconnect would be
to cut a hole into an object and keep the
disconnected surface to use as a cap.

Note

At the seams of the disconnected polygons, the
Phong shading disappears and a ridge appears,
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since now there are two edges. (See also
Smoothing Tag, page 189.)

|+ Frararsa B

L

Preserve Groups

This option is selected by default. With this
option the polygons are disconnected in one
piece from the object (as long as they were
connected to begin with). If this option is
switched off then each active polygon is
separated individually and independently from
all other active polygons.

Explode Segments

This applies to the integrated version of
BodyPaint 3D with CINEMA 4D only. Please
consult the CINEMA 4D Reference manual for
details.

Split

The Split function differs very slightly from the
Disconnect function; the difference is that, when
using Split, the disconnected polygons leave a
separate object behind. The original object is not
changed.

The polygons mode must be active and a
polygon selection must exist in order for you to
use this tool.

Note

If you wish to delete the separated part from the
original object, you can choose Delete directly
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after the split as the selection is still active (this
works only if you are in polygons mode).

Make Editable

This is relevant only if you are running
BodyPaint 3D with CINEMA 4D. Please consult
the CINEMA 4D reference manual for details.

Align Normals

When an object is created in a 3D modeling
program, by convention the surface normals
should point outwards from the object.
However, it is quite possible that some of the
normals point in the wrong direction (i.e.
inwards). This can lead to rendering anomalies
later on. Fortunately, the problem is easily
rectified by choosing the Align Normals
function, which re-aligns the offending surface
normals so that they point in the correct
direction.

BodyPaint 3D adjusts the orientation of the
normals according to the normal direction of the
first polygon in a polygon selection.

If no polygons are selected, all normals are
aligned.

Note

BodyPaint 3D does not recognize an object’s
inner and outer surface. A sphere has an inner
and an outer side, but only one surface level,
which can be confusing. We need a better
definition.

Let us define this single surface level to have an
Inner and an Outer property. Outer designates,
in principle, the direction in which the surface

normals point and Inner is therefore the
opposite direction. This plays a role with texture
projection, where you have the possibility to
project textures from only the front or the back
(see Texture Mapping, page 255).

So, if there is an equal number of normals
pointing one way as point the other way how
do we decide which is the Outer surface? We
could either choose randomly or, perhaps, look
at the first polygon in the sequence and use its
normal as the basis of our calculation -
BodyPaint 3D does the latter.

Why exactly are these normals needed?

As described above, the direction of the normals
defines the interior and the exterior of an object.
This is important, among other things, for
displaying an object in the Perspective View.

Occasionally, a situation can arise in which some
polygons become invisible in the Perspective
View. This can happen if Backface Culling is on
and the reason is as follows.

To save on processor performance you may
have, sensibly, enabled Backface Culling (see
page 22) for your scene; this is where only the
polygons visible from the front of an object are
displayed in the Perspective View. The polygons
positioned directly at the back of an object are
not drawn.

When displaying a sphere and other volume
objects in the Gouraud shading mode you may
notice no difference, simply because you do not
see the back of the sphere anyway. But should
you select all the polygons of this sphere and
reverse the normals (see next section), you will
now see only the back of the sphere; the front is
now transparent since you now have inverted
the sphere. The inside is now the outside - and
this becomes invisible because of the Backface
Culling.



Should you find yourself inadvertently in a
situation like this you should switch off Backface
Culling and reverse the normals of these
polygons.

Another important factor is smoothing with
angle limit active (see Smoothing, page 189).
BodyPaint 3D calculates whether edges are to
be smoothed based on the angle of the
polygons to each other. If two polygons with
differently aligned normals lie next to each
other, BodyPaint 3D calculates incorrect angle
information, causing ghastly results when
smoothing.

The angle of the normals to each other is also
significant when using Displacement Mapping
(see page 237).

Reverse Normals

This function is similar to Align Normals. Here,
however, the normals are reversed. If no
polygons are selected, all the normals of a
selected object are reversed. With an active
selection only the normals of the selected
polygons are considered.

Note

Reversing the normals is achieved by changing
the point sequence in a polygon.
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22 Functions Menu

Connect

AR

BodyPaint 3D’s Group Objects command (see
page 199) enables you to place objects into a
group. The Connect command converts an
object group into a single object.

For example, a fence consisting of hundreds of
individual planks can be connected to form just
a single fence object.

Connect requires an object group to be selected
in the Object manager. Only use the command
if you are certain that the object will not require
separation later on; although you can split the
object into its original parts manually, it is a
time-consuming process.

Note

Only polygon objects can be connected. Other
objects such as light sources will be ignored.

Tip
You can speed up render time by connecting any
groups that contain lots of objects. The reason
for this is that a single object can be rendered
more quickly than a few hundred objects, even
though they contain the same number of

polygons.
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23 Plug-ins Menu

In general terms, plug-ins are auxiliary modules
which extend the function range of a program.
Within BodyPaint 3D, plug-ins are able, for
example, to automate particular functions or to
add new import and export filters.

For this purpose BodyPaint 3D includes an
efficient programming language, C.O.F.FE.E.,
available to both developers and end-users.

This is a completely object-oriented
programming language whose syntax is closely
related to C++ or Java. Further information on
the development of plug-ins can be found in the
C.O.F.EE.E. SDK (Software Development Kit) on
our website (www.maxon.net); there you will
also find links to different plug-in vendors.

Note

Plug-ins can be developed freely by anyone and
offered for sale. However, MAXON Computer, as
the manufacturer of BodyPaint 3D, has no
influence on the quality of these plug-ins and
you should assure yourself as to the value-for-
money and usefulness of a plug-in before
purchase. Of course, we give as much support as
possible to all vendors and developers of plug-
ins - however, if a problem should arise with one
of these products, please contact the
manufacturer of the plug-in directly. Please
understand that MAXON Computer can give no
information on, or provide technical support for,
third-party products.

As already mentioned, plug-ins can solve diverse
tasks. Consequently, after installation, your new
plug-in may appear in one of several places
within BodyPaint 3D's menu structure. To this
end, please consult the vendor's plug-in
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documentation. If no such information is
supplied in the documentation, perhaps the
plug-in is listed in the Plug-ins menu.

Execute Last Plug-in

This menu item on the Plug-ins menu executes
the last plug-in that was used.

Compile File ...

Use this command (on the Plug-ins menu) to
compile a C.O.FEE.E. program. A file requester
opens for you to locate the file that you wish to
compile.

Sub-folders

You can create sub-folders within the Plug-in
menu structure to help you organize your plug-
ins. To do this, use the Macintosh Finder or
Windows Explorer to create a sub-folder of any
name within the Plugins folder. Next, copy the
associated plug-ins into the sub-folder, taking
into account the naming conventions used by
your operating system. The new structure will
appear in the Plug-ins menu the next time you
restart BodyPaint 3D.
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24 Render Menu
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24 Render Menu

The Render menu contains all the options you
need to render a picture. You can define several
render presets, e.g. for preview and for final
rendering. In this way, you do not have to
change the settings constantly.

Note

BodyPaint 3D's RayBrush technology enables
you to paint onto a rendered picture in three
dimensions - see page 182.

Render View

k3

This function renders the scene in the active
editor window. If you are working in the all
views mode, you can render each view one by
one. To define the render mode and further
render options, use the render settings (see
below).

You may cancel rendering at any time by
pressing the ESC key or by clicking the mouse.
Once rendering commences, a render progress
bar appears at the lower left of the editor
window.

Missing textures

If BodyPaint 3D is unable to find the textures for
any of the materials used in a scene, an alert will
appear. If you choose to continue rendering, the
materials will be used without the missing
texture maps. BodyPaint 3D searches for
textures and animation files in the following
locations: in the scene folder, in the scene's ‘Tex'
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folder, in the ‘Tex' folder of the BodyPaint 3D
folder, in the Texture Paths specified in the
General Settings (including their sub-folders).

Render Active Object
&

This function renders the active object and its
child objects in the active editor window. The
other objects are ignored and will not appear in
reflections or transparencies. To define the
render mode and further render options, use the
render settings (see below).

You may cancel rendering at any time by
pressing the ESC key or by clicking the mouse.

Once rendering commences, a render progress
bar appears at the lower left of the editor
window.

Missing textures

If BodyPaint 3D is unable to find the textures for
any of the materials used in a scene, an alert will
appear. If you choose to continue rendering, the
materials will be used without the missing
texture maps. BodyPaint 3D searches for
textures and animation files in the following
locations: in the scene folder, in the scene's ‘Tex'
folder, in the ‘Tex' folder of the BodyPaint 3D
folder, in the Texture Paths specified in the
General Settings (including their sub-folders).
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Render Region

&F

This function renders a region in the editor
window. Once you have chosen the function,
drag a box to define the region. To define the
render mode and further render options, use the
render settings (see below).

You may cancel rendering at any time by
pressing the ESC key or by clicking the mouse.
Once rendering commences, a render progress
bar appears at the lower left of the editor
window.

Missing textures

If BodyPaint 3D is unable to find the textures for
any of the materials used in a scene, an alert will
appear. If you choose to continue rendering, the
materials will be used without the missing
texture maps. BodyPaint 3D searches for
textures and animation files in the following
locations: in the scene folder, in the scene’s ‘Tex'
folder, in the ‘Tex' folder of the BodyPaint 3D
folder, in the Texture Paths specified in the
General Settings (including their sub-folders).

Render to Picture Viewer

This function renders the scene in the Picture
Viewer. Once rendering commences, a render
progress bar appears at the lower left of the
editor window. The bar shows you the time that
has elapsed since the render started.

The Picture Viewer includes some display
options. For example, you can turn off color
channels and change the viewing size. (See
page 273.)

To define the render mode and further render
options, use the render settings. You may cancel
rendering at any time by pressing the ESC key or
by clicking the mouse.

You must use the Picture Viewer as opposed to
the editor if you wish to save the picture. Enter
a filename in the render settings before you
render. See page 412.

Missing textures

If BodyPaint 3D is unable to find the textures for
any of the materials used in a scene, an alert will
appear. If you choose to continue rendering, the
materials will be used without the missing
texture maps. BodyPaint 3D searches for
textures and animation files in the following
locations: in the scene folder, in the scene's ‘Tex'
folder, in the ‘Tex' folder of the BodyPaint 3D
folder, in the Texture Paths specified in the
General Settings (including their sub-folders).

Render Settings

A project can have several render settings. This
function opens the active settings (indicated by
a tick on the Render menu).

The default render settings are called ‘New'. If
you wish to add further default settings, create
the settings and then save the otherwise empty
scene in BodyPaint 3D's root folder under the
name ‘Template.c4d' (see Initialisation File,
page 66). For a full description of all the render
settings, see page 402.



New Render Settings

You can use this function to create new render
settings. The render settings dialog opens.

Enter a name for the new settings under Name
on the General page - choose a meaningful
name (e.g. ‘Preview’) so that the new settings
will be easy to distinguish from any other
settings.

Once you have finished creating the settings,
the new name will appear in the lower section
of the Render menu.

Fesrwies
Fesruer it [okF

Prsruder Fsgeie
Frandar ko Pickors Visan A0F
Bakoh Reradesieg

Frarchar Switing CwksE
e Ruked esiimge

Ligiatn Fiamcar S sl

Fiidl Revadsing
Figh St
v Fitoma

You can create settings for a variety of purposes.
Perhaps you will create settings with low
antialiasing, no reflections and no shadows for
preview rendering called 'Preview’. You may
also create settings with high antialiasing,
reflections and shadows called ‘Final Rendering'.
You can create as many settings as you like.

To choose which settings are active, click on the
corresponding name in the Render menu. The
active tick will then appear in front of that
name.
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Delete Render Settings

This function deletes the active render settings
(indicated by a tick on the Render menu). The
name of the settings will be removed from the
Render menu.
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Render Settings Dialog

General Tab
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This enables you to change the name of the
settings (the default name is ‘New'). Choose a
meaningful name (e.g. 'Preview’) so that the
new settings will be easy to distinguish from any
other settings.

Render Mode

This setting defines the mode used to render the
picture.

As Editor

If you select this mode, the renderer will use the
editor window's active shading mode, e.g.
wireframe, Gouraud shading.

Cel-Render B/W

Cel-Render B/W renders all objects as black
outlines on a white background. You can refine
this mode using the Cel-Renderer options on the
Options tab - see page 416.

The render time for the Cel-Render B/W mode
increases linearly with the number of polygons,
even though the mode is heavily optimized.

Cel-Render Color

Cel-Render Color renders all objects using a
reduced color palette and black outlines on a
black background. This gives the rendered
subjects a cartoon-like feel. You can refine this
mode using the Cel-Renderer options on the
Options tab - see page 416.

The render time for the Cel-Render Color mode
increases linearly with the number of polygons,
even though the mode is heavily optimized.



Raytracer

This is a combination of two modes - scanline
mode and raytracing mode. Raytracing mode is
used only for those parts of the picture that
cannot use scanline mode (e.g. transparent
surfaces, hard shadows). Otherwise, scanline
mode is used since it is faster. This automatic
switching between modes (termed adaptive
raytracing) accelerates rendering with zero loss
in picture quality.

If you use the following settings, the scanline
mode will be used:

Transparency No Refraction
Reflection  Floor & Sky Only
Shadow Soft Only

If you choose the following settings, scanline
mode will be used as much as possible but
raytracing mode will be used where required
(e.g. transparent surfaces, hard shadows):

Transparency With Refraction
Reflection  All Objects
Shadow All Types

The two sample pictures below show the same
scene.
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The left-hand picture was rendered using the
scanline mode only - there are no shadows, only
the sky is reflected and, although the bottle and
glass are transparent, there is no refraction.
Raytracing mode was chosen for the right-hand
picture. Now hard shadows are visible, the
bottle is reflected in the mirror and the bottle
and glass both refract light. Even so, all parts of
the right-hand picture that do not use these
effects used the faster scanline mode.

As you can see from the pictures, the effects
offered by raytracing can make all the difference
in rendering a realistic picture.

Note

You can speed up rendering by using a multi-
processor system. BodyPaint 3D detects the
extra processors automatically and distributes
the render task accordingly. For example, if you
are using four processors, the render speed can
increase by up to a factor of 3.6.

Antialiasing

Images consist of pixels and are prone to
staircase effects. This phenomenon is called
aliasing. BodyPaint 3D equips you with
powerful antialiasing modes to defeat these
ugly pixels.

You can set the strength of your chosen
antialiasing mode using the Oversampling
setting — see page 407.
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Antialiasing > None Antialiasing > Edge And Color
If you select None, antialiasing is switched off. If you select Edge And Color, shadows and
Expect a grainy image... textures as well as object edges will be

antialiased...

Antialiasing > Edge ialiasi /
If you select Edge, object edges will be Antialiasing > Always

antialiased. Shadows and textures will not be If the Always option is selected, each pixel in the
antialiased, though... image will be antialiased - even those pixels that

do not require antialiasing...

The Always option should be considered an
extreme measure - it causes a large increase in
render time yet the image improvements are
often negligible. Edge And Color with a high
oversampling value gives high-quality rendering
and is usually the better choice.



Oversampling

This value refers to the maximum number of
additional rays that are calculated for a pixel
requiring antialiasing.

The higher you set this value, the more accurate
the antialiasing will be. However, increasing the
oversampling value will increase the render time
as well.

The render time is influenced greatly by the
antialiasing and oversampling values. For
example, Always antialiasing with 3 x 3
oversampling takes about four times longer to
render than Edge And Color with the same
oversampling, yet the difference in image
quality is usually minor.

You should reserve Always for the very highest
image quality.

Edge And Color provides almost identical results
to Always and is rendered in a fraction of the
time. It is often more effective to choose a
higher oversampling value for Edge And Color
rather than move up to Always. A good time vs.
quality compromise for quality images is Edge
And Color with 4 x 4 or 6 x 6 oversampling.
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Transparency

Transparency > None

If you activate this option, transparency and
alpha channels will not be rendered...

Transparency > No Refraction

No Refraction means that all transparent
materials will be rendered but without
refraction. If you are working with alpha
channels, make sure you use No Refraction,
otherwise the surfaces will be rendered
opaque...
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Transparency > With Refraction

Select this option if you wish transparent
materials to refract as well. Refraction is often
essential for realistic glass and water. Any
refraction in the render will increase the render
time. If there is no refraction in the render, the
render time will not increase, even though this
option is selected...

Reflection

Reflection > None

If None is selected, reflections will not be
rendered.

Reflection > Floor & Sky Only

If Floor & Sky Only is selected, only the floor
and sky objects in the scene will be reflected.
This option is rendered very quickly and is a

good compromise for time-critical projects...




Reflection > All Objects

If you select All Objects, all the objects in the
scene can be reflected. If there are no reflective
objects in the scene, the render time will not
increase, even though this option is selected...
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Shadow

Shadow > None

If None is selected, shadows will not be
rendered. The scene may lack contrast and
appear flat as a result...

Shadow > Soft Only

If you have selected Soft Only, soft shadows will
be rendered. Soft shadows render extremely
quickly and look natural (often more natural
than hard shadows, which take longer to
render)...
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Note that BodyPaint 3D is one of the few
programs that enable you to cast soft shadows
from omni lights. See Omni, page 318.

Shadow > All Types

If All Types is activated, soft shadows, hard
shadows and area shadows will be rendered.
Additional rays must be calculated for hard
shadows and area shadows...

Output Tab
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The settings on the Output tab refer to
rendering in the Picture Viewer only. These
settings have no effect on rendering in the
Perspective View. As a result, you must render
to the Picture Viewer if you wish to save the
rendered picture.

Resolution

You can use this setting to define the size of the
image. You choose the resolution from the
popup menu or enter your own values in the
two text boxes to the right.

If you do the latter, the resolution popup menu
setting will change to Manual automatically.
(You do not have to select Manual yourself.)
The popup menu lists common formats.

Film Format

The film format corresponds to an image's X:Y
ratio.

You can choose the film format from the popup
menu or enter your own values in the two text
boxes to the right.



If you do the latter, the resolution popup menu
setting will change to Manual automatically.
(You do not have to select Manual yourself.)
The popup menu lists common film formats.

The resolution and the film format are linked. If
you change the film format, the resolution will
be adjusted automatically in the Y direction. Try
the following example for clarification.

Select a resolution of 320 x 240. This is the
same as a computer's 4:3 ratio. Change the
film format to 70 mm (cine format) - the
resolution changes to 320 x 145 automatically
(it is scaled in the Y direction to match the
format).

The default setting for the film format is
Automatic. This means that images will be
rendered in the specified resolution independent
of any particular ratio.

Two lines will appear in the Perspective View to
frame the area that will be rendered.

Pixel

The two values specified here define the ratio of
a pixel's on-screen width (left box) to its on-
screen height (right box). The pixel ratio for
most monitors is 1:1, so usually you do not need
to change this setting.

However, some display media use a pixel ratio
other than 1:1 and the setting must be adjusted
to avoid distortion such as circles appearing as
ellipses.

If you need to calculate the pixel ratio manually,
expand the editor window so that it fills the
entire screen. Select the side view and import a
cube. Measure the cube’s width and height with
a ruler and enter values in the corresponding
pixel boxes.
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Frame

This popup menu and the two fields to its right
are valid for the integrated version with
CINEMA 4D only - please see the CINEMA 4D
Reference manual for details.

Field Rendering

This popup menu is valid for the integrated
version with CINEMA 4D only - please see the
CINEMA 4D Reference manual for details.

Frame Rate

This setting is valid for the integrated version
with CINEMA 4D only - please see the
CINEMA 4D Reference manual for details.
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Save Tab
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Format

BodyPaint 3D supports the following picture
formats: TIFF, TARGA, BMP, PICT, IFF, JPEG,
Photoshop PSD and any formats installed on
your system under QuickTime.

QuickTime 4 upwards supports the following
single picture formats: BMP, Photoshop PSD,
SGl, JPEG, PICT, PNG, TIFF and QuickTime
Image.

Note

If you are using Windows, you must install
QuickTime to take advantage of the extra
formats.

Options

This is relevant only if you are running
BodyPaint 3D with CINEMA 4D. Please see the
CINEMA 4D reference manual for details.

Name

This popup menu is valid for the integrated
version with CINEMA 4D only - please see the
CINEMA 4D Reference manual for details.

DPI

You can use this setting to choose the DPI for
the following picture formats: BMP, TIF, PICT.
The DPI affects a picture's print size.

An example

You render a picture that is 700x1000 pixels. If
you save the picture with 72 DPI, the print size
will be 24.7cm x 35.3cm. If you save the picture
with 300 DPI, the print size will be 5.9cm x
8.5cm - assuming that the print program
supports the DPI setting.

Alpha Channel

If you activate this option, a pre-multiplied
alpha channel will be calculated during
rendering.

The alpha channel uses the same resolution as
the color picture. Pixels in the alpha channel are
either white or black. A white pixel in the alpha
channel indicates the presence of an object in
the corresponding pixel of the color image. A
black pixel in the alpha channel indicates no
object in the corresponding pixel of the color
image.

You can use the alpha channel for compositing
in image editing programs.

Imagine that you have a scanned image of an
airfield and you wish to render an aircraft in
BodyPaint 3D and place it on the runway. You
can render the aircraft with an alpha channel in
BodyPaint 3D. Next, use the alpha channel in
the image editing program to cut out the non-
aircraft parts of your render so that the airfield
shows though in those parts. The edges of the
alpha channel picture are antialiased in grayscale
so that there is a soft transition in the
composited picture.



Pre-multiplied alphas have one particular
shortcoming - please study the image below.

On the left the rendered image, in the middle the alpha
channel and on the right the result

Can you see the dark seam caused by the alpha
channel? This arises because both the picture
and the alpha channel were rendered with
antialiasing. By definition, the color picture and
the alpha channel must be multiplied and so the
black is calculated twice.

You can avoid this dark seam by using the
Straight Alpha option. Note that straight alphas
are only suitable for compositing programs -
they are unusable as conventional pictures.

Warning!

The entire alpha channel will be masked if you
use a sky, floor or background object in your
scene! Do not use any of these objects if you
need the alpha channel.

Alpha channels are integrated automatically for
TARGA, TIFF, PICT and PSD. If you have
activated Separate Alpha or if you have chosen
a different picture format, the alpha channel is
saved separately to the color picture. These files
are indicated by an ‘A_' before the filename,
e.g. 'A_room.tif". Separate alphas are saved in
the TIF format.

CHAPTER 24 « RENDER MENU = 413

Straight Alpha

You can use this option if straight alphas are
supported by your compositing program. This
avoids the dark seam associated with pre-
multiplied alphas. Note that straight alphas are
only suitable for compositing programs - they
cannot be used as conventional pictures.

'

On the left the rendered image, in the middle the alpha
channel and on the right the result

Activate the straight alpha only when you wish
to post-edit the result. The picture is useless as
direct output.

Warning!

The entire alpha channel will be masked if you
use a sky, floor or background object in your
scene! Do not use any of these objects if you
need the alpha channel.

Alpha channels are integrated automatically for
TARGA, TIFF, PICT and PSD. If you have
activated Separate Alpha or if you have chosen
a different picture format, the alpha channel is
saved separately to the color picture. These files
are indicated by an ‘A_' before the filename,
e.g. 'A_room.tif". Separate alphas are saved in
the TIF format.
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Depth Channel

The depth channel contains grayscale pixels that
indicate how distant objects are from the
camera. The darker a pixel, the more distant
that part of the object is.

On the left the rendered image and on the right the depth
channel

Depth channels are often used in post-
production to add effects such as depth of field
and fog. The depth channel can also be used to
insert objects within the picture.

Depth channels are integrated automatically for
TARGA, TIFF, PICT and PSD.

If you have activated Separate Alpha or if you
have chosen a different picture format, the
depth channel is saved separately to the color
picture. These files are indicated by a ‘D_’
before the filename, e.g. ‘D_room.tif'. Depth
channels are saved in the TIF format.

Separate Alpha

Alpha channels or depth channels are usually
integrated automatically for TARGA, TIFF or
PICT pictures. If you wish to save the alpha/
depth channel as a separate file, activate this
option. In addition to your color picture (e.g.

‘room.tif"), you will also have a file containing
the alpha channel (e.g. ‘A_room.tif') or depth
channel (e.g. ‘D_room.tif").

Note

If you have activated both Alpha Channel and
Depth Channel, only the alpha channel will be
integrated into the picture. The depth channel
will be saved as a separate file.

Path

Choose the folder and filename so that the
picture can be saved automatically after
rendering.

You can type in the entire path if you wish.
Alternatively, click on Path to open a system
dialog so that you select the folder.

If you enter a name without a path, the picture
will be saved in the active scene's folder.

External

You can use External to specify an application
for the rendered picture to be passed on to. For
example, you can redirect the picture to an
image editing program for further processing. If
you are using Windows, you can use a batch file
with command parameters. If you use a
Macintosh, you may use AppleScript.

Click on External to open a system dialog so
that you can select the program.
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Depth of Field

If this option is activated, depth of field will be
rendered if it is used by any of the cameras. You
may wish to switch off depth of field for
preview rendering.

Please note that this is a post-processing effect -
it will not be visible until after the normal image
has been rendered.

Lens Effects

If this option is activated, lens effects will be
rendered if they are used in your scene. You
may wish to switch off lens effects for preview
rendering.

Please note that this is a post-processing effect -
it will not be visible until after the normal image
has been rendered.

Glow Effects

If this option is activated, glow effects will be
rendered if they are used in your scene. You
may wish to switch off glow effects for preview
rendering.
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Please note that this is a post-processing effect -
it will not be visible until after the normal image
has been rendered.

Note

Glow effects are like the lens effects. They are
post processed effects (they are only taken into
consideration after the actual picture is
rendered), so you cannot see them in reflections
and you cannot see them through transparent
objects.

Volumetric Lighting

Volumetric lighting permits shadows in visible
light. This can produce stunning effects, but it
also increases render time significantly. Deselect
this option if you want to turn off volumetric
lighting.

Level of Detail (CINEMA 4D scenes only)

This value influences all CINEMA 4D objects in
the active scene that support a reduction in
detail, such as metaballs, primitives and NURBS.
However, any objects that have their own Level
of Detail setting (see Display Tag, page 196) will
continue to use their setting.

If the value is set to 100%, the objects will be
rendered with full detail. If the value is set to
50%, the objects will be rendered with only half
their usual detail.

Note

If you render to the editor window, the editor’s
level of detail value (Display menu) will be used
in preference. It is only when you render to the
Picture Viewer that the value in the render
settings is used.
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Scene Motion Blur

This is relevant only if you are running
BodyPaint 3D with CINEMA 4D. Please see the
CINEMA 4D reference manual for details.

Dithering

This is relevant only if you are running
BodyPaint 3D with CINEMA 4D. Please see the
CINEMA 4D reference manual for details.

Object Motion Blur

This is relevant only if you are running
BodyPaint 3D with CINEMA 4D. Please see the
CINEMA 4D reference manual for details.

Filter

You can apply built-in post-processing filters to
the rendered picture.

None
No filter is applied.

Soft

Each pixel is balanced with its neighbour to yield
a softer transition. Use Strength to increase or
decrease the effect.

Edges

The Edges filter emphasizes transitions in the
picture. This reinforces the edges. Use Strength
to increase or decrease the effect.

You can use Edges to sharpen your pictures - for
example, try using the filter with 30% strength
for a still.

Medium

Medium filters out unattractive peaks in pixel
color values. Use Strength to increase or
decrease the effect.

Options Tab
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Active Object Only

If this option is active, only the active object is
rendered in the Picture Viewer.

Auto Light

If there are no lights in your scene, BodyPaint 3D
will use the auto light (a standard light source)
when rendering so that you can see the objects.

Log File

If this option is enabled, the render log will be
recorded in ‘Renderlog.txt' in the BodyPaint 3D
folder.

The render log contains a complete history of
the render process including system resource
information. In particular, you can check the log
if you need to identify problems that occurred
during rendering.

The information in the log file is not overwritten
by subsequent renders. Rather, new log
information is appended. As a result, this file can
grow to a fair size over time. You may wish to
delete the file manually from time to time - a



new file will be created the next time the log is
recorded. (You will not confuse BodyPaint 3D by
deleting the file).

Textures

This option activates or deactivates textures for
rendering. For example, you might deactivate
textures for a test render or for cel-rendering.

If the option is activated, textures will be
rendered. If Textures is deactivated, the average
color value of the top texture layer (the right-
most texture in the Object manager) will be
rendered.

Cel-Render Color with and without the Texture option active

Cancel if Texture Error

If BodyPaint 3D cannot find a texture when
rendering the scene, an alert dialog will appear.
If this option is not selected and you confirm the
alert, the rendering continues without the
missing texture.

Ray Depth

The Ray Depth value determines how many
transparent objects (or areas made invisible
using the alpha channel) can be penetrated by
the renderer. The lower you set the ray depth,
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the fewer the number of objects that can be
seen through. Those areas that cannot be
penetrated are rendered black.

A processing depth of 1 means that calculations
are finished for that pixel once a ray hits
something in the scene. Transparencies and
alphas are therefore not visible.

A value of 2 means that, after a ray has hit a
surface, a second ray is calculated for the
transparency. The greater the processing depth,
the further rays are followed into the scene and
the results rendered.

The following scenes with transparencies and
alphas were rendered with a ray depth of 2, 4
and 8.

Reflection Depth

When a ray is sent into the scene, it can be
reflected by reflective surfaces. With certain
arrangements, e.g. two mirrors opposite each
other, it is possible that a ray will be reflected
endlessly - it is trapped between the mirrors and
the raytracer would never finish rendering the
picture. In order to prevent this, you can set the
maximum number of reflected rays in Reflection
Depth.
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You can also use Reflection Depth to limit the
render time for the picture. Often, only the first
generation of reflection is important. Further
rays tend to add very little to the image quality
but increase the render time considerably.

A processing depth of 1 means that calculations
for a pixel are finished once a ray hits something
in the scene. Reflections are therefore not
visible.

A value of 2 means that, after a ray has hit a
surface, a second ray is calculated for the
reflection. The greater the processing depth, the
further rays are followed into the scene and the
results rendered.

The following scenes with reflective objects
were rendered with Reflection Depth set to 2, 4
and 8.

Shadow Depth

The shadow depth is analogous to the reflection
depth. In this case, tests are carried out to see if
a surface point lies in the shadow of another
object.

This is tested for using additional shadow rays,
which are sent from the surface in the direction
of the light source.

The value you enter for this setting determines
for which generation of camera rays shadows
are calculated. For example, if you reduce the
value to 2, shadows will not be rendered for
reflected, transparent or refracted rays.

The following scenes with reflective and
transparent objects were rendered with Shadow
Depth set to 2, 4 and 8

Threshold

This value helps to optimize the render time.
With complex scenes, particularly those
containing many reflective and transparent
surfaces, 90% of the processed rays contribute
less than 10% to the general picture brightness
and color. With a threshold value of, for
instance, 15%, the rays stop their movement
from the camera into the scene as soon as their
brightness falls below this critical value.

What exactly does that mean?

When a ray hits a surface, the values for
transparency and reflection are calculated. If, for
example, the threshold is set to 15% and the
surface has a material with 10% reflection
(Brightness slider), the material will not reflect.



In order to render the reflection in this case, the
threshold must be reduced to 9% or less (or the
reflection of the material must be increased to
16%).

Sometimes it is useful to increase the threshold
to prevent minor details being reflected.
Although minor details are calculated correctly,
too much detail in reflections can distract the
viewer. However, if you wish to calculate all
rays, set the threshold to 0%.

AA Softness

This stands for antialiasing softness and the
option enables you to control how hard or soft
the antialiasing is. You can use this to fine-tune
the antialiasing to suit your picture.

For crisp pictures, set the value between 0 and
50%.

If your pictures should retain a soft look, use a
value between 50 and 100%.

Note

As a rough guideline, use a value between 20-
60%. This is only a rough guideline that
depends on the subject matter - do not worry if
your preferred setting differs.

Cel-Renderer

These options apply to the render modes Cel-
Render B/W and Cel-Render Color.

Cel-Render B/W renders all objects as black
outlines only on a white background. Cel-
Render Color renders all objects with a reduced
color palette and black outlines on a black
background. This results in a classic cartoon
style.
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Illumination

If this option is activated, the shading of objects
is affected by the illumination. Shadows will also
be rendered. Note that this option only has an
effect with Cel-Render Color.

If Illumination is deactivated, the average color
value of the top texture layer (the right-most
texture in the Object manager) will be used to
render the objects. As a result, each object has a
monotone color. Also, shadows will not be
rendered with the option deselected.

Outline

This option draws an outline around the
silhouette of objects. This is critical with the Cel-
Render B/W mode since if you deselect the
option all you will see is the background color!
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With Cel-Render Color, the outline helps to
bring out the individual objects and give them a
cartoon feel.

Note

The outline is drawn around the silhouette of
individual objects only. For example, if you have
connected an object group to form an individual
object, only the overall silhouette will be
outlined, not the individual silhouettes.

You can change the color of the outline using
Edge Color.

Edges

If this option is activated, all polygon edges are
outlined in black. This creates a shaded
wireframe feel. You can change the color of the
edges using Edge Color.
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Edge Color

This option enables you to change the color
used by the options Outline and Edges. This
option affects both cel rendering modes (Cel-
Render B/W and Cel-Render Color).




Background Color

This option allows you to change the
background color for the Cel-Render B/W
mode. The option has no effect on the Cel-
Render Color mode.
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25 Window Menu
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Most of the following menu entries activate a
window or a manager. If the particular window
or manager is already present in the layout, but
not in the foreground, the call will cause it to
come to the front. If the selected item is not in
the layout or if an additional view panel, icon
palette or status bar is opened, this appears first
in a new window. With the drawing pin (see
page 60) this window can then be placed
elsewhere within the layout.

Layout

Under this menu entry are some functions that
allow you to modify your work environment to
suit your own preference. More information on
this can be found in Chapter 4, Workflow, page
55.

New Icon Palette

This opens a new, empty icon palette in its own
window. You can then populate this palette with
icons from the Command manager (see

page 36).

Edit Palettes

If you choose this command, the Edit Palettes
mode is activated and the Command manager
opens. The icons are surrounded by blue frames,
indicating that you may edit them - e.g. you can
drag icons from the Command manager and
drop them onto any of the palettes.

There are two ways to exit the Edit Palettes
mode - either close the Command manager or
deselect the check box.
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Load Layout

If you have setup your working environment to
your satisfaction and saved it (as a '.14d’ file),
you can reload that configuration with this
command.

Reset Layout

This instruction resets your BodyPaint 3D layout
to the original, preset layout. This is particularly
useful if you need to call our support team since
you and they then have a common interface to
work from. Your own customized layouts can
increase your workflow enormously but when
searching for an elusive problem a common,
standardized layout is essential.

Save as Default Layout

Use this to save the visible working environment
as the default layout. When you next start
BodyPaint 3D this is the layout that will be used
(remember that this only saves your

BodyPaint 3D setup - you must clear up your
desktop yourself!).

Note

In the General Settings you can choose to save
the layout automatically when quitting the
program.

However, if you have slaved for hours creating
the perfect working environment and want to be
sure that the layout is saved immediately, you
should use Save as Default Layout. After all,
power cuts have an uncanny knack of happening
when you have not saved your work!
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Save Layout as

This command lets you save your layout under
its own name so that you can create as many
named setups as you need; e.g. one for painting
in the Perspective View, one for editing UV
mesh in the Texture View.

Layout files have the extension '.14d".

Default Layouts

So that you can access different layouts quickly
this command shows all the '.14d" layout names
that are present in the ‘Prefs’ folder within the
'‘BodyPaint 3D" folder.

Painter

This menu item enables you to open editors and
managers that relate to painting.

Brush Settings

This opens the Brush Settings dialog. You can
also open the dialog by double-clicking on a
brush preset in the Brush manager.

In the dialog you adjust parameters for the
active brush.

For details on the Brush Settings, please see
page 89.
Color Settings

Opens the Color Settings dialog. You can also
open the dialog by double-clicking on a color
preset in the Color manager.

The dialog enables you to adjust parameters for
the active color.

For details on the Color Settings, please see
page 75.

Brush Presets

This opens the Brush manager. This manager
gives you access to the default brush presets as
well as your own brush presets.

For details on the Brush manager, see page 98.

Color Presets

This opens the Color manager. This manager
gives you access to the default color and pattern
presets as well as your own presets.

For details on the Color manager, see page 83.

Layer Manager

Opens the Layer manager. The Layer manager is
the control center which gives you access to
your textures. Not only can you select individual
layers to edit them, you can also drag-and-drop
to reorder the layer stack, create new layer
masks or merge layers together.

For details on the Layer manager, please see
page 107.

Bitmap Info

This opens the Bitmap Info manager. This
manager provides you with information such as
the size or memory consumption of the active
layer or active material. You can also adjust the
active layer's opacity.

For details on the Bitmap Info manager, please
see page 115.

New View

BodyPaint 3D enables you to open as many
views on a scene as you want and the
perspective is always freely adjustable within
each view (see View Menu, page 13).

This is where you create a new view; when it
first appears it uses the standard 3D perspective.



New Texture View

BodyPaint 3D enables you to open as many
textures in their own view window as you wish.
To open a texture in the view, either drag a
texture into the view or double-click on the
texture's name in the Layer manager.

Object Manager

This opens the Object manager. In this manager
you can activate an object (even if it is not
visible in the Perspective View), change the
object hierarchy and manipulate the various
properties of the objects. The Object manager is
described in detail in Chapter 11, page 187.

Material Manager

W R Bl hwen
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This opens the Material manager which holds all
the materials and textures present in a scene
and also shows material previews. You can
assign a material to an object using drag-and-

drop; simply drag the material onto the
appropriate object in the Object manager.

The Material manager is described in detail in
Chapter 12, page 207 while the various texture
projections are discussed on page 255.

Picture Viewer

This opens the Picture Viewer window, also
known as the Picture manager. When you
perform a final render, the picture appears in
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this output window (instead of in the
Perspective View). Also, you can view image
files (e.g. textures) directly in this window and
you are even able to convert them to other
formats.

Coordinate Manager

Use this to open the Coordinate manager. This is
a universal tool for the numeric manipulation of
elements within your scene.

The Coordinate manager is described in detail in
Chapter 15, page 285.

Structure Manager

This opens the Structure manager. The Structure
manager enables you to select and edit the
active object’s points, polygons and UVW
coordinates. You can edit the coordinates
numerically.

The Structure manager is described in detail in
Chapter 14, page 277.

Browser

Here you open the Browser. The Browser is an
enormously powerful tool for the administration
of your project data and libraries. Whole
directories can be scanned to create a catalog
and can be saved with a preview as well as with
further information. Instead of searching long
and hard in the murky depths of your hard disk
folders use the Browser to get your chosen
textures, objects or scenes with just a few
mouse clicks.

The Browser is described in detail on page 57.
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Global Status Bar

This opens the Global Status Bar, which shows
information such as the render time.

Active Tool Manager

The more complex tools (for example, the
selection tools) within BodyPaint 3D have
various parameters (such as the radius of
selection) which are shown in the Active Tool
window; here you can also adjust them as
necessary.

The adjustable parameters are described within

the appropriate chapters for the individual tools.

Console

The Console window is used for the output and
control of C.O.FRE.E. programs. C.O.FFE.E.
print commands are displayed here, as are any
errors. In the case of errors, the number and
program position are shown.

Command Manager

This function opens the Command manager
which contains a list of all the functions and
commands that exist in BodyPaint 3D, including
the various icons and keyboard short-cuts. Here
you can arrange your own icon palettes or
change the shortcuts to suit your own needs.

There is a more detailed description of the
Command manager on page 36.

Menu Manager
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You can use this manager to rearrange
BodyPaint 3D's menu structure. The use of the
manager is self-explanatory. If you getin a
tangle, you can restore the structure with Revert
to Original.

Other Entries

BodyPaint 3D is able to hold several scenes in
memory at the same time.

At the bottom of the Window menu is a list of
filenames for all the open scenes. Choose a
filename to access that scene. The order of the
list corresponds to the order in which the scenes
were opened.
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26 Help Menu
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26 Help Menu

Help (CINEMA 4D) Info
This menu item only appears if you are running This opens the same info screen that
BodyPaint 3D with CINEMA 4D. It opens the appears momentarily when the program
online CINEMA 4D 3D manual that was copied loads. You can use this screen to check
to your hard drive during the standard the version number of BodyPaint 3D, be
installation process for CINEMA 4D. sure to quote this number when
contacting technical support. You can
He|p (BodyPalnt 3D) close the window by clicking on it.

This opens the online BodyPaint 3D manual that
was copied to your hard drive during the
standard installation process.

MAXON Online

This menu item will open the MAXON
homepage provided that you have an Internet
browser installed. This is the place for the latest
BodyPaint 3D information as well as service
updates.

Personalize

This opens the Registration dialog so that you
can enter your final serial number. You will
receive your final serial number once you have
returned your registration form to us or to your
local Maxon contact.

Warning

The serial number that is included with the
program will expire after six months of use, after
which you will no longer be able to use the
program. Please send in your registration form as
soon as possible.
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Appendix 1 Formulas

You can type in a formula wherever
BodyPaint 3D accepts a value, e.g. in the
Coordinate manager.

This appendix lists all the units, operators,
functions and constants that you may use in
your formulas.

Units

You may enter values using any of the units
listed below (examples in brackets) - regardless
of the basic units defined in the general settings
(BodyPaint 3D will convert the units for you).

km kilometres (23 km, 0.125km)
m metres (13.23 m, 1000m)

cm centimetres (11.5 cm, 328.275cm)
mm millimetres (14 mm)

um micrometres (678 um)

nm nanometres (3.867 nm)

mi miles (12.5 mi)

yd yards (17.9 yd)

ft feet (572 ft)

in inches (0.125 in)

F frame number (O F)

Note

If you change the basic units in the general
settings, e.g. from metres to millimetres, only
the measurement units are changed, not existing
numerical values. For example, if an object has a
width of 10 metres, but you then change the
basic units to millimetres, the object will then
have a width of 10 millimetres. If you wish to
scale the objects to reflect the change in units,
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group all the objects and scale the group using
the Coordinate manager.

Operators

The function parser has the most important
arithmetic operators built in (examples in
brackets):

+ addition (144 + 14 = 158)

- subtraction (144 - 14 = 130)

* multiplication (144 * 2 =

/ division (144 / 12 =12)
MOD modulus (123 mod 4 = 3)
A power (12 A2 =144)

(open bracket (3 + (4 *2)=11)
) close bracket ((3+4) *2=14)

Functions

ABS absolute value (abs(-123) = 123)

SIN sine (sin(30) = 0.5)

COS cosine

TAN tangent

ASIN arc sine

ACOS arc cosine

ATAN arc tangent

SINH sine hyperbola

COSH cosine hyperbola

TANH tangent hyperbola

LOG10 /ogarithm to base 10 (log70(100) = 2)
LOG /ogarithm to base e (log(e) = 1)

EXP exponential function (exp(5) = 148.413)
SQRT square root (sqrt(144) = 12)

SQR square (sqr(12) = 144)

288)

Note

Function arguments must be bracketed. The
number of open brackets must equal the number
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of close brackets. Functions may be embedded:
sin(sqr(exp(pi)))

The argument of a trigonometric function is
always interpreted in degrees. sin(2*pi) does not
mean the computation of sin 180 degrees,
merely approx. sin 6.283 degrees.

Constants
BodyPaint 3D includes two important constants:

Pl Pi (3.142)
E Euler's number (2.718)

With all the above you should be able to define
even the most complex operations in a very
precise way. You can combine them freely. For
example:

2km+exp (sin (4mm*pi) )/ ((sin(1l4cm)) "2
+(cos (14cm)) *2)



Appendix 2 Programming
Plug-ins

The C.O.F.E.E.E. Programming
Language

C.O.FEE.E., BodyPaint 3D's plug-in language, is
not based on macros or scripts but is a complete
and powerful programming language in its own
right. It closely resembles C++ and Java so that
if you are already familiar with these languages
you will immediately feel at home with
C.O.F.EE.E. You simply have to learn the various
functions implemented by BodyPaint 3D.

Before you can start programming, you will
need the SDK (Source Development Kit) from
MAXON Computer - you can obtain this from
MAXON Computer's web page at
www.maxon.net.

What is the advantage of programming in
C.O.FEE.E.?

Apart from the ease of integrating new
functionality into BodyPaint 3D, BodyPaint 3D is
a multi-platform program; BodyPaint 3D is
available for the Apple Power Macintosh (Mac
OS 8 and above) and Intel PC (Windows 9x and
Windows NT/2000). Writing plug-ins in
C.O.FEE.E. means that your new BodyPaint 3D
function will work immediately on all these
platforms; no re-compilation or reprogramming
is required.

How do you create such a program?

Simply write your C.O.E.EE.E. programs in any
editor (perhaps that supplied with your
computer) or word processor and save it as a
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regular ASCII text file; BodyPaint 3D will happily
process regular text, with no high-ASCII
characters.

So that BodyPaint 3D can find its C.O.FF.E.E.
programs and load them automatically, they
must be placed in the Plug-ins folder which
should be in the root BodyPaint 3D folder. If you
check the contents of this folder, you should
find some examples already there.

However, you can also store C.O.F.FE.E.
programs elsewhere on your hard disk. If you
want to load such a program into BodyPaint 3D
just use the File > Open menu command - such
a file cannot be automatically integrated into
BodyPaint 3D’'s menu structure.

The API

You can, if you wish, write your applications
using any C/C++ compiler rather than the
C.O.FEE.E. language. You can access
BodyPaint 3D's functionality through pre-
defined interfaces. These interfaces are in the
form of an API (Application Programming
Interface) library which is part of the SDK.

Note, however, that if you use an external
compiler (as opposed to C.O.F.F.E.E.) this will be
platform dependent and you will need to re-
compile your program for each platform you
want your plug-in to support. Your plug-ins may
even require reprogramming.
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C.O.F.E.E.E. Support

Support for BodyPaint 3D developers is available
exclusively on MAXON Computer's website:

www.maxon.net

There you will find, among other things, the
SDK. This contains the C.O.F.F.E.E. compiler and
detailed descriptions of the programming
language and the interface libraries. It is, of
course, possible for commercial plug-in
manufacturers to keep their source code secret
and proprietary.

Our developer support is not static; the
interfaces to BodyPaint 3D and their
functionality are updated frequently. Therefore,
please take note of announcements at
www.maxon.net on a regular basis.



Appendix 3 File Formats

While working with BodyPaint 3D there will be
occasions when a particular graphic format will
not load or a 3D file will prove difficult to
convert. There are so many formats and sub-
formats for images and 3D files that

BodyPaint 3D cannot even dream of coping
with all of them.

The following sections contain summaries of all
formats that BodyPaint 3D supports. If you need
more detailed information, you should refer to
the relevant technical information for that
format.

Image Formats
TIFF

Bit depths
1, 4,8, 24,32

Compressions
Uncompressed, RLE compressed.

Notes

Only Baseline TIFF is supported. Exotic formats
such as CMYK images are not supported, nor are
files that have been LZW compressed (this is due
to licence rights). It is of course not possible to
give an exhaustive list of non-supported formats,
since such a list in a sense could never be
definitive.

With QuickTime installed LZW compressed
images and other variants are also imported.
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IFF

Bit depths
1,4,8,16, 24

Compressors

Uncompressed, RLE compressed.

Notes

IFF images are read only if they conform to the
Commodore/Electronic Arts specifications.

EHB, HAM-6 and HAM-8 modes are supported.

TARGA

Bit depths
24,32

Compressors
Uncompressed.

Note

Only TGA-1 is supported. With QuickTime
installed other variants are also imported.

PICT

Bit depths
4,8,16, 24, 32

Compressors

Uncompressed, RLE compressed.

Note

With QuickTime installed all PICT variants are
imported (as long as the QuickTime compressors
are available).
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BMP

Bit depths
1,4,8,16, 24

Compressors
RLE-4, RLE-8.
JPEG

Bit depths
24

Note
Grayscale JPEGs cannot be loaded.

PSD

Bit depths
1,8,24,48

Color Formats:
Indexed Color, RGB, not CMYK.

Notes

For writing, multiple alpha channels are
supported.

When importing, layers are preserved and will
appear in the Layer manager.

With QuickTime installed, all QuickTime
formats are supported i.e. PNG, SGI and
QuickTime image.

3D Formats

DXF

BodyPaint 3D offers complete support for DFX
files written by AutoCAD (up to and including
version 12) or by the export filters of other
applications, provided they are 100%
compatible.

LightWave

BodyPaint 3D can convert LightWave Version 5
files and scene descriptions completely, although
you may need to post-edit light source settings
and texture placements. UV coordinates can be
imported with LightWave Version 6

3D Studio Import

— These files are loaded:
3DS (regular 3DS files)
PRJ (3DS project files)
MLI (3DS materials libraries)

— The object hierarchy is copied 1:1, referenced
objects are duplicated in BodyPaint 3D.

— The following material channels are imported:
environment light, specular color, specular
settings (are recalculated), transparency,
luminance, color texture, specular texture,
transparency texture, environment texture,
relief (bump) texture, luminance texture.

CAUTION!

The 3DS transparency texture is the exact
opposite of the transparency mode in
BodyPaint 3D. In 3DS materials are more
transparent the darker a texture pixel, whereas
in BodyPaint 3D they are more transparent the
lighter the pixel.

— UV mapping is copied.



— Position, scaling, rotation and light sequences
are adjusted to suit BodyPaint 3D.

— Textures can be renamed automatically on
loading.

— So-called target objects loaded from 3DS (from
cameras and light sources) become axes (null
objects) and are given the extension 't', which
is added to their object name.

— 3DS files are binary files and are not recognised
by their extensions but by their identifier.

3D Studio Export

— All polygon objects, light sources and cameras
are exported, Hyper NURBS objects are
transformed into polygon objects.

— Material export:
color, luminance, transparency, environment,
specular, specular color, relief (bump), all with
any defined textures. The mean value of the
texture channel is exported with the shader.

Note

Regrettably, 3D Studio can cope only with
filenames consisting of eight characters plus a
three-letter extension. Therefore texture
filenames will be truncated to conform with this
restriction.

3D Studio accepts only one UV coordinate per
point. Therefore texture mapping differ after
exporting in this format.

QuickDraw3D Import

— Light source and camera information cannot
be read.

— The following objects are ignored:
Torus, TriMesh (new with QD3D v1.5); NURBS
can cause problems in certain cases.
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— References (both internal and external) are not
read.

— UV coordinates are not read.

— Textures are not read.

QuickDraw3D Export

— Light source and camera information cannot
be written.

- UV coordinate export is supported.
— Texture export is supported.

— ASCII 3DM files cannot be written, only binary.

Note

QuickDraw 3D accepts only one UV coordinate
per point. Therefore texture mapping may
appear different after exporting in this format.

Direct3D Export

- Typical extension *.x, ASCIlI Format, MESH and
FRAME format.

— Zoom factor for entire scene, automatic
indenting.

— Rename texture names to any extension.

— Texture information (UV coordinates and
texture names)

— Texture channels:
color, luminance, specular, specular color,
transparency, environment.

Note

For all scenes to display properly with a
Direct3D Viewer it is necessary for all textures to
have an edge length of a power of 2 (i.e. 2, 4, 8,
16, 32, 64, 128, 256, 512, 1024, ...).
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VRML V1.0c and 2.0 Import

- ASCII format.

— Creating all basic objects (cuboid, sphere, cone,
cylinder).

— Polygon objects of any size and number of
vertices (n corners are triangulated).

— Perspective cameras, light sources (direct,
point, spot).

— Material tags:
ambient color, diffuse color, specular color,
emissive color, shininess.

— WWW Links are created as a BodyPaint 3D
attribute (WWW tag).

Note

Object names in VRML files must not contain
any special characters (not even +, -, *, /). This
may be the only reason that BodyPaint 3D is
refusing to load a file!

VRM L 2.0 Import

— Inline scenes (references to scenes are
automatically loaded).

VRML1.0c and 2.0 Export
— ASCII format (optionally formatted).

— Hierarchical saving of all objects: HyperNURBS
are converted to polygon objects.

— Object names are converted, special characters
are filtered/converted.

— Textures:
If there are any textures, the program looks for
the color texture, the luminance texture and
the environment texture (in that order). Color
textures, even inline textures, are saved as files.

— Materials:

Color, luminance, specular, specular color,
transparency, environment.

- WWW links/addresses are saved: when an
object is selected in the web browser, the
program branches to that link.

Wavefront OBJ Import

— The file to be imported must have the file
extension ".OBJ". The file itself contains no
information to suggest its origin. Without the
extension, BodyPaint 3D cannot open the
objects.

- ASCII format.

— Polygon objects are loaded.

— Objects are given a dummy material.
- UV mapping is supported.

— No object hierarchy can be created.

Wavefront OBJ Export

— ASCII format.

- Polygon objects; HyperNURBS are converted
to polygon objects, UV coordinates.

DEM Landscape Import

- BodyPaint 3D does not support the more
recent DEM-SDTS format.

— The VistaPro-DEM format is supported.

— The file to be imported must have the file
extension ".DEM". The file itself contains no
information to suggest its origin. Without the
extension, BodyPaint 3D cannot open the file.
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What can you do when you are stuck and the
manual does not appear to help? - You may
want to contact technical support.

MAXON Computer, and its distributors
worldwide, will help you with any technical
problems you encounter. So that we can help
you as efficiently as possible, please keep in
mind the following:

Please contact us (or your local distributor) in
writing if possible, preferably by email.

We have telephone lines, of course, but
problems with a package as complex as
BodyPaint 3D may take time to solve - it is not
always possible to solve the problem while you
are on the phone. With email, however, our
technicians can consult with colleagues for
assistance — even the programmers if necessary
— and get back to you as soon as possible.
Email is also convenient for attaching an
example of the problem and, likewise, it may be
helpful for us to send you a scene.

Please keep support enquiries separate to other
enquiries, orders etc.

Orders are dealt with by our busy Sales staff, so
your support question is unlikely to be passed
onto a support technician.

Please allow for a reasonable response time.

We operate on a queuing system basis only. Our
customers are equally important and we will
respond to you at the earliest opportunity.

Please supply your telephone number and
times when we may contact you on that
number.

Occasionally, we may need to contact you for
further details.
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Please send an example scene to demonstrate
the problem, if applicable.

“When | paint, | get a mess”. It is difficult to
solve problems with such limited detail and
sometimes we need to examine the problem
scene. After all, we and our hard-working beta
testers, have tested the functions many-a-time
without finding a fault.

Please keep any example scenes as small and
as relevant as possible.

For example, if only an alloy wheel is required to
demonstrate the problem, please delete the rest
of the car - it merely gets in the way. This saves
our time and in turn we can respond to your
problem sooner.

Please supply us with a complete description of
the relevant steps leading up to the problem.

Ideally, we would like a little ‘recipe’ that
generates the problem consistently. Please keep
the 'recipe' concise.

Include rendered images if relevant.
Please tell us which settings you used.

Please tell us which programs you have running
at the same time as BodyPaint 3D. If you are
using MacOS, please let us know which system
extensions are loaded.

Sometimes, another program or a system
extension (MacOS) may cause a problem
indirectly.

Please include details of your hardware
configuration.

“I' have a Macintosh/PC" is of little help on its
own. Also, please let us know which version
(e.g. 6.00) of BodyPaint 3D you are using. If
you have Internet access, please use the support
form on our website (www.maxon.de). Tell us
what other programs and system extensions you
are running concurrently with BodyPaint 3D.
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If the program crashes, it will display an error
message. Please let us know the exact
message.

If you are using Windows, you will see many
other details listed. Please ignore these extra
details - they are as enlightening as the
infamous Macintosh message “Application
Unknown has quit unexpectedly because of
error -1"...

Please let us know BodyPaint 3D’s message.

If you have Internet access, please check the
FAQs on our website before you contact
technical support.

Often, you will find the answer in the FAQs.

Our service is limited to technical support only.
We cannot undertake subcontracting.

“Can you paint my spaceship model, please?"

We must concentrate our resources on helping
customers with genuine problems that are
within the bounds of technical support.

However, there are numerous web addresses
where you can find additional help. Please visit
our website (www.maxon.de) for links to these
valuable resources.
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Alpha channel, Alpha buffer

Used for blends with 2D images or movies. This
channel determines at which points and to what
extent an underlying picture will be visible.
Alpha channels are usually grayscale images; the
darker a pixel the more intensely the underlying
picture comes through.

Ambient

This refers to the surrounding light which causes
the scene to generally appear brighter. In
BodyPaint 3D this property is set in the
Environment object.

Antialiasing

Method for reducing the undesirable zig-zag
effect along object and colour edges. It is
achieved by generating intermediate points from
colours of adjoining pixels. Images that have
had antialiasing applied normally appear
somewhat blurred.

Backup

Security copy of data or of files.

Bitmap

Two-dimensional pixel graphic.

Browser

Application that lets you manage and view files.
Bump Map

Relief texture. The surface is seemingly
indented. Usually grayscale images. The darker
a pixel, the more strongly the object is indented.
BodyPaint 3D also lets you reverse this
behaviour.

CAD
Computer Aided Design.
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CPU

Central Processing Unit, the heart of the
computer. Without it, nothing works.

Drag-and-drop

This is the technique of grabbing an object on
screen with the mouse and keeping the mouse
button depressed while moving it to another
position. When the target is reached, the mouse
button is released and the object "dropped'. This
may trigger other actions (like launching a
program).

Gouraud Shading

This shading algorithm smooths the edges of
objects. Without it, objects usually look faceted,
i.e. the individual surfaces are visible.

Halo

Refractive and reflective effects around a light
source.

HSV

One of the colour models—Hue-Saturation-
Value.

Label

This is usually a non-tiled texture, analogous to
the labels that you find on bottles.

Lens Flares

When photographing or filming light rays may
fall into the lens, causing smaller or larger
coloured rings on the exposed material. Such
flares can be the result of air bubbles or lenses
that are not completely tight. One normally tries
to prevent this disturbing effect, however, in
photorealistic computer graphics it is sometimes
desirable to use them as a design element (this
is sometimes overused).
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Local Coordinates

Every object has its own origin, which is
subordinate to the world coordinate system (or
other objects that are higher in the hierarchy).
Local coordinates are useful for determining
positions of subordinate objects.

Mapping

The way in which a texture is projected onto an
object. Also refers to the technique that is used,
such as Bump Mapping, etc.

Mesh
Synonym for wireframe.
Model

Complex 3D structure consisting of one or many
(hierarchically structured sub-) objects.

Multi processor system

Computers working with multiple central
processors. This can be used to work on several
processes simultaneously or to have several
processors tackling one task. Applications need
to support this type of processing in order to
benefit from it.

OpenGL

The standard, developed by Silicon Graphics, for
exchanging 3D data between applications and
graphics cards.

Phong Shading

This Shading algorithm smooths the edges of an
object. Without it, objects may look faceted, i.e.
each individual surface is clearly visible.

Pixel

Picture element. The size of a pixel depends on
the resolution of the output device. Monitors
usually have 72 pixel per inch (dpi), laser
printers 600.

Plug-in

Separate add-on which is integrated into the
main application at launch and is then called
from within it. Plug-ins are not normally
autonomous, i.e. they do not work outside an
application.

Polygon

3D models consist of (control) points and
connecting lines. Each surface area that is
formed is called a polygon.

Procedural textures

Mathematically generated textures (2D and 3D).
Their advantage is that they are largely
independent of the projection type and can,
depending on their programming, be tiled
seamlessly.

QuickTime

Apple graphics standard. There are QuickTime
movies and images as well as the VR (virtual
reality) walkthroughs.

RAM

Random Access Memory: Data may be read and
written to this memory in a non-sequential
manner. When you switch off the computer, the
contents of this type of memory are deleted.

Raytracing

Computes the course of a light beam in space.
In non-scientific computer geometry it is not
light rays that are being traced but visual rays,
i.e. rays that emanate from the viewer's eye
rather than from a light source.

Rendering

Refers to the computing of images. The method
used (raytracing, scanline ...) is irrelevant. The
application of filters to 2D images (such as
brightening and sharpening) is also called
rendering.



RGB

The colour model Red/Green/Blue. Mixing
varying parts of these three colours produces
the intermediate colours.

Scanner

Device for reading images (from books, photos
etc.) into the computer. Useful for creating
realistic textures. With a 3D scanner it is even
possible to capture three-dimensional objects
and convert them into models.

Scene

Refers to the whole of a 3D computer model,

consisting of objects, light sources, cameras, etc.

Seamless Textures
See Tile Textures.
Shadow buffer

Buffer for storing information which allows
objects to cast a shadow. These buffers are used
particularly for generating soft shadows.

Texture

Usually a 2-dimensional image, which can be
used as a label, a tile, or in its full format for
defining material attributes. There are also 3-
dimensional textures, which are normally
generated with the help of mathematical
algorithms. These are normally referred to as
procedural textures (see separate entry) or
shaders.

Tile textures

These are textures which can be joined
seamlessly (tiling). However, when looked at
from a distance, distinct repetitions can be
visible in the pattern, if you cover a large area
with small tiles. If you want to avoid this, use a
mathematically generated 'infinite’ texture — see
Procedural Textures.
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User interface

Appearance of a program allowing interaction
with the user. Includes all graphical elements,
such as menus, popups, buttons, etc.

Vertex

A node. Vertices are the intersections of two
lines in a wireframe model and of three edges in
a surface model. In BodyPaint 3D vertices are
edited in Point mode.

Virtual Reality

No widely accepted definition exists, but what is
generally meant is an artificial, computer-
generated three-dimensional world.

Volumetric Lighting

Special lighting technique, which calculates
shadows within visible light.

Voxel

Volume element. Originally, the expression was
used in medicine, in analogy to pixels, when
scanners were able to read in three-dimensional
objects. They were the smallest spatial unit that
a medical scanner was able to resolve.

Wireframe

Most common way of representing objects in a
3D editor. Objects are shown as wire structures.
Often, this is the only possible representation,
but BodyPaint 3D also supports Gouraud
Shading, Flat Shading, Cuboid, Skeleton and
invisibility.

Z buffer

Is used for computing quick previews, that take
no account of shadows or surface detail.
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Index

Symbols

2D Shader 238-249

3D Formats 440

3D Shader 249-255
new 208

3D Studio 440

A

Achromatic Light 44

Active Channel
display 183

Active Layer 110

Active Object
apply texture to 211
copy 197, 305
copy active tag to children 201
cut 197
delete 197, 306
deselect all 306
edit object axis 367
edit with object tool 366
frame (in camera) 13
frozen selections 382
information 199
link view to 15
move 361
quick navigation 364
render 401
render in Picture Viewer 416
resize 362
rotate 363
save 196
search for 200
select all 306
setting display of 14
shading property of 14
show animation path of 14
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X-ray mode 14
Active Tool Manager 375, 376, 377, 428
introduction 9
Active Tool Window. See Active Tool Manager
Add
blending mode 76
layer mask 114
Additive textures 268
Align. See Snap
Align Normals 388
in DXF files 294
Alpha Channel 108, 110, 112, 115, 231
in brick shader 239
in cloud shader 240
in cyclone shader 241
in fire shader 242
in flame shader 242
in galaxy shader 243
in RTTM display 23
in Saturnring shader 245
in sunburst shader 247
omit from render 407
render with 412
separate alpha option 414
when rendering 407
Ambient lllumination 332
Animation
animation path 14
drag-and-drop 59
export to VRML 2 298
Animation Path
displaying 14
editing 14
Animations
in the browser 63
play with Open 290
Antialiasing 405
lines with OpenGL 46
softness 419
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while selecting 166

API
for C.O.FEE.E. 437

AppleScript 414

Area Light 321

Area Shadows 323

Arrange
icon palettes. See Command Manager
materials. See Sort Materials
objects in the Object Manager 188
view 24

ASCII Cloud
load 278

Auto Light 416
with quick shading 20

Axes Tools 370

B

Back Light 353
Backface Culling 14, 22
disabling 15
display tag in Object Manager 189
invisible polygons 388
option for VRML 1 297
option for VRML 2 298
Background
and alpha channels 232
color 421
compositing 192
picture 15
Background Color 81
Background Layer 107
Background Picture 15
Backlight 353
Backup Copies
automatic 41
Bake UV 146
Bank 370
axis 370
changing with the mouse 363
Basic Units 42
overriding 435

Batch File
with external in render preferences 414
Beard
brush preset 101
Bevel
option for brick shader 239
Bias
in light shadow tab 334
relative vs absolute 335
Bitmap
brush type 95
edit UV 146
info for material 115
load 96
selection, editing 81
selection tools for paint 163
textures 127
transform 172
Bitmap Filters 151
Blending
layers 116
of layers 108-109
Blending Modes 75
Blur
to soften a texture 215
BMP 440
Border
adding to texture channel 179
Bounding Box. See also Marquee
used to group objects 199
Brightness
of color 77
of light 328
of material color 213
Browser 57-65
and C.O.FFE.E. 64
and the Drawing Pin 60
creating a catalog 58
drag-and-drop 59
importing into 60
information window 64
movies 63
new catalog 60



open catalog 60

opening from the Window Menu 427

preferences 63
relative catalog paths 61
render all pictures 64
saving from 61
scenes 64
search 65
select all images 63
settings 28
sorting 65
use of catalog example 62
Brush 171
bitmap 96
direction 93
fade 94
filter 96
hardness 91
jitter 92
preset 70
pressure 90
random setting 95
rotation 92
settings 89
settings effectors 92
shape 89
squeeze 92
strength. See Brush: pressure
tool 171
Brush Manager 98
close 98
Brush Position
painting mode 78
Brush Presets
delete 99
duplicate 99
edit 99
export 98
import 98
new 98
new group 98
rename 99
save 98

viewing 99
Brush Settings 89-97
save 97
Brush Type
bitmap 95
generic 89
Bump Map. See Relief Map
Bump Texture 230

C

C++
and C.O.FFE.E. 437
C.O.FEE.E.
and plugins 397
and the Console Window 428
API 437
in the Browser 64
programming 437
SDK 437
shaders 238
Source Development Kit (SDK) 397
support 438
Camera 311-357
depth of field 312
edit 364
editor 15
focal length 312
focus 313
frame scene with 13
frame scene without 13
framing 13
in View menu 15
interactive control 313
lens effects 345
move 364
move hotkey 6
rotate 365
rotate hotkey 6
scale 365
scale hotkey 6
scene 15
target 315
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tool 364
undo/redo view 304
Camera Tool 364
Cancel
render 211
Canvas
fitto UV 149
size 179
Catalog
delete pictures 63
example of use in Browser 62
making paths relative in Browser 61
new in Browser 60
open in Browser 60
save in Browser 61
Cel Render 404
Channel Shader 238
Channels
material 82
material, copy/paste 214
multiple, painting to 83
of material 112
Chromatic 43
Circle
interpolation 216
Clip Mapping 231

Clipping

of light 317, 331
Clone

texture 171
Close

all 290, 291

brush manager 98

brush settings 97

file 290

on the Pin menu 40

texture 130

the Browser 63

the document 290

the Material Manager 209

the Object Manager 196

the Structure Manager 279
Close All 290, 291

Color
background 81, 421
blending 75
brightness 77
choosing 76
copy 80
editing settings 80
foreground 81
manager. See Color Manager
of material 213
of texture 129
paste 80
picker 170
preset 70

presets 83. See also Presets: colors/patterns

settings 75
sliders 77
using to select 167
Color Depth
information 64
of texture 214
Color Manager 83
close 84
Color System 43
Command Manager 36, 428
Command Palettes 32
introduction 8
new 32
Commands
grouping 34
Compositing Background 192
Cone
light 319
shadow 338
Connect
an object group 393
select polygons/splines 379
Connect Function 393
Console Window 428
Context Menus
introduction 8



Contrast
of light 328
Convert to polygons 388
Coordinates
generate UVW 201
Copy 38
active object 197, 305
cells in Structure Manager 279
color 80
image in picture manager 274
layer 110
material 210
tag to children 201
Create
a MultiBrush 102
Create Mask 181
Cube
light 337
Cubic Mapping 260
Cursor Keys 363
in the Structure Manager 277
Cut 38
active object 197, 305
cells in Structure Manager 279
material 209
Cut/Copy/Paste
colors 80
Cylinder 296
Cylindrical Mapping 259

D

Darken
blending mode 76
Decal Mapping 263-265
Deformers
and level of detail 189
and UVW coordinates 201
Delete 38
active object 197
brush presets 99
cells in Structure Manager 279
color/pattern presets 84

INDEX * 455

layer 113

material 210

object 306

palette command 36

points 366

render settings 403

selected UV 149

tag from children 201
DEM 295
Depth Channel 414. See also Alpha Channel
Depth of Field

for cameras 312

option in Render Menu 415
Deselect

frozen points 383

frozen polygons 383

hide elements deselected 381
Deselect All

active objects 306

cells in Structure Manager 280

points/polygons 379

preview pictures 63
Difference

blending mode 76
Diffusion

material 220
Direct3D Format 292, 293, 441
Direction

of tablet pen 93
DirectX Format 292, 293
Disconnect

surfaces 387
Disk

loading patterns from 78
Displacement

mapping 237
material 237
Display

of lights in editor 315

of objects, control of 198

tag in Object Manager 189
Display Mode

for active object 14
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for inactive objects 15

introduction 20

options 20-23
Display Selected Channel 183
Display Tags Option 196
Display Units 40

lens effects 349

material 211, 212

menu in Browser 63

menu in Brush Manager 99
menu in Color Manager 80
menu in Material Manager 209

Dissolve menu in Object Manager 197
blending mode 75 menu in Structure Manager 279
Distance model 367
brush setting 94 movie 219

Distant Light 319
Dock
windows 7, 30
Drag-and-drop
in the Browser 59
in the Brush Manager 99
in the Color Manager 84
in the Layer Manager 110
in the Object Manager 187
Draw Line 174
Draw Polygon
in texture view 175
Draw Text 174
Duplicate
brush presets 99
color/pattern presets 84
layer 113
Dust
in visible light 341
DXF 292, 294, 440
circle option 294

E

Edges
filter 416

Edit
2D shader 218
animation path 14
brush presets 99
camera 364
glows 347
in View menu 13

object 199, 366
object axis 367

object tag 201

palette 36, 425

points 366

polygons 366

primitive objects 388
selection mask mode 81
streak 348

surfaces 387

texture 107, 369
texture axis 369

UV points 136

UV polygons 137, 139-141

Edit Material. See Material Editor

Editor Camera 15
Effectors

for brushes 92

when painting textures 79
Environment

color 356

fog 356

material 227
Environment Object 356
Erase

blending mode 76
Eraser 172
Exclusion

blending mode 76
Expand Object Group 199
Export

brush presets 98

color/pattern presets 83



from picture manager 273
scene 291
settings 27
External Compiler
for C.O.ERE.E. 437
Eyedropper 77, 170

F

Fade

brush stroke 94
Falloff

of light 330
Feather

selection 166
Feature Overview 55
Field Rendering 411
File

close 290

close all 290, 291

export 291

formats 439

import 290

import ASCII into Structure Manager 278

import into Browser 60
initialization 66

layout 426

logfile example 416

menu in Browser 60

menu in Material Manager 208
menu in Object Manager 189

menu in Structure Manager 278

new 289
open 289
quit 5
recent files 42, 298, 299
revert to saved 290
save 290
save all 291
save as 291
save project 291
File Formats 439

for textures 131
Fill
layer 181
selected UV polygons 181
Fill Light 352
Film Formats
for render 410
Filter
edges when rendering 416
for brush 96
ignore for material channel 76
render post-processing 416
wet edges 96
Filters
bitmap 151
Final serial number 431
Fit Canvas 149
Flat Mapping 259
Flatten
layer 114
Flip
texture channels 181
Floor object 354
Focal Length
of camera 312
when scaling 365
Focus
of camera 313
Fog
environment 356
material 228
shader 251
simulating 229
visible light 323
Folding
commands 34
Font
of text 174
Foreground Color 81
Fractal
turbulence 248
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Frame Rate

when rendering 411
Frames

show safe 15
Freehand Selection 376
Freeze Selection 382
Fresnel

material transparency 224
Frontal Mapping 260
Frozen Layers

DXF option 294
Frozen Selections 382
Functions

mathematical 435

menu 393

G

General Settings 27, 40-52
Generate Backup Copies 41
Generate UVW Coordinates 136, 201
Genlock. See also Alpha Channel
in Material Manager 231
Glossary 445
Glow 346
editor 347
material 236
Gouraud Shading 20
in preferences 64
Graphics Tablet 40, 93
using with texture painting 79
Grayscale
to RGB 115
Grid Lines
for textures 369
Group
color/pattern presets, show 84
commands to palette 34
expand objects 199
icons 8
objects 199
presets 83

tabs 31

windows 30
Groups

preserve when disconnecting 387
Grow Selection 380
GUI 6

H

Hard Shadows 322
Hardness
of brush 91
Heading 370
axis 370
changing with the mouse 363
Help
overview of features 55
with layers 117
Help menu 431
Hermite. See Bézier
Hide
deselected points/polygons 381
object with backface culling 15
objects in Object Manager 198
other than frozen selection 383
selected points/polygons 381
High Quality Shading 183
Highlight. See Specular
Hotkeys 6
HPB System 370
option 40
HSV 77
HSV Model 45

Icon Editing. See Command Manager
Icon Palette

new 40, 425
Icons

for brush presets 99

for color/pattern presets 84



grouping 8
IFF 439
Ignore Filter
for material channel 76
lllustrator 295
load object 196
Image
formats 439
in the background 15
Import
ASCII cloud 278
brush presets 98
color/pattern presets 83
file 290
settings 27
Inactive Object
displaying 15
Information
about current scene 200
about MAXON 431
about selected object in Object Manager 199
in Browser 64
Initialisation files
New.c4d 66
Template.c4d 5
Template.cat 66
Template.l4d 66
Input Fields
introduction 8
Interactive Control
of camera 313
of NURBS 310
Interactive Mapping
of UV mesh 150
Interpolation
circle 216
Invert Selection 379
Isoparms 21

J

Jitter Brush Function 92
JPEG 440

K

Key Light 352
Keyboard Shortcuts 36
adding your own 37
Keys
for quick navigation 364
hotkeys 6
using cursor keys 363

L

Launching 5

Layer
active 110
alpha channel 110, 112
and the texture tag 193
background 107
blending 108-109, 116
delete 113
drag-and-drop 110
duplicate 113
DXF option 294
fill 181
flatten 114
info 115
mask 110, 111
material channels 112
memory 117
merge 113
move 116, 170
new 113
offset 116
opacity 108, 116
re-arrange 110
strength 108, 116
textures 267
tutorial 117

Layer Manager 107, 426

active material channels 82

Layer Mask 111
add 114
managing 114
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Layers
frozen, DXF option 294
Layout
load 56, 425
save 42
save as 57, 426
save default 425
Lens Effects 345-357
edit 349
option when rendering 415
Level of Detail
view 20
Light
bias of shadow 334
glow 346
lens effects 345
Light Cube 337
Light maps 352
Lighten
blending mode 76
Lighting
ambient light 332
area 321
brightness 328
clipping 331
contrast 328
distant 319
dust in visible light 341
falloff 330
key light 352
memory needed 317
negative 328, 332
noise 317, 343
omni 318
outline shadow 337
parallel 320
radiation option 317
render time needed 318
shadow map 322
shadows 316
show clipping range 317
show illumination range 317
show visible light 317

soft shadow 336

spot 319

target light 354

texture mapping 352

visible 324

volumetric 324
Lights

displaying in editor 315
LightWave 440
Lines 174

antialiased by OpenGL 46
List

of textures 109, 159
Live Selection 378
Load

bitmap 96

catalog 60

colors/patterns 80

layout 56, 425

manager settings 41, 43, 46

material 289

materials 209

object 196

point cloud 278

scene 289

texture 129, 130
Lock

painting mode 78
Log File 416
Luminance

material 221

M
Macintosh

simulating right mouse button 5

Magic Wand 167
Magnet

UV points/polygons 144
Magnify 364. See also Zoom
Make Tab 39
Manager

active tool 428



colors 83

command 428

layer 426

menu 428

picture 427

pin icon 39
Manager Settings

loading 41, 43, 46
Managers

docking/undocking 39

introduction 7
Managing Textures 132-134
Map

UV mesh interactively 150
Mapping

clip 231

cubic 260

cylindrical 259

decal 263-265

different on same object 269

displacement 237

flat 259

frontal 260

MIP 217

of textures 255-267

restrict to selection 269

RTTM 23

SAT 217

shrink wrapping 262

spatial 260

spherical 258

texture, disable 15

types 258-265

UvW 260
Mapping Types 258-265
Marquee

selection 375
Mask

create from polygons 181

for layer 110, 111

managing for layers 114
Material

allocating texture 130

channels 82, 112
channels, copy/paste 214
channels, list 109
color 213

color brightness 213
copy 210

cubic mapping 260
cut 209

cylindrical mapping 259
delete 210

diffusion 220

edit 211, 212

enable for editing 107
environment 227

fog 228

fresnel 224

glow 236

ignore filters 76

load 209, 289
luminance 221

new 208

painting multiple 182
paste 210

reflection 225

relief map 229
remove duplicate 212
remove unused 212
rename 212

render 210

save 209

search 256

sort 211

specular 234
transparency 222
view active channels 112

Material Channel

converting 115

Material Editor 212-219, 220
Material Manager 207, 427

introduction 9
redo 209

Memory

layer 117
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needed by lighting 317
Menu
help 431
Menu Manager 38, 428
revert to original 39
Menus
editing 38
introduction 8
Merge
layer 113
Mesh, UV 134. See also UV Mesh
Metal
brush preset 101
simulating 227
specular on material 234
Metal Shader 253
MIP Mapping 217
MIP Maps Option 46, 47
Mirror
selected UV 149
texture channels 181
Missing Textures 401
Mix
texture channels 219
Mixed Textures 269
Mixing
layers 116
of layers 108-109
Model
edit 367
scale hotkey 6
Model Tool 367
Modes
of blending colors/patterns 75
of painting 78
Motion Blur
object 416
scene 416
Mouse 5
right mouse button, Macintosh 5
wheel 5
Mouse Hit
painting mode 78

Mouse Wheel 95
using with texture painting 79
Move
active object 361
bitmap 172
camera 364
cells in Structure Manager 277
hotkeys 6
layer 116
points 366
quick navigation 364
selected UV 149
UV points/polygons 141
Move Layer 170
Movie
creating (rendering) 412
data, editing in texture 219
displaying in Browser 63
editing in texture pane 218
opening 290
playing 290
render as 412
render formats 412
Multi Channel Palette 81
Multi Channels
texture 82
MultiBrush 100
creating 102
Multiply
blending mode 76

N

Name
of texture 116
Negative lighting 328, 332
New
3D shader 208
alpha channel 115
brush preset 98
brush preset group 98
camera 311
catalog 60



command palette 32
icon palette 40, 425
layer 113
layer mask 114
line in Structure Manager 278
material 208
render settings 403
scene/document 289
submenu 38
tag in Object Manager 189
texture 129
texture tag 193
view panel 426
New.c4d 66
Noise
in lighting 317, 343
Normal
blending mode 75
Normals 22
align 294, 388
and decal mapping 263
displaying 14
general information 388
reverse 389
Null Object 309
NURBS Objects 310-357

0]

Object
delete 306
edit 199, 366
environment 356
floor 354
load 196
motion blur 416
move hotkey 6
null 309
paste 197
rotate hotkey 6
scale hotkey 6
sky 355
use shading property 22

Object Axis 367
editing 367
Object Group
connect 393
Object Hierarchy 188
Object Manager 187
drag-and-drop 187
introduction 9
redo 197
texture menu 201
Object Property. See Tag
Object Tag
edit 201
Objects
controling display 198
expand group 199
group 199
select all 306
ol
brush preset 100
Omni Light 318
Opacity
adjusting for color/pattern 75
of layer 108, 116
Open
catalog 60
file 289
in picture manager 273
scene/file 289
texture 130
OpenGL
antialiasing lines 46
Operators (mathematical) 435
Optimal Mapping 136, 147
Optimize
UV mesh 147
Outline
UV polygons 181
Oversampling 407
Overview of Features 55
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P

Paint
lock mode 78
object tutorial 69
selection tools 163
texture 127
with textures 77
Painter
window 426
Painting Mode 78
Palette. See also Command Palettes
edit 425
grouping 34
multi channel 81
Palette Command
delete 36
Palettes
edit 36
Parallel Light 320
Paste 38, 305
cells in Structure Manager 279
material 210
object 197
Path
render option 414
texture 71
texture, option 51
to texture 214
Paths
catalog 61
Pattern
presets 83. See also Presets: patterns
Pattern Manager. See Color Manager
Patterns
blending 75
defining 75
loading from disk 78
picking with eyedropper 77
preset 77
tiling when painting 78
Pen
direction 93

draw direction 93
graphics tablet options 79
pressure 93
tilt 93
Perspective View 16, 70
Pick
color 170
PICT 439
Picture
in the background 15
Picture Manager 273
export image 273
open image 273
zoom 274
Picture Sequence
render 412
Picture Viewer 427. See Picture Manager
render to 402
Pin Menu 39
Pitch 370
axis 370
changing with the mouse 363
Pixel Ratio 42
in render settings 411
Plastic
specular on material 234
Plug-ins 397
folder 214
programming 437
Point
cloud 278
delete 366
Points
deselect all 379
edit 366
edit UV 136
select from polygons 381
selecting UV 137
UV magnet tool 144
UV move tool 141
UV rotate tool 143
UV scale tool 143
UV shear tool 144
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UV snap when moving 142 colors/patterns, import 83
Points Tool 366 colors/patterns, rename 84
Polygon colors/patterns, save 83

select from points 381 colors/patterns, show group 84

selection 377 colors/patterns, view 84
Polygons patterns 77

create mask 181 Pressure

delete UV 149 of brush 90

deselect all 379 of tablet pen 93

drawing 175 Previews

edit UV 137 deselect all in Browser 63

editing 366 Programming

fill UV 181 in C.O.FEE.E. 437

invisible with backface culling 388 Programming Interface. See API

mirror UV 149 Project

move UV 149 save 71, 291

outline UV 181 Projection

select connected 379 changing type 15

selecting UV 137 modes 16-19

uv 135 Projection Modes

UV, editing 139-141 and UV mesh 135

UV magnet tool 144 Projection type 69

UV move tool 141 Property

UV rotate tool 143 object. See Tag

UV scale tool 143

UV shear tool 144 Q

UV snap when moving 142
Polygons Tool 366 Quadrangles
Preferences and polygons 373

Browser 63 Quick Navigation 364

general 27, 40 Quick Shading 20
Preserve Groups QuickDraw3D 441

when disconnecting 387 Quit 5
Presets

adding to the colors manager 80 R

brush 70

brush, save 97 Random

color 70 brush setting 95

colors/patterns 83 Ray Depth

colors/patterns, delete 84 in render settings 417

colors/patterns, duplicate 84 RayBrush 182

colors/patterns, export 83 Raytracer

colors/patterns, icons 84 render setting 405
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Raytracing

samples in metal shader 251

Re-arrange

objects in Object Manager 188
Real Time Texture Mapping 23

save 41
Recent File List 42
Recent Files 298, 299
Recover
last saved file 290
Rectangle Selection 375
Redo 304
in Material Manager 209
in Object Manager 197
in Structure Manager 279
view 13
Redraw Limit 42
Reflection
as a lens effect 345
material property 225
when rendering 408
Reflection Depth
when rendering 417
Refraction
when rendering 407
Refractive Index 225
Region
render 402
Registering 431
Relief Map
for materials 229
Remap 146
Remove
duplicate materials 212
unused materials 212
Rename
brush presets 99
color/pattern presets 84
material 212
Render
a region 402
active object 401
alpha channel 412

as movie 412

cancel 211

edges filter 416

field rendering 411

film format 410

frame rate 411

lens effects 415

material 210

mode 404

path 414

picture sequence 412
post-processing filter 416
stop 273

straight alpha 413

tag 191

time needed by lighting 318

Render Active Object 401
Render Menu

depth channel 414
depth of field option 415

Render Settings 402-403

delete 403

lens effects 415
mode 404

name of 404

new 403
oversampling 407
pixel ratio 411

ray depth 417
raytracer 405
reflection 408
reflection depth 417
refraction 407
resolution 410
save formats 412
shadow 409
shadow depth 418
threshold 418
transparency 407
volumetric light 415

Resolution

texture 129



when rendering 410
Reverse Normals 389
Revert to Original Menus 39
Revert to Saved 39, 290
RGB 77

to grayscale 115
RGB Model 44
Right Mouse Button

on a Macintosh 5
Rotate

active object 363

bitmap 172

brush tip 92

hotkeys 6

texture 180

texture when painting 79

UV points/polygons 143

RTTM. See Real Time Texture Mapping

Rubber Stamp. See Mouse Hit

S

Safe Frames
activating 15

SAT Mapping 217

Save
active object 196
all files 291
brush preset 97
brush presets 98
color/pattern presets 83
colors/patterns 80
default layout 57, 425
file 290
layout as 57, 426
layout at program end 42
material 209
project 291
RTTM textures 41
scene 290
settings, general 27
texture 131
when rendering 412

Save as 291
Save Project 71
Scale
active object 362
bitmap 172
hotkeys 6
texture 178
texture when painting 79
UV points/polygons 143
Scale Axes
option in general settings 46
Scene
load 289
Scene Cameras 15
Scene Motion Blur 416
Screen
blending mode 76
SDK 437
Seamless tiles 266
Search
active object 200
for material 256
in Browser 65
paths 51, 401
Segmentation. See Subdivision
Select
adjacent polygons 381
by color 167
hide 381
invert 379
points from polygons 381
polygons 366
polygons from points 381
UV points/polygons 137
Select All
catalog images in Browser 63
objects 306
points/polygons 379
Select Connected 379
Selection
anti-aliasing 166
feather 166
freehand 376
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freeze 382

frozen 382

grow 380

live 378

magic wand 167
polygon 377
rectangular marquee 375
restrict material over 269
shrink 380

tolerance 168

tolerant 138, 375, 376, 377, 378

tools for paint 163
Selection Fundamentals 373, 374
Selection Mask

edit 81
Selection Menu 373
Selection Tools

for paint 163
Selective UVW Mapping 262
Serial number

entering your final number 431
Set Selection. See Freeze Selection
Setting Ray Depth 417
Setting the Render Resolution 410
Settings

Browser 28

brush 89

color 75

import/export 27

pattern 75

save 27
Shader - 2D

cloud 240

cyclone 241

fire 241

flame 242

gradient 241

marble 243

neptune 244

noise 245

saturnring 245

starfield 246

stars 247

sunburst 247

turbulence 248

uranus 248

water 249
Shader - 3D

earth 250

fog 251

marble 252

metal 253

rust 253

terrain 254

venus 254

wood 253
Shaders 238-255
Shading 14

high quality 183

objects, property of 22
Shadow Bias 334
Shadow Depth

and materials 226

when rendering 418
Shadows 316

area 323

color 333

density 333

hard 322

outline 337

soft 336

transparency 335

when rendering 409
Shape

of brush 89
Shear

bitmap 172

UV points/polygons 144
Shortcuts

keyboard 36
Show Normals 14
Show UV Mesh 136
Shrink Selection 380
Shrink Wrap Mapping 262
Size

of texture 116, 178



of texture canvas 179
Skeleton Display 21
Sky Object 355
Sliders

for choosing color 77
Smoke

simulating 229
Smoothing 189

and surface normals 389

how it works 190

tag in Object Manager 189
Smudge 97
Snap

UV points/polygons 142
Sort

materials 211
Sort Materials 211
Sorting

in Browser 65
Source Development Kit. See SDK
Spatial Mapping 260
Specular

metal 234

plastic 234
Spherical Mapping 258
Splines

polyline 292

select connected 379
Spot Light 319
Square

interpolation 216

spot light 319
Squeeze Brush 92-103
Starting 5
Store Color 89
Straight Alpha 413
Streak

editor 348
Strength

of brush 90
Stroke

UV polygons 181
Structure Manager 278

delete cells 279

moving cells 277

new line 278

pasting 279

redo 279
Subdivision

and hyper NURBS 310
Support 443

for C.O.FFE.E. 438
Surface

editing 387
Surface Normals 22. See also Normals
Surfaces

disconnect 387

T

Tabs
create 39
grouping 31
introduction 8
Tag
display 189
new 189
render 191
smoothing 189
texture 193
url 195
TARGA 439
Target Camera 315
Target Light 354
Technical Support 443
Template.c4d 5
Text 174
Texture
applying 255
applying to one side only 263
bitmap filters 151
bitmaps 127
channels 82
choosing with eyedropper 77
clone 171
close 130
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color 129 Texture Axis

color depth 214 adapt to object axis 203
discussion 127 adapt to view 203

edit 107 adapt to world axes 203
editing 369 edit 369

editing movie 218 mirror 204

editing movie data 219 Texture Error 417
effectors 79 Texture Geometry Dialog 255
eraser 172 Texture Mapping 255-267
error 417 light maps 352

flip 181 Texture Paint Option 75
fog/smoke simulating 229 Texture Paths 51

grid lines 369 Texture Tool 369

layers 107, 267 Texture View 70, 127
layers, managing 132-134 changing size 159

list 109 draw polygons 175
load 129, 130 eyedropper 170

menu in Object Manager 201 texture list 159
metal-like 227 zoom 170

mirror 181 Textures

mixing channels 219 disabling display 15
name 107, 116 displaying 23

new 70, 129 missing 401

optimize UV mesh 147 mixing 269

painting with 77 Threshold

painting with graphics tablet 79 when rendering 418
painting with mouse wheel 79 Thumbnails

path 214 in Browser 28, 58
paths 71 TIFF 439

resolution 129 Tile

rotate 180 and textures 265
rotate when painting 79 seamless 266

save 131 uv 183

scale when painting 79 Tiling

size 116, 129, 178 patterns 78

soften with blur 215 Tilt

stretching 262 of tablet pen 93

tag 193 Tolerance

tag, new 193 of selection 168

tiling 265 Tolerant Selection 138, 375, 376, 377, 378
to material 130 Tool

transform bitmap 172 axes 370

wallpaper 80 camera 364



points 366

polygons 366
Transform

UV mesh 149
Transform Bitmap 172
Transparency

for materials 222

option in lighting 335

when rendering 407
Transparent Axes 46
Triangles

and polygons 373
True Color 128
Turbulence

shader 248
Tutorial 69

layer 117

MultiBrush 102

UV Coordinates 134
Types

of brush 89

of file format 131

U

Undo 304
buffer 303
depth of 42
in Material Manager 209
in Object Manager 197
in Structure Manager 279
view 13

Undo Depth 132

Undock
manager 39
window 7

Ungroup Object Group. See Expand Object

Group
Unhide 381
Units

for display 40
URL
tag 195

uv

bake 146

edit bitmap 146

edit points 136

edit polygons 137

fill polygons 181

magnet tool 144

move tool 141

optimize 147

outline polygons 181
polygons, editing 139-141
rotate tool 143

scale tool 143

selecting points/polygons 137
shear tool 144

snap when moving 142
tile 183

UV Coordinates Tutorial 134
UV Editor 134
UV Mesh 134

adapt to canvas 149
bake 146

bitmap filters 151
delete selected 149
edit 139-141

edit bitmap 146
interactive mapping 150
magnet 144

mirror selected 149
move 141

move selected 149
optimize 147

rotate 143

scale 143

shear 144

show 136

snap when moving 142
transform 149

UV Polygons 135
uvw

generate coordinates 201

UVW Coordinates 261

generate 136
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UVW Mapping 134, 260
selective 262

\'

Version number 431
View
active material channels 112
arrangement 24
brush presets 99
cameras 15
colors/patterns 84
configure 14
level of detail 20
perspective 70
texture 70
texture view 159
undo/redo 13
View Icons 13
View Panels 13
new 426
Viewport Settings 27
Visible Light 324
dithering 342
dust 341
preventing contouring 342
show option 317
Volume Shader 249
Volumetric Lighting 324
render option 415
VRML 442

w

Wallpaper 80

Wavefront 442

Web Browser
and the URL object tag 195
MAXON online 431

Wet Edges 96

Wheel Mouse 95

Window
active tool 375, 376, 377
change size 8
grouping with dock 30
undock 7
Window Menu
Browser 427
Coordinates Manager 427
Painter 426
Windows
docking/undocking 7, 30
Wireframe 20

X

X-ray mode
activating 14

Z

Zoom. See also Magnify
in picture manager 274
texture view 159, 170
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